SageERPAccpac

How can we help you?

Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage ERP
Accpac working smoothly for your business! Your Sage Business
Partner is also an excellent resource to consult when you have
guestions about Sage ERP Accpac.

[}l I'm setting up Sage ERP Accpac and need information or assistance

[t I'm looking for instructions to complete a task within Sage ERP Accpac

[t | think something is broken, or I'm getting error messages

[}l 'm looking for downloads, updates, or technical specifications

[}l | want to become a more skilled user of Sage ERP Accpac

[}l | want to share knowledge with other Sage ERP Accpac users

[}l | want to contact a Sage ERP Accpac representative
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New Features in Version 6.0

Accounts Payable 6.0 includes the following new features and
improvements:



In Product Update 1:

A new T5018 (CPRS) Electronic Filing form is now available in the
Periodic Processing folder.

If you file more than 50 T5018 slips for a calendar year, the Canada
Revenue Agency (CRA) requires you to file original and amended T5018
information returns over the Internet. You use the new T5018 (CPRS)
Electronic Filing form to create your T5018 information return in the
required XML format. You can then submit the generated file using the
CRA's Internet File Transfer application. If you are filing fewer than 50
slips, you can submit the file to the CRA on electronic media.



In the 6.0 Release:

e Changes in Processing to Respect New Fiscal Period Locks

Accounts Payable supports changes to Common Services' Fiscal
Calendar.

Fiscal periods are now locked separately for each Sage ERP Accpac
program. Although this change does not affect the way you enter
transactions in Accounts Payable, you should note the following
points:

(0]

The system checks the status of a fiscal period for Accounts
Payable when you enter certain dates in Accounts Payable
transactions. It also checks the status of the fiscal period for
Bank Services when you print a payment check.

If the period is locked for Accounts Payable, you receive a
warning, an error message, or no message, depending on the
setting for the Locked Fiscal Period option on the Company
Profile’s Options tab.

If the period is locked for Bank Services and the Locked Fiscal
Period option is set to Error, you receive an error message
when you add a receipt or print a refund cheque. (Otherwise,
no warning or error appears.)

Generally, you should lock a period for Accounts Receivable,
Bank Services, and Accounts Payable at the same time, to
avoid this situation.

(¢]

If a fiscal period is locked for General Ledger but not for
Accounts Payable, you can create batches for General Ledger
during posting or using the Create G/L Batch icon (depending
on Accounts Payable's G/L Integration settings). When you try
to post transactions to a locked period in General Ledger,
however, the transactions will be placed in an error batch. You
can avoid this situation if you create and post General Ledger
batches for outstanding Accounts Payable transactions before
locking a period for General Ledger.

e New Portal-Related Security Authorizations



o Two new authorizations — Aged Payables Snapshot and
Days Payable Outstanding Snapshot — allow users to view
and configure the Aged Payables snapshot and the Days
Payable Outstanding snapshot, respectively, in the new Sage
ERP Accpac portal.

o The new Accpac Inquiry authorization allows users to query
Accounts Payable data in the new Sage ERP Accpac portal. If
they also have Export Processing authorization for Accounts
Payable, they can print or export the results of these queries.

o A new Vendor Developer Inquiry authorization supports the
new portal's Inquiry feature. Developers of third-party
programs, including macros, should incorporate this resource
in their security structures.

Upgrading from an Earlier Version?

¢ If you are upgrading from version 5.5, see Changes in Accounts
Payable 5.6.

e |f you are upgrading from version 5.4, also see Changes in Accounts
Payable 5.5.

e If you are upgrading from version 5.3, also see Changes in Accounts
Payable 5.4.




Accounts Payable Forms

The following list includes the name of each Accounts Payable icon that
you can select from the Sage ERP Accpac Company Desktop.

Select one of the keywords below for information on the purpose and
operation of the forms these icons lead to.

Vendor maintenance

Recurring Payables
Remit-To Locations
Vendor Activity
Vendor Groups
Vendors
1099/CPRS Inquiry

Transaction processing

Adjustment Batch List
Adjustment Entry
Control Payments
Create Payment Batch
Invoice Batch List
Invoice Entry
Payment Batch List
Payment Entry
Payment Inquiry
Payment Selection Codes
Post Batches

Periodic processing

1099/Electronic Filing

Clear History

Clear Statistics

Create G/L Batch

Create Recurring Payable Batch
Create Retainage Batch




Delete Inactive Records
Revaluation
Year End

Reports

Setup reports

1099/CPRS Codes
Account Sets
Distribution Codes
Distribution Sets
E-mail Messages
GI/L Integration
Optional Fields
Options

Payment Codes
Payment Selection Codes
Terms

Transaction reports

Aged Cash Requirements
Aged Payables

Aged Retainage

Batch Listing

Batch Status

G/L Transactions

Check Regqister

Posting Errors

Posting Journals

Vendor Transactions

Vendor reports

1099/CPRS Amounts
Letters/Labels

Recurring Payables Report
Remit-To Locations




Vendor Group List

Vendor Group Period Statistics
Vendors

Vendor Activity Statistics
Vendor Period Statistics

Setup

Account Sets
Distribution Codes
Distribution Sets
E-mail Messages
GI/L Integration
Optional Fields
Options

Payment Codes
Payment Selection Codes
1099/CPRS Codes
Terms

18 Related Topics
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Accounts Payable Menu Commands

The menu bar appears in all Accounts Payable forms immediately below
the form title.

For more information about menu commands, select from the following
menu titles:

File menu

Settings menu

Help menu

12 Related Topics
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Data Entry Tools and Shortcuts

Accounts Payable data entry forms contain many aids to data entry which
you can activate by pressing a function key or clicking an icon.

Select the icon or command listed below for which you want information:

aor » Or 44 ¥ ¥ « Or
R Navigation [ o
Find 0 buttons Zoom New

12 Related Topics
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Working with Data Entry Grids

The first tab of each transaction entry form in Accounts Payable contains
a detail entry grid that shows the document details in tabular format.

If there are more columns than can be displayed at one time, you can
use the horizontal scroll bar at the bottom of a list to view the additional
columns. You can also rearrange the order of columns, or change column
widths, consistent with how you enter data.

If you need to view or edit options for a single detail, you can select a
detail and open a separate form that lets you see all the fields for the
selected detail.

To add details using the detail grid, do one of the following

e If a blank line is highlighted, tab to the Item Number field, then either
type the item number or select it from the Finder. Enter the remaining
information for the detail.

e To start a new line, press Insert or tab through the end of the last line
on the grid. If you want to insert a new line in a particular location,
highlight the line above the location, then press Insert.

A detail line is saved as you enter it on the detail entry grid.

To edit details using the detail grid

e Highlight the line you want to edit, then enter your changes on that
line.

To delete details using the detail grid

1. Highlight the line you want to delete.

2. Press the Delete key on your keyboard.

3. If you see a message asking you to confirm the deletion, click Yes.
To open a Detail form (F9)

In most cases, you can enter all the necessary details for a document
right on the grid.

You can also view and edit all the fields for a single detail on a separate



Detail form.

To open the Detail form to edit item information or to change options,
highlight the detail on the grid, then either click the Detail button or press
the F9 key on your keyboard.

See also

Data Entry Tools and Shortcuts




The File menu appears in all Accounts Payable program forms. Use its
commands as follows:

Print In report forms, begins printing the current report. In non-report
forms, opens the related report form, for you to make selections to
specify the report you want to print.

Printer Setup Lets you select the printer or file to which you want to print,
or select Preview to print to your screen.

Customize Lets you hide fields on a form, depending on the user.

Import Lets you enter information about the data you want to import, and
import it.

Export Lets you enter information about the data to export, and export it.
Close Closes the current form.



Help Menu

The commands on the Help menu provide different kinds of information
about the Sage ERP Accpac Accounts Payable program.

Contents Displays the table of contents for the Accounts Payable on-line
help system, from which you can select help on various aspects of
Accounts Payable.

Using helpProvides information on how to use Help.

About Accpac Lists the version number of Sage ERP Accpac that is
installed on your system. Also lists information about the equipment you
are using, and the amount of memory and percentage of system
resources that are currently available.



Settings Menu

A Settings menu appears on all transaction forms and on some report
forms.

The Settings menu provides the following options:

The Auto Clear option helps you to streamline
data entry in transaction entry forms.

Auto Clear Select the Auto Clear option to start a new entry
automatically when you add a transaction (as if
you clicked the Add button, then the New
button).

In some forms, the Settings menu also contains
options that let you save the current settings as
personal defaults or restore the program's

original settings.
Save Settings As

Defaults ¢ To save the current settings as your

personal defaults for the form, select the
Save Settings As Defaults option.

e To revert to the program's original settings,
select the Clear Saved Settings option.

In Invoice Entry, Quick Mode lets you copy fields
from the existing entry or detail to new entries or
details.

When you click Quick Mode on the Settings
menu, a separate form appears that lets you
select Quick Mode settings.

] e To copy header fields to new transactions in
Quick Mode the batch you are working on, select Use
Quick Mode For Entries, then specify the
entry fields you want to copy.

e To copy detalil fields to new details in the



transaction you are working on, select Quick
Mode For Lines, then specify the detail
fields you want to copy.

When you start a new entry or detail, fields from
the previous transaction or detail are copied to
the new transaction or detail, so you don’t have
to re-enter them.



Steps for Setting Up Accounts Payable

After you activate Accounts Payable, follow the steps in this topic to set
up a new Accounts Payable ledger.

[}] step 1: Select options and add setup information

[}l step 2: Add vendor records

[}l step 3: Transfer your accounting data to Accounts Payable

[}l step 4: Design the formats for your preprinted forms
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Creating Formats for Printed Forms (Checks,

Advices, Letters, Labels)

The Accounts Payable package includes sample checks and payment
advices, letters, and labels that you may be able to use "as is," or adapt
for the forms you currently use.

Accounts Payable ships with standard business forms that can be edited
using Crystal Enterprise (if you are using Sage ERP Accpac 500), or
Crystal Reports (if you are using Sage ERP Accpac 100 or Sage

ERP Accpac 200).

Accounts Payable includes Crystal (.RPT) versions of the following
printed forms:

e AP1099 — 1099 code form for laser printers.
e APLETTO1 — sample letter.

e APLBLO1 — sample labels. (Note that labels are approximately 6.5
cm by 2.5 cm, and are designed to fit a page of 30 labels, arranged in
3 columns.)

e APCHECK — advice only

e APCHKO1 — advice-check-advice forms for laser printers

e APCHKO1A — similar to ARCHKO1. The check portion is & ansi-compiiant
e APCHKO02 — advice and check

e APCHKO03 — check-advice-advice

e APCHK11 — check-advice-advice for 11-inch check forms.

e APCHK11A — similar to ARCHK11A, in & ansi-compliant

e APCHK14 — check-advice-check-advice for 14-inch forms

You select the checks you want to use when you set up bank accounts in
Bank Services.

You should set up and test the forms you want to use before you begin
entering transactions.

Modifying reports using Crystal Reports
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See the accompanying Seagate documentation shipped on the Sage
ERP Accpac CD ROM.

& Related Topics
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Using Multicurrency Accounting in Accounts

Payable

Accounts Payable lets you process invoices and payments in any
currencies your vendors use. This section summarizes the steps you take
to set up a multicurrency Accounts Payable system.

Note: Before you can use the multicurrency features, you must first install
the Sage ERP Accpac Multicurrency package for the Sage ERP Accpac
edition you are using (sold separately).

To create a multicurrency Accounts Payable system, you

1. Turn on the Multicurrency option for the company and select a default
rate type in the Company Profile form in Common Services.

2. Use the Common Services Currency forms to add any currency codes
you need for Accounts Payable, and enter rates for the currencies you
use.

When you install Sage ERP Accpac, you also install a large set of
currency codes that use standard international abbreviations. You
probably will not need to define new codes unless you do not use the
international codes.

3. Use Accounts Payable's Options form to select the Multicurrency
option for your Accounts Payable system.

4. Use the Account Sets form to add at least one account set for each
currency you want to use in Accounts Payable. In each account set,
enter the currency code and the numbers of your exchange gain and
loss general ledger accounts.

5. When you create vendor groups and vendor records, select the
account set and the rate type for each record.

The vendor's account set determines the vendor's currency. The
vendor group account set is only a default when adding vendor
records. You can override it.

Invoices are always issued in the vendor currency, although payment
can be in any currency.



6.

If you post transactions to add year-to-date figures, enter them in the
appropriate currencies.
If you enter statistics for previous years and periods, you must enter

amounts in both the functional and vendor currencies. Accounts
Payable cannot calculate equivalent amounts from statistics you enter

yourself.

When you post transactions during and after setup, Accounts Payable
calculates statistical totals in both the functional currency and the
vendor's currency, using the exchange rate posted with each
transaction.

& Related Topics
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Entering Accounts Payable Setup Information

Before you can add vendor records to Accounts Payable, you must set
up other records to assign to your vendors.

You select icons from the A/P Setup folder to set up the following records:

e Account sets

Distribution codes

Distribution sets (optional)

E-mail messages (optional)

Optional fields (if you use them)

Payment codes

Payment selection codes

1099/CPRS codes

e Terms

If you want to set up recurring payables, you choose the Recurring
Payables icon from the Vendors folder.

18 Related Topics
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Setting Up Vendor Records

Adding vendor records to Accounts Payable involves transferring your
existing vendor information to Sage ERPAccpac and selecting options
that let you process payables more effectively.

You use the Vendors form to enter most of your vendor information to
Accounts Payable. This form lets you enter information such as:

e The vendor number (the code you use to identify the account), as
described under "Assigning Vendor Numbers," later in this section.

e Whether the account is on hold. See "Placing a Vendor Account on
Hold," later in this section.

e An optional "short name," (an abbreviation or acronym that represents
the vendor). For more information, see "Entering Short Names," later
in this section.

e The vendor's name, address, Web site, e-mail address (one for the
vendor and one for your contact), and phone numbers.

e The date on which you started to do business with the vendor.

e Comments you want to store with the vendor record or want to print
on correspondence with the vendor, display during transaction entry,
or keep for other purposes.

e Additional information your company wants to include in the optional
fields created in the Options form for your vendor records, if you
purchased the separate Optional Fields package from Sage
ERPAccpac.

Processing options for vendor transactions

You also use the Vendors form to identify the ways in which you process
transactions for each vendor, specifying the following information.

e The account set, which determines the general ledger accounts to
which the vendor's transactions are distributed. Each set includes
accounts for payables control, purchase discounts, and prepayments.

e |f you use multicurrency accounting, the account set also includes
unrealized and realized exchange gain and loss accounts.



e The default payment terms that Accounts Payable will use to calculate
the due date, discount period, and discount amount for vendor
invoices.

e The bank code and credit limit associated with the vendor.

The vendor bank code is the bank account on which you usually write
checks to pay the vendor.

e The method for distributing invoice amounts to G/L accounts.

You may distribute amounts by distribution code, distribution sets, or
by general ledger account code.

e How you check for duplicate vendor invoices.

o Whether you pay each invoice with a separate check or cover several
invoices with a single payment.

e Tax information for vendor invoices, and whether the vendor is subject
to 1099 (for US vendors) or CPRS (for Canadian vendors) reporting.

The tax group for the vendor determines the taxing authorities and tax
class for each authority to which you would pay tax on an invoice.
This information tells Accounts Payable how to calculate tax amounts
on the vendor's invoices.

In addition to the information you can enter for each vendor in the
Vendors form, Accounts Payable automatically adds the statistics it
collects from all transactions posted to each vendor account

If you select the Allow Edit Of (vendor) Statistics option in the Options
form, you can enter statistical figures when you are setting up a new
Accounts Payable system, and revise them as needed.

You can define as many additional remit-to addresses as you need, using
the Remit-To Locations form.

You can import vendor records into Accounts Payable from non-Sage
ERPAccpac programs, instead of entering them in the Vendors form.
Assigning vendor humbers

You use the Vendors form to add vendor records. For each new record
you assign a unique vendor number, up to 12 characters, including



letters, numbers, and symbols.

If your current system for assigning vendor numbers makes sense in
Sage Accpac, you may want to transfer your present system. However,
you should probably take the time now to evaluate your current system,
because the best time to switch systems is when you already have to
recreate all your vendor records.

If you do not have a logical method of assigning vendor numbers, you
should develop a system before you add any vendor records to Accounts
Payable.

Your numbering system should let you organize the records as you
require, such as alphabetically, by region, and for reporting purposes.
The system should also allow for expansion as your business grows.

Setting a vendor account Inactive

You can set a vendor record inactive prior to deleting it, to ensure that no
further transactions are processed.

You cannot set inactive status, however, if there are any unposted
transactions for the vendor.

Placing a vendor account on hold

You can place a vendor account on hold. When an account is on hold,
Accounts Payable warns you when you start to enter an invoice for the
vendor, and you then choose whether to continue entering the invoice.

You cannot enter payments or prepayments for a vendor who is on hold,
or otherwise decrease the balance in the vendor account, using the
Create Payment Batch form. However, you can pay vendors on hold
using the Payment Entry form.

Entering short names

You can enter a code or "short name" of up to ten characters for each of
your vendors. Short names are a means by which you can list vendors in
alphabetical order (or any other order) on reports, and still include the full
vendor name in the vendor record, because Accounts Payable can sort
records by short name first.



To illustrate, assume you have the following four vendors. When listed
alphabetically, the names appear in this order:

A. Craig & Son

Bashaw Bulldozing

Mr. Stephen Kershaw
The Garden Restaurant

If you assign a short name that is the first seven letters of the name by
which you want to list the accounts, they appear in this order:

Vendor name Short name
Bashaw Bulldozing BASHAW
A. Craig & Son CRAIG

The Garden Restaurant GARDEN
Mr. Stephen Kershaw KERSHAW

If you want, you can print short names on vendor statements. You might
then want to use them for a purpose that is unrelated to vendor names.

You may have designed your vendor numbers so that they list vendors in
alphabetical order or in another order that meets your requirements. In
that case, you might choose not to use short names at all.

Selecting processing options

You choose the processing options you want to use with each vendor on
the Processing tab of the Vendors form:

e The account set.

e The default payment terms.
e The bank code.

e The credit limit.

e The method for distributing invoice amounts to general ledger
accounts.

e The rate type for converting source currencies to their functional-
currency equivalents (multicurrency ledgers).



e Whether you pay each invoice separately.
e How you check for duplicate vendor invoices.

Entering tax information

Whether you are charged taxes on purchases or are tax exempt, you
enter all the necessary tax information in the vendor record. Accounts
Payable can then automatically calculate all the applicable taxes so you
can verify the invoices you receive from vendors.

To specify tax information in the Vendors form, you first select the tax
group that includes the taxing authorities and tables that apply in the
vendor's geographical area. (You set up tax groups in the Tax Services
forms in Common Services.)

You then select the taxing authorities that tax sales to the vendor and the
tax class that indicates the type of sales on which the vendor is charged
tax by each authority.

If the vendor has a tax-exemption number or a registration number, such
as for the Canadian Goods and Services Tax (GST), you also enter it.
You can also include the number in the information you print on invoices
and statements.

Using vendor statistics

Accounts Payable keeps statistics for vendors, and displays them in the
Vendors form. You can view the statistics by the type of year and length
of period specified in the Options form for vendor statistics.

For each vendor, the application displays the amount and number of
invoices, payments, discounts taken and lost, credit notes, debit notes,
adjustments, and paid invoices. The application also calculates and
displays the total days to pay and average days to pay for the vendor.

Activity statistics

Accounts Payable also displays the current outstanding balance and
keeps track of the year-to-date amounts and the dates of the highest
balance and largest invoice in the current and previous years, and the
last invoice, payment, credit note, debit note, adjustment, and discount
posted to the vendor's account.



Finally, Accounts Payable calculates and displays the total invoices paid,
number of checks, average payment, total days to pay, and average days
to pay for the account.

Editing statistics

You can edit the statistics in a vendor record if you select the Allow Edit
Of Statistics option in the Options form.

Reporting tax amounts in statistics

The totals kept for invoices, credit notes, and debit notes can include or
exclude tax amounts posted with the document, depending on your
choice for the Include Tax In Statistics option in the Options form.

You can also see, but not change, the outstanding balance, open
document count, current prepayment amount, and number of
prepayments for the account.

Setting up records for recurring payables

If you regularly pay the vendor for the same order, such as monthly rent,
you can create recurring payable records, using the Recurring Payables
Setup form. (See Recurring Payables — overview.)

Processing vendor comments

You can enter any number of comments in vendor records, using up to
2,509 characters for each comment.

To view an entire comment on a separate form (rather than having to
scroll to see it), double-click in the Comment column.

When you enter a comment, you can also enter a follow-up date when
you want to check on the comment, as well as an expiration date when
you want to delete the comment. Once the expiration date is reached,
Accounts Payable automatically deletes the comment when you use the
Clear History form to clear comments for the vendor number.



12 Related Topics
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Accounts Payable Security: Overview

If security is turned on for your Sage ERP _Accpac system, users without
Accounts Payable security assignments have no access to Accounts
Payable.

To view records and to print reports in Accounts Payable, you must
belong to a security group with Common Inquiryauthorization.

Common Inquiry authorization by itself does not let you edit any Accounts
Payable records. To edit records or perform processing tasks, your
security group must be authorized to perform additional tasks from the
following areas:

[}l Setup Maintenance

[t control Payments

[}l vendor Maintenance

[} Invoice Batch Inquiry
[t Invoice Batch Entry

[t Invoice Batch Posting

[}l set Invoice Batch Ready To Post

] payment Batch Inquiry

[}l payment Batch Entry

[}l payment Batch Posting

[}l Set Payment Batch Ready To Post

[ Adjustment Batch Inquiry

[}l Adjustment Batch Entry

[}l Adjustment Batch Posting

[}l set Adjustment Batch Ready To Post

[ Check Printing

[}l vendor Analysis
[t Clear History / Records / Stats

[}l period End Maintenance

[t Year End Maintenance

[ Import Processing
[}l Export Processing.

[}l Transaction History Inquiry

[}l Transaction Optional Fields

[}l Dashboard
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[}l Aged Payables Snapshot

[}l Days Payables Outstanding Snapshot

[ Accpac Inquiry
[ vendor Developer Inquiry



javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

Choosing Accounts Payable Options

Once you have activated Accounts Payable, your first task is to use
Accounts Payable's Options form to choose the options you want to use
with your Accounts Payable system.

You also use the G/L Integration form to specify how and when to
produce transactions for General Ledger.

The options you choose determine how your Accounts Payable system
will operate, and the types of data that will be stored and displayed. You
can also use the forms after setup to review your entries and change
most of them, if necessary.

12 Related Topics
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Options — Company Tab

Use this tab to:

e Change the contact name, telephone number, and fax number for
Accounts Payable.

To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use
the Company form in Common Services.

Click the links below for help on using the corresponding tabs:

Processing | Transactions | Numbering | Retainage

For an overview of the Options form, see Options form.

12 Related Topics
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Options — Processing Tab

Use the Processing tab to:

¢ Indicate whether your Accounts Payable system uses multicurrency
accounting. (See Using Multicurrency Accounting in Accounts
Payable.)

e Specify whether to force listing of batches before posting.

e Specify whether imported and external batches can be edited.

¢ Indicate whether Accounts Payable accumulates and reports vendor
and vendor group statistics.

¢ |f statistics are accumulated, the type of year and period for which
they are to be kept, whether tax is included in the statistics, and
whether statistics can be edited.

e Define the aging periods by which you group outstanding and overdue
transactions on reports, and specify whether you age unapplied credit
notes, debit notes, and prepayments in the current period or the
period associated with their document dates.

e Set the default number of days you keep comments in vendor records
and indicate whether you require batch listings (before posting).

Click the links below for help on using the corresponding tabs:

Company @ Transactions = Numbering | Retainage

Changing Options

At any time, you can change your choices for all processing options,
except the Multicurrency option. Once you turn on the Multicurrency
option you cannot turn it off again.
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Options — Retainage Tab

The Retainage tab appears when you select the Retainage Accounting
option on the Processing tab of the Options form.

You use this tab to specify default settings for retainage when you add
new vendor records.

Accounts Payable uses the retainage settings from vendor records as
defaults when you enter invoices, credit notes, or debit notes, although
you can change settings for particular vendors — and for individual
documents.

Click the links below for help on using the corresponding tabs:

Company | Processing @ Transactions = Numbering

12 Related Topics
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Options — Transactions Tab

This tab lets you:

e Specify the following options for invoice, credit note, and debit note
transactions:

o Whether you report 1099/CPRS payments, and whether you
permit 1099/CPRS amounts to be edited.

o The default method for calculating tax on invoices (automatic or
manual tax calculation).

o Whether to use document totals as default amounts subject to
1099/CPRS reporting on invoices, debit notes, and credit notes.

e Set options for payment transactions, including:
o The default bank code for your company.

o The order in which to list documents when applying payments and

credit notes in the Payment Entry form. See Displaying Open
Documents in Payment Entry.

o Whether you enter adjustment transactions in payment batches.

o Whether you permit editing of system-generated batches (of
payments).

e Set the default sort order when printing checks, which include:
o by Vendor Number

(¢]

by Payee Name

(¢]

by Payee Country

(@)

by Payee Postal Code

o

by Transaction Number

You can change your choices for these options at any time, provided no
other Accounts Payable forms are in use.

For information about a tab on the Options form, click the corresponding
link:




' Company | Processing | Numbering | Retainage |
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G/L Integration Form | Fieid List_|

Sage ERP Accpac Accounts Payable produces general ledger
transactions from all batches you post. Each general ledger transaction
includes all the information you need to update Payables data accurately
in your general ledger.

If you use Sage ERP Accpac General Ledger, Accounts Payable creates
batches of Payables transactions right in General Ledger, where you can
edit and post them. If you use another general ledger system or your
Sage ERP Accpac General Ledger system is at another location,
Accounts Payable creates batches you can import into another
application, or print, then enter manually into your general ledger.

The GJ/L Integration form lets you:

e Determine how Accounts Payable produces and maintains
information from posted transactions for General Ledger. (Use the
Integration tab.)

e Define the source codes used to identify different types of Accounts
Payable transactions created for General Ledger.

e View the last posting sequence number for each type of batch posted
to General Ledger.

e Determine what data to include in the G/L Entry Description, G/L
Detail Reference, G/L Detail Description, and G/L Detail Comment
fields in general ledger transactions. (Use the Transactions tab.)

Changing your choices

You can change any of your choices on the G/L Integration form at any
time. You should be aware that your new choices apply only to general
ledger transactions created after the change, and do not affect pre-
existing general ledger batches.

If you use the Create G/L Batch form to produce general ledger batches
and want to change to producing them during posting, we recommend
that you first run Create G/L Batch to create any outstanding
transactions.



18 Related Topics



javascript:mc13.Click()

Assigning Document Numbers to Prepayments

Accounts Payable assigns a unique number to each prepayment
document you add to a payment batch.

The number is a combination of a prefix that identifies the transaction
type, and a number that is assigned sequentially by Accounts Payable,
starting with the number you specify.

You enter the prefix and next number to assign to prepayment
documents on the Numbering tab of the Options form.

You may be able to continue using your current numbering scheme. At
any time, you can also specify a different prefix and next number in the
Options form for Accounts Payable to assign. (Note, however, that you
cannot make a change that would create duplicate document numbers.)

Check number sequences and the next check number are set in Bank
Services. Invoices use the numbers assigned by the vendor.
Prefix and Next Number

You can use up to six characters for the prefix, and up to nine digits for
the document number.

If you do not enter a prefix and document number, Accounts Payable
automatically assigns 1 as the first document number and uses "PP" as
the prefix for all prepayment documents.

Sequence Number

When you add a prepayment in the Payment Entry form, Accounts
Payable automatically assigns a document number, using the prefix and
next number you specified in the Options form. If you use the assigned
number, the Next Number box is updated in the Options form.

Document numbers can go as high as 999999999, then they are
automatically reset to 1.

Changing the Next Document Number

If you want to change the next number to assign in the Options form to a
lower number, you may want to also change the prefix, to prevent



Accounts Payable from assigning the same document number twice. You
cannot post two documents with identical document prefixes and
numbers.

& Related Topics
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Account Sets

This form lets you create groups of general ledger account numbers that
you can use to:

e Categorize vendor transactions by accounts to which they are posted
in general ledger. These general ledger accounts are: Payables
Control, Purchase Discounts, and Prepayment.

e Use separate account sets to designate different types of payables, or
vendors in different geographical areas.

In multicurrency ledgers:
e Specify the currency used by vendors assigned to each account set.

e For account sets that do not use the functional currency, enter
account numbers for unrealized exchange gains and losses, and
realized exchange gains and losses.

e For account sets that do not use the functional currency, specify an
account for exchange rounding differences.

You must create at least one account set before you can add vendor
records.

If you use multicurrency accounting, you must add at least one account
set for each currency used by your vendors. The account set you assign
to a vendor must use the vendor's currency.

Before using

e Print the Account Sets report for the records you want to edit or
delete. Choose the Account Sets icon from the Setup Reports folder.

e Print the Vendor List with the Profile information to see which vendors
use the account sets you want to change.

¢ |f changing account numbers, check that your general ledger contains
the accounts you want to assign for these general ledger accounts:

o Payables Control

o Purchase Discounts



o Prepayment

o Unrealized and realized exchange gain and loss accounts
(multicurrency ledgers)

o Retainage (when retainage is used)

If your database does not include Sage ERP Accpac General Ledger,
Accounts Payable will not verify any general ledger account numbers.
You will have to check the numbers you specify against the general
ledger that you use.

Multicurrency account sets

If you use multicurrency accounting, you assign a currency code to each
account set to identify the currency used by the vendors you will assign
to the set. Once you save (add) an account set, you cannot change its
currency.

Multicurrency account sets that do not use the functional currency also
include the accounts to which you post gains and losses that result when
you revalue Accounts Payable transactions at new exchange rates:

e Unrealized Exchange Gain (available only if you use the Realized and
Unrealized Gain/Loss accounting method)

e Unrealized Exchange Loss (available only if you use the Realized and
Unrealized Gain/Loss accounting method)

e Exchange Gain

e Exchange Loss

e Exchange Rounding

These general ledger accounts must allow the account set's currency.

The general ledger accounts you assign to multicurrency account sets
depend on the type of currency information you require in your general
ledger. For example, you might use a separate Payables Control account
for each currency, but use the same numbers for the rest of the accounts
in all your account sets.

If you use the same account number for all the unrealized and realized
exchange gains and losses accounts, the balance in that account in your



general ledger will be the net exchange gain or loss on Payables
transactions.
Editing account sets

You can change everything in most records except the identifying code.
To change the code, you first add a record with the code you want to use,
then delete the record with the code you do not want.

If you use multicurrency accounting, you cannot change the currency
code assigned to an account set.
Deleting account sets

You can delete account sets only when they are not assigned to vendors
or vendor groups.

If you want to delete a code that is assigned to a vendor group or vendor
record, you must first assign a different account set to the vendor record,
then delete the unwanted code.

Click here for tips on using Accounts Payable forms.
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Distribution Sets

Use this form to:

e Create sets of distribution codes to represent the standard groups of
distributions to general ledger accounts that you make when entering
vendor transactions. You can also enter General Ledger accounts
directly in distribution sets.

You do not have to create distribution sets. If you prefer, you can assign
the general ledger account numbers or distribution codes you need to
invoice details as you enter them.

If you add distribution sets, you can assign them to vendor records.
Accounts Payable automatically displays the corresponding distribution
codes assigned to a distribution set when you enter transactions for the
vendor, but you can make any changes you need.

Before using

You must define distribution codes before you can use them in
distribution sets.

For each vendor account, you choose whether to distribute transactions
for the vendor by general ledger account numbers, distribution codes, or
distribution sets, and you enter the default set, code or account number.
(You can override the default during data entry.)

Adding distribution sets
You use the Distribution Sets form to add distribution sets.

For each record you enter a unique code, up to six characters, a
description (name) for the code, the method for distributing the amounts
(Manual, Spread Evenly, Fixed Percentage, or Fixed Amount) and the list
of distribution codes (or General Ledger accounts) in the set.

Tip: To reuse the description and Discountable status from an existing
distribution code, insert the code in the distribution set, as usual. Then
clear the code 1, and enter the General Ledger account you want to use
in the G/L Account field.

You can define as many distribution sets as you need to represent the
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various combinations of general ledger accounts to which you post
invoice data.
Editing a distribution set

You can change the description, the distribution method, the list of
distribution codes, and the accounts in a distribution set, but you cannot
change the code that identifies the distribution set.

If you want to reuse the description and discount status from an existing
distribution code, add the distribution code to the distribution set. Then
clear the Dist. Code field, and enter the G/L account you want to use.
(You cannot change the account for a line to which a distribution code is
assigned.)

To edit a distribution set
1. Enter the code for the distribution set, or select it from the Finder.
2. Make the changes you need.

3. Choose Save to record the changes.

Effects of changes
If you make a distribution set inactive:

e You cannot select the inactive distribution set as the default set when
adding a new vendor group or vendor record.

e You cannot save changes to a vendor group or vendor record that is
assigned the inactive distribution set.

e You cannot use the inactive distribution set when you add an invoice.
(But you can print and post transactions that include the distribution
set if you made it inactive after you entered the transaction.)

If you change the accounts for a distribution code, Accounts Payable
immediately updates the distribution sets that use the those codes when
you save the changes.

Deleting distribution sets

Deleting sets does not remove any information from your ledger (except
the set definition). If you accidentally delete a set, just add it again.



You cannot delete a distribution set if it is assigned to a vendor record.
You must assign a different distribution set to the vendor first.

Deleting a set after adding an invoice (but before posting it) has no effect
on posting. However, you will have to change to a valid set if you edit the
invoice.

Before you start

¢ Assign a different distribution set to vendor groups and vendor
records that use the set you want to delete.

To delete a distribution set

1. Enter the code for the distribution set, or select it from the Finder.

2. Choose the Delete button. If a message appears asking you to
confirm the deletion, choose Yes.

After changing distribution sets

¢ Print the Distribution Sets report by choosing File, Print from the
Distribution Sets form or by choosing the Distribution Sets icon in the
Setup Reports folder.

e Edit vendor groups and vendor records which were assigned the set.
Click here for tips on using Accounts Payable forms.

& Related Topics



javascript:mc16.Click()

E-mail Messages

The E-mail Messages form lets you:
e Create messages to send with e-mailed letters.

e Use variables (field names) from your company database so that e-
mailed messages will include vendor- or company-specific
information.

You identify each e-mail message using a unique 16-character Message
ID code.

When printing letters using the Letters/Labels form, select Vendor as the
delivery method. You can then select the message ID for the message
you want to send with the letter.

To create a message that you can use with letters that you e-mail to
vendors

1. Choose E-mail Messages from the A/P Setup folder.

2. Complete the fields on the form. (For help with the fields, click the
Field List button at the top of this page.)

3. Enter the body of the message. Use field names, preceded by a dollar
sign, to identify variable information that you want to include with the
message.

4. Click Add (or Save) when you are satisfied with your message.



Options Form — Overview

You select options when you create your Accounts Payable ledger. Once
you have set up your ledger, use the Options form (in the Setup folder)
when you need to review or change your selections.

Click here for tips on using Accounts Payable forms.

Click the links below for help on using the corresponding tabs:

Company Processing Transactions
Numbering @ Retainage

Before using

Before changing any of the settings or other information in the Options
form, make sure you understand the impact the options have on
processing within Accounts Payable.

Changing settings

You can change your choices for most Accounts Payable options at any
time, provided that no other Accounts Payable forms are open and no
one else is currently using the Accounts Payable database.

Note: The only option you cannot change is the Multicurrency option.
Although you can select it at any time, you cannot turn it off again once
you have selected it and saved the change.

Also note that you cannot save most changes to the Options form if any
other Accounts Payable forms are open.

12 Related Topics
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Optional Fields Form

This form appears in the A/P Setup folder if you use age Sage

ERP Accpac Transaction Analysis and Optional Field Creator, a
separately licensed package that you can purchase and use with any
edition of Accounts Payable.

To set up optional fields for your Accounts Payable system

1. Choose Optional Fields from the A/P Setup folder.

2. Specify the type of optional field you are defining.

3. Select the optional field code for each optional field you are defining.

If you want to retain optional field information from Accounts Payable
transactions when you create batches for General Ledger, you must
use the same optional fields for transactions in Accounts Payable as
you use in General Ledger.

4. If you want to set a default value for the optional field, double-click in
the @ vaue set cOlumn to change it to Yes.

5. Enter or select the & value that the program will display as the default for the optional field.

When you specify a value that is defined in Common Services, the
program displays the description for the value.

6. To make the optional field @ mandatory, double-click in the Required
column.

If you make an optional field a required field, the Auto Insert field
changes to Yes.

7. Select Yes in the Auto Insert field if you want the program to display
the optional field and its default value on the form for the type of
optional field when you set up new records or enter transactions.
Select No if you do not want the optional field to appear automatically.

8. If the optional field you are defining is for a type of transaction:
a. Click the Settings button.

b. In the Settings form, specify the types of accounts for which this
optional field can be passed to General Ledger when you post
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transactions.

c. If you use Project and Job Costing, select the External Cost
Transactions option if you also want Accounts Payable to update
the contract in Project and Job Costing.

d. Click Close to return to the Optional Fields setup form.
9. Click Save to save your changes.

& Related Topics
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Payment Codes Form

This form lets you:

e Display on the Payment Entry form fields that are appropriate for the
type of payment you are making.

® [1] Group vendor payments by the type of payment: CaSh, CheCk, Credit Card,
and Other.

Note that these payment codes are different from payment selection
codes, which are used as criteria for generating payments from Accounts
Payable.

Click here for tips on using Accounts Payable forms.

12 Related Topics
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Payment Selection Codes

This form lets you add Payment Selection Codes.

Payment selection codes define the criteria for selecting outstanding
invoices and generating transactions to pay them. You must create at
least one payment selection code if you want Accounts Payable to
generate payments for invoices automatically.

You use the Create Payment Batch form to generate the payment
transactions.

Click the links below for help on using the corresponding tabs:

Select | Criteria | Exclusion | Optional Fields

Click here for tips on using Accounts Payable forms.

12 Related Topics
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1099/CPRS Codes

This form lets you add codes to assign to your vendors who are subject
to 1099/CPRS reporting.

You must enter a 1099/CPRS code in the Vendors form for each vendor
you mark as subject to 1099/CPRS reporting.

1099/CPRS expense class codes correspond to the various box numbers
on a standard 1099 or CPRS form. In other words, they identify different
categories of 1099/CPRS payments. You specify the default 1099/CPRS
code for each vendor in the vendor records, but you can specify a
different code for each invoice, if necessary. (Generally, you should
assign code 3, Other Income, for vendors subject to CPRS reporting in
Canada.)

The Minimum To Report amount that you enter for a 1099/CPRS code is
used when you print 1099 forms or file 1099s electronically.

Accounts Payable sets up most 1099/CPRS codes when you activate a
new database. You should have to add or edit codes only if the existing
code structure changes.

The codes created by Accounts Payable are:

Minimum
1099/CPRS To
Code Report Description
1 600 Rent
10 Royalties

600 Other income

zero Federal income tax withheld

zero Fishing boat proceeds

600 Medical and health care payments
600 Non-employee compensation

Substitute payments in lieu of dividends or
interest

5,000 Direct Sales

10
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10 600 Crop insurance proceeds

13 zero Excess golden parachute payments
14 zero Gross proceeds paid to an attorney
15A 600 Section 409A Deferrals

15B zero Section 409A Income

16 zero State income tax withheld

1099/CPRS vendor amounts are accumulated by code and by period.
Each time you enter an invoice, you can specify the 1099/CPRS code to
which the invoice applies. Accounts Payable prints each code amount in
the appropriate box on the 1099/CPRS form.

Note that although 1099/CPRS codes and amounts are entered with
vendor invoices, Accounts Payable accumulates the 1099/CPRS
statistics each time you post payments for the vendor.

Editing 1099/CPRS codes

You can change the description and Inactive status only. You cannot
change the 1099/CPRS code.

However, assigning Inactive status does not affect the accumulation of
1099/CPRS information at posting.

Deleting 1099/CPRS codes

Deleting codes does not remove any information from your ledger
(except the code definition). However, you should not delete 1099/CPRS
codes if you are required to print 1099/CPRS forms. If you accidentally
delete a code, just add it again.

If you delete a 1099/CPRS code, you can no longer assign it to vendor
records — nor can you update a vendor record which has that code
assigned.

If you add non-standard codes

e Only standard 1099-MISC codes are printed on the stock 1099/CPRS
Amounts report.

e |f you add any non-standard 1099/CPRS codes, you must modify the



1099/CPRS Amounts report form to print the non-standard codes.

See also
Account Sets
Distribution Codes
Distribution Sets
Options form
Steps for Setting Up Accounts Payable
Terms




Terms

Use this form to:

¢ Define the payment terms by which your vendors calculate invoice
due dates.

e Specify the method used to calculate discount periods and discount
amounts on invoices from vendors who offer discounts for early
payment.

Click here for tips on using Accounts Payable forms.

Adding terms codes

You must add at least one terms code before you can enter Accounts
Payable transactions.

Installment payments

A set of terms can be as simple as a due date and discount date and
rate, or they can include payment schedules to allow for installment
(timed) payments.

Setting up instaliment terms

You use the Multiple Payment Schedule option to set up a terms code
that allows installment payments. You can define installment periods that
vary in length, and use different methods to calculate due dates and
discounts. You can also set up as many installment periods for a terms
code as you need.

Calculating discounts before or after tax

If you pay tax on purchases, you can specify whether to include tax in the
document total that Accounts Payable uses to calculate discount
amounts

Using standard due dates

Standard due dates are similar to "day of the month due,"” except they do
not restrict you to a single due date. For example, you can use standard
due dates to assign invoices to the 15th or 30th of each month.



If your vendor uses standard due dates (such as the 1st or 15th of the
month), you can create a terms code table to calculate a due date for
each of up to four ranges of days on which invoices were issued.

For example, your table could specify that invoices entered between the
1st and 15th of each month are due on the 30th of the month, and that
invoices entered between the 15th and the end of the month are due on
the 15th of the next month.

You define standard due dates with a table that lets you specify a due
date for each of up to four ranges of days on which invoices were issued.
You can also specify due dates that are one or more months later.

When you use due date tables, you can either define discount periods in
the same way as for other terms options, or you can enter a table of
standard discount periods.

Assigning terms to vendor records

You assign a terms code to each vendor record to set the default terms
that appear when you enter transactions for the vendor. You can choose
different terms for the vendor during transaction entry without changing
the standard terms assigned in the vendor record.

Using terms with transactions

When entering transactions, you enter a terms code with each invoice,
and Accounts Payable automatically does all the required calculations.

Editing terms codes

You can change all the information in a terms code record except the
terms code.

To edit a terms code

1. Enter the code for the terms, or select it from the Finder.
2. Make the changes you need.

3. Choose Save to record the changes.

Effects of changes



If you make a terms code inactive:

¢ You cannot select an inactive terms code as the default code when
adding a new vendor group or vendor record.

e You cannot update a vendor group or vendor record that uses an
inactive terms code.

¢ You cannot use the inactive terms code when you add an invoice.
(But you can print and post invoices you entered with the terms code
before you made the code inactive.)

Other changes you make to terms codes have no effect on existing,
unposted documents that use the codes. If you want to use changes
such as new discount percentages on existing unposted invoices, you
must edit the invoices to enter the new information for the terms code.

Deleting terms codes

Deleting payment terms does not remove any information from your
ledger (except the terms definition). If you accidentally delete a payment
terms code, you can just add it again.

Deleting a payment term after adding an invoice (but before posting it)
has no effect on posting. However, you must specify a different code if
you edit the invoice (because you cannot save changes to the invoice if
the terms code is invalid).

Accounts Payable prevents you from deleting a terms code that is
assigned to a vendor record.

1. Enter the terms code, or select it from the Finder.

2. Choose the Delete button. If a message appears asking you to
confirm the deletion, choose Yes.

After changing terms code records

¢ Print the Terms report by choosing File, Print from the Terms form or
by choosing the Terms icon in the Setup Reports folder.

¢ |If necessary, edit any unposted invoices in the Invoice Entry form to
substitute other terms codes for the terms records you deleted, or to
change terms information for records you modified.
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Distribution Codes

Use this form to:

e Define codes to identify the general ledger account numbers to use
when distributing purchases to general ledger accounts.

e Specify a description (name) for each distribution code.
e Specify whether the distribution code is active or inactive.
e Specify a Discountable status for the distribution code.

A distribution code is a name for a single general ledger account.
Distribution codes provide an easy way to specify account numbers when
you distribute purchases, because you can make them shorter — and
easier to remember — than the general ledger account numbers.

Accounts Payable lets you distribute transactions by distribution sets
(groups of distribution codes), by distribution code, or by general ledger
account number. You select a default distribution method for each vendor
in the vendor records.

Once you define distribution codes, you can group them in distribution
sets, to provide sets of default distributions for assignment to vendors.

Click here for tips on using Accounts Payable forms.

Posting transactions with distribution codes

When you post invoice and adjustment batches, Accounts Payable
creates general ledger transactions for the accounts represented by
distribution codes, and lists the information on the posting journals.

Before using

¢ Print the Distribution Codes report from the Setup Reports folder.

e |f changing account numbers, check that your general ledger contains
the accounts you want to assign to new distribution codes.

o If deleting codes, print the Distribution Sets report from the Setup
Reports folder. Accounts Payable does not warn you if you are
deleting a code that is part of a distribution set, but you will not be



able to use the code if you distribute an invoice using the distribution
set to which it belonged.

e Print the Vendor List with the Profile information to see which vendors
use the distribution codes you want to change.
Adding distribution codes

You use the Distribution Codes form to add distribution codes. For each
record you enter a unique code, up to six characters, a description
(name) for the code, and the general ledger account number that the
code represents.

You can define as many distribution codes as you need to represent the
various general ledger accounts to which you distribute purchases.

1. Click the New button next to the Distribution Code field.

2. Fill in the Description and General Ledger Account fields and add the
record.

Editing distribution codes

You can change the description and the general ledger account number
assigned to a distribution code, but you cannot change the distribution
code.

To edit a distribution code

1. Enter the distribution code, or select it from the Finder.
2. Make the changes you need.

3. Click Save to record the changes.

Effects of changes

If you change the general ledger account assigned to a distribution code,
the new general ledger account is used only in transactions you add after
making the change. Existing transactions will be posted to the original
general ledger account, unless you edit the transactions to enter the new
account number.

If you change the general ledger account assigned to a distribution code,
the new account number is automatically entered in any distribution set



records that use the distribution code.
Making a distribution code inactive has the following consequences:

e You cannot select an inactive distribution code as the default code
when adding a new vendor group or vendor record.

¢ You cannot update a vendor group or vendor record that uses an
inactive distribution code.

e You cannot use the inactive distribution code when you add an
invoice. (But you can print and post the invoice if you made the
distribution code inactive after you entered the invoice.)

e You cannot add or save changes to a distribution set that includes an
inactive distribution code.

Deleting distribution codes

Deleting codes does not remove any information from your ledger
(except the code definition). If you accidentally delete a code, just add it
again.

Note that Accounts Payable does not stop you from deleting a code
which is part of a distribution set, or a code which is assigned to a vendor
record. However, if you delete a distribution code, that code will be
rejected when you try to distribute an invoice using the code (even if you
are using the code in a distribution set).

Deleting a code after adding an invoice (but before posting it) has no
effect on posting. However, you will have to change the code if you edit
the invoice, because you cannot save changes to an invoice that uses a
deleted distribution code.

Before you start

¢ Assign a different distribution code to vendor groups and vendor
records that use the code you want to delete.

e Post batches that use the code you want to delete, or edit the batches
to enter the new code to use.

To delete a distribution code

1. Enter the distribution code, or select it from the Finder.



2. Click the Delete button. If a message appears asking you to confirm
the deletion, choose Yes.

After changing distribution code records

¢ Print the Distribution Codes report by choosing File, Print from the
Distribution Codes form or by choosing the Distribution Codes icon in
the Setup Reports folder.

e Edit any distribution sets which contain a deleted distribution code to
remove a deleted distribution code and, if desired, assign a new
distribution code. You should also print new copies of the Vendor
Group List and Vendors report for the records you changed.

e Print new copies of the Distribution Sets report for any sets in which
you changed distribution codes.

¢ |If you do not want to use a modified or deleted distribution code with
existing unposted transactions, edit the transactions to assign new
distribution codes or general ledger account numbers to which to post
the transactions.

Click here for tips on using Accounts Payable forms.

& Related Topics
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Adding Vendor Records

Use the Vendors form to add records for your vendors to Accounts
Payable. You must add vendor records before you can enter and process
transactions in Accounts Payable.

Before adding a vendor record

e Add Accounts Payable tax groups and other tax information to Tax
Services.

e Add the vendor group, account set, distribution codes, distribution set,
bank code, terms code, optional fields, and tax group you want to
assign to the vendor.

e Decide on the vendor number and the name and short name to enter
for the vendor. You must enter a number and name for each vendor
before you can add the record. Short names are optional.

Multicurrency ledgers

If you are creating a multicurrency Accounts Payable ledger, you must
assign an account set that uses the vendor's currency. You must also
know the rate type to use for vendors with different source currencies.

Adding statistics

If you want to enter statistics for vendors, select the Allow Edit Of
Statistics option on the Processing tab of the Options form before you
continue.



Adding Vendor Groups

You must add at least one vendor group before you can add vendor
records.

To add a vendor group

1. Click the New button next to the Group Code field, then type the code
for the new vendor group you want to define.

2. Fill in the fields and add the record.

Copying an existing record into a new vendor group

To define a new vendor group that uses some of the information entered
in the record for another vendor group, you can copy the information into
the new record, as follows:

1. In the Group Code field, type the code for the vendor group you want
to copy, or choose it from the Finder.

2. When the group record is displayed, erase the code in the Group
Code field and type in the code you want to assign to the new record.

3. Press the Tab key to leave the Group Code field.
4. Edit any of the fields requiring changes for the new group.
5. When finished, choose Add to add the new group.



Entering Current and Historical Transactions

Accounts Payable can display statistical information for vendor accounts,
and vendor groups for the current year and for all the previous years for
which you retain the data. You add the historical information you need
during setup. Accounts Payable then automatically updates the statistical
information every time you post transactions.

Adding prior and current-year data

To set up your Accounts Payable system properly, you must follow these
steps:

1. Enter and post the outstanding invoice balances in your vendor
accounts at the beginning of the fiscal or calendar year — depending
on your method for collecting vendor statistics.

For example, if you have two partially paid invoices from vendor 1000,
enter the unpaid portion of each invoice.

The dates for these transactions should be the dates of the original
invoices.

2. If you want to have prior-year statistics in the vendor records, edit the
statistics after posting the opening invoice amounts.

3. Enter and post all invoices you received since the beginning of the
year up to your last Accounts Payable posting to the General Ledger.

4. Enter and post all payments you made since the beginning of the year
up to your last Accounts Payable posting to the General Ledger.

5. Delete all general ledger batches created from posting historical
transactions. If you post these to your general ledger, you will be
duplicating posted transactions.

Once you have completed these steps you can proceed to enter new
invoice and payment transactions.

Entering current-year data

When you first set up your Accounts Payable system, you must establish
the opening balances in your vendor accounts and enter any transactions



that are outstanding at the time.

The information in this section outlines the steps you take to enter figures
for the current year-to-date.

Entering outstanding invoice balances in vendor accounts

You create the opening balances in your vendor accounts by entering
them as invoices using the Invoice Entry form, then posting them.

The opening balance invoice should use the first date of the current fiscal
year as the transaction (document) date. You can also import the figures
from a spreadsheet or other non-Sage ERP Accpac program.

Entering current-year transactions

When you set up an Accounts Payable system part way through a fiscal
year, you must enter the transaction data for the current year-to-date. To
add the data, enter it directly into Accounts Payable batches, or import it,
then post it using one of the following methods.

e Post all the current-year transactions, one at a time, period by period.
This provides full detail for current-year transactions.

e Post all the transactions for the current period, and the net changes in
each vendor's invoice and payment totals for each of the earlier
periods in the current year.

This provides full detail for current-period transactions, and creates
accurate balances for previous periods in the current year.

e Post the net changes in each vendor's invoice and payment totals for
each of the periods in the current year.

This produces accurate balances for each account in each period of
the current year, but does not provide transaction detail for the audit
trail reports.

e Post the net change between the opening and current balances for
each vendor account.

This is the quickest method of entering the data, but it does not
provide transaction detail for audit trail reports.



Previous-year statistics

If you need to add purchase history for previous years to a new Accounts
Payable system, you can add it quickly, or import it, using the Vendors
and Vendor Groups forms.

You enter statistics by the periods and years specified for the options to
keep the data.

Entering vendor statistics for previous years

For each vendor and vendor group, you can enter the amount and
number of invoices, payments, discounts taken, discounts lost, credit
notes, debit notes, adjustments, and paid invoices.

You can also enter the:

e Amount and date of the high and low balance this year and last year,
and the largest invoice for each year.

e Amount and date of the last invoice, payment, credit note, debit note,
adjustment, and discount.

e Total invoice amount paid, number of checks, average payment, days
to pay, and average days to pay.

You can review the figures in the Vendors and Vendor Groups forms, and
you can print them using the Statistics option in the Setup reports for
each type of data.

If you do not need historical data right away, you do not have to add it
when you set up an Accounts Payable system. The application updates
the figures automatically each time you post transactions.
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Importing and Exporting Accounts Payable

Records

If you presently have a computerized accounts payable system, you may
be able to transfer vendor records directly into Sage ERP Accpac
Accounts Payable by importing them.

You can also export records from another Sage ERP Accpac Accounts
Payable database, edit them in a spreadsheet or other program to
change codes, amounts, and other information, then import them into the
new Accounts Payable system you are setting up.

Accounts Payable records you can import and export include:
e Account sets
e 1099/CPRS codes (although these are set up by Accounts Payable)
e Distribution codes
e Distribution sets
e E-mail messages
e Payment codes
e Remit-to locations
e Terms codes
e Vendor groups
e \endors
e Payment selection codes

You could, for example, export vendor records to a spreadsheet to
analyze their statistics. You could also export all vendor records with the
same account set to a spreadsheet, change their tax group, then import
them back into Accounts Payable.

Accounts Payable can create export files in several formats, including
Microsoft Excel, Microsoft Access, Comma Separated Values and
Continuous ASCII file formats, dBase 5, ODBC, and XML formats. You
select the format to use when you export the data.



You can also create files to be imported by Accounts Payable in any of
the above programs or formats.

For information about importing and exporting Accounts Payable records,
see the Accounts Payable Help and the System Manager Help.

& Related Topics
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Processing Recurring Payables

If you regularly pay for such costs as rent, standing orders, or services
that vary little from period to period, you can automatically create invoices
for all or a selection of the payables and vendors at once.

The ability to create separate recurring payable batches saves you from
having to enter an invoice for each recurring payable and vendor
manually. It also provides an specific audit trail for the recurring payables
by assigning them a separate batch type (Recurring).

Preparing recurring payable records

You use the Recurring Payables form to add records for the recurring
payables you use and to assign them to vendors.

Specifying when to process recurring payables

You can create payables you intend to apply indefinitely, or you can set
them up to stop once you have paid a maximum amount or reached a
certain date, or once you have processed a specified number of invoices.

You schedule the recurring payable for processing at regular intervals,
and you can also have System Manager remind specific or all Sage
ERP Accpac users to create invoices for the recurring payables. To find
out more about creating schedules and using reminders, see the System
Manager help.

Entering details for recurring payable invoices

You add distributions to recurring payable records, similar to invoice
entry.

You can have Accounts Payable calculate taxes when you create a
recurring payable batch, or you can enter the taxes manually.

Other information you can enter with recurring payables

If you need to send your payment to a different address from the one in
the vendor record, you can include a remit-to location with each payabile.
The remit-to location is used on the invoice when you create a recurring
payable batch.



Creating recurring payable batches

When the recurring payables are due, you use the Create Recurring
Payable Batch form to create a batch of invoices.

If the recurring payable record uses a schedule that includes a reminder,
you can also process the recurring payable right from the Reminder List
in Common Services.

You can create a recurring payable batch by vendor number, vendor
group, or recurring payable code.

Accounts Payable creates invoices for the amounts specified in the
selected recurring payable records.

When you process a recurring payable batch, Accounts Payable checks
to ensure that the invoice total (including taxes) will not cause the amount
invoiced to date to exceed the maximum amount specified in the
recurring payable record. If the maximum amount will be exceeded,
Accounts Payable does not create the invoice, and does not update the
Last Invoiced date field for the recurring payable.

If a recurring payable batch with the same batch date exists when you
process a recurring payable batch, the new transactions are added to
that batch.

You can edit the recurring payable batches, print listings for them, and
post them in the same way you process other types of batches.

If you accidentally delete a recurring payable invoice, or if you need to
create an additional recurring payable invoice for another reason,
Accounts Payable lets you create an invoice manually.

To create an invoice manually for a recurring payable, display the
recurring payable record, then click the Create Invoice button.

Assighing document numbers to recurring payable
invoices

When you create a recurring payable batch, Accounts Payable
automatically assigns a document number to each invoice. The
document numbers use the prefix and start with the next number
assigned for recurring payables on the Numbering tab of the Options



form.

Reusing deleted recurring payable invoice humbers

If you delete a batch of recurring payable invoices before posting them,
Accounts Payable does not automatically reset the next invoice number
for recurring payables in the Options form. To prevent gaps in your audit
trail of recurring payable invoice numbers, you should change back to the
number assigned to the first invoice in the deleted batch.

Reporting recurring payable invoices

Invoices for recurring payables are shown as transaction type IN on all
listings and reports in Accounts Payable, and the batch type is Recurring.
The G/L Transactions report assigns AP-IN as the source code for
recurring payable invoices.

When you post a batch of recurring payables, the program adds the
recurring payable amounts to vendor period-to-date and year-to-date
invoice totals. It also updates the Last Invoiced date and Last Invoice
Amount fields in the recurring payable record.



Remit-to Locations — Overview

Remit-to locations are the addresses to which vendors want you to send
payments. The remit-to address may be different from the address in the
vendor record, for example, if the vendor address is just for ordering.

You use the Remit-To Locations form to add remit-to addresses for your
vendors.
Primary remit-to locations

If you mark a remit-to location as the primary remit-to location (an option
in the Remit-To Locations form), Accounts Payable will use this location
as the default address on invoices and on vendor checks.

Accounts Payable can keep an almost unlimited number of remit-to
addresses for your vendors, and you can choose the remit-to location to
use when you are entering payments.

For each remit-to location, you can:

e Specify whether it is the primary location.
e Set the location to active or inactive.

e Specify the check language.

e Enter a remit-to address.

e Provide default entries for the vendor optional fields. If you use the
remit-to location, these entries will override the optional field entries
provided by the vendor record.

Specifying remit-to locations

When you add a remit-to location in the Remit-To Locations form, you
assign a code that identifies the location. You then use the code to select
the location during invoice or payment entry.

To add or change a remit-to address while entering an invoice or a
payment

1. Click the zoom button beside the Remit-To Location field.
2. Choose another remit-to location code using the Finder, or enter an



alternate address for this invoice only.

Customizing remit-to address information

You use the Optional Fields form to add extra fields to the Optional Fields
tab of the Remit-To Locations form. (Optional fields are available if you
purchased a separate license for the Transaction Analysis and Optional
Field Creator package.)

If you set any remit-to location optional fields for automatic insertion, they
appear on the tab, along with their default values.

You can accept or change the optional field values. If an optional field
requires validation, you can select only a value that is assigned to the
optional field in Common Services or, if the optional field allows it, you
can leave the default value field blank.
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1099/CPRS Inquiry

Use this form to:

e Look up the history of 1099/CPRS payments made to vendors that
are subject to 1099/CPRS reporting.

e Add, modify, or delete 1099 or CPRS amounts, if your Accounts
Payable system allows you to edit these amounts.

Note: If you need to add, modify, or delete a 1099 or CPRS amount,
ensure that the Allow Edit of 1099/CPRS Amounts option is selected on
the Transactions tab of the A/P Options form before you begin.

Click the links below for additional help on using the corresponding
buttons:

Print | Close

To use the 1099/CPRS Inquiry form

12 Related Topics
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Recurring Payables Setup

The Recurring Payables form lets you:

e Create records for standard invoices you receive from your vendors. A
recurring payable can be for a single item such as rent, or for a
standing order or service that is almost identical from month to month.
Recurring payables are identified by code as well as by vendor
number, so you can generate a batch of a single invoice type.

¢ View statistics for invoices created for the recurring payable.
e Manually create an invoice for a recurring payable, if necessary.

You can also include recurring payables in the Reminder List, so that
System Manager can remind a specific user, or all users, to process the
payables when they become due. For more information about reminders,
see the System Manager help.

To create a new recurring payable

Click one of the links below for help on using the corresponding tab:

Invoice | Detail | Optional Fields | Tax/Totals | Statistics

Click the links below for additional help on using the buttons on the
Recurring Payables Setup form:

Click here for tips on using Accounts Payable forms.

Multicurrency recurring payables

There is no rate information tab in the form because the exchange rates
are unknown for the recurring invoice. The only rate information you enter
is the rate type on the first tab (the Invoice tab).
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Remit-To Locations

Use this form to:
e Add, edit, and delete remit-to locations &.
e Look up the remit-to locations assigned to a vendor.

e Assign primary remit-to locations to be used on invoices from the
vendor and printed on checks to the vendor.

e Specify the check language to use for each location.

e Provide default entries for remit-to location optional fields. If you use
the location when entering invoices, the optional entries from the
remit-to location record override the entries provided by the vendor
record.

Restrictions on changing records

You can change all the information in a remit-to location except the remit-
to code. If you need to change the code, you must add another record
using the new code, then delete the record you no longer need.

Multicurrency ledgers

You can change the language in which the amounts are printed on
checks. If you want to change the language for other items on the check
or advice form, you must change the check report.

Before you start

¢ Print the Remit-To Locations report.

e Print the Vendor List, including the information you want to change for
the remit-to location.

e Make sure you want to add or change the remit-to information — not
the vendor information.

To add, edit, or delete remit-to locations

1. To select an existing record, type its vendor number or choose the
number from the Finder (click the Finder icon beside the Vendor
Number field or press F5 with the cursor in the Vendor Number field).
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You can also use the navigation buttons to select the vendor.

The form displays the remit-to location code, the name of the location,
and the address and zip or postal code in grid (or columnar) format.

2. To edit an existing remit-to code, select the location on the grid, then
click Open.

To start a new record, click the New button .

To delete a location, select the location on the grid, then click the
Delete button. If a message appears asking you to confirm the
deletion, click Yes. (Note that you cannot delete a remit-to location, or
set it inactive, if it is used in unposted documents.)

3. Edit the existing record or add a new one on the form that opens.
4. Click Add or Save to keep any changes you make.
Click Close to leave without saving changes.

Click the links below for help on using the corresponding tabs:

Address | Contact = Optional Fields

For information about the buttons on the Remit-To Locations inquiry form,
click one of the following links:

OpenNe

Effects of changes

Inactive status — If you make a remit-to location inactive, you can no
longer use it when adding an invoice. If you make a primary remit-to
location inactive, make sure that you also turn off the primary remit-to
location selection.

Optional fields — If you use Sage ERP Accpac Transaction Analysis
and Optional Field Creator, you can assign remit-to location optional
fields to store additional information that you want to keep with remit-to
location records.

You use the Optional Fields tab of the Remit-To Locations form to assign
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optional fields for particular remit-to locations. If you set any remit-to
location optional fields for automatic insertion, they appear on the tab,
along with their default values.

You can accept or change the optional field values. If an optional field
requires validation, you can select only a value that is assigned to the
optional field in Common Services or, if the optional field allows it, you
can leave the default value field blank.

After changing remit-to locations

Print the Remit-To Locations report to check the new record information
and to update your printed records.
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Vendor Activity

This form displays summary information about the current status of your
company's accounts with its vendors. The form contains the following
tabs:

e Activity. This tab displays summary information about the current
status of the account with the selected vendor, and shows the most
recently posted transactions.

e Aging. This tab displays your company's account balance with the
vendor in each of the aging periods used in your Accounts Payable
system, selected by the aging and cutoff dates you specify.

e Vendor Transactions. This tab displays a single line of summary
information for each invoice, credit note, debit note, prepayment, and
payment that has been posted to the vendor's account. You can
include pending amounts in the display, if you want. You also use this
tab to open a separate form to view detailed information about the
history of each displayed document.

e Payments. This tab lists the payments you made to the selected
vendor.

Click the links below for help on using the corresponding tabs:

Activity | Aging @ Transactions | Payments

12 Related Topics
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Vendor Groups

Use this form to:

e Create vendor groups to which you can assign vendors. Use vendor
groups to:

o Classify vendor records by common characteristics.

o Set default entries to speed up the task of adding records for
vendors.

o Select records for processing.

For an overview of vendor groups, see Vendor Groups Overview.

Click here for tips on using Accounts Payable forms.

Click the links below for help on using the corresponding tabs:
Group | Invoicing | Optional Fields | Statistics

For information about fields in the Vendor Groups form, select the Field
List button beside the title of this help topic.

To use the Vendor Groups form

1. To select an existing record, type its group code or choose it from the
Finder (click the Finder beside the Group Code field or, with the
cursor in the Group Code, field press F5).

To start a new group record, click the "new" icon next to the Group
Code field.

To delete a group, enter its group code, then choose the Delete
button. If a message appears asking you to confirm the deletion,
choose Yes.

2. Click the tab you want to see.
3. Click Add or Save to keep any changes you make.
Click Close to leave without saving changes.
For information about specific tasks, choose from these topics:

Adding new vendor groups




Editing vendor groups

Deleting vendor groups

After changing vendor groups

Print the Vendor Groups report, including the information you changed for
the group, to check the new record information.

Edit vendor records that belong to a group to make the same changes
you made to the group. For example, if you changed the terms code in
the vendor group and want to assign it to all vendors in the group, you
must also edit the vendor records to select the new terms code.

& Related Topics
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Vendors

Use the Vendors form to:
eAdd new vendor records.
eChange or @ gelete €XiSting records.
*Review period and activity statistics.

For an overview of vendor records, see Setting Up Vendor Records

Click one of the links below for help using the corresponding tab:

Address Contact | Processing | Invoicing
Optional Fields | Statistics = Activity Comments

To use the Vendors form

1.To select an existing record, type its vendor number or choose it from
the Finder (click the Finder icon beside the Vendor Number field or
press F5 with the cursor in the Vendor Number field).

To start a new vendor record, click the "New" icon next to the Vendor
Number field.

To delete a vendor record, enter its vendor number, then click the
Delete button. If a message appears asking you to confirm the
deletion, choose Yes.

2.Click the tab you want to see.
3.Click Add or Save to keep any changes you make.
Click Close to leave without saving changes.

For information about specific tasks, choose from these topics:
Adding vendor records
Editing vendor records
Deleting vendor records
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Batch Processing — Overview

Accounts Payable operates on a batch system. This means you:

1. Enter the three main types of transactions — invoices, payments, and
adjustments — into batches.

Batches are groups of transactions that share the same batch number
and batch date. Each transaction has its own entry number, vendor
number, date, and detalils.

2. List the batches to check for errors.

3. Post the batches to record the transactions in vendor accounts and
distribute the amounts to general ledger accounts.

4. Print the posting journals and G/L Transactions report as part of your
audit trail records of batches.

The batch system for processing transactions provides great flexibility at
the batch-entry stage, and tight auditing control during and after posting.

For details, see the following topics:

Assigning and using batch numbers and entry numbers
Creating Accounts Payable batches

Editing and deleting batches and transactions

Force Listing of Batches

Journal entries generated by Accounts Payable

Listing batches

Number of open batches permitted at one time

Posting batches

Printing posted transactions

Tracking batches

If you use Intercompany Transactions with Accounts
Payable

If you use Intercompany Transactions, the Accounts Payable component
in ICT lets you enter invoices, debit notes, credit notes, and interest
charges for related companies. ICT A/P posting creates an Accounts
Payable batch in the A/P ledger for the originating company and creates
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an ICT G/L batch in the ICT company. Posting an ICT A/P batch creates
an Accounts Payable batch in the originating company's Accounts
Payable ledger (for posting invoices, debit notes, credit notes, and
interest to vendor accounts), and it creates an ICT G/L batch in the ICT
company. (For online help specifically about ICT features, you must open
an ICT form, and then press F1 on your keyboard. You can only do this if
you have installed ICT and activated it in an ICT company.)

& Related Topics



javascript:mc32.Click()

Journal Entries Generated by Accounts Payable

This topic describes the effects of posted transactions on the general
ledger.

Invoices. Assigned to source code AP-IN on the G/L Transactions report,
except interest invoices, which are assigned the source code AP-IT.

Posted invoice transactions debit the general ledger inventory account
or expense account you specify with each invoice detail (either directly

or using a distribution code) and credit the vendor's Payables Control
account.

GIL Accounts DR CR

Inventory (or

Expense) X
Retainage control X
Payables control X

The entry for a retainage invoice is:

GIL Accounts DR CR
Retainage Control X
Payables Control X

Credit notes. Assigned to source code AP-CR on the G/L Transactions
report.

Credit note transactions credit the general ledger account (the

inventory account in this example) and debit (decrease) the vendor's
Payables Control account.

GIL Accounts DR CR

Payables control X

Retainage control X
Inventory X

Debit notes. Assigned to source code AP-DB on the G/L Transactions



report.

Debit note transactions debit the general ledger account represented by
the distribution code (inventory in this example) and credit (increase) the
vendor's Payables Control account.

GIL Accounts DR CR

Inventory X
Retainage control X
Payables control X

Payments. Assigned to source code AP-PY on the G/L Transactions
report.
Payments debit the vendor's Payables Control account, credit the
Bank account specified for the payment batch, and credit the Payment
Discounts account (if a discount is taken). Discounts are assigned the
source code AP-ED (for earned discount).

GIL
Accounts DR CR

Payables
control X

Bank X

Payment
discounts X

Prepayments. Assigned to source code AP-PI on the G/L Transactions
report.

Prepayments debit the Prepayment account and credit the Bank
account for the payment batch. When you apply the prepayment later,
Accounts Payable will credit the prepayment account and debit the
expense or asset account that you specify.

GIL Accounts DRCR
Prepayments X
Bank X

Miscellaneous payments. Assigned to source code AP-PY on the G/L



Transactions report.

Miscellaneous cash payments debit the general ledger account you
specify on the Payment Detail tab of the Payment Entry form and
credit the Bank account for the payment batch.

GIL Accounts DR CR

Misc. expense X

Bank X

Adjustments. Assigned source code AP-AD on the G/L Transactions
report.

An adjustment entered as a positive number credits the vendor account
(increases the payables balance) and debits the general ledger account
you specify when you enter the adjustment.

For example, the following adjustment was entered as a positive
adjustment to the inventory account.

GIL

Accounts DR CR
Inventory X
Payables

control X

An adjustment entered as a negative amount debits the vendor account
and credits the general ledger account you specify when you enter the
adjustment.

Multicurrency transactions

Exchange gains or losses during revaluation. Assigned source code
AP-GL (for "gain/loss") on the G/L Transactions report.

Accounts Payable creates entries for General Ledger when you revalue
an invoice in a source (non-functional) currency at an exchange rate that
is different from the rate currently used by the invoice.

The following transaction registers a loss, because changes in the
exchange rate have increased the value of the vendor invoice:



GIL Accounts DR CR

Exchange (or
Realized) loss X

Payables control X

If you use the Realized and Unrealized Gain/Loss accounting
method for your company, exchange gains and losses are considered
@Qunrealized® until the document is paid. Revaluation sends unrealized
gain and loss transactions to General Ledger as reversing transactions
(meaning they are automatically reversed at the beginning of the next
fiscal period).

The following entry shows how the unrealized loss is reversed:

GIL Accounts DR CR
Payables control X

Exchange (or
Realized) loss X

When you print the Vendor Transactions report for the period in which
you post the reversing revaluation transaction, both transactions appear
for the vendor. Their net effect on the account balance is zero.

If you use the Recognized Gain/Loss accounting method, revaluation
exchange gains and losses are not reversed.

Exchange gains or losses arising on settlement. Assigned source
code AP-GL (for "gain/loss") on the G/L Transactions report.

This type of exchange gain or loss arises when you settle an invoice
using an exchange rate that is different from the rate currently used by
the invoice.

If posting changes the value of an invoice (for example, through partial
payment, full payment, or credit note), Accounts Payable calculates the
gain or loss for the portion of the invoice that was changed by the
posting, and creates gain or loss transactions for the general ledger
accounts.

The following transaction registers a gain, because the exchange rate on
settling reduced the value of the vendor invoice:



GIL Accounts DR CR

Payables control X

Exchange (or
Realized) gain X

Note that credit notes and debit notes do not affect gains or losses if they
are issued at the exchange rate of the original invoice. However, they will
generate gains or losses if they are issued at a different rate.

Transaction types

A full list of the transaction types listed on the G/L Transactions report
follows:

AP-AD Adjustment

AP-CF Applied Credit (from)
AP-CR Credit Note

AP-CT Applied Credit (to)
AP-DB Debit Note

AP-DF Applied Debit (from)
AP-DT Applied Debit (to)
AP-ED Earned Discount Taken
AP-GL Gain or Loss (multicurrency ledgers)
AP-IN Invoice

AP-IT Interest Charge

AP-Pl Prepayment

AP-PY Payment
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Posting Batches

Posting accomplishes the following tasks. It:

e Updates vendor accounts with the transaction information entered in
batches.

e Updates the vendor and vendor group statistics.

e Creates general ledger transaction information for the G/L accounts
affected by the transactions.

Posting creates G/L batches for the transactions if you use the Create
G/L Transactions During Posting option. If you do not use the option,
the G/L transaction information is stored for later addition to a G/L
batch.

o Creates transactions to realize gains or losses due to changes in
exchange rates (if payments are settling invoice transactions). These
transactions affect the General Ledger only.

e Updates bank services with payment amounts and check numbers (if
printing and posting checks).

e Updates 1099/CPRS information for vendors who are subject to
1099/CPRS reporting (with tax information from invoices and payment
totals from payments).

e Creates a posting journal for each group of batches posted at the
same time.

e Updates the posting sequence numbers for each type of batch listed
on the Numbering tab of the Options form.

¢ |If you create General Ledger transactions during posting, updates the
sequence numbers for the General Ledger batches on the Integration
tab of the Integration form.

e Updates the status of each batch that was posted.

Posting sequence numbers

Accounts Payable assigns a posting sequence number to each
transaction during posting. The same sequence number is assigned to all



transactions that are posted together. Posting sequence numbers provide
another way to trace posted transactions back to source documents.

Each time you post batches, Accounts Payable increases the posting
sequence number by 1, and updates the posting sequence numbers that
are displayed in the Options form. You can look up the current posting
sequence numbers in the Options form to be sure you have up-to-date
copies of posting journals and G/L Transactions reports.

Accounts Payable uses a separate numbering sequence for each type of
batch (invoice, payment, and adjustment).
Posted batches are automatically deleted

When you post a batch, its contents are transferred to the vendor
accounts.

However, transactions in a posted batch cannot be edited. To change
posted transactions, you enter adjustments or apply debit notes or credit
notes.

When you post an imported batch, it is automatically deleted only from
Accounts Payable. You should also delete the batch file from the program
where you created it, to avoid accidentally importing the batch twice.

Preparing to post batches

You take the following steps to post batches:
1. Print listings of the batches you want to post.
2. Choose the Ready To Post option for each batch you want to post.

Posting invoices and adjustments
You can post invoices and adjustments in two different ways:

¢ Post individual batches from the Invoice Batch List form or Adjustment
Batch List form.

e Post one or more Ready To Post batches in a range using the Post
Invoice Batches or individually in the Post Adjustment Batches form.

Posting payment batches and printing checks



You post payment batches using the Print/Post button in the Payment
Batch List form.

Print/Post is a two-stage process. Accounts Payable first prints any
checks in the batch that have not been printed using the Payment Entry
form and posts the check information to Bank Services if the print run
was successful.

Once the check data has been posted to Bank Services (this happens
when you leave the Print Checks form), the program proceeds to the
payment posting stage.

If all checks in the batch have been printed or if the payment batch did
not contain any checks for printing, Print/Post skips the printing step, and
proceeds directly to post the payment information to vendor accounts.

Payment posting applies all payment information to vendor accounts, and
creates a Payment Posting Journal and a Check Register, which are the
audit trail reports of the checks that were produced to pay vendors.

Posting errors

If errors are found in a batch during posting, the incorrect transactions
are not posted. Instead, they are placed in a new batch that uses the next
available batch number.

The details of the incorrect transactions are printed in an error report
which you print separately from the posting journal. If checks were
printed for any of the incorrect entries, the word "Printed" appears with
the transaction on the error report.

& Related Topics
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Posting to a Future Year

If you are near the end of your fiscal year and wish to create a post-dated
check, you will need to post to a future year. To do so, make sure the
Create GL Transactions By option is set to Creating a New Batch in
A/P G/L Integration form (select AP Setup > GL Integration to open).

If Create GL Transactions By option is set to Creating and Posting a
New Batch, you will get an error message as the system will attempt to
post to the current Fiscal Year, not a future one.



Processing Adjustment Batches

Accounts Payable provides several convenient methods by which you
adjust transactions and account balances. You can:

e Create batches of write-off transactions.
e Enter adjustments individually.

You can also enter adjustments to specific documents in the Payment
Entry forms, if you use the Allow Adjustments In Payment Batches option
in the Options form.

Recording adjustment information in Bank Services

Note that Accounts Payable does not send adjustment information to
Bank Services. This means that if you make any adjustments that affect a
bank account, you must make a second adjustment in Bank Services.

Entering adjustments individually

You can enter adjustments, one at a time, in the Adjustment Entry form,
specifying the document number to adjust and the general ledger
account to debit or credit.

You can also adjust documents that have been completed and cleared
from Accounts Payable or enter a general adjustment to an account
balance. You enter this type of adjustment as a credit note or debit note
in the Invoice Entry form.

When you add an adjustment, Accounts Payable automatically assigns a
document number, beginning with 1.

Vendor statistics include the total amount and number of adjustments
entered for the period, and the amount and date of the last adjustment
transaction entered.



Processing Invoices, Credit Notes, Debit Notes,

and Interest

This section presents an overview of invoices, credit notes, debit notes,
and interest entry. It also describes how Accounts Payable calculates
taxes and discounts on invoices, and tells you how to specify discounts
and set up payment schedules.

You use the Invoice Entry form to create new batches for invoices, credit
notes, debit notes, and interest charges. You can add all four document
types to a single batch, or use separate batches for each type.
Multicurrency ledgers

If you use multicurrency accounting, the vendor's currency and the
exchange rate appear when you enter the vendor number. You can
change the exchange rate, rate type, and rate date for an invoice, using
the Rate Information form, but you cannot change the currency. You enter
all amounts in the vendor's currency.

If you need to change the tax group for a multicurrency vendor, you must
select another tax group that also uses the vendor's currency.

Information entered with each invoice, credit note, debit
note, and interest charge

e Enter header information for the document (transaction).

Header information includes the vendor number, document type and
date, remit-to address, tax group, payment terms, and other data that
are the same for the entire document.

e Enter tax information.
e Distribute the document and tax amounts to general ledger accounts.
With each document, you can also:

e Enter the payment amounts, dates, and discount information for
payment schedules (installment payments).

e Enter data in optional invoice fields.



Editing unposted invoices, credit notes, and debit notes

You also use the Invoice Entry form to change or correct open invoice
batches, including error batches created during posting.

Use the Allow Edit Of Imported Batches option if you want to edit batches
that were created by other Sage ERP Accpac applications or non-Sage
ERP Accpac applications.

For more information, select from the following:

Applying credit notes and debit notes to other documents
Assigning multiple payments to invoices

Calculating discounts

Calculating tax — overview

Changing the tax class for individual distributions for tax calculation
Creating General Ledger transactions

Distributing invoices, credit notes, and debit notes
Distributing self-assessed taxes

Entering document header information

Entering multicurrency invoices, credit notes, and debit notes
Entering optional fields on invoices

Invoicing interest

Updating vendor statistics
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Processing Payments

Accounts Payable provides two ways to enter payments:

e Use the Payment Entry form to create new payment batches manually
and enter payments one-by-one.

You can issue checks or other payments manually, then use Payment
Entry to record the checks, or you can enter payments in Accounts
Payable and use Payment Entry to print the checks.

e Use the Create Payment Batch form to create batches of checks
automatically.

Once you generate payment entries, you can list them, edit them
using the Payment Entry form, print the checks, and post the
transactions to vendor accounts.

For an overview of the Payment Entry form, see Payment Entry form —
overview.

For an overview of system-generated checks, see Create Payment Batch
form — overview.

Payment Entry form

Use the Payment Entry form to record transactions such as payments of
C.0.D. charges, cash advances, prepayments, and payments to vendors
who are not defined in your Accounts Payable system. You can also use
Payment Entry to import payment batches from non-Sage ERP Accpac
programs.

You can open the Payment Entry form by choosing the icon from the
Transactions folder or by clicking the New button on the Payment Batch
List form.

Create Payment Batch form

You can use very precise criteria to select the transactions for which
checks will be generated, as well as specify exception vendor lists, and
use payment controls to force or hold payments. Accounts Payable
generates and prints system checks for current payables when you use
the Create Payment Batch form.



Checks and payment advices

You can change the information that appears on, and the layout of,
printed checks and advices. For more information on customizing checks,
see the documentation that comes with Crystal Reports.

& Related Topics
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Create Recurring Payable Batch Form

You use the Create Recurring Payable Batch form to create a batch of
recurring-payable invoices for selected vendors and recurring payables.

Depending on your choice for the Method option, Accounts Payable
creates a new batch or adds the new transactions to an existing batch.
The batch appears in the Batch List form as a Recurring batch, using the
next available invoice batch number.

If you want to edit a recurring-payable batch, you use the Invoice Entry
form.

You post the generated invoices, then process the payments and print
checks as you would for any other type of invoice.

If the terms specified for a recurring payable include a multiple payment
schedule, Accounts Payable calculates the schedule when it processes
the payable.

Accounts Payable warns you when it creates the last invoice before a
recurring payable expires. You can update the recurring payable if you
want to continue using it.

Accounts Payable does not create an invoice for a recurring
payable if:

¢ |t encounters an error while processing a recurring payables batch .
The program displays an error message when it finishes processing
the batch.

e Posting the invoice would cause the amount invoiced to date to
exceed the maximum amount for the recurring-payable.

e The invoice would exceed the maximum number of invoices permitted
for the recurring-payable.

e The invoice date is after the expiration date specified for the recurring-
payable.

e The vendor is inactive or on hold.
e The recurring payable is inactive.

If the program does not create an invoice for a recurring payable, it does
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not update the Last Posted Invoice fields in the recurring payable record.

Note: When you delete a vendor record, Accounts Payable
automatically deletes all recurring payables for the vendor.

To process recurring payables

Click here for tips on using Accounts Payable forms.
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Using Retainage (Holdback) Accounting

Accounts Payable lets you account for retainage (or a holdback) that
occurs when your vendor withholds a percentage of an invoiced amount,

usually by mutual agreement or according to a statute (such as a
Builders Lien Act).

Note that there are two steps in processing retainage:

1. First, you post an invoice, debit note or credit note that specifies a
holdback (retainage) for the document.

2. Later, you post a separate retainage invoice, debit note, or credit note
to invoice the outstanding retainage amount.

Before Using Retainage Accounting

Before you can process retainage in Accounts Payable, you must:

e Set the option to use retainage accounting on the Processing tab of
the A/P Options form.

e Specify default retainage settings for vendors on the Retainage tab of
the A/P Options form.

e Specify a retainage control account for each account set in your
Accounts Payable system.

Entering Original Documents with Retainage

An invoice, debit note, or credit note from which retainage is taken is
called an original document in Sage ERP Accpac.

You enter the invoice, debit note, or credit note using the Invoice Entry
form, as usual.To indicate that retainage applies to the document,
however, you select the Retainage option. (Note that this option appears
only if you selected the Retainage Accounting option for your Accounts
Payable system.)

The program then displays the retainage percentage, retention period,
retainage rate, and the retainage terms from the vendor record. Unless
the document is job-related, you can change these retainage factors for a
particular document, as follows.
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[ Retainage Amount

o [1 Retainage Percentage

® [ Retainage Due Date

® [ Retention Period
® [t Retainage Rate

o [1 Retainage Terms

Apply document transactions

Note that when you apply original debit notes or credit notes that include
retainage in Invoice Entry, or when you apply credit notes in Payment
Entry, only the original document balances are affected.Outstanding
retainage amounts remain with original documents until you post
retainage documents or adjustments to clear the outstanding retainage.

Job-related retainage

If the document is job-related, you enter the retainage exchange rate and
the retainage terms at the document level. However, because
outstanding retainage amounts are tracked separately for each job-
related detail, you enter a separate due date, retention period, and
retainage amount or retainage percentage for each detail on a job-related
document.

Taxes on Retainage

Tax on retainage is processed according to the Report Tax option
selected on the A/P Options form.

The option provides the following alternatives:

® [} At Time Of Original Document

® [} As Per Tax Authority

To report tax, the program posts tax amounts to a tax liability account and
updates the tax tracking reports. The timing of the tax liability on
retainage documents depends on the tax authority.

Posting original invoices, debit notes, and credit notes
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When you post the original retainage document, the program deducts the
retainage from the document total, and posts the amount to the retainage
control account.

For example, if you enter an invoice for $10,000 with 10% retainage, an
invoice is posted for $9,000 with retainage outstanding of $1,000.

The retainage amount remains in the control account until you invoice it
in accordance with:

e The retention period or retainage due date specified for the invoice.

e The number of days in advance specified on the A/P Options form for
generating retainage documents.

Adjusting Original Documents

Adjustment Entry lets you adjust retainage related to posted invoices,
debit notes, and credit notes, as follows:

e To change the retainage amount for an original document, you use
the detail-entry grid to adjust each detail or to add a new detail that
includes retainage. Enter the amount by which to adjust retainage in
the retainage debit or retainage credit fields on the grid.

You can also add retainage to a document that did not include
retainage. You enter the retainage due date, as well as the retainage
amount, for each detail on the detail-entry grid. You also enter
retainage terms and the retainage exchange rate for the document, if
you are adding retainage to a document for the first time.

If the original document was posted using a version of Accounts
Payable earlier than version 5.4, you adjust the retainage debit or
retainage credit for the whole document on the Retainage tab.

¢ You specify retainage terms and the retainage exchange rate option
for the whole document on the Retainage tab.

Note that if retainage was included on the original document, the
program uses the retainage exchange rate setting from the original
document.

e If you add a new detail to which retainage applies, the retainage
document detail inherits the Discountable status from the distribution



code used in the adjustment detail.

If you don't use a distribution code in the adjustment detail, the
retainage detail is discountable by default.

e You can change both the retainage amount and add or change
document details. The program then creates two entries: one for the
detail adjustment, and the other for the retainage adjustment.It does
not create a compound entry.

When you post the adjustment, the program adjusts the outstanding
retainage account.

Note that Accounts Payable does not calculate any retainage on
adjustment transactions. You must enter the retainage manually, whether

you are adding it for the first time, or adjusting existing retainage debits or
credits.

Invoicing Outstanding Retainage

You invoice for outstanding retainage amounts, or holdbacks, either

manually, using the Invoice Entry form, or automatically, using the Create
Retainage Batch form. If you have posted debit notes and credit notes to
which retainage applied, you also create retainage debit notes and credit
notes using the Invoice Entry form and the Create Retainage Batch form.




Invoicing Manually for Retainage

Normally, you would use the Create Retainage Batch form to invoice
periodically for retainage. However, Accounts Payable also lets you
process outstanding retainage manually, as you require.

To invoice manually for outstanding retainage, or to manually process a
credit note or debit note to clear an outstanding retainage amount, you
use the Invoice Entry form.

You enter information for the retainage invoice, credit note, or debit note,
as usual. Note that to invoice for retainage, however, you must:

e Select Summary as the detail type. (Retainage documents are
summary documents.)

e Select Retainage Invoice, Retainage Credit Note, or Retainage Debit
note as the document type, consistent with the original retainage
document for which you are now processing outstanding retainage.
(These options are not available if you selected Item as the detall
type.)

Because outstanding retainage remains associated with the original
retainage document, you must use a retainage invoice if the original
document was an invoice, a retainage debit note if the original document
was a credit note, and a retainage debit note if the original document was
a debit note.

Use the Original Document field to specify the original retainage
document for which you are invoicing the outstanding retainage.

When you post the retainage documents (invoices, credit notes, or debit
notes), the program transfers outstanding retainage amounts from the
retainage control account to the payables control account.

Viewing Retainage Information
You can view retainage information on the:

® [ vendor Activity form.

® [ vendors form

e Aged Retainage report.
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Revaluing Outstanding Retainage Amounts

If you use multicurrency, when you run Revaluation, the program also
revalues amounts outstanding in the retainage control account.

For revalued outstanding retainage, the program creates general ledger
entries to adjust the retainage control account rather than the payables
control account.

If your Sage ERP Accpac system uses the Realized and Unrealized
Gain/Loss the accounting method to revalue multicurrency documents,
the program also creates reversing entries for the next period. (You set
the revaluation accounting method in the Company Profile, in Common
Services.)

The Revaluation Posting Journal includes a separate section for
retainage after the current revaluation for each vendor.

If you include job-related details on the posting journal, a retainage
section appears on the Summary page after the current job details.



Adjustment Batch List

Use this form to:

e Display a list of posted and unposted adjustment batches, beginning
with the batch number you specify. Displayed information includes:

o Batch number

o Batch date

o Batch description

o Number of entries

o Type (Entered, Imported, Generated)

o Status (Open, Printed, Ready To Post, Deleted, Posted, Post In
Progress, Check Creation In Progress)

o Posting sequence number
o Number of errors
o Last edited
o Adjustment amount
e Create a new adjustment batch.
e Select an existing batch to edit, delete, or post.

If you try to post a batch for which you have not selected the Ready
To Post option, you see a message that lets you select the option
from the Adjustment Batch List form.

e Post individual adjustment batches.

e Print batch listings, batch status reports, posting journals, and posting
error reports.
[ To list batches

[l To create, view, edit, post, or delete a batch

Click one of the links below for information about buttons on the
Adjustment Batch List form:

| New | Open | Post |Refresh
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Delete | Close | Print

To view the transactions in an unposted batch, either open the batch you
want to view, or print the batch listing report or preview it on your screen.
You cannot edit a batch for which you have selected the Ready To Post
option.

To be able to view a posted batch, you must not have cleared the batch
using the Clear Deleted And Posted Batches option (in the Clear History
form).

Other reports you can print from the batch list

e To print the Batch Status report, choose Print Batch Status from the
File menu.

¢ To print the posting errors report, double-click in the Number Of Errors
column for the error batch.

¢ To print the posting journal, click in the Posting Sequence Number
column.

Click here for tips on using Accounts Payable forms.

& Related Topics
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Adjustment Entry — Overview

Use this form to:

e Enter adjustments to open and fully paid documents in vendor
accounts. (You use Adjustment Entry to adjust fully paid documents
only when you have not yet cleared the documents from Accounts
Payable.)

e Edit batches of adjustments created during posting (when adjustment
batches contain errors), and imported from other accounting
programs.

e Print a batch listing report for the selected batch.

You can also enter adjustments to documents to which you are applying
payments in the Payment Entry form, if you select the Allow Adjustments
In Payment Batch option (in the Options form). You use the Payment
Entry form to edit this type of adjustment.

To enter an adjustment to an open and fully paid document

For information about the tabs on the Adjustment Entry form, click the
links, below:

Document Retainage
Optional Fields | Rates

Working with adjustment batches

[l To create a new adjustment batch

[}l To edit an existing batch

[}l To view header information for a batch

[*] To print a batch listing for an adjustment batch

Click here for tips on using Accounts Payable forms.
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Control Payments

Use this form to:

¢ View or change the due date, discount date and percent, prepayment
activation date (if applicable), discount amount, and document status
of individual transactions.

e Set a payment limit for an invoice, or clear all payment limits for
invoices in a range.

e Change the status of groups of selected transactions, for ranges of
vendors.

For complete instructions on using the Control Payments form, see Steps
for applying payment controls.

Single Document
Use this tab to
e Select single documents for a specific vendor

e Change the status of individual documents, as well as the due date,
discount date, discount percent, and discount amount.

e Change the prepayment activation date for prepayments.
e Set a payment limit for a selected document.

For information on setting payment controls for a specific document, see
Control Payments — single document.

Range Of Documents

Use this tab to change the status of a range of invoices, debit notes,
credit notes, and prepayments for a range of vendors. For example, use
Range Of Documents to hold all invoices for one vendor or for a vendor
group.

You can also clear all payment limits for invoices in a specified range.

To control payments for a range of vendors, see Control Payments —
range of documents.
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Normal status

Use Normal status to clear documents of any Forced or On Hold status
you applied previously.

Date and discount changes are permanent

Changes to the due date, discount date, discount percent, and discount
amount are permanent changes to the document. You would make them
after renegotiating terms or if the original document was incorrect.

Forced documents

Invoices and debit notes that are assigned a Forced status will be paid in
the next check run, unless:

e The payment amount of the check is outside the minimum and
maximum amounts specified for the check run.

e The vendor bank does not match the batch bank, and you selected
the vendor record option to Select Vendors With This Bank Code
Only.

e The vendor currency does not match the vendor currency for the
batch.

e There is a pending payment in an open batch for the same document.

Documents on hold

Documents assigned an On Hold status will not be paid in a system
check run until the On Hold status is removed. (You can also place the
vendor on hold using the Vendors form.)

On Hold documents are not applied during posting:

e When you post invoice batches, Accounts Payable does not apply
any matching prepayments if either the prepayment or the invoice has
an On Hold status. In addition, it does not apply credit notes or debit
notes if either the credit (or debit) note or the specified Apply-To
document is on hold.

e When you post payment batches, prepayments are not applied to
matching invoices if the invoice has an On Hold status.



To apply a prepayment, debit note, or credit note to a document you have
put on hold, you first remove the On Hold status using the Control
Payments form, then use an Apply Document transaction in Payment
Entry to apply the prepayment, debit note, or credit note.

Before you start

e Post all invoice, payment, and adjustment batches so your vendor
records are up to date.

e Print and review the Vendor Transactions report to see which
payments you want to control.

¢ You may also choose Create Payment Batch, set your payment
criteria, and print a Pre-Check Register to review payments.

& Related Topics
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Create Payment Batch

This form lets you:

e Create batches of checks to pay vendor invoices that are due or have
a discount available for early payment.

You can have only one system-generated batch open at one time.

To edit batches created by Create Payment Batch, use the Payment
Entry form. (You must select the option Allow Edit Of System
Generated Batches in the Options form.)

e Print a report (payment register) of the payment transactions to be
created by the current payment criteria when you generate a payment
batch. We recommend that you always print a payment register, so
you do not get unexpected results when you generate the batch.

Create Payment Batch generates payments for vendors according to
their payment code. For vendors with no specific payment code,
Accounts Payable creates checks only if you specified a check-type
payment code as the default for your Accounts Payable system [.

Note: You must create at least one payment selection code before you
can use this form to create a payment batch.

For complete instructions on creating a payment batch, see Steps for
creating a payment batch.

For complete instructions on using the Control Payments form, see Steps
for applying payment controls.

Click one of the links below for help on using the corresponding tab:

Select | Criteria | Exclusion  Rates | Optional Fields

Click the names of the buttons below for additional help:

Reqister Generate Clear Close

Payment criteria and payment selection codes
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The Create Payment Batch form selects vendors for payment according
to criteria you specify, and creates a payment batch that you can later
edit with the Payment Entry form.

You define the criteria for selecting payments by first defining at least one
payment selection code with the Payment Selection Codes form. You
then select the code you want to use when you create a payment batch,
and modify the criteria, if necessary.

Unposted payment batches

Create Payment Batch scans the payment entries in all unposted batches
to make sure that outstanding invoices are not paid twice.

Payment controls

Create Payment Batch also checks to see whether any payment controls
have been placed on vendors or invoices using the Control Payments
form.

Multicurrency ledgers

All payment entries in a batch are in the same currency and are drawn
from the same bank.

All vendors being paid must have the same source currency; however,
payments do not have to match the vendor's currency. For example, you
can create a batch of checks in US dollars to pay vendors whose source
currency is the drachma.

Discounts

If you take discounts, you must specify a range of discount dates on the
Vendor and Date Selection Criteria tab of the Create Payment Batch
form. Accounts Payable will review all documents with a discount date
within the range you specify (that meet other criteria), and take discounts
if they are available as of the batch date you specify on the Bank and
Currency Selection Criteria tab of the form.

Optional fields

If you use optional fields, an Optional Fields tab is available. Initially, the



tab displays any payment optional fields that you set up for automatic
insertion, along with their default entries. You can accept or change the
inserted optional field entries, or you can delete the optional fields. You
can also assign different payment optional fields to the batch.

When you generate payment entries, Accounts Payable assigns optional
fields to the payment entries, as follows, using the values specified on the
Optional Fields tab:

o All payment [t optional fields that are set up for automatic insertion.

e Any additional optional fields you specified for the payment batch on
the Optional Fields tab.

Check language

The language for printing the check amount in text is taken from the
vendor record or primary remit-to record for each vendor. If you need to
specify a different language for individual checks, you will have to edit the
payment entries after you create the batch.

Printing checks

To print checks for all the payments in a batch.

To print a single check before processing all other checks.

& Related Topics
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Invoice Batch List

Use this form to:

e Display a list of posted and unposted invoice batches, beginning with
the batch number you specify. The list also displays [ information about each
batch.

e Create a new invoice batch.

e Select an existing batch to edit, post, or delete. If you try to post a
batch for which you have not selected the Ready To Post option, you
see a message that lets you select the option for the batch from the
Invoice Batch List form.

e Lets you post individual batches.

e Print batch listings, batch status, posting journals, and posting error
reports.

To list batches

1. To start the display with a specific batch number, type the number or
select it from the Finder.

2. To limit the displayed list to batches that are open or ready to post,
uncheck the option Show Posted And Deleted Batches.

3. Select the option Show Posted And Deleted Batches, unless you want
to limit the display to batches that are open or ready to post.

To view, create, delete, or post a batch

e To work with an existing batch, select it (highlight it) in the list, then
click the button for the action you want to take. Note that you cannot
choose to work with posted or deleted batches.

e To create a new batch, click the New button.

For information about a button on the Invoice Batch List form, click its
name;

Open New Delete |Post
Close PrintRefresh
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To view the transactions in an unposted batch, either Open the batch you
want to view, or print the batch listing report or preview it on your screen.
You cannot edit a batch for which you have selected the Ready To Post
option.

To be able to view a posted batch, you must not have cleared the batch
using the Clear Deleted And Posted Batches option (in the Clear History
form).

Click here for tips on using Accounts Payable forms.
Other reports you can print from the batch list

e To print the Batch Status report, choose Print Batch Status from the
File menu.

e To print the posting errors report, double-click in the Number Of Errors
column for the error batch.

¢ To print the posting journal, click in the Posting Sequence Number
column.

For information about using menu commands and icons, see Data entry
tools and shortcuts.
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Invoice Entry — Overview

Use this form to:

e Enter vendor invoices, credit notes, debit notes, and individual interest
charges.
e Enter prepayments with invoices.

e Edit invoices, credit notes, debit notes, and invoices in batches
created in Accounts Payable or imported from other accounting
programs.

e Add a new vendor or a new remit-to location during invoice entry or
when editing an existing invoice.

o Enter job-related details that will update contracts and projects in
Project and Job Costing, if you use that program.

e Enter X intercompany transaction details, if you use the Sage ERP ACCpaC
Intercompany Transactions (ICT) program to send transactions
between companies.

® [t print a batch listing report for a selected batch.

Invoice Entry lets you use Quick Mode to copy many of the fields from
the previous transaction or detail to a new transaction or detail, so you
don't have to re-enter them.

For detailed information about the tabs on the Invoice Entry form, click
the links, below:
Document Taxes | Retainage | Terms

Optional Fields | Rates @ Totals

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment Close

Click here for tips on using Accounts Payable forms.

Job-related invoices, credit notes, and debit notes

You can enter invoices that are either job-related invoices or not job-
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related — you cannot enter a mixed invoice.
To enter a Project and Job Costing invoice, you must:
e Select the Project and Job Costing option.
¢ |dentify the contract, project, and category for each detail you enter.

When you post job-related invoices, credit notes, and debit notes,
Accounts Payable updates the project in Project and Job Costing. It also
creates general ledger journal entries to update the Work-In-Progress
and Payables Control accounts.

Multicurrency information (multicurrency ledgers only)

If you use multicurrency accounting, you enter amounts in the Invoice
Entry form in the vendor's currency.

When you enter a vendor number, the vendor's currency code is
displayed on the Document tab. If the vendor does not use the functional
currency, you also see a Rates tab that you can use if you need to
change exchange rate information.

When you are entering a credit note or debit note for a specific invoice,
the original exchange rate used for the invoice is also displayed on the
Rates tab.

Intercompany Transactions Invoices

If this is an ICT company, the following fields are displayed on the A/P
Invoice Entry Document tab:

¢ Originator (in the header)
e Destination (in the detail grid)

¢ Route No. and Description (in the detail grid)

Posting an ICT batch creates an A/P batch in the originating company's
Accounts Payable ledger (for posting to vendor accounts), and creates
an ICT G/L batch in the ICT company.
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Payment Batch List

Use this form to:

e [ pisplay alist Of open, posted and deleted payment batches, beginning
with the batch number you specify.

e Create a new payment batch.

e Select an existing batch to edit, print checks for and post, or delete.

e Print batch listings, batch status reports, posting journals, and posting
error reports.

Note: You must use this form to post payment batches. Accounts
Payable does not have a Post Payment Batch form.

To view the transactions in an unposted batch, either open the batch you
want to view, or print the batch listing or preview it on your screen. You
cannot view deleted batches, and you cannot edit batches for which you
have selected the Ready To Post option.

[ To list batches

[l To view, create, delete, or print checks and post a batch

For information about the buttons in the Payment Batch List form, click
the following links:

Open New | Delete
Print/ Post | Print | Close

Other reports you can print from the batch list

e To print the Batch Status report, choose Print Batch Status from the
File menu.

e To print the posting errors report, double-click in the Number Of Errors
column for the error batch.

e To print the posting journal, click in the Posting Sequence Number
column.

For information about using menu commands and icons, see Data entry
tools and shortcuts.
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Payment Entry

Use this form to:

Start new payment entries and enter the general information for a
check € such as the type of payment entry, the vendor number, the
name on the check, the check date, and whether you are recording
information for a check that is already issued or printing it from
Accounts Payable.

Apply payments to projects you maintain in Sage ERP Accpac Project
and Job Costing, and allocate partial payments to different contracts
and projects listed on the invoice.

Enter and optionally print checks for vendors to pay outstanding
invoices or cash invoices, or to prepay vendors.

Enter and optionally print miscellaneous checks.

Apply previously posted prepayments or credit notes to posted
invoices and debit notes.

Edit system-generated payment batches (generated by the Create
Payment Batch form).

Enter adjustments to invoices you are paying in the Payment Entry
form, instead of using the Adjustment Entry form.

Print a batch listing report for a selected batch.

For an overview of payment entry, see Processing payments.

For full instructions on adding payments, see Enter and apply a payment.

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Adjust Jobs

History | Print Check|Void Check| Close

Click here for tips on using Accounts Payable forms.

Multicurrency information (multicurrency ledgers only)
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If you use multicurrency accounting, note that all payments are in the
currency you selected for the batch.

Payment Types

In most cases, a payment transaction is the information that Accounts
Payable needs to print one check for a vendor and update the vendor
account with the check information.

However, the Payment Entry form lets you enter four types of
transactions:

e Payment. Records a check to pay outstanding transactions. You can
print the check from Payment Entry or enter the number of a
previously written check.

The program displays the vendor's outstanding transactions (invoices,
debit notes, and interest charges), and you select the transactions
you want to partially or fully pay.

e Prepayment. Records a check written as a prepayment. You can
print the check from Payment Entry or enter the number of a
previously written check.

Prepayments pay for a purchase before you have been invoiced for it.
When you receive the invoice, you enter it using the Invoice Entry
form, and post it. The prepayment will then be applied against the
invoice.

e Apply Document. Lets you apply a posted prepayment or credit note
to an invoice, debit note, or interest charge.

e Miscellaneous Payment. Lets you issue a check to a person or
company for which you have not set up a vendor record. You enter
the details of the purchase in the detail entry grid in the same way as
you enter an invoice. The distributions debit the general ledger
accounts you specify and credit the bank account.

The fields that appear on the Document tab of the Payment Entry form
depend on the type of transaction you are entering.

For information about each type, choose from the selection below:



Applying Payments
Applying Prepayments and Credit Notes

Miscellaneous Payments
Prepayments

Choose the set of instructions you need

To open an existing payment batch
To create a new payment batch

[}l To view header information for a batch

To enter and apply a payment

To add a prepayment

To apply a previously posted prepayment or credit note
To enter a miscellaneous payment (or cash invoice)

To edit a manual check

To adjust an invoice when entering a manual check
[ To print a batch listing for a payment batch

To print a check from Payment Entry

12 Related Topics
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Payment Inquiry

The Payment Inquiry form lets you:

e Look up Payments by bank range, vendor range, check status,
transaction type, date range, year and period range, and check
number range.

For example, you can look up all the payments from a selected bank,
or you can display information for a payment for which you have only
the payment number. (You are not limited to viewing the payments for
one vendor at a time, as when using the Vendor Activity form.)

¢ Drill down from a selected line on the list to view the original payment
in the Payment Entry form.

To use the Payment Inquiry form to look up payments

Click the links below for additional help on using the corresponding
buttons:

Print Open Document Close
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Post Batches Form

Use this form to:

e Post batches of payments, invoices, or adjustments to vendor
accounts. You can post only one type of batch at a time, but you can
post a single batch, a range of batches, or all unposted batches of the
chosen type.

Note: For an ICT company, the Batch Type option section is not
available. In Intercompany Transactions, you can post only invoice
batches.

e Post all batches that are Ready To Post, or specify a range of
batches.

Batches are posted only if they are marked Ready To Post on the
respective Batch List form.

Posting updates vendor records and creates transactions
for the General Ledger

Posting updates vendor transaction information. It also updates statistics
in vendor records. Posting also creates general ledger transactions for
the accounts affected by the transactions.

You can add general ledger transactions to batches automatically during
posting, if you use the Create G/L Transactions During Posting option, or
you can add them, later, using the Create G/L Batch form.

Before you post batches

1. Print listings of the batches you want to post.

2. Ensure that no unprinted checks are included in any payment batches
you want to post.

Normally, you use the Payment Batch List form to print checks for,
then post, all the checks in a selected batch. If the batch contains few
checks for printing, however, you might prefer to print them one at a
time using the Payment Entry form.

3. Assign Ready To Post status to open batches using the Invoice Batch



List, Payment Batch List, or the Adjustment Batch List form,
depending on the type of batch you want to post.

Force Listing of Batches

If you use the Force Listing Of Batches option, you must print batch
listings for each batch you want to post. You must also print a new listing
if you edit the batch after printing the batch listing.

Posting sequence numbers

Accounts Payable assigns a posting sequence number to each
transaction during posting. Each time you post batches, Accounts
Payable increases the posting sequence number by 1 for the type of
batch.

You can look up the current posting sequence numbers in the Options
form.

You cannot edit posted transactions

When you post a batch, its contents are transferred to the vendor
accounts and you can no longer edit the transactions. You must enter
adjustments or apply debit or credit notes to change any transactions you
have already posted.

Printing posted transactions — Posting Journals and GJ/L
Transactions Report

Each time you post, Accounts Payable creates a journal of the entries
from the batches you posted together. These posting journals are an
essential part of your audit trail, because they provide a record of all
posted details and of the related general ledger distributions.

You can also print the G/L Transactions report each time you create
general ledger transactions. The report lists all the distributions that were
created for general ledger accounts when you posted batches. (In the
Options form, you can choose whether to add the general ledger
transactions to G/L batches automatically each time you post Accounts
Payable batches or at a later time, using the Create G/L Batch form.)

You should keep your audit trail of posted transactions up to date by



printing and filing each posting journal as it is created, and by regularly
creating general ledger transactions and printing and filing the G/L
Transactions report.

Delete imported batch source files after posting

Note that when you import and post a batch, the original file you imported
still exists in the program where you created it. You should delete
batches once you have imported and posted them, to avoid accidentally
importing a batch twice.

CSV GIL batch if you do not use Sage Accpac

If you do not use Sage ERP Accpac General Ledger — or if your Sage
ERP Accpac General Ledger system is at another location — Accounts
Payable creates its general ledger transactions in a file called
APGLTRAN.CSV, which can be imported by a remote site Sage ERP
Accpac General Ledger, or transferred to another general ledger that you
use. The file is in a Comma Separated Values (CSV) format.

All general ledger transactions are placed in the same CSV file. Each
time Accounts Payable creates transactions it will ask you whether you
want to add to the file, or replace it.

You should always add to the CSV file (choose the "Append" option). If
you overwrite the file, you will destroy all transactions that are already in
the file.

When you are ready to transfer the batch to your general ledger, copy the
file to the computer or directory where your general ledger is located, and
delete the original CSV file. Then make a backup copy of the CSV file.

& Related Topics
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Reporting Accounts Payable Data

Your Accounts Payable system can print a wide variety of reports which
provide you with up-to-date information and a source of backup
information in case your Accounts Payable data is damaged.

This section briefly describes all the reports produced by Accounts
Payable.

Printing reports

There are five ways you can print reports in Accounts Payable. You can:

e Print directly from the program to the printer, to obtain permanent
copies of the information.

e Print the information on your screen, for quick review.

e Print to a file for printing later, importing into another program, or
transferring to a diskette.

e Print to an RTF file and send it as an e-mail attachment to a specified
recipient.

e If you are using Seagate Info server software, print a report at a
specific time and date and define the publishing format and
destination.

Using a laser printer, you can print all Accounts Payable reports on 8%2"
by 11" or A4-sized paper.

On dot matrix printers all Accounts Payable reports are 132 characters
(columns) wide.

Setup reports

You can print a report showing the information entered to define each of
the records you create when setting up or updating your Accounts
Payable system. These reports include the Options, Account Sets,
1099/CPRS Codes, Distribution Codes, Distribution Sets, Terms, Remit-
To Locations, and Payment Selection Codes reports.

They also include the lists and statistical reports for vendors and vendor
groups.



Any time you add, delete, or change any of these records, you should
print and file the corresponding reports, to keep your printed records up
to date.

Choose icons from the Setup Reports folder to print these reports.

Vendor reports

You can print a report showing the information entered for your vendor
records, including the lists and statistical reports for vendors and vendor
groups. Reports you can print for your vendors also includes the
1099/CPRS Amounts and Remit-To reports.

Whenever you change any of these records, you should print and file the
corresponding reports, to keep your printed records up to date.

Choose icons from the Vendor Reports folder to print these reports.

Transaction reports

You can print a complete range of reports of your Accounts Payable
transactions. Choose icons from the Transaction Reports folder to print
the following reports.

e Audit Trail. The batch listings, posting journals, error reports, batch
status reports, and the G/L Transactions report are important parts of
your Accounts Payable audit trail. You should regularly print these
reports, check them carefully, and file them in a secure place. Note
that you must print the G/L Transactions report before you clear
posting journals.

¢ Analytical Reports. Accounts Payable also provides three important
reports that you can use to interpret, analyze, and summarize your
data, including the Aged Cash Requirements, Aged Payables, and
Vendor Transactions reports. A summary of the contents and uses of
each of these reports follows.

Aged Cash Requirements report

The Aged Cash Requirements report highlights the cash amounts that
will be required to meet obligations as they become due, including the
amount needed to pay invoices that are overdue, current, and due in
each of four future periods you define. Use the report for cash flow



analysis and projections.

You can print the report in detailed form, listing all outstanding documents
for each vendor, or summary form, printing one line for each vendor
number, including the overdue and current balances and the balances in
each aging period.

Aged Payables report

The Aged Payables report groups outstanding transactions into a current
period and four aging periods by document date or due date. Use the
report to analyze your payables.

You can print the report in detailed form, listing all outstanding documents
for each vendor, or in summary form, printing one line for each vendor
number, including the current balance and the balance in each aging
period.

Vendor Transactions report

The Vendor Transactions report serves as an audit trail of posted
transactions in your vendor accounts, within the range of dates you
specify. Use the report to obtain an overview of your vendor accounts in
any period for which you have Accounts Payable data.

You can report the details of any combination of invoices, debit notes,
credit notes, and prepayments. You can also choose to include zero
balances and applied details, and print a total for each transaction type.

If you use multicurrency accounting, you can also print the report in
functional currency or in the vendors’ currencies.



Periodic Processing

There are several Accounts Payable forms you can use to complete the
types of processing you do at specified intervals, such as at month end or
period end, and to clear out obsolete data and records.

This section outlines periodic procedures you might follow, and tells you
how to use Accounts Payable to accomplish the tasks.

1.

Update Accounts Payable records, such as to enter changes of
address, make corrections, and select the Inactive option for records
you plan to delete.

Use the icons in the Vendors and Setup folders to revise these
records.

Post transactions that apply to the period. Print and file the posting
journals.

Use the Invoice Entry form, and the Payment Entry, and Adjustment
Entry forms

Print the Vendor Transactions and Aged Payables reports to identify
amounts that should be paid, or that require other action.

Use the Vendor Transactions and Aged Payables icons from the
Transaction Reports folder to print the reports.

Use the Create Recurring Payable Batch in the Periodic Processing
folder to generate invoices for the recurring payables you have set up.

Create and post batches of adjustments, such as transactions to
correct errors found when you reconcile bank statements.

Use the Adjustment Entry icon from the Adjustments folder.

If you have a multicurrency ledger, you may need to update exchange
rates in Common Services and revalue multicurrency transactions
and balances periodically, to reflect changes in exchange rates.

Choose the Revaluation icon from the Periodic Processing folder.

Print the G/L Transactions report (using the G/L Transactions icon in
the Transaction Reports folder), then create any outstanding general
ledger transactions. (Use the Create G/L Batch icon in the Periodic



Processing folder.)

Process the batches in Sage ERP Accpac General Ledger, if you use
it, or post them manually to your other general ledger.

. Clear the paid transactions, vendor comments, and statistics that you
no longer need, and delete records that you classed as inactive and
prepared for deletion.

Choose the Clear History, Clear Statistics, and Delete Inactive
Records icons, respectively, from the Periodic Processing folder to
clear this information.

. Use the 1099 Electronic Filing form, in the A/P Periodic Processing
folder, to file 1099s electronically, if you are required to file 1099
forms. (If you do not file electronically, you choose the 1099/CPRS
Amounts form from the Vendor Reports folder to print out the forms.)



Year End Processing

At the end of each fiscal year, use the Year End form to transfer current-
year activity statistics for vendor groups and vendors to the previous
year, in preparation for a new year. You may also want to follow the same
procedures you use at the end of each period.

Before you start

Before running Year End, you must:

Post or delete all outstanding batches.
Print all posting journals.

Print the G/L Transactions report, then create any outstanding general
ledger transactions.

Close all other Accounts Payable forms and make sure no other users
are using Accounts Payable.

What Year End does

The Year End function performs the following tasks:

If you select the Reset All Batch Numbers option, Year End resets the
next batch number to 1 for all batch types, and deletes all information
for posted and deleted batches, so they no longer appear on the
Batch Status report.

Note that resetting batch numbers will prevent you from viewing
transactions from the General Ledger Transactions form.

Inserts the Average Days To Pay total from the year you are closing
into the Average Days To Pay field for the previous year and into the
Total Days To Pay field for the new year in vendor records.

Clears activity statistics, if you select the Clear Activity Statistics
option. This step moves year-to-date vendor activity statistics to last-
year activity statistics, and sets year-to-date totals for the new year to
zero. It also sets the largest invoice this year and the largest balance
this year to zero.

e Resets to 0 (zero) the Total Invoices Paid, Number Of Checks, and



the Total Days To Pay fields in the Vendor Activity Statistics tab, in the
Vendors form.



Clear History

Use the Clear History form to remove obsolete data from your
Accounts Payable system. You can clear ranges of the following
information:

e Fully paid documents
Vendor comments
1099/CPRS Amounts

Printed posting journals

Posting errors

Deleted and posted batches

To clear obsolete data
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Clear Statistics

Use the Clear Statistics form to remove obsolete data from your
Accounts Payable system. You can clear ranges of the following
information:

e Vendor period statistics.
e Vendor group period statistics.

Note that the Clear Statistics form clears period statistics, not activity
statistics. Activity statistics are kept only for the current year to date and
the previous year, and are cleared by the Year End form (with the
current-year statistics becoming the previous-year statistics).

Before you start

e Post all outstanding batches that could affect records you want to
clear.

e Determine the fiscal year and period through which to clear statistics.
e Print reports of the data you want to clear. For example:

o Before clearing statistics for vendors or vendor groups, print
the statistical report for the type of information you plan to clear.
Specify the year and period you plan to clear in the To fields for the
Year and Period options. Specify the range of vendor numbers or
vendor group codes to clear.

Check the reports to be sure you are clearing the statistics you
intended to clear, then file them as permanent records of the
information.

To use the Clear Statistics form

1. Select the types of records you want to clear.

2. Select the range of vendors for which you want to clear statistics.
3. Type the fiscal year and period for which to clear.

4. Choose Process.

After using



Check that data was cleared properly.
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Create G/L Batch

Use this form to:

e Create general ledger transactions from outstanding posted invoice,
payment, and adjustment batches.

e Create general ledger transactions when you revalue accounts at new
exchange rates in multicurrency ledgers.

You use this form to create general ledger batches if you did not select
the Create G/L Transactions During Posting option on the Integration tab
of the G/L Integration form.

Multicurrency ledgers

If you use multicurrency accounting, you also use this form to produce
general ledger batches containing revaluation transactions that you
created with the Revaluation form.

Revaluation transactions revalue all outstanding multicurrency Accounts
Payable documents at new exchange rates. Because revaluation
transactions are for unrealized amounts, they are posted to the General
Ledger system as reversing transactions, which means that General
Ledger simultaneously posts reversing transactions to the first day of the
next fiscal period.

Note that revaluation transactions created by Accounts Payable are set
as automatically reversing transactions. If they were posted to Sage ERP
Accpac General Ledger, they would be reversed at the beginning of the
next fiscal period.

If you are posting them to a different general ledger, you must also
reverse these transactions in the next fiscal period.

Before you start
e Select options on the Integration tab of the G/L Integration form.

e Post all outstanding invoice, payment, and adjustment batches in
Accounts Payable.

To create General Ledger batches



You post the General Ledger batches in Sage ERP Accpac General
Ledger, if you use it, or in your other general ledger system.

Note that if you try to post a G/L batch to a period that is locked for
General Ledger, the transactions will be placed in an error batch.
Therefore, make it a practice to create and post General Ledger batches
for outstanding Accounts Receivable transactions before locking a period
for General Ledger.

To use the Create G/L Batch form:

1. Select the types of posted batches from which to create transactions
(Invoice Batches, Payment Batches, Adjustment Batches,
Revaluation).

2. Select the posting sequence number through which to create
transactions for each batch type.

3. Choose Process.

Use the Create G/L Batch form to produce batches of general ledger
transactions from the invoice, payment, and adjustment batches you
posted in Accounts Payable.

You must create all outstanding general ledger batches before you can
use the Year End form.
If you do not use Sage ERP Accpac General Ledger

Accounts Payable creates its general ledger transactions in a file called
APGLTRAN.CSV, which can be imported by a remote site Sage ERP
Accpac General Ledger, or transferred to another general ledger that you
use. The file is in Comma Separated Values format, and is created in the
same directory as your company database.

Note that all general ledger transactions are placed in the same CSV file
and that each time Accounts Payable creates transactions, it appends
them to the CSV file.

After using

Post the batches in Sage ERP Accpac General Ledger, if you use it.

If you use a different general ledger, import the CSV batch file into your



general ledger, then delete the file.
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Create Retainage Batch | FieidList_|

You can use the Create Retainage Batch form periodically to create a
batch of retainage invoices, debit notes, and credit notes for the vendors,
documents number, or vendor groups you select.

If you assigned a schedule (on the Retainage tab of the A/P Options
form) that uses a reminder to users, Accounts Payable can remind users
to process retainage transactions when they are due. Users can then
process the retainage transactions directly from the Reminder List in
Common Services, rather than from the Create Retainage Batch form.
For more information about using schedules and reminders, see the
System Manager Help.

Accounts Payable assigns the next available invoice, credit note, or debit
note batch number to the retainage batch. It assigns the next retainage
invoice, retainage debit note, or retainage credit note number specified
on the Retainage tab on the A/P Options form.

To create a batch of retainage documents using the Create
Retainage Batch form

1. Choose Create Retainage Batch from the Periodic Processing folder.
2. Specify the Run Date for this retainage batch.

3. Specify the types of original retainage documents for which you are
now processing outstanding retainage.

4. Choose the type of record by which to select outstanding retainage for
processing, then enter the range of records from which to select
outstanding retainage.

5. In the Number Of Days In Advance field, specify the number of days
in advance of the retainage due date that retainage documents can
be created.

6. Click Process to create the batch.
7.

Accounts Payable updates the Last Invoiced field on the Retainage tab of
the A/P Options form.



Note that taxes are calculated only on original documents. They do not
appear for retainage documents.

After using the Create Retainage Batch Form

Use the Invoice Entry form to make any changes to the retainage
invoices, debit notes, and credit notes.

Choose Batch Listings from the Transaction Reports folder to print a
listing of the batch. Select Retainage as the batch type.

Verify the information, then file the listing. If you need to make
corrections, reprint the listing after editing the batch.

Select the Ready To Post option for the batch on the Invoice Batch
List form.

Post the batches.
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Delete Inactive Records

Use the Delete Inactive Records form to:

e Remove obsolete vendor, vendor group, remit-to location, and
recurring payable records.

The form removes records only if they currently have an inactive status
and were set to inactive within the range of dates you specify.
Before you start

e Print reports.

e Update records.

e Assign Inactive status to all records you want to delete.

Deleting vendor records
Before you can delete a vendor record:
e Pay or settle all invoices and debit notes.
e Clear all the vendor's fully paid documents in the Clear History form

e You can use Clear History to clear comments for vendors, if you want.
However, the Delete Inactive Records form automatically deletes the
comments and statistics in the vendor records it deletes.

e Delete remit-to locations for the vendor.

To identify inactive vendor records, print the Vendors report, selecting
one or more of the Address, Profile, or Comment options.

The report shows which vendor records are inactive (on the first line for
each vendor), and when the status was changed.

When you delete vendor records, you also delete vendor statistics and
comments.

Deleting vendor groups
You can delete vendor groups.
To delete a vendor group, first assign its vendors to another group or



delete them, as you cannot delete a vendor group to which vendors are
assigned.

To discover whether vendors are still assigned to the group, print the
Vendor Groups report, selecting the Group Members option.

Note that when you delete a vendor group, you also delete the vendor
group statistics.

Deleting remit-to locations

Before you delete inactive remit-to locations, make sure there are no
unposted transactions that use them. (You cannot edit and save a
transaction with an inactive or deleted remit-to location; however, you can
post it without errors.)

To delete inactive records

& Related Topics
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Revaluation

Use the Revaluation form to:

e Revalue multicurrency transactions at new exchange rates, to
determine the current value of payables on specific dates (in
multicurrency ledgers only).

e Process a provisional revaluation (select the Provisional Revaluation
option) to determine the transactions that would be created for the
general ledger exchange gain and loss accounts if you revalued the
accounts at the specified rates.

e Create revaluation transactions for the general ledger exchange gain
and loss accounts.

e Click a History button to open a separate form that lets you view
historical revaluations for a selected currency, and select revaluations
that you need to redo.

When exchange rates fluctuate, you may need to revalue outstanding
documents denominated in other currencies to reflect their present value
in your own (functional) currency at a particular time, for example, at
financial statement dates. (When you revalue a transaction, Accounts
Payable recalculates its functional equivalent value at a new exchange
rate.)

In Sage ERP Accpac, gains and losses due to fluctuating exchange rates
are treated as permanent or temporary, depending on the exchange
Gain/Loss Accounting Method specified for your Sage ERP Accpac
system (in the company profile).

Click here for an overview of the revaluation process.

To revalue transactions
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Year End

Use the Year End form to:

e Reset batch numbers, so that the next batch you create of all types
will use number 1.

e Move vendor activity statistics for the current year into the previous
year, and zero the totals for the new year.

o Clear year-to-date statistics from recurring payable records.

e Reset to 0 (zero) the Total Invoices Paid, Number Of Payments, and
the Total Days To Pay fields on the Activity and Statistics tabs, on the
Vendors form.

To use the Year End form

12 Related Topics
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1099 Electronic Filing

You use the 1099 Electronic Filing form to create an electronic file to
submit 1099 forms through the IRS FIRE (Filing Information Returns
Electronically) System using a modem or by mailing them on magnetic
tape or diskettes.

When you finish filing, Accounts Payable automatically prints a summary
report of the information you filed, which you can keep with your records.

Note: You should refer to IRS documentation for information on
electronic filing requirements before you submit 1099s electronically. For
example, the IRS does not accept compressed files. If the resulting
IRSTAX file is larger than 1.4 megabytes, you will have to submit a file
that spans two or more diskettes.

To create an electronic file for your 1099 forms:

12 Related Topics
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T5018 (CPRS) Electronic Filing

If your company operates in Canada and your primary source of business
income is construction, you must report amounts paid or credited for
construction services to the Canada Revenue Agency (CRA) by filing a
T5018 information return, which consists of a T5018 Summary and
related T5018 slips.

You use the T5018 (CPRS) Electronic Filing form, available in the
Periodic Processing folder, to create your T5018 information return in the
required XML format. You can then submit the generated file to the CRA
through their website or on electronic media acceptable to the CRA
(DVD, CD, or diskette).

Note that the CRA does not process files that span more than one
diskette or CD. Be sure to choose a media type that can accommodate
the entire information return.

Important! If you file more than 50 T5018 slips for a calendar year, you
must use CRA's Internet File Transfer application to file original or
amended T5018 returns.

File a T5018 (CPRS) Information Return Electronically




Printing to a File

To print to a file, choose Print Destination from the File menu on the
company desktop. Choose File, then enter the drive, directory, and
filename, or use the Browse button to scroll through the list of directories
and files to select the file you want to use. You can enter the name of a
non-existent file or directory to be created by the system when you print.

After printing to a file, you can clear the data for some reports such as
posting journals and the Batch Status report using the Clear History form.

12 Related Topics
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Printing to a Printer

To print to a printer, choose Print Destination from the File menu on the
company desktop. Choose Printer, then choose OK.

After printing to a printer, you can clear the data for some reports, such
as posting journals and the Batch Status report, using the Clear History
form.

12 Related Topics
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Printing to the Screen

To print to the screen (display the report on your monitor), choose Print
Destination from the File menu on the company desktop. Choose
Preview, then choose OK.

Printing to your screen satisfies the Force Listing of Batches option.

12 Related Topics
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Printing to an E-mail

To print to an e-mail, choose Print Destination from the File menu on the
company desktop. Choose E-mail, then choose OK.

After printing to an e-mail, you can clear the data for some reports, such
as posting journals and the Batch Status report, using the Clear History
form.

12 Related Topics
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Printing According to a Schedule

You can schedule a report to be printed from a computer running
Seagate Crystal Info software.

To schedule a report for printing, choose Print Destination from the File
menu on the company desktop. Click Schedule, then click OK.

A dialog box appears when you choose to print:
e Enter your Seagate Crystal Info user name and password.
e Choose a server from the APS field (Automated Process Server).

¢ Indicate the publishing format and enter the name of the file you are
scheduling for printing.

e Choose the destination (either to a hard disk on another workstation
or to a computer running Crystal Info server.

e Enter the date and time you’d like the report printed.

12 Related Topics
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Account Sets Report — Printing

This report lists the descriptions and numbers of the general ledger
accounts used in the account sets in your Accounts Payable system.
Print the report when you add, change, or delete account sets.

For more information on the contents of this report, see Account Sets
Report — Features.

When to print
Print the report when you add, change, or delete account sets.
To print the Account Sets report

1. Choose File, Print from the A/P Account Sets folder, or select the
Account Sets icon from the Setup Reports folder.

2. Select the range of account sets you want to print. The default range
includes all account sets.

3. Click @ print.

12 Related Topics
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Distribution Codes Report — Printing

The Distribution Codes report lists the descriptions and numbers of the
general ledger accounts used in the distribution codes in your Accounts
Payable system.

For information on the contents of this report, see Distribution Codes
Report — Features.

When to print
Print the report when you add, change, or delete distribution codes.
To print a report

1. Choose File, Print from the Distribution Codes form, or select the
Distribution Codes icon from the Setup Reports folder.

2. Select a range of distribution codes.
3. Click @ print.

12 Related Topics
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Distribution Sets Report — Printing

The Distribution Sets report lists the distribution methods and distribution
codes specified for the distribution sets you use to allocate purchase
amounts in your Accounts Payable system.

For information on the contents of this report, see Distribution Sets
Report — Features.

When to print
Print the report when you add, change, or delete distribution sets.
To print the report

1. Select File, Print from the Distribution Sets form, or choose the
Distribution Sets icon from the Setup Reports folder.

2. Select a range of distribution sets to include.
3. Click @ print.

12 Related Topics
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E-mail Messages Report — Printing

The E-mail Messages report lists the messages you send to vendors with
e-mailed letters.

Print the report when you add, change, or delete e-mail messages.

For more information on the contents of this report, see E-mail Messages
Report — Features.

To print the report

1. Select File, Print from the E-mail Messages form, or choose the E-
mail Messages icon from the Setup Reports folder.

2. Click @ Print.
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G/L Integration Report — Printing

The G/L Integration report lists the integration options and other
information specified on the G/L Integration form that determines how
your Accounts Payable system interacts with General Ledger.

Print the report when you change the G/L Integration options for
Accounts Payable.

For more information on the contents of this report, see G/L Integration
Report — Features.

Before Using

If necessary, set up printing destinations, and turn on and connect the
printer.

To print the report

1. Click File, Print on the G/L Integration form, or choose the G/L
Integration icon from the Setup Reports form.

2. Click @ Print.

12 Related Topics
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Optional Fields Report — Printing

This report lists the optional fields you have defined for Accounts
Payable.

For information on the contents of this report, see Optional Fields Report
— Features.

When to print

Print the report when you add, change, or delete optional field records.
To print the report

1. Choose the Optional Fields icon from the A/P Setup Reports folder.
2. Choose [ print

12 Related Topics
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Options Report — Printing

The Options report lists the options selected and other information
entered in the Options form to specify how your Accounts Payable
system operates.

Print the report when you change your selections for Accounts Payable
options.

For information on the contents of this report, see Options Report —
_Features.

When to print
Print the report when you change option selections.
To print the report

1. Choose File, Print from the Options form, or select the Options icon
from the A/P Setup Reports folder.

2. Click @ print.

12 Related Topics
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Payment Codes Report — Printing

The Payment Codes report lists the codes, descriptions, and methods of
payment used in your Accounts Payable system.

Print the report when you add, change, or delete Payment Codes.

For information on the contents of this report, see Payment Codes Report
— Features.

To print the report

1. Choose File, Print from the Payment Codes form, or select the
Payment Codes icon from the Setup Reports folder.

2. Click @ Print.
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Payment Selection Codes Report — Printing

The Payment Selection Codes report lists the bank and currency codes,
selection criteria, and exclusion criteria defined for the payment selection
codes used to create payment batches in your Accounts Payable system.

For information on the contents of this report, see Payment Selection
Codes Report — Features.

When to print

Print the report when you add, change, or delete payment selection
codes.

To print the report

1. Choose the Payment Selection Codes icon in the Setup Reports
folder.

2. Choose the range of codes to print

3. Select the Optional Fields checkbox if you want to include optional
fields in the report.

4. Click @ print.

12 Related Topics
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Terms Codes Report — Printing

The Terms Codes report lists the information entered for each terms code
to specify how to calculate due dates, discount amounts, and discount
periods on invoices that use the code.

Print the report when you add, change, or delete terms codes.

For information on the contents of this report, see Terms Codes Report
— Features.

To print the report

1. Select the File, Print command in the Terms form, or choose the
Terms icon in the A/P Setup Reports folder.

2. Select the range of terms codes that you want to print.

3. Select the Include Multiple Payment Schedules option if you have
created terms codes that use the option.

4. Click @ print.

12 Related Topics
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1099/CPRS Codes Report — Printing

The 1099/CPRS Codes report lists the code and description for each
1099/CPRS code entered in your Accounts Payable system. The code
numbers correspond to the box numbers on the US 1099-MISC form.

For CPRS reporting in Canada, it is recommended that you use code 3,
Other, to track payments to Vendors subject to CPRS reporting.

For information on the contents of this report, see 1099/CPRS Codes
Report — Features.

If you add non-standard codes

e Only standard 1099-MISC codes are printed on the stock 1099/CPRS
Amounts report.

e If you add any non-standard 1099/CPRS codes, you must modify the
1099/CPRS Amounts report form to print the non-standard codes.

To print the report

1. Select File, Print in the 1099/CPRS Codes form or choose the
1099/CPRS Codes icon in the Setup Reports folder.

2. Select a range of 1099/CPRS codes.
3. Click @ print.

12 Related Topics
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Aged Cash Requirements Report € Printing

The Aged Cash Requirements report highlights the cash amounts that
will be required to meet obligations as they become due, including the
amount needed to pay invoices that are overdue, current, and due in
each of four future periods you define. Use the report for cash flow
analysis and projections.

You can print the report in detailed form, listing all outstanding documents
for each vendor, or summary form, printing one line for each vendor
number, including the overdue and current balances and the balances in
each aging period.

For information on the contents of this report, see Aged Cash
Requirements Report € Features.

When to print

Print the Aged Cash Requirements report when you need a listing of the
amounts owed and when they are due, to assist you with cash-flow
management, short-term planning, and budgeting.

To print the report

1. Choose the Aged Cash Requirements icon from the A/P Transaction
Reports folder.

2. Select from the following:

Age By. You can age outstanding documents or balances by their
due dates or document dates.

Age As Of. Specify the date on which to report the payables. The
program uses this date to assign transactions to aging periods. For
example, if you print the report aged by due date, the program
assigns each transaction to an aging period by calculating the number
of days between its due date and the Age As Of date.

Cutoff By. The report includes only transactions that have a
document date that is on or before the cutoff date you specify.

There are three methods for selecting a cutoff date:



o Document Date

o Posting Date
o Year/Period

Print Transactions In. Indicate whether to print a summary or
detailed report, and whether to print the detailed version of the report
with transactions ordered by document date (Detail by Date) or by
document number (Detail by Document).

Sort Transactions by Transaction Type. Select this checkbox if you
want sort transactions by document type for each vendor on the
report.

Use Aging Periods. The aging periods entered in the Options form
appear, but you can assign different periods for individual reports, if
you want. The aging periods are used to group transactions by the
future dates at which they will become due, rather than by the amount
of time they are overdue. All overdue amounts appear in the Overdue
column on the report.

Select Vendors By SpEley up 1O [ four criteria to select the vendor accounts to list on the
report.

If you do not specify selection criteria, the report includes all vendor
records.

Sort Vendors By SpGley up tO [ four orders by which to sort records for the report.

If you do not specify sorting criteria, the report orders the records by
vendor number.

If you want to include subtotals (for a single currency company) or
subtotals by currency (for a multicurrency company), select Vendor
Group or Account Set as the primary sort order.

Show Group Title. If you want to include a title for each sorted group,
select the Title checkbox for each group of records you are sorting by.

Show Group Subtotal. If you want to include subtotals for each
sorted group, select the Show Group Subtotal option for the groups of
records you are sorting by.

[Include] Contact/PhonelCredit. Choose this option if you want to list
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the vendor's contact person and phone number and your credit limit
for the vendor.

[Include] Space For Comments. Select this option to leave blank
space at the end of each vendor record for your notes.

[Include] Vendors/ITransactions on Hold. Choose this option to
include vendors that you have placed on hold in the Vendors form,
and transactions that you have placed on hold in the Control
Payments folder.

[Include] All Available Discounts. Select this option if you want the
program to calculate amounts owing by taking advantage of all
available discounts.

Select Transaction Types. Select the types of transactions to
include on the report. You can include any or all of the transaction
types listed. Note that, If you clear the Adjustments checkbox,
adjustments can still appear as Applied Details on the documents that
payment was applied to. Select the Adjustments checkbox and
adjustments can appear both as Applied Details and Regular
Documents.

[Show] Applied Details. Select this option to include all the
documents such as payments and credit notes that were applied to
each reported invoice. If you do not select this option, the report
shows only the balance owing for each outstanding document.

[Show] Fully Paid Transactions. Select this option to list documents
that are fully paid, but not yet cleared from Accounts Payable.

[Show] Aged Retainage. Select this option to include retainage
documents with taxes on the report. This checkbox is disabled if
Document Date is selected as the Report Type.

Print Amounts In. Use this option to select the currency for the
report. You can list transaction amounts in the vendor currency or the
functional currency.

If you list transactions in the functional currency, and you have
performed a revaluation, the report shows the new functional
amounts.



3. Click @ print.

12 Related Topics
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Aged Payables Report — Printing

The Aged Payables report groups outstanding transactions into a current
period and four aging periods by document date or due date. Use the
report to analyze your payables.

You can print the report in detailed form, listing all outstanding documents
for each vendor, or in summary form, printing one line for each vendor
number, including the current balance and the balance in each aging
period.

For information on the contents of this report, see Aged Payables Report
— Features.

When to print

Print the Aged Payables report when you need a listing of the status of
your payables on a given date, such as at the end of a fiscal year or
period.

To print the report

1. Choose the Aged Payables icon from the A/P Transaction Reports
folder.

2. Select from the following:

Report Type. You can age outstanding or overdue documents or
balances by their due dates or document dates.

Age As Of. Specify the date on which to report the payables. The
program uses this date to assign transactions to aging periods. For
example, if you print the report aged by due date, the program
assigns each transaction to an aging period by calculating the number
of days between its due date and the Age As Of date.

Cutoff By. The report includes only those transactions that have a
date that is on or before the cutoff date you specify.

There are three methods for selecting a cutoff date:
o Document Date

o Posting Date
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o Year/Period

Print Transactions In. Indicate whether to print a summary or
detailed report, and whether to print the detailed version of the report
by document date (Detail by Date) or by document number (Detail by
Document).

Sort Transactions by Transaction Type. Select this checkbox if you
want sort transactions by document type for each vendor on the
report.

Use Aging Periods. The aging periods entered in the Options form
appear, but you can assign different periods for individual reports, if
you want.

Select Vendors By SpEley up 1O [ four criteria to select the vendor accounts to list on the
report.

If you do not specify selection criteria, the report includes all vendor
records that meet the other criteria you select in this folder (for
example, all vendors that have transactions on or before the cutoff
date).

Sort Vendors By SpGley up tO [ four orders by which to sort records for the report.

If you do not specify sorting criteria, the report orders the records by
vendor number.

Show Group Title. If you want to include a title for each sorted group,
select the Title checkbox for each group of records you are sorting by.

Show Group Subtotal. If you want to include subtotals for each
sorted group, select the Show Group Subtotal option for groups of
records you are sorting by.

[Include] Contact/Phonel/Credit. Choose this option if you want to list
the vendor's contact person and phone number, and your credit limit
for the vendor.

[Include] Space for Comments. Choose this option to leave blank
space at the end of each vendor record for your notes.

[Include] Vendors With A Zero Balance. Choose this option to
include vendors with zero balances.
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[Include] Vendors/Transactions on Hold. Choose this option to
include vendors that are placed on hold in the Vendors form, and
transactions that you have placed on hold in the Control Payments
form.

Select Transaction Types. Select the types of transactions to
include on the report. You can include any or all of the transaction
types listed. Note that, If you clear the Adjustments checkbox,
adjustments can still appear as Applied Details on the documents that
payment was applied to. Select the Adjustments checkbox and
adjustments can appear both as Applied Details and Regular
Documents.

Applied Details. Choose this option to include all the documents
such as payments and credit notes that were applied to each reported
invoice. If you do not select this option, the report shows only the
balance owing for each outstanding document.

[Show] Fully Paid Transactions. Select this option to list documents
that are fully paid, but not yet cleared from Accounts Payable.

[Show] Aged Retainage. Select this option to include retainage
documents with taxes on the report. This checkbox is disabled if
Document Date is selected as the Report Type.

Print Amounts In. Use this option to select the currency for the
report. You can list transaction amounts in the vendor currency or the
functional currency.

If you list transactions in the functional currency, and you have
performed a revaluation, the report shows the new functional
amounts.

3. Click @ print.

Other Reports

You can also print the Overdue Payables By Due Date and the Overdue
Payables By Document Date reports from the Aged Payables Report
form.
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Aged Retainage Report — Printing

The Aged Retainage report lets you print reports of outstanding retainage
amounts owed to vendors.

For information on the contents of this report, see Aged Retainage
Report - Features.

When to print

Print the report when you need to review retainage that is due to vendors,
such as at the end of a fiscal year or period.

To print the report

1. Choose the Aged Retainage icon from the A/P Transactions Reports
folder.

2. Select report options as follows:
Report Type. You can choose:
o Aged Retainage By Due Date &
o Future Retainage By Due Date &
o Overdue Retainage By Due Date &

Age As Of. Specify the date on which to report the retainage. The
program uses this date to assign retainage to an aging period by
calculating the number of days between its due date and the date
entered in the Age As Of field.

Cutoff By. The report includes only those transactions or balances
that have a due date before or on the cutoff date you specify. There
are three methods for selecting a cutoff date:

o Document Date
o Posting Date
o Year/Period

Print Transactions In. Indicate whether to print a summary or a
detailed report, and whether to print the detailed version of the report
by document date (Detail By Document Date), by due date (Detail By
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Retainage Due Date), or by document number (Detail By Document).

Use Aging Periods. Aging periods are used to group outstanding
retainage amount. The aging periods entered in the Options form
appear, but you can assign different periods for individual reports, if
you want.

o On the Aged Retainage By Due Date report, all outstanding
retainage amounts are grouped according to the dates on which
they become due.

o On the Overdue Retainage By Due Date reports, overdue
outstanding retainage amounts are grouped according to the dates
on which they became due.

o On the Future Retainage By Due Date report, outstanding
retainage amounts are grouped according to the future dates at
which they will become due.

Select Vendors By SpEley up 1O [ four criteria to select the vendor accounts to list on the
report.

If you do not specify selection criteria, the report includes amounts for
all vendors that use the account type you select.

Show Group Title. If you want to include a title for each sorted group,
select the Title checkbox for each group of records you are sorting by.

Sort Vendors By. You can choose up to four orders by which to list
(sort) records for the report. If you do not specify sorting criteria, the
report orders the records by vendor number.

Show Group Subtotal. If you want to include subtotals for each
sorted group, select the Show Group Subtotal option for groups of
records you are sorting by.

Include Taxes. Select this option to include tax information on the
report.

Print Amounts In. Use this option to select the currency for the
report. You can list transaction amounts in the vendor currency or the
functional currency.

If you list transactions in the functional currency, and you have
performed a revaluation, the report shows the new functional
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amounts.
3. Click @ Print.
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Batch Listing € Printing

A batch listing is the printed record of the transactions in a batch.

You can print batch listings for invoice, payment, and adjustment batches
that have been entered, imported, generated, or posted. The invoice
batch listing includes debit notes and credit notes, as well as interest
invoices.

For information on the contents of this report, see Batch Listing €
Features.

When to print

You should print batch listings after entering, importing, generating, or
editing a batch, at any time before the batch is posted, then file them with
your other audit trail records.

If you select the Force Listing Of Batches option in the Options form, note
that when you print to any print destination (including Preview), Accounts
Payable changes the batch print status to printed. Be sure to print the
batch listing to a printer or a file before posting.

To print batch listings
1. Open the @ gatch Listings form.

Select the batch type for the batches you want to print. &
Select the range of batch numbers to print.

Enter the @ range of batch creation dates.

a M DN

Select optional information you want to include, as follows:
o Reprint Previously Printed Batches
o Show Comments
o Show Schedules
o Show Tax Details &
o Show Adjustment Details &
o Show Job Details &
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o Show Optional Fields &
6. Select the types of batches to print. You can choose:
o Entered
o Imported &
o Generated
o Recurring
o External @
o Retainage
7. Select the statuses of batches to print. You can choose:
o Opent
o Ready To Post &
o Posted ™
8. Click @ print.

Notes
e You cannot print batch listings for deleted or posted batches.

e Batch listings are optional unless you use the Force Listing Of Al
Batches option in Options.

e Once you list a batch, its status changes to "Printed" on the Batch
Status report.

After using

o Verify contents, correct any errors, reprint the edited batches, then file
the listings.

e Post the batches.
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Batch Status Report — Printing

The Batch Status report describes all unposted invoice, payment, or
adjustment batches, and posted or deleted batches for which the
information has not yet been cleared from Accounts Payable. The report
is a valuable management tool for tracking batches, particularly when
several operators are entering batches on a multi-user system.

For information on the contents of this report, see Batch Status Report —
Eeatures.

When to print

Print the report when you need batch information, and before clearing
batch status information (details of posted and deleted batches). You can
clear information about printed posting journals and deleted and posted
batches using the Clear History form.

To print the report
1. Choose the Batch Status icon in the A/P Transaction Reports folder.
2. Select:

o The Batch Type

o Arange of batch numbers.

o Arange of batch creation dates.

o The type(s) of batches to include.
o The status(es) of batches to include.
3. Click @ print.
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Check Register — Printing

The Check Register report lists details of checks that are produced and
posted to vendor accounts during a check run. The Register can also list
the general ledger distributions that result. Checks that are used for
alignment or leading, as well as checks that are voided before posting,
are not included on this report because they do not result in the creation
of general ledger distributions or changes to vendor account balances.
These checks are listed on the Check Status report in Bank Services.

For more information on the contents of this report, see Check Register
— Features.

When to print

Print the report after posting a check run, as part of your audit trail of
payments made during the check run.

To print the report

1. Choose the Check Register icon in the A/P Transaction Reports
folder.

2. Select a range of posting sequences.
3. Indicate whether to print the general ledger transactions summary.
4. Click @ print.

12 Related Topics
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G/L Transactions Report — Printing

The G/L Transactions report is a list of the general ledger transactions
created from all posted Accounts Payable batches, and from posted
revaluations (in multicurrency ledgers). You can print detailed or
summary versions of the report.

The level of detail for transactions on the detailed report depends on your
choices on the Integration tab of the G/L Integration form. For example, if
you choose Consolidate By Account And Fiscal Period, the report shows
a total for each general ledger account and fiscal period. If you choose
Do Not Consolidate, the report shows full details for each transaction.

For information on the contents of this report, see G/L Transactions
Report — Features.

When to print

e After posting Accounts Payable batches, or after creating general
ledger batches (if you choose generate GL batches using the Create
G/L Batch form).If you do not use Sage ERP Accpac General Ledger,
print the report before transferring the batch information to another
general ledger system.

e Before using the Year End form. You must create any outstanding
general ledger batches (if you use the option to create the batches on
request) and print the G/L Transaction report before clearing posting
journals.

If you do not use Sage ERP Accpac General Ledger, Accounts Payable
creates the general ledger batch in a CSV (Comma Separated Values)
file, tailored to the Sage ERP Accpac General Ledger format. You can
send the file to a remote location that uses Sage ERP Accpac General
Ledger, or modify the information in the file to suit another general ledger
program.

To print the report

1. Choose the G/L Transactions icon from the A/P Transaction Reports
folder.

2. Make selections in the following fields:



Select Batch Type. Specify the batch types to include. You can select
any or all of the Invoice, Payment, and Adjustment batch types. If you
use multicurrency accounting, you can also choose Revaluation. For
each type you select, enter a range of posting sequence numbers.
The latest posting sequence numbers are displayed in the To box.
You can choose them or enter earlier numbers.

Report Format. Select Detail or Summary.

Sort By. If you choose the detailed report format, specify the order in
which to list the transactions on the report. The choices are by
general ledger Account Number, by Year/Period, and by Batch/Entry
Number. The summary report is sorted by general ledger account
number.

Currency. If you use multicurrency accounting, specify whether to
print amounts in each source currency or in the functional currency.

3. Click @ print.

& Related Topics
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Posting Errors Report — Printing

The Posting Errors report is created by Accounts Payable when you post
batches that contain errors. The report lists the incorrect entries and
explains why they could not be posted. You can print the report for
invoice, payment, and adjustment batch posting errors.

Note that if you are printing this report for an Intercompany Transactions
company, the Payment and Adjustment Error reports are not available.

For information on the contents of this report, see Posting Errors Report
— Features.

When to print

Print the report after posting a batch, if the program warns you that an
error batch has been created.

To print the report

1. Choose the Posting Errors icon in the Transaction Reports folder.

2. Select the type of error report to print (Invoice, Payment, or
Adjustment).

3. Select a range of posting sequences.
4. Click @ print.

12 Related Topics
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Posting Journals — Printing

A posting journal is the printed record of the transactions in a group of
batches that were posted together.

You can print posting journals for invoice, payment, and adjustment
batches. In multicurrency ledgers, you can also print posting journals of
the transactions that are created when you revalue documents at new
exchange rates.

This is an audit trail report of all uncleared details that have been posted.
You use the Clear History form to clear the data for the journals after
printing.

For information about the contents of this report, see Posting Journals —
Features.

When to print

You should print posting journals after each posting run, then file them
with your other audit trail records. You must print all outstanding posting
journals before you can use the Clear History form to clear them, or use
the Year End form to do year-end processing.

If you use multicurrency accounting, you also print posting journals after
revaluing transactions at new exchange rates.

To print the report

1. Set the printing destination using the File menu on the company
desktop.

2. Select the Posting Journal icon from the A/P Transaction Reports
folder.

3. Select:

Select Posting Journal. Select the type of journal to print: Invoice,
Payment, or Adjustment. The Invoice Posting Journal includes credit
note, debit note, and interest transactions. If you use multicurrency
accounting, you can also select Revaluation or Provisional
Revaluation.



Note that if you are in an Intercompany Transactions company, the
only posting journal you can print is the Invoice Posting Journal.

From Posting Sequence and To Posting Sequence. Type the
lowest and highest numbers in the range of posting sequences for
which you want to print journals.

A unigue posting sequence number is assigned each time you post
batches. These fields display the lowest and highest posting
sequence numbers in your Accounts Payable system for the type of
journal you select. (You use the Clear History form to clear posting
sequences for the journals you have already printed.)

Reprint Previously Printed Journals. Select this option if you want
to print additional copies of journals you printed before.

Do not select the option if you want to print only the journals you have
not already printed from the specified range of posting sequence
numbers.

Include Job Details. Select this option to include job-related
information, such as the contract, project, and category, with each
transaction printed. (The option to include job details is available if
you use Sage Accpac Project and Job Costing. It is not available as
an option in an ICT company.)

Include Optional Fields. Select this option to include optional field
information for each printed transaction. (The option is available only
if you use optional fields.)

Include G/L Ref.IDesc. Select this option to print the G/L reference
and description with each transaction.

Sort By. Specify the order in which to list transactions on the posting
journal:

o Batch/Entry — lists transactions in order by the batch and entry
numbers they were assigned when you entered them.

o Vendor Number — lists transactions in order by their vendor
numbers.

o Document Date — lists transactions in order by the dates that you
entered when you created the transactions.



The name of this choice varies with the type of journal you want
to print. Select Adjustment Date when you are printing
adjustment posting journals.

o Document Number — lists invoices, credit notes, debit notes, and
interest charges by their document numbers.

Select Check Number to list payment transactions by the
check or payment number you entered with each transaction or
by the numbers that are assigned by Accounts Payable to
transactions entered without numbers.

Select Adjustment Number to list adjustment transactions by
the adjustment number that Accounts Payable assigns to the
transactions when you create them. This option lists
transactions in the same order as sorting by batch and entry
number, unless you create transaction batches in a non-
sequential order. For example, if one person opens an
adjustment batch but does not enter the adjustments until after
a second person has opened a second batch and entered
transactions, then the transactions in the second batch would
be listed first.

3. Click @ print.

& Related Topics
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Vendor Transactions Report — Printing

The Vendor Transactions report lists transactions that were posted to
vendor accounts during the period you specify when you print the report.
You can order the transactions by document date, by"document number,
or by fiscal year and period.

For information on the contents of this report, see Vendor Transactions
Report — Features.

When to print

Print the report when you want to see the current status of your vendor
accounts.

Before using

Update account information by entering, importing, and posting
outstanding batches.

To print the report

1. Choose the Vendor Transactions icon from the A/P Transaction
Reports folder.

2. Then select:

Report Type. You can order transactions by document dates, by
document numbers, or by fiscal year and period.

From Document Date ... To. Indicate a range of dates for which to
include transactions. This option appears when you report
transactions by document date or by document number.

From Year/Period... To. Specify the fiscal year and period range for
which you want to report transactions. Documents outside this range
do not appear on the report. This option appears when you report
transactions by fiscal year and period.

Sort Transactions by Transaction Type. Select this checkbox if you
want sort transactions by document type for each vendor on the
report.

Select Vendors By SpGley up 1O [ four criteria to select the vendor accounts to list on the
report.
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If you do not specify selection criteria, the report includes all vendor
records that meet the other criteria you select in this form (for
example, the program does not include vendor records with a zero
balance unless you select the Print Vendors With A Zero Balance
option).

Sort Vendors By SpGley up tO [ four orders by which to sort records for the report.

Show Group Title. If you want to include a title for each sorted group,
select the Title checkbox for each group of records you are sorting by.

Show Group Subtotal. If you want to include subtotals for each
sorted group, select the Show Group Subtotal option for groups of
records you are sorting by.

[Include] Contact/Phonel/Credit. Choose this option if you want to list
the vendor's contact person and phone number, and your credit limit
for the vendor.

[Include] Space For Comments. Choose this option to leave blank
space at the end of each vendor record for your notes.

[Include] Vendors With A Zero Balance. Choose this option to
include accounts with a zero balance, for example, to find out which
vendor accounts are dormant. Note that an account could have
outstanding transactions even with a zero balance, for example, an
offsetting invoice and credit note.

[Include] Totals By Transaction Type. Choose this option to list a
total for each transaction type (invoices, debit notes, credit notes,
interest, and prepayments) after the listing for each vendor.

Select Transaction Types. Select one or more transaction types to
include on the report. The choices are Invoice, Debit Note, Credit
Note, Interest, Prepayment and Payment.

[Show] Applied Details. Choose this option to include all the
documents such as payments and credit notes that were applied to
each reported invoice. If you do not select this option, the report
shows only the balance owing for each document.

[Show] Fully Paid Transactions. Select this option to list documents
that are fully paid, but not yet cleared from Accounts Payable.
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Print Amounts In. If you use multicurrency accounting, use this
option to select the currency for the report. You can list transaction
amounts in the vendor currency or the functional currency. If you list
transactions in the functional currency, and you have performed a
revaluation, the report shows the new functional amounts.

3. Click @ print.

7 Related Topics
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1099/1096 Forms — Printing

You can use Accounts Payable to track payments to vendors who are
subject to 1099 reporting, and print the data on official 1099 MISC/1096
forms.

You must select the Use 1099/CPRS Reporting option in the Options
form to accumulate 1099 data and print this report. A 1099 form is printed
for a vendor only if you selected 1099 for the Tax Reporting option in the
vendor record.

Sage ERP Accpac Accounts Payable comes with a sample 1099
(AP1099.rpt)/1096 (AP1096.rpt) format, designed for laser printers. (The
format was valid at the time this program was released. If the form
changes, you can update the report formats using Crystal Reports.)

For information on the contents of the forms, see 1099/1096 Forms —
Features.

If you add non-standard codes
e Only standard 1099-MISC codes are printed on the stock 1099/1096
Amounts report.
When to print

Print 1099 or 1096 forms at the end of each calendar year, after you have
entered all transactions for the calendar year.

To print the report

1. Select the Print 1099/1096 forms icon from the A/P Vendor Reports
folder.

If you are printing 1096 forms, select the check boxes for the following
options, as necessary:

o Preaddressed Form. Select this option if you are using preprinted
forms that already include the address, so that the program does
not print the address.

o Final Filing. Select this option if you are not required to file Forms
1099, 1098, 5498 or W-2G in the future.



2. Select:

Form. Select the type of report you want to print. You can choose
1099 or 1096.

For Tax Year. Select the year for which you want to report 1099 data.

Use Form. Select the name of the 1099 form or 1096 form to use.
Click the Browse button (or press the Alt and B keys together) if you
are not sure of the name of the form, then select the form from the list
that appears.

Vendor Number. Select a range of vendor numbers.

3. Enter payer information, including the name, address, telephone
number, and tax number of your company.

If you are printing 1096 forms:

o From the Type field, select the type of tax number you are using
(your employer ID number or social security number).

o Enter an optional contract name and e-mail address.

If your company is not in the U.S., select the Foreign Entity check
box.

4. Click @ print.

5. If you want to use the same settings the next time you print the form,
select the Save Settings As Defaults option from the Settings menu.

Printing alignment copies

To print a test copy of a 1099 or 1096 form to check the alignment of the
forms in your printer, click the Align button. You can repeat this step as
often as needed when the printing destination is set to Printer.

& Related Topics
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T5018 (CPRS) Forms — Printing

You can use Accounts Payable to track payments to vendors who are
subject to CPRS reporting, and print the data on official CPRS forms.

You must select the Use 1099/CPRS Reporting option in the Options
form to accumulate CPRS data and print this report. A CPRS form is
printed for a vendor only if you selected CPRS for the Tax Reporting
option in the vendor record.

Sage ERP Accpac Accounts Payable comes with a sample T5018
(APCPRS.rpt) format, designed for laser printers. (The format was valid
at the time this program was released. If the form changes, you can
update the report formats using Crystal Reports.)

For information on the contents of the forms, see T5018 (CPRS) Forms
— Features.

When to print

Print CPRS reports at the end of each calendar year, after you have
entered all transactions for the calendar year.

To print the report
1. Select the CPRS Amounts icon from the A/P Vendor Reports folder.
2. Select:

For Tax Year. Select the year for which you want to report CPRS
data.

Use Form. Select the name of the CPRS form to use. Choose
Browse (click the Browse button or press the Alt and B keys together)
if you are not sure of the name of the form, then select the form from
the list that appears.

Business Number. Enter your business number.

Vendor Number. Select a range of vendor numbers.

CPRS Code. Select the range of CPRS codes to report on.
3. Click @ print.
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Printing alignment copies

To print a test copy of a CPRS form to check the alignment of the forms
in your printer, choose the Align button. You can repeat this step as often
as needed when the printing destination is set to Printer.

& Related Topics
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Letters and Labels — Printing

You can print letters and mailing labels for the vendors in your Accounts
Payable system. For example, you might want to send covering letters to
your vendors with your payments.

Sage ERP Accpac Accounts Payable comes with a sample covering
letter and a sample mailing label form, formatted for laser printers, that
you can use or change to suit your company's requirements .

For information on the contents of letters and labels, see Letters and
Labels — Features.

To print letters or labels
1. Choose the Letters/Labels icon from the Vendor Reports folder.
2. Fill in the fields on the form, as follows:
Letter/Label. Select the option for the type of form you are printing.

Use Letter/Label. Select the name of the letter or label form to use.
Choose Browse (click the Browse button or press the Alt and B keys
together) if you are not sure of the name of the form, then select the
form from the list that appears.

Run Date. This is the date that appears on the forms.

Delivery Method. Specify how you want to send the letters to your
vendors, as follows:

o Print Destination — to send the statements to the default print
destination you selected on the company desktop.

o Vendor — to send the letters via the method specified in your
vendor records for each vendor.

Message ID. This field appears when you select Vendor for the
Delivery Method. Select the code for the message you want to send
with e-mailed letters.

Select By Sp@ley up 1O [ four selection criteria to select the vendor accounts for which to print

letters or labels.

Sort By SpGley up 1O [ four orders by which to list (sort) records for the letters or labels.
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Include Vendors with a Zero Balance. Select this option if you want
to print letters or labels for vendor accounts with zero balances (as of
the cutoff date).

3. Click @ print.

Tip

If you are sending letters to accompany payment checks, you may find it
simpler to print checks, then advices, specifying the letter you are

sending with the checks as the advice form. This method ensures that
you print a letter for each payment check.

Printing alignment copies

To print a test letter or sheet of labels to check the alignment of the
letterhead or labels in your printer, choose the Align button. You can
repeat this step as often as you need to when the printing destination is
Printer.

Note that the sample labels are approximately 6.5 cm by 2.5 cm, and are
designed to fit a tab of 30 labels arranged in 3 columns.

& Related Topics
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Recurring Payables Report — Printing

The Recurring Payables report is a list of the recurring payables that you
have set up. It can also show the processing schedule attached to each
recurring payable record.

Print this report prior to creating a recurring payable batch to ensure that
the information is up to date.

For information on the contents of this report, see Recurring Payables
Report — Features.

To print the report
1. From the Vendor Reports folder, choose Recurring Payables.

2. In the Recurring Payable Code From and To fields, enter the range of
codes you want to list in the report.

3. In the Vendor Number From and To fields, enter the range of vendors
you want to include in the report.

4. Select the Show Schedules option if you want to include the
schedules for the recurring payables codes that you are listing.

5. Select Optional Fields to include optional field information for each
recurring payable.

6. Click ®© print.

12 Related Topics
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Remit-To Locations Report — Printing

The Remit-To Locations report lists the remit-to locations (addresses to
which you send checks) used by your vendors.

For information on the contents of this report, see Remit-To Locations
Report — Features.

When to print

Print the report when you add, change, or delete remit-to locations.



To print the report

1.

Choose File, Print in the Remit-To Locations form, or choose the
Remit-To Locations icon from the Vendor Reports folder.

Select:

o Whether to include address information (address, contact name,
and check language) or optional field information for the remit-to

locations. You must select at least one of these options to print the
report.

o Arange of vendor numbers.
Click & print.

& Related Topics
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Vendor Group List — Printing

The Vendor Group List reports the information entered for each vendor

group in your Accounts Payable system, and the vendors assigned to
each group.

For information on the contents of this report, see Vendor Group List —
Eeatures.

When to print
Print the report when you add, change, or delete vendor groups.
To print the report

1. Choose File, Print in the Vendor Groups form, or choose the Vendor
Groups icon from the Vendor Reports folder.

2. Then make your selections in the following fields:
Report Type. Select Vendor Group List.

Include. Specify whether to include profile information, group
members, or optional fields. You must select at least one of these
options to print the report.

From Group/To. Specify a range of vendor groups. If you are using
only one group, enter the group code in both the From and To fields.

3. Click @ print.

18 Related Topics
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Period Statistics Reports — Printing

You can print the Period Statistics reports for vendors and vendor groups.

Each report lists the total amount of invoices, payments, discounts taken,
discounts lost, credit and debit notes, and adjustments you have
recorded for a given vendor during the period covered by the report, as
well as the total number of invoices paid during that period. The
information on this report is also available on the Vendor Statistics tab of
the Vendors form and the Group Statistics tab of the Vendor Groups
form.

The reports list statistics for the type of year and period specified in the
Options form.

Print the report when you need a summary of statistics, such as at the
end of each reporting period.

For information on the contents of this report, see Period Statistics
Reports — Features.

To print a report

1. Choose File, Print from the Vendors form or the Vendor Groups form,
or select the report icon from the Vendor Reports folder, depending on
the type of report you want to print.

2. In the Report Type box, select Vendor Period Statistics (for the
Vendor Period Statistics report) or Vendor Group Statistics (for the
Vendor Group Period Statistics report).

For the Vendor Period Statistics report, select the currency (if you use
multicurrency accounting), whether to include the number of
documents that make up the total amount for each type of transaction
listed on the report, the years and periods for which to include
transactions, and up to four selection and sorting criteria.

For the Vendor Group Statistics report, choose whether to include the
number of documents that make up the total amount for each type of
transaction listed on the report, then select the ranges of groups,
years, and periods to include.

3. Click @ print.
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Vendors Report — Printing

The Vendors report lists the information entered for the vendor records in
your Accounts Payable system.

For information on the contents of this report, see Vendors Report —
Eeatures.

When to print
Print the report when you add, change, or delete vendor records.
To print the report

1. Choose the File, Print command from the Vendors form, or choose
the Vendors icon from the Vendor Reports folder.

2. Then make your selections in the following fields:
Report Type. Select Vendors.

Include. Specify whether to include the vendors' addresses, profile
information, comments, optional fields, or recurring payables. You
must select at least one of these options to print the report.

If you choose to print comments from the vendor records, enter a
range of follow-up dates for which to include comments.

Select By. Specify up to four selection criteria for the report. Your
choices for the first selection criterion are: Vendor Number, Vendor
Group, or Short Name.

Your choices for the remaining three selection criteria include the
above and Account Set, Vendor Balance, Vendor Equivalent Balance
(multicurrency ledgers only), Vendor Name, Currency Code
(multicurrency ledgers only), and Start Date.

If you do not specify selection criteria, the report includes all vendor
records.

Sort By. You can choose up to four orders by which to list (sort)
records for the report. You can sort by Vendor Group, Account Set,
Vendor Balance, Vendor Equivalent Balance (multicurrency ledgers
only), Vendor Name, Short Name, and Currency Code (multicurrency



ledgers only).

If you do not specify sorting criteria, the report orders the records by
vendor number.

3. Click @ print.

& Related Topics
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Vendor Activity Statistics Report — Printing

The Vendor Activity Statistics report lists information about the purchases
and payment history for the current year to date and previous fiscal year
for the vendor records in your Accounts Payable system. Most of the
information on this report is also available on the Vendor Activity tab of
the Vendors form.

For information on the contents of this report, see Vendor Activity
Statistics Report — Features.

When to print

Print the report when you need to check on vendor account activity such
as the last time you made a purchase from the vendor, the date and
amount of your last payment to the vendor, the average number of days it
takes you to pay the vendor, or the date a vendor's balance was last
revalued (if you use a multicurrency Accounts Payable system).

To print the Vendor Activity Statistics report

1. Choose File, Print in the Vendors form, or choose the Vendors icon in
the Vendor Reports folder.

2. Choose Vendor Activity Statistics from the Report Type box.

3. Specify whether to print amounts in the vendor currency or the
functional currency (if you use a multicurrency Accounts Payable
ledger).

4. Select up to four selection and sorting criteria. If you do not specify
selection criteria the report includes all vendor records. If you do not
specify sorting criteria the report orders the vendor records by vendor
number.

5. Click @ print.
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Sage ERP Accpac Training

Become a Sage ERP Accpac expert with online or classroom training
through Sage University.

If you want to get beyond the basics and tap into the full power of your
Sage ERP Accpac system, nothing beats targeted training and
education.

Our training resources include a nationwide network of authorized
classroom training centers, online courses, partners who can conduct on-
site training, manuals and guides for your self-study, and an annual
customer conference.

For more information on Sage ERP Accpac training, choose one of the
following links:

Find a Course

Search training courses on the Sage University Web site by product,
type, location, track, schedule—or try our advanced search.

Anytime Interactive

Anytime Interactive training offers a full range of recorded instructor-led
sessions that are easy to use, always accessible, and ready when you
are. All you need is a computer, speakers and a high-speed Internet
connection.

Anytime Interactive sessions are ideal for review material, acquainting
new-hires with basic processing skills, and cross-training staff. Interactive
sessions include product specific instruction and online review quizzes.

Classroom

Instructor-led classroom training provides you with personal interaction in
a professional atmosphere you will enjoy. Classroom training also allows
you the opportunity to become Sage certified.

Classroom training is ideal if you prefer one-on-one assistance,
interaction with other students and a classroom atmosphere.


http://sagesoftwareuniversity.com/acc/eu/courses/find_a_course.htm
http://sagesoftwareuniversity.com/acc/eu/courses/byproduct/accpacerp/anytime.htm
http://sagesoftwareuniversity.com/acc/eu/courses/byproduct/accpacerp/classroom.htm

Lunch & Learn

Lunch & Learns are one-hour Realtime (Online) sessions that cover a
particular topic or process. Each Lunch & Learn is designed to increase
productivity by simply providing you with a stronger understanding of a
specific feature or functionality within the software.

Choose one of our 40+ information packed Lunch & Learn sessions and
become more proficient in just one hour.

Realtime

Realtime training sessions are online, instructor led and scheduled for a
specific date and time. All you need is a computer, phone, and an
Internet connection. Everything happens live, so you can ask questions
and interact with other participants and the instructor.

Realtime combines the interaction of a classroom with the convenience
of staying right where you are.

Realtime sessions include live product specific instruction, electronic or
printed course materials, hands-on exercises, and online review quizzes.


http://sagesoftwareuniversity.com/acc/eu/courses/byproduct/accpacerp/lunchnlearn.htm
http://sagesoftwareuniversity.com/acc/eu/courses/byproduct/accpacerp/realtime.htm

Add a Prepayment When You Add an Invoice

To add a prepayment:

1.

Open A/P Transactions > Invoice Entry, and then select the open
batch that contains the invoice or to which you want to add the
invoice.

Enter the invoice information, and then click Add or Save, or select
the existing invoice that you are prepaying.

Click the Prepay button.
Click here for help on the fields on the Prepayment form.

In the Batch field, type the number of the payment batch to use, or
use the Finder to select the payment batch to which to add the
prepayment.

To create a new payment batch, click the New button beside the
Batch Number field, then enter a description and a date for the batch.

5. Fill in the remaining fields in the form.

6. Click the Add button to add the prepayment.

You can add only one prepayment per invoice.
Click the Close button.

To cancel a prepayment before you have processed it, click Close
without first clicking Add, then click Yes at the message that appears.

You can edit the prepayment in the Payment Entry form after you post
the invoice.

[}l Additional information

[l Related topics
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Enter an Invoice, Credit Note, or Debit Note

[l overview

[}l Before adding an invoice, credit note, debit note, or interest invoice

To add an invoice, credit note, debit note, or interest invoice:

1.

a &~ D

Open Accounts Payable > A/P Transactions > Invoice Entry.

Click here for help on the fields that appear on the Invoice Entry form.

[} select an existing batch OF [ create a new batch.

[t] Use the Entry Number field to select the entry, then enter a descriptiOn for the entry.

[}l Enter header information on the Document tab.

[ Enter distribution details 1N the detail entry grld

To check or change the general ledger accounts and tax information
for a detail, click the Account/Tax button. (Click Close to return to the
Invoice Entry form.)

Check to & pe sure you have distributed all document amounts before you calculate tax for
the document.

To check or change taxes for the document, click the Taxes tab.

o Click the Distribute Taxes button to allocate tax to each of the
distributions in the list. The amounts are displayed in the Allocated
Tax column.

o You can edit the tax amount that was allocated to each distribution
detail if you select Enter as the tax entry method on the Taxes tab.

On an invoice from which retainage will be deducted, use the
Retainage tab to specify terms for the retainage document. In a
multicurrency ledger, you also specify which rate to use when you
process the retainage.

9. Click the Terms tab, then enter Payment terms.

0. If you use invoice optional fields, click the Optional Fields tab to view

or edit the optional fields assigned to this invoice.

If the document does not use the functional currency and you need to
edit the exchange rate, rate date, or rate type, use the Rates tab to
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adjust them.
2. Click Add to add this document to the batch.

3. If you need to enter a prepayment for the invoice, click Prepay to add
it now.

[}l After adding the invoice

[l Related topics
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Enter a Job-Related Invoice

[l overview

To enter a job-related invoice:

1.

On the Invoice Entry form, enter the vendor number and other header
information as usual.

Select the Job Related option. (If the option is dimmed, delete the
distribution line in the detail grid on the form.)

Additional fields appear that let you enter job-related details. The field
names are the Level 1, Level 2, and Level 3 names (and their plural
forms) that you specified on the P/M Options form. The program uses
the default names, Contract, Project, and Category (and their plurals),
respectively, unless you specified different names.

For each detail, indicate the contract, project, category, and resource
affected by the transaction by entering information in the job-related
fields that appear.

Accounts Payable also displays (depending on the project type) the
default billing type, A/R item number, unit of measure, General Ledger
account, and unit cost from the contract in the following fields.

In the Quantity field, enter the quantity of the resource (for the
specified unit of measure) for which your vendor is billing.

On the Options tab, Accounts Payable displays the optional fields you
set up for the contract. Enter the optional codes you want to use for
this invoice.

Complete the rest of the tabs and fields as you would for any other
invoice, credit note, or debit note.

Click Add when you are finished.
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Edit Exchange Rate Information on an Invoice

L] Before you start
To enter exchange rate information:
1. Click the @ Rratestab 0N the Invoice Entry form.

Click here for help on the fields on the Rates tab.

2. In the Rate Type field, enter the code for the rate type to use to
convert the source currency to your functional currency.

3. In the Rate Date field, enter the date to use for selecting the
exchange rate.

4. If the correct exchange rate does not appear in the Exchange Rate
field, enter it, and then press the Tab key to record the rate.
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Edit Optional Fields for an Invoice Detail

L] Before you start
To change the optional fields for a document detail:

1. With the invoice displayed on the Invoice Entry form, select the detail,
then click the zoom button (a ) in the Optional Fields column header.
You can also select the detail, then press Shift+F9.

An Optional Fields form appears, displaying any invoice details
optional fields that are marked for automatic insertion.

2. Use this Optional Fields form to add or delete optional fields for the
detail. You can add any optional fields that are defined for invoice
details.

3. You can also change the default values that appear, as follows:

o |f the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional
field allows blanks, you can leave the value field blank.

o If the optional field is not validated, you can select a predefined
value, or you can enter any value that is consistent with the type of
field (amount, text, yes or no, and so on), providing your entry
does not exceed the length permitted for the field.
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Edit Taxes on an Invoice, Debit Note, or Credit Note

L] Before you start
To change tax amounts for a document:

1. If you need to change the vendor's tax group for this document, click
the Taxes tab.

a. Select the vendor's tax group (invoices, credit notes, and debit
notes). The tax group assigned to the vendor record is displayed
automatically, but you can choose another tax group. In a
multicurrency ledger, if the tax group does not use the vendor's
currency, Tax Reporting fields appear.

b. Choose the tax entry method. In the Tax Amount field and/or the
Tax Base field, select one of the following:

o Calculate — to have Accounts Payable calculate tax amounts
or tax bases for you.

o Do not enter tax amounts on this tab because the program
calculates them for you.

o A Tax Included column appears beside the Vendor Tax
Class column. Use the column to specify whether taxes
are included or excluded in the amounts you will distribute
in the detail distribution grid.

o Check the Vendor Tax Classes. If they are not correct, use
the Finder to select the correct classes.

o Distribute — if you want to enter the total tax for each tax
authority manually, then allocate tax amounts to details
automatically using the Distribute Taxes button.

o Enter — if you want to enter all tax amounts (tax totals and
detail taxes)

If you choose Calculate as the entry method for the tax amount
and Distribute or Enter for the tax base, the program will use the
tax base to calculate the tax amount automatically.

If you select Calculate or Distribute as the tax entry method, you
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cannot directly edit tax amounts for distribution lines, but you can
change tax classes.

Note: You can:

o Use the Calculate Tax button to calculate the tax for the
document.

o Use the Distribute Taxes button to prorate the total tax amounts
for individual document details.

o If you enter tax reporting amounts manually, use the Derive
Rates button to calculate the implicit exchange rate for the tax
reporting currency.

To change taxes for an invoice detail:

1. On the Document tab, select the distribution line, then click the
Account/Tax button. Make the changes in the Detail Accounts/Taxes
form that appears.

2. Click the Taxes tab to check tax amounts for the document and
compare the totals on the screen with the totals on the source
document.

[}l Additional information
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Enter an Advance Credit for Goods You Return

[l Before you start

To process an advance credit:

1.
2.
3.

5.

Display the payment entry in the Payment Entry form.
Click the Zoom () button beside the Advance Credit field.

On the Advance Credit form that appears, for each claim for which
you are recording a credit, press the Insert key to create a detail line,
then complete the following detail fields:

] Document Number

[}l Reference
[ Description

[t claim Amount

The Advance Credit field displays the total amount of advance credits
entered.

Click the Close button to return to the Payment Entry form, where you
apply the Payment (including the advance credit), as usual.

Click Save.

[}l After adding the advance credit

[l Related topics
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Set Up a Recurring Payable for a Vendor

[l Before you start

To create a recurring payable:

1.

Open Account Payable > Vendors > Recurring Payables.

Click here for help on the fields on the Recurring Payables setup
form.

Click the New (&) button beside the Recurring Payable Code field.

3. Enter or select the recurring payable code you want to use with the

new payable. (Note that you can use the same recurring payable
code for different vendors.)

4. Enter a description for the recurring payable.

Enter or select the number of the vendor you will pay periodically
using this recurring payable.

On the Invoice tab, enter:
a. A start date for the payable.
b. An expiration type.

c. Depending on the expiration type, the expiration date &, the
maximum amountt, or the number of invoices to produce L.

d. [ Header information fOr the document.

Use the Detail tab to enter @ dewils fOr the recurring payable, as you
would for an invoice.

To check or change the general ledger accounts and tax information
for a detail, click the Account/Tax button. (Click Close to return to the
Invoice Entry form.)

8. To check or change taxes for the document, click the Tax/Totals tab.

9. Click Add (or Save, if you are updating an existing recurring payable

record).

L] After adding recurring payable records
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Process Recurring Payables

[l Before you start

To process recurring payables:

1.

Open Accounts Payable > Periodic Processing > Create Recurring
Payable Batch.

Click here for help on the fields that appear on the Create Recurring
Payable Batch form.

Type the run date.

3. Specify whether to create invoices by recurring payable code, vendor

number, or vendor group.

4. Specify the ranges for the selected record type.

6.

Use the Method field to specify whether to create a new batch, add
the invoices to an existing batch, or use the default method to
determine whether to create a new batch or add the invoices to an
existing batch.

Click Process.

[}l After generating a batch of invoices

[}l Additional information

[l Related topics
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Manually Create an Invoice for a Recurring Payable

] overview
To create an invoice for a recurring payable:
1. Choose Accounts Payable > A/P Vendors > Recurring Payables.

Click here for help on the fields on the Recurring Payables setup
form.

2. In the Recurring Payable Code field, select the code for the type of
payable.

3. In the Vendor Number field, select the vendor whose invoice you want
to create.

4. Click the Create Invoice button.
5. Fill'in the fields on the Create Invoice form that appears.
o Specify the date for the invoice, as follows:

o Select Next Scheduled to create an invoice using the next
scheduled date

o Select Other if you want to specify a different date (for
example, to reproduce an invoice that you accidentally
deleted). If you select Other, specify the invoice date in the date
field that becomes available.

o Specify whether to create a new batch for the invoice or add the
invoice to an existing invoice batch. If you select Add To An
Existing Batch, enter the batch number in the next field (or use the
Finder to select the number).

6. Click Process to create the invoice, or click Cancel if you no longer
want to create the invoice.
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Process Outstanding Retainage

To create a batch of retainage documents:

1. Open Accounts Payable > Periodic Processing > Create Retainage
Batch.

Click here for help on the fields on the Create Retainage Batch form.

2. Specify the Run Date for this retainage batch.

3. Specify the types of original retainage documents for which you are
now processing outstanding retainage.

4. Choose the type of record by which to select outstanding retainage for
processing, then enter the range of records from which to select
outstanding retainage.

5. In the Number Of Days In Advance field, specify the number of days
in advance of the retainage due date that retainage documents can
be created.

6. Click Process to create the batch.
7.

Accounts Payable updates the Last Invoiced field on the Retainage tab of
the A/P Options form.

[ After generating a retainage batch

[}l Additional information

[l Related topics
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Post an Invoice Batch

[] Before posting a batch

To post one invoice batch at a time:

1. Open Accounts Payable > A/P Transactions > Invoice Batch List.

2. Select (highlight) the batch you want to post in the list, and then click
Post.

If the Ready To Post option is not selected for the batch, a message
appears that lets you select the option and post the batch.

To post a range of batches, use the Post Batches form.
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Post a Range of Batches

L] Before you start

To post a range of batches:

1. Choose Accounts Payable > A/P Transactions > Post Batches.

2. Select the type of batch to post (invoice, payment, or adjustment).You
can post only one type of batch at a time.

3. Select the All Batches option to post all the batches of the chosen
type, or select Range and then specify the range numbers for the
batches you want to post. (You can post a single batch, a range of
batches, or all ready-to-post batches of the chosen type.)

4. Click Post.

[ After posting
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Pay a Vendor's Invoice

L] Before you start

To enter the payment:

1. Open Accounts Payable > A/P Transactions > Payment Entry.

Click here for help with the fields on the Payment Entry form.

2. [ create Or @ select the payment batch to use.

3. Beside the Entry Number field, type a description of the payment
transaction or other information you want to record.

4. Select Payment as the transaction type, if it is not already displayed
as the default.

5. Enter the date for the payment, and, if necessary, change the fiscal
year and period to which you are going to post the transaction.

6. Enter [ vendor information.

7. Accept the payment code that appears, if it is correct, or use the
Finder to choose the right code.

8. Select the Print Check field if you are going to print the check from
Accounts Payable, and specify the Check Language.

If you leave the field blank (because you are entering information for a
manual check), enter the check number in the Check Number field.

9. To apply the payment to an invoice:

a. Unless you know the document number to which to apply the
payment, click the Select checkbox, and then:

1. Specify the selection criteria (the document type &, & jist order,
and an optional starting number, balance, or date).

2. Click the Go (»») button to display the vendor's open
documents of the selected type.

3. Enter Yes in the Apply column for each document to which
you want to apply the payment. To partially pay a document,
type the amount to apply in the Applied Amount column.
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b. If you know the document number, or there are only a few
documents for this vendor from which to choose:

1. Click the first line in the detail-entry grid.

2. In the Document Number field, enter the document number, or
double-click the field to use the Finder (a ) to select the
document.

3. To partially pay a document, type the amount to apply in the
Applied Amount column.

4. If you are entering a partial payment for a job-related
document, choose an apply method for the payment, and edit
the distribution for the payment, if necessary.

5. If you need to pay another document, press the Insert key on
your keyboard to start another detail line.

0. When finished, click Add or Save to add and apply the payment.

To cancel the application, click Close or select another entry number,
then click No at the message that appears asking whether you want
to save your changes.

[}l After adding a vendor payment

[l Related topics
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Prepay a Vendor

[l overview

These steps are for adding a prepayment that you will apply later.

To add a prepayment:

1. Open Accounts Payable > A/P Transactions > Payment Entry.

Click here for help with the fields on the Payment Entry form.

2. [ select an existing batch, OF & create a new batch.

3. Click the New (&) button beside the Entry Number field, and in the
adjacent field, enter a description for the payment, such as
"Prepayment of PO 5664."

4. Select Prepayment as the transaction type to record an advance to a
vendor account.

5. Fill in the remaining fields on the Payment Entry form:

e}

Payment Date (to appear on the check and for aging and statistical
purposes)

Posting Date

Vendor number

Remit-To (person or company to which the check is made out; use
the zoom button or press F9 to change)

Account Set

Payment Code

Print Check (option) (if you want to print the check from Accounts
Payable; do not select if you have already issued the check)

Depending on the payment type, enter the Check Number (if you
are recording a manually written check. You cannot enter a
number if you selected Print Check), check language, or a cash
account.

Check Language (for printing the amount only; edit the check form
to change other aspects of the check)
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o An optional reference for the prepayment
o Optional fields (if you use them)

o Vendor Amount (the amount of the prepayment)

o Apply By (used for matching the prepayment to an invoice).

o Apply To (You can manually enter a document number or click the
finder to select a from a list of numbers. If you selected PO
number in the Apply By field, you will be prompted to specify
where you want to select the PO number from).

o Activation Date

6. If the prepayment is job-related, select the Job Related field, then &

distribute the payment to particular jobs.

7. When finished, click Add or Save.

[l After adding a prepayment

[}l Additional information

[l Related topics
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Print a Check when You Pay a Vendor

L] Before you start
To print a check from the Payment Entry form:

1. Display the payment in the Payment Entry form, if it is not already
selected.

Click here for help on the fields on the Payment Entry form
2. Click the Print Check button.
Accounts Payable displays the Print Checks form.

3. Make sure that the check form selected in the Print Checks form is
the one you want to use, and make sure the check forms are
positioned properly in the printer. You can print an alignment check to
test the positioning.

4. Click Print.

Once the check is printed, Accounts Payable asks whether it was
printed correctly.

5. Review the check, and if it was printed correctly, click Yes.
If the check was not printed correctly:
a. Click No.

b. Reset the print status by clicking the print status column or by
clicking the Select Reprint Range button and then specifying the
number of the check you printed.

If you are also printing a payment advice, Accounts Payable asks
whether the advice forms are in the printer. Click Yes to print the
advice form, then click Yes again when it asks whether the advice was
printed correctly.

[t] After printing a check

[l Related topics
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Print Checks and Post a Payment Batch

To print checks and post the payment information to vendor
accounts

1.
2. Select the batch for which you want to print checks.

3.

4. If the Print Checks form appears, review the check printing settings

Open the Payment Batch List form.

Click the & printPost button.

and the list of checks the program is ready to print.

[}l Adjust any settings that are incorrect.

Click the Print button when you are ready to proceed.

If you are printing checks, then advices (instead of checks only or
combined check and advice forms), the program will tell you to insert
the check stock in the printer before proceeding.

When printing is finished, Accounts Payable asks whether the checks
were printed correctly.

Review the checks, then click Yes or No.

If you choose No — checks are not correct — click the Select Reprint
Range button and specify a range of checks for reprinting, then click
the Reprint button.

If you choose Yes, Accounts Payable returns you to the Payment
Batch List form, and posts the payments.

If you are printing advices after the checks, the program will start to
print advices as soon as you click Yes to confirm the check printing.

The program asks you to confirm that advices were printed correctly
before it returns you to the Payment Batch List and posts the
payments to vendor accounts.

[}l After printing checks

[}l Related information
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Enter a Cash Invoice (Miscellaneous Payment)

[l overview

To add a cash invoice or cash payment:

1.

1.
2.

N o g s~ WD

Open Accounts Payable > A/P Transactions > Payment Entry.

Click here for help with the fields on the Payment Entry form.

Use the Batch Number field tO @ create a new payment batch O [ select an existing batch.

Enter a description for the payment (such as "Payment for camera”).

[t create a new miscellaneous payment for the vendor.

Enter & general information fOr the payment entry.

Enter @ distibution detaits fOr the payment.

If you have a multicurrency ledger and you want to specify the
exchange rate for the miscellaneous payment, click the Rates button.
On the Rate Override form that appears, change the rate date and
exchange rate, as necessary, then click OK.

To check or change the taxes calculated for the document (including
the tax reporting amount), or to change the tax group for the
document, click the Document Taxes button.

To check the taxes calculated for a distribution detail, or to enter them
manually if tax is not calculated automatically for the payment, select
the detail, then click the Account/Tax button.

If you have a multicurrency ledger and you want to specify the
exchange rate for the miscellaneous payment, click the Rates button.
On the Rate Override form that appears, L change the rate date and exchange rate,
as necessary, then click OK.

When ready, click Add or Save.
Click Close to close the Payment Entry form.

[}l After distributing the payment

[}l Additional information

[l Related topics
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Enter and Apply a Payment

[l overview

To add a vendor payment:

1.

a &~ WD

Choose the Payment Entry icon from the A/P Transactions folder.

Click here for help with the fields on the Payment Entry form.

[} Select or enter the batch number.

[}l Select or enter the payment entry number.

Enter a description for the payment, such as "Payment of Inv 7764."

Select "Payment" as the transaction type if you are recording a check
you issued to a vendor, or are entering a vendor check you want to
print.

Fill in & general information about the payment:

7. Click the Select Mode option, unless you know the number of the

documents to which you are applying the invoice, or there is a large
number of documents for this vendor. Then:

If you are using Select Mode:
a. Select the type of documents @ you want to display.
b. Select the order by which to list documents. &

c. Type the starting number, date, or balance, depending on the
choice you made for ordering documents, or press F5 to select it
from the Finder.

d. Click the Go button, or press F7.

e. For each document to which you want to apply the payment, select
Yes in the Apply column. &

f. Tab to the Applied Amount column and change the amount if you
are not paying the entire invoice.

g. Accounts Payable automatically applies the entire amount, and
takes the full discount unless you specify otherwise.

If you are not using Select Mode:
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a. Type the Document Number or select it using the Finder.

b. Type "1" for the Payment Number, or enter the number of the
payment if the document has a multiple payment schedule.

c. Type the Applied Amount.

d. Type the Discount Amount, if any.

8. If you need to adjust an invoice or other document, & iick the Adjust button tO
open the Miscellaneous Adjustment Entry form, then:

a. Enter a reference and description for the adjustment.

b. Select the line number you want to edit on the document you are
adjusting. The program displays the distribution code and general
ledger account used in the original transaction, but you can
change them.

c. Type the amount of each adjustment detail.
d. Click Save, then click Close to return to the Payment Entry form.

9. If the document you are paying is job-related, and you are only paying
part of the invoice, select an apply method, and & apply the partial payment

manually.

0. When finished, click Add or Save.

[l After entering and applying payments
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Apply Payment Controls

Overview

[}] Before You Start

To control payments in system-generated batches:

1.

Open Accounts Payable > A/P Transactions > Control Payments.

Click here for help on the fields on the Control Payments form.

Specify how to select documents (and what you want to control), by
choosing one of the following options:

o Single Document.

o Range of Documents.

If you select Specific Document, fill in the following fields to select
the document you want to change:

o Vendor Number

o Document Number (invoice, credit note, debit note, or
prepayment)

o Payment Number (will be "1" unless the document has a multiple
payment schedule)

Click the Go (»») button or Press F7 to display information for the
document so that you can change it. The fields you can change are:

o Due Date
o Discount Date

o Discount Percent

o Discount Amount

o Document Status (Normal, Forced, or On Hold)

o Activation Date for prepayments (the date after which the
prepayment is considered when calculating the amount due for
payment)

If you select Range Of Documents, fill in the following ranges:
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o Vendor Group
o Vendor Number

o Document Number (since different vendors use different
numbering systems, this option may be useful only if you are
selecting invoices from a single vendor)

Select the Document Types for which you want to change the status.
Select the Document Status that you want applied.

4. Click Process once you have selected the document or range of
documents and specified the change.

[l After applying payment controls

[}l Related information
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Create a Payment Batch Automatically

[l Before you start

To create a payment batch:

1.

Open Accounts Payable > A/P Transactions > Create Payment Batch.

Click here for or help on the fields on the Create Payment Batch form.

Type a payment selection code, or select one from the Finder. You
must enter a code in order to continue.

If the Selection Code field does not appear, you can either:

o Edit all the fields in the Create Payment Batch form to select the
records you want.

Or

o Use the Clear button to erase all criteria, then enter the code you
want, and modify the payment criteria as necessary.

Fill in the fields on the @ select tab.

4. Click the Criteria tab, then fill in the fields on the @ ciriteria tab.

Transactions must meet all selection criteria on this tab and on the
previous tab to be considered for payment.

5. Click the Exclusion tab, then fill in the fields on the @ exclusion tab.

6. In multicurrency ledgers, if the bank or vendor currency is not the

functional currency and you need to change the exchange rate
information for the ChECkS, [l use the Rates tab to adjust them.

Check all your criteria to make sure these are the vendors for which
you want to generate checks.

If you use optional fields, check the Optional Field tab to ensure that
any payment optional fields assigned to the batch are correct. Edit the
optional fields or add different ones, as necessary.

Make sure your printer is turned on and ready, then click the Register
button to print the Pre-Check Register.

Review the register and make whatever changes are necessary for
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your check run.

Note: You can leave the Create Payment Batch form at any time.
The program retains all the criteria you specified to ensure that the
generated checks match the Pre-Check Register.

1. When you are ready to create the payment batch, click the Generate
button.

[}l After creating a payment batch



javascript:void(0);

Write Off Small Differences During Payment Entry

[}l Before adjusting an entry

To adjust a document during payment entry:

1.

Open Accounts Payable > A/P Transactions > Payment Entry.

Click here for help with the fields on the Payment Entry form.

Create a new Payment or Apply Document transaction in the
Payment Entry form, or select one for editing.

On the application grid, select Yes in the Apply column for the
document you want to adjust, and then, in the Applied Amount
column, enter the amount you are paying or applying to the
document.

With the apply-to document selected, click the Adjust button.
The Miscellaneous Adjustment Entry form opens.

5. Enter a reference and description for the adjustment.

6. In the Adjust Line Number field, use the Finder to select the document

b O © ®

detail you want to adjust.

Enter a distribution code or general ledger account number for the
adjustment detail.

Enter the adjustment amount for the detalil.

Repeat steps 5, 6, and 7 for each adjustment detail.

When finished, click Close to return to the Payment Entry form.
Click Add or Save.
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Apply a Posted Prepayment or a Credit Note

[}l Before you apply a document

To apply a prepayment or credit note to an invoice or a debit note:

1.

Open Accounts Payable > A/P Transactions > Payment Entry.

Click here for help with the fields on the Payment Entry form.

Select an existing payment batch, or create a new payment batch.

3. [ Use the Entry Number field to create a new transaction, and enter a description for the

transaction, such as "Apply Prepayment to Inv 7764."

4. Choose Apply Document as the transaction type.

Fill in the following header fields on the Payment Entry form:
o Payment Date

o Posting Date

Vendor Number

(¢]

o

Remit-to Location

(@)

Payment Code

(¢]

Document Number
Select Mode

o

If you chose the Select Mode option:

a. Select the document type (All, Invoice, Debit Note), list order
(Document Number, PO Number, Due Date, Order Number,
Document Date, Current Balance), and an optional starting
number, balance, or date.

b. Click Go (s») to display the vendor's open documents of the
selected type.

c. Double-click in the Apply column to select Yes for each document
to which you want to apply the payment.

If you did not choose Select Mode:
a. Click the first blank line in the distribution grid, or press the Insert
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key to create a blank line.

b. Use the Finder in the Document Number column to select the
document to which you want to apply the prepayment or credit
note, or type the number in the Document Number field.

7. If you are issuing a payment that is not in your functional currency,
click the Rates button to check or edit the exchange rate used for this
payment.

8. To partially pay a document, type the amount to apply in the Applied
Amount column. You can post the transaction without fully applying
the prepayment or credit note, leaving some to be applied at a later
date. However, you cannot apply more than the total amount of the
payment.

9. If you need to adjust a document you are paying, click the Adjust
button to open the Miscellaneous Adjustment Entry form, then:

o Enter a reference and description for the adjustment.

o Enter the distribution code or general ledger account number for
each adjustment detail.

o Type the amount of each adjustment detail.
o Click Save, then click Close to return to the Payment Entry form.

Note that to use the Adjust button, you must have selected the Allow
Adjustments In Payment Batch option in the Options form.

0. When finished, click Add or Save to apply the prepayment or credit
note. (To cancel the application, click Close, or select another entry
number, then click No at the message that appears asking whether
you want to save your changes.)

[}l After saving an apply document transaction
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Apply a Payment or Credit Note to a Job-Related Invoice

[l Before you start

To apply amounts to details for different contracts, projects,
categories, and resources:

1. Display the payment, prepayment, or credit note in the Payment Entry
form.

2. In the detail-entry grid of the Payment Entry form, for the job-related
invoice you are paying, select Yes @ in the Apply column.

3. With the invoice selected, click the Jobs button.

4. On the Project and Job Costing Apply Details form that opens, enter
the amount to apply to the selected invoice, then, in the Apply Method
field, specify one of the following methods to apply the amount to
contracts, projects, categories, and projects that appear on the
invoice:

o Top Down

o Prorate By Amount

5. Select any details that are not being paid at this time, then click the
Clear button to remove the details from the distribution.

6. Click Close to return to the Payment Entry form.
7. Click Add or Save.
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Partially Pay a Job-Related Document

To apply partial payments to job-related invoices:

1.
2.

Open Accounts Payable > A/P Transactions > Payment Entry.

On the Payment Entry form, enter payment header details as usual,
including the vendor number, transaction date, year and period.

Select an apply method to use as the default for the current payment
entry.

Select the job-related invoice you want to pay as usual.

o If you use Select for the mode, click the Go button to display the
unpaid invoices for the selected vendor, then select Yes in the
apply column for the invoice.

o If you use Direct as the mode, enter the invoice number in the
document field in the detail grid, or use the Finder to choose the
invoice.

Enter the amount of your payment in the Applied Amount column for
the selected invoice, then tab out of the field.

If the Applied Amount is less than the current balance and you want to
select particular details to which to apply the partial payment or to use
a different apply method for this invoice:

a. Click the Jobs button to open the Project And Job Costing Apply
Detail form.

b. Select the apply method to use to allocate the partial payment to
invoice details.

c. Click the Go button to display the invoice details.

d. Select any details that are not being paid at this time, then click the
Clear button.

e. If you do not want to use an apply method to allocate amounts to
the details, enter the amount that you are paying for each invoice
detail. Ensure that the sum of the amounts applied to the details is
the same as the total applied to the invoice. For example, you
might need to adjust the amounts for an invoice that uses a



multiple payment schedule.

f. When you are finished, click Close to return to the Payment Entry
form, then click Save to save your payment entry.

7. Click Add.

[l Related topics
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Adjust a Posted Transaction

To add an adjustment:

1.

Open Accounts Payable > A/P Transactions > Adjustment Entry.

Click here for help with the fields on the Adjustment Entry form.

Select or create the adjustment batch to use.

3. To assign the entry number, click the New button beside the Entry

Number field.

Enter an optional description for the entry, then enter the adjustment
date, the posting date, the vendor number, an optional reference and
reference description, the document number to adjust (or select it
from the Finder), and the payment number (if the adjusted document
includes a payment schedule).

Use the Finder for the Adjust Line Number field to select a detail for
adjustment.

Include for each detail:
o The distribution code or the general ledger account number.

o The amount. (Enter a positive amount to reduce the balance of an
invoice or debit note, and a negative amount to increase the
balance of these documents.)

o If the adjustment is for a job-related document, the contract,
project, and category to adjust in Project and Job Costing.

7. If you use retainage accounting, adjust retainage as necessary.
8. Click Add.

The Add button changes to Save. If you make changes to the
adjustment after you have added it, you then choose Save to record
your changes.



Adjust a Document when Entering a Manual Check

[l Before you start

To adjust an invoice to which you are applying a manual check:

1. Open Accounts Payable > A/P Transactions > Payment Entry.

Click here for information on the fields that appear on the Payment

Entry form.
2. Display the batch and the payment you want to adjust.

3. Select the Print Check option.

4. Apply the payment as usual, and then, to adjust an invoice you are
paying:

a.
b.

C.
d.

Select (highlight) the invoice you want to adjust on the detail grid.

Click the Adjust button, and enter the adjustment details on the
form that appears.

Save the adjustment.
Click Close to return to the Payment Entry form.

5. Edit the payment once again to turn off the Print Check option and
enter the number of the check you issued.

[l Related topics
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Edit a Manual Check

If you do not select the Print Check option, you cannot edit a payment
after you save it. Accounts Payable assumes that a check with a number
has been printed.

If you need to edit the amount, you can:
e Delete the payment and re-enter it.
Or
e Zero the check number and select the Print Check option.

You can then edit the payment or adjust the invoice to which it is
applied, then save the payment.

After saving the changes, edit the payment again, this time turning off
the Print Check option and entering the check number.

[l Related topics
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Void a Printed Check

[l overview

To void a printed check:

1.

In Payment Entry, display the batch and the entry.

2. Select the check on the detail grid.
3.
4

. Click Yes when prompted, if you are sure you want to void this check.

Click the Void Check button.
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Reverse a Posted Check

You do not reverse posted checks in Accounts Payable. You must use
the Reverse Transactions form in Bank Services to reverse a posted
check.

When you post the reversal in Bank Services, you can choose whether to
reinstate the associated invoice in Accounts Payable, if the invoice
information still exists. You cannot reinstate an invoice if the vendor has
no record in Accounts Payable, however (for example, if you reverse a
miscellaneous payment to a one-time vendor).

Note: If your Sage ERP Accpac system uses security, you must have
authorization to use the Reverse Transactions form in that program.

For more information about reversing a posted check, see the Bank
Services help.

If you have not yet posted the payment, see Void a printed check.




Look Up Account Activity for a Vendor
To look up account activity for a vendor:
1. Open Accounts Payable > Vendors > Vendor Activity.

2. In the Vendor No. field, type the vendor number or select it from the
Finder.

3. If you use multicurrency accounting, select the currency in which to
display figures. You can choose Vendor Currency or Functional
Currency.



Look up Payment Information
To look up payments:
1. Open Accounts Payable > A/P Transactions > Payment Inquiry.

The Payment Inquiry form displays all payments as the default list.

2. [t select criteria to limit the list of payments, as needed.

3. Click the Go button (s») to display payments that meet the selected
criteria.

o To view a payment in the Payment Entry form, select (highlight)
the payment on the list, then click the Document button.

o To view details of the payment (including, in a multicurrency
system, any gains or losses on settlement of a document) in a
separate Payment Information form, select the payment, then click
the Open button.

o To print the Payment Inquiry report, click the Print button.
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Look Up Remit-to Locations for a Vendor
To display a list of remit-to locations for a vendor:
1. Open Accounts Payable > Vendors > Remit-to Locations.

Click here for help on the fields on the Remit-to Locations form.

2. Type the vendor number or select it from the Finder beside the
Vendor No. Field.

The Remit-To Locations columns display the remit-to location code,
the name of the location, and the address and zip or postal code for
each remit-to location record you have entered for the vendor.

To work with a remit-to location record from the list:
1. Select the location from the list, then click:
o Open to open the record for editing.
Or
o New to start a new remit-to location record for the vendor.
Or
o Delete to delete the remit-to location record.
2. Once you have displayed a record, you can:
©  Edit the location
o Start a new remit-to location @

When you open a record for editing or create a new record, you
can enter special instructions and the tax group that applies to the
remit-to location. This information appears as default entries when
you select the remit-to location while adding invoices, credit notes,
or debit notes for the vendor. (You change the information for a
particular document.)

o Delete a location
o View remit-to locations for a different vendor @

3. Click the tab you want to see. (Click the links shown above for
descriptions of tabs.)
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4. Click Add or Save to keep any changes you make.
Click Close to leave without saving changes.

[l Related topics
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View Document History when Applying a Payment or a
Credit Note

[l Before you start

To view the history of an invoice, credit note, or debit note while
applying a payment or credit note:

1. Select the document in the list on the Payment Entry form.
2. [ choose Yes iN the Apply column for the document line.
3. Click the History button.

The Document History form appears, providing & information about each document
that was previously applied to the selected invoice, credit note, or
debit note.

4. To see other columns or lines, click the arrows in the lower corners of
the form, or use the scroll bars.

5. You cannot change any of the information in this form.
6. Click Close to return to the Payment Entry form.
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Add, Edit, or Delete a Vendor Group

[l Before you start

You must add at least one Vendor group before you can add Vendor
records.

To add a Vendor group:

1. Open Accounts Payable > A/P Vendors > Vendor Groups.
Click here for help on the fields on the Vendor Groups form.

. Click the New icon (&) beside the Group Code field.

3. In the Group Code field, type the code for the new vendor group, and
then press the Tab key.

N

4. Fill in the fields on the Vendor Groups form.
. Click Add.

6. If you want to add another record:

ol

a. Repeat steps 2 through 4 to enter information for the new record.

o |If you want to reuse the information you entered for the
previous group, simply type the code for the new vendor group
in the Group Code field, then press the Tab key.

o |f you want to add vendor group that uses information from
another vendor group, display the record for the group you
want to copy, type the new vendor group code, and then press
the Tab key.

b. Enter any changes you need, then click Add to add the new group.

To edit a Vendor group record:
1. Open Accounts Payable > A/P Vendors > Vendor Groups.

2. [ use the Group code field tO display the record you want to edit.

3. Make the changes you need in the record.
4. When finished, click Save to record your changes.

To delete a Vendor group record:
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1. Open Accounts Payable > A/P Vendors > Vendor Groups.

2. Type the code for the vendor group you want to delete, select it from
the Finder, or use the navigation buttons to display the code you
need.

3. Click the Delete button.

4. If you see a message asking you to confirm that you want to delete
the record, click Yes.

[}l After modifying vendor group records

[l Related topics
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Add, Edit, or Delete a Vendor

[l overview

L] Before you start
To add a new vendor:
1. Open Accounts Payable > A/P Vendors > Vendors.
Click here for help on the fields on the Vendors form.
. Click the New () icon beside the Vendor Number field.

. In the Vendor Number field, type the code for the new vendor.

2
3
4. Complete the fields on the vendor record.
5. Click Add to add the new vendor.
6. If you want to add another record:

a. Repeat steps 2 through 4 to enter information for the new record.

o |If you want to reuse the information you entered for the
previous group, simply type the code for the new vendor group
in the Group Code field, then press the Tab key.

o |f you want to add vendor group that uses information from
another vendor record, display the record you want to copy,
type the new vendor group code, and then press the Tab key.

b. Enter any changes you need, then click Add to add the new group.
To edit or view an existing vendor record:
1. Open Accounts Payable > A/P Vendors > Vendors.

2. [ use the Vendor Number field tO dISpIay the record you want to edit.

3. Make the changes you need in the record.

4. When finished, click Save to record your changes.
To delete a vendor record:

1. Open Accounts Payable > A/P Vendors > Vendors.

2. Type the code for the vendor you want to delete, select it from the
Finder, or use the navigation buttons to display the code you need.
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3. Click the Delete button.

4. If you see a message asking you to confirm that you want to delete
the record, click Yes.

[}l After modifying vendor records

[}l Additional information

[l Related topics
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Add a New Remit-to Location for a Vendor

[l overview

[}l Before adding a remit-to location

To
1.

add a remit-to location:
Open Accounts Payable > Vendors > Remit-to Locations.

Click here for help on the fields on the Remit-to Locations form.

Type the vendor number (or select it using the Finder), then press the
Tab key.

The program displays a list of the remit-to locations that you have
entered previously for this vendor.

3. Click the New button to start a new remit-to location record.

4. in the Remit-To Location field, type a unique code to identify the remit-

© N o O

to location, then press the Tab key to move to the next field.
Type a description of the location.

Fill out the fields on each tab.

When ready, click the Add button.

When you have finished adding remit-to locations, click Close to
return to the list of remit-to locations, then click Close again.

edit an existing remit-to location:
Open Accounts Payable > Vendors > Remit-to Locations.
Click here for help on the fields on the Remit-to Locations form.

Type the vendor number (or select it using the Finder), then press the
Tab key.

The program displays a list of the remit-to locations that you have
entered previously for this vendor.

Select (highlight) the remit-to location you want to edit, then click
Open.

Make your changes.
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5. Click Save.

6. When you have finished editing remit-to locations, click Close to
return to the list of remit-to locations, then click Close again.

To delete a remit-to location:
1. Open Accounts Payable > Vendors > Remit-to Locations.
Click here for help on the fields on the Remit-to Locations form.

2. Type the vendor number (or select it using the Finder), then press the
Tab key.

The program displays a list of the remit-to locations that you have
entered previously for this vendor.

3. Select (highlight) the remit-to location you want to edit, then click
Delete.

4. If a message appears asking you to confirm the deletion, click Yes.

[}l After adding or modifying a remit-to location

[l Related topics
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Clear Obsolete Data from Accounts Payable

[l Before you start

To clear obsolete data:

1.

WD

5.

Choose A/P Periodic Processing > Clear History.

Click here for help on the fields on the Clear History form.

Select the types of records you wish to clear.

Specify the ranges for each type of record.

Type the dates or fiscal year and period for which to clear.
Click Process.

[}l Additional information

[l Related topics
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Remove Inactive Records from Accounts Payable

[l Before you start

To delete inactive records:

1.

WD

5.

Open Accounts Payable > Periodic Processing > Delete Inactive
Records.

Click here for help on the fields on the Delete Inactive Records form.
Select the types of records you wish to delete.

Specify the ranges for each type of record.

Type the range of dates for which to delete records.

Click Process.

If you do not want to delete all the types of records you select for the
same range of dates, use the form more than once, as needed to delete
each type of record for the applicable dates.

[}l After removing inactive records
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Import Information into Accounts Payable

To import account information or transactions:

1.

Create the file you want to import. You can create a template for an
import file by exporting a few records of the type you want to import,
then selecting Save Template during the exporting procedure and
entering a name for the template file.

Open the Accounts Payable form in which you maintain the data you
want to import. For example, to import vendor accounts, open the
Vendors form; to import invoices, open the Invoice Entry form.

On the File menu, click the Import command.

4. Type or select the file name and file type in the form that appears

next.

If you previously created a template for importing, choose the Load
Template button, then select the template file.

Choose the fields that you want to import and select from any other
options that appear. (You can save your choices as a template for the
next time you import records.)

Click OK to begin importing.



Change GIL Integration Options

L] Before you start

To change GIL integration options:

1. Open Accounts Payable > Setup > G/L Integration.
Click here for help on G/L Integration fields.

2. Use the Integration tab to change options that determine how and
when to process general ledger batches.

3. Use the Transactions tab to Change the & information that is included with general ledger

transactions.

4. When you are satisfied with your choices for G/L integration, click
Save, and then click Close..

[}l After changing integration options

[l Related topics
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Set or Change Program Options for Accounts Payable

L] Before you start
To set program options for Accounts Payable:
1. Open Accounts Payable > A/P Setup > Options.
Click here for help on the fields on the A/P Options form.

2. Click the tab that contains the options you want to change.
3. Make your changes.
4. Click Save to keep your changes.

Note: You cannot save most changes to the Options form if any other
Accounts Payable forms are open.

5. Click Close when you are finished or to leave the form without
changing any information.

[}l After changing options

[}l Additional information

[l Related topics
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Create Batches of Transactions for General Ledger

[*] pefore you start
To create G/L batches:

1. Open Accounts Payable > A/P Periodic Processing > Create G/L
Batch.

Click here for help on the fields on the Create G/L Batch form.

2. Select the @ wypes of posted batches from which to create transactions.

3. Select the posting sequence number through which to create
transactions for each batch type.

4. Click @ process.

[}l After creating a GIL batch

[}l Additional information
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Clear Obsolete Data from Accounts Payable

[l Before you start

To clear obsolete data:

1.

WD

5.

Choose A/P Periodic Processing > Clear History.

Click here for help on the fields on the Clear History form.

Select the types of records you wish to clear.

Specify the ranges for each type of record.

Type the dates or fiscal year and period for which to clear.
Click Process.

[}l Additional information

[l Related topics
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Remove Inactive Records from Accounts Payable

[l Before you start

To delete inactive records:

1.

WD

5.

Open Accounts Payable > Periodic Processing > Delete Inactive
Records.

Click here for help on the fields on the Delete Inactive Records form.

Select the types of records you wish to delete.
Specify the ranges for each type of record.

Type the range of dates for which to delete records.
Click Process.

If you do not want to delete all the types of records you select for the
same range of dates, use the form more than once, as needed to delete
each type of record for the applicable dates.

[}l After removing inactive records
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File 1099 Reports Electronically

L] Before you start
To create an electronic file for your 1099 forms:
1. Open Accounts Payable > A/P Periodic Processing > 1099 Electronic
Filing.
Click here for help on the fields on the 1099 Electronic Filing form.

2. Complete the header, transmitter, and payer fields according to IRS
requirements.

3. Click Generate to produce the electronic file.

4. Follow the instructions on FIRE system. Be sure to record for future
reference the name that the IRS assigns to your file. You will need the
name if you are required to submit a replacement file.

5. When you have finished, click Close.
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File a T5018 (CPRS) Information Return Electronically

[l Before you start

To create an electronic file for your T5018 information return:

1.

Open Accounts Payable > A/P Periodic Processing > T5018 (CPRS)
Electronic Filing.

Click here for help on the fields on the T5018 (CPRS) Electronic

Filing form.

Complete the header, transmitter, and payer fields according to
Canada Revenue Agency (CRA) requirements. You must complete
both the Transmitter Information and Payer Information sections, even
if the transmitter and payer are the same company.

Click Process to produce the electronic file.

4. Make a note of the name and location of the generated output file.

When you have finished, close the T5018 (CPRS) Electronic Filing
form.

[}l After you create the electronic file
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Revalue Transactions in Other Currencies

Overview

[l Before you start

To revalue transactions:

1.

Open Accounts Payable > Periodic Processing > Revaluation.

Click here for help on the fields on the Create Revaluation Batch form.

Indicate whether to do a & provisional revaluation OF &N & actual revaluation.

3. For each currency you wish to revalue, use one line on the grid to

4.

enter the following information:

[ Currency.

[}l Revaluation date.

[t Earliest backdated activity date.

[l Rate type.
[}l Rate date.

[ Exchange rate.
To change the optional fields and values for a particular line or to

delete optional fields, either double-click in the Optional Fields column
for the line or select the ”ne, then @ click the Optional Fields column heading.

Tip: Enter the revaluation information, then select the Provisional
Revaluation option to do a test run before performing the next step.

Click Process.

[ After creating a revaluation batch

[}l Related information
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Start a New Fiscal Year

[l overview

L] Before you start
To start a new fiscal year:
1. Open Accounts Payable> Periodic Processing > Year End.

Click here for help on the fields on the Year End form.

2. [ select the options YOU Want to include in year-end processing.
3. Click Process.
4. When finished, click Close.

[}l Additional information
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Add or Modify a Distribution Code

[}l Before adding or modifying a distribution code

To add a distribution code:
1. Open Accounts Payable > A/P Setup > Distribution Codes.

Click here for help on the fields that appear on the Distribution Codes
form.

2. On the Distribution Codes form that appears:

o In the Distribution Code field, type the code to identify the
distribution.

o In the Description field, type a description of the code.

o |n the General Ledger Account ﬁeldS, enter the @ account numbers to which to
post transactions that use the distribution code.

If you use Sage ERP Accpac General Ledger with your Accounts
Payable database, you can use the 1 einder @) to Select the general
ledger accounts from a list.

o Sp@ley a [ default discount status fOr the distribution code.
3. When finished, click Add.

To edit a distribution code:

1. Open Accounts Payable > A/P Setup > Distribution Codes.
2. Select the distribution code you want to change.

3. Make your changes.

4. Click Save.

To delete a distribution code:

1. Open Accounts Payable > A/P Setup > Distribution Codes.
2. Select the distribution code you want to delete.

3. Click Delete.

If a message appears asking you to confirm the deletion, click Yes.

[}l After adding or modifying distribution codes
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[}l Additional information

[l Related topics
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Add or Modify an Optional Field

[l overview

[}] Before adding or modifying an optional field

To set up an optional field for use in Accounts Payable:

1.

Open Accounts Payable > A/P Setup > Optional Fields.

Click here for help on the fields on the Optional Fields form.

In the Optional Fields For fleld, select the @ type of record or transaction fOr which
you are defining the optional field.

Use the Finder to select the optional field code (& or codes) YOUu want to
use for the selected type. The program displays the description for the
optional field.

Note: If you want to retain Accounts Payable optional field
information when you create batches for General Ledger, you must
use the same optional fields for transactions in Accounts Payable as
you use in General Ledger.

If you want to specify a default value for the optional field:

a. In the Value Set field, double-click the Value Set column to set field
to “Yes.”

b. In the Default Value field, @ enter or select the vaiue that the program will
display as the default for the optional field.

When you specify a value from Common Services, the program
displays the description for the value.

Double click the Required field to indicate whether the optional field

must be used in the records and transactions for which it is created.

During data entry, if an optional field is required and does not have a
default value, you must fill in the field before you can proceed.

Select Yes in the Auto Insert field to display the optional field and its
default value when you set up new records or enter transactions on
the form for which you are defining the optional field.

Click the Settings button, if it is available, t0 & specify additional settings fOr the
optional field.
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8. Click Add (or Save).
To edit an optional field:
1. Open Accounts Payable > A/P Setup > Optional Fields.

2. Select the @ type of record or transaction fOr Which you want to edit the optional
field.

3. Make the changes you need on the grid.

4. Use the Settings button to select the type of General Ledger accounts
to which optional field information can be passed, or to indicate
whether optional field information can be passed to Project and Job
Costing.

5. Click Save to record the changes.
To delete an optional field:
1. Open Accounts Payable > A/P Setup > Optional Fields.

2. Select the type of optional field in the Optional Fields For field, and
then select (highlight) the optional field that you want to remove on
the grid.

3. Click the Delete button, or press the Delete key on the keyboard.
If a message appears asking you to confirm the deletion, click Yes.

[}l After adding or modifying an optional field

[}l Additional information
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Add or Modify a Terms Code

[}l Before adding or modifying a terms record:

To add a terms record:

1.

7.

Open Accounts Payable > A/P Setup > Terms.

Click here for help on the fields on the Terms form.

In the Terms Code field, enter the identifying code, then press the Tab
key and enter a description for the terms code.

For the @ calculate Base For Discount With Tax option, SpeCify whether to include tax
amounts in the invoice totals on which discount amounts are
calculated.

If you want to allow payment by installments with this code, select the
Multiple Payment Schedule option. Then select the due date type and
enter information for each payment.

In the Due Date Type field, @ select the method By Which you calculate
invoice due dates.

In the Discount Type field, @ select the method YOU USE tO calculate the last
day on which your vendors let you take a discount for prompt
payment. If your vendors do not offer discounts, ignore the discount
fields and columns.

Click the Add button.

To edit a terms code:

1.
2.
3.
4.

Open Accounts Payable > A/P Setup > Terms Codes.
Select the terms code you want to change.

Make your changes.

Click Save.

To delete a terms code:

1.
2.
3.

Open Accounts Payable > A/P Setup > Terms Codes.
Select the terms code you want to delete.
Click Delete.
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If a message appears asking you to confirm the deletion, click Yes.

[}l After adding or modifying payment terms

[}l Additional information

[l Related topics
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Add or Modify a Payment Code

[}l Before adding or modifying a payment code

To add a payment code:

1.

4.
5.

Open Accounts Payable > A/P Setup > Payment Codes.
Click here for help on the fields on the Payment Codes form.

In the Payment Code field, type an identifying code, using up to six
characters, and then press the Tab key.

Type a description for the payment code, such as the name of the
credit card.

For the payment type, select Cash, Check, Credit Card, or Other.
Click Add.

To edit a payment code:

1.
2.
3.
4.

Open Accounts Payable > A/P Setup > Payment Codes.
Select the payment code you want to change.

Make your changes.

Click Save.

To delete a distribution code:

1.
2.
3.

Open Accounts Payable > A/P Setup > Payment Codes.
Select the payment code you want to delete.
Click Delete.

If a message appears asking you to confirm the deletion, click Yes.

[l After adding or modifying payment codes

[l Related topics
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Add or Modify an Account Set

[l Before you start

To add a new account set:

1.

Choose Account Payable> A/P Setup > Account Sets.
Click here for help on the fields on the Account Sets form.

In the Account Set Code field, type a unique code, using up to six
characters, to identify the account set.

In the Description field, type a description of the account set.

4. Type or Hselect the general ledger account numbers that make up the

5.

set.

In a multicurrency account set that does not use the functional
currency, you must also enter the currency code and account
numbers for the unrealized exchange gain, unrealized exchange loss,
realized exchange gain, realized exchange loss, and exchange
rounding accounts.

You cannot change the currency code assigned to an account set
after you add the set.

When finished, click the Add button.

To edit an account set:

Open Accounts Payable > A/P Setup > Account Sets.
Select the account set you want to change.

Make your changes.

Click Save.

To delete a terms code:

1.
2.
3.

Open Accounts Payable > A/P Setup > Account Sets.

Select the account set you want to delete.

Click Delete.

If a message appears asking you to confirm the deletion, click Yes.
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[}l After adding an account set
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Export Accounts Payable Information

To export Accounts Payable information:

1.

Open the form or form that displays the kind of data that you want to
export.

If necessary, create the records you wish to export. For example, to
export an invoice batch, create the batch in the Invoice Entry form,
export it.

On the File menu, click the Export command.

4. On the form that appears, select the type of information to export, or

choose Load Template to use an export template you created
previously that matches the information you want to export.

5. To limit the range of records to export, use Set Criteria.

6. In the next form, enter the export file name and file type. If you

frequently export information with these specifications, use the Save
Template button to create an export template that you can use next
time you export the data.

When ready, click OK to begin exporting.

If you specified a non-existent folder and file, Accounts Payable asks
whether to create them.



Use a self-assessed tax

[l overview

To create and use a self-assessed tax:

1.

N o g &

In Tax Services create two new tax authorities:

o Authority 1 is the tax expense. This tax can be distributed with the
invoice amount or expensed separately to a tax expense account.

o Authority 2 is the tax payable. Specify that this tax is expensed
separately to the tax payable account.

Create Purchases tax classes for vendors and items for both tax
authorities.

Enter tax rates for purchases for each of the authorities:
For authority 1 specify the tax rate as you would for any other tax.

For authority 2 specify a negative tax rate of the same amount that
you specified for authority 1.

The two taxes will cancel each other and not add to the value of the
invoice.

Add both taxes to the tax group you want to use for the vendor.
Specify the self-assessing tax group when you add an invoice.
Make sure that you are using the same tax class for both taxes.

If you are not calculating tax, enter a positive tax amount for authority
1 and a corresponding negative amount for authority 2 on the Vendor
Taxes tab.

If you are calculating tax, set the two taxes to "No" for Tax Included.
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Choose Printers for Reports

Sage ERP Accpac lets you choose a default printer for all reports that
you print, and assign different printers to specific reports (such as
invoices or labels).

To change the default printer for all reports:

1. On the Sage Accpac desktop, select File > Page Setup.

2. Click the Printer button.

3. Choose the printer that you want to use from the drop-down list.

The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.

4. Click the Properties button to change available settings for your
particular printer.

5. Click OK to return to the Page Setup form.

6. Click the Print Destination button and check that the print destination
IS set to printer.

If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination

page.
7. Click OK on the Print Destination Page, and then Click OK on the
Page Setup page.

To assign a specific report to a specific printer:
1. Open the report form which you want to assign to a printer.
2. Select File > Print Setup from the report form menu.

3. Choose whether you want to choose the printer that is set as the
Windows default printer, or choose a specific printer for this report.

Note: By default, the specific printer is the one chosen as the printer

on the Page Setup form selected from the File menu on the Sage
ERP Accpac Desktop

The printer list includes all printers that have been added to the



Printers and Faxes list in Windows.

4. Click the Properties button to change available settings for your
particular printer.

5. Choose a paper source if you want to select a particular paper tray or
paper stock for this report.

6. Click OK Page Setup page.

[l To clear the assigned printer for this report

[t] Prompt for printer each time you print

[l Related topics
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Display Reports on the Screen

Sage ERP Accpac lets you print reports to a printer, to the screen, to a
file, or as an attachment to an e-mail message.

Note: You must be assigned to a security group that has been assigned
permission to change the print destination. (Otherwise, the only
destination available will be to a physical printer.)

To change the default print destination to Preview:
1. On the Sage Accpac desktop, select File > Print Destination.
2. Select Preview to view a report on the screen.

You can print from the Preview window by clicking the Printer button,
and you can e-mail the report.

3. Click OK.

[}l Additional information regarding print destinations

[l Related topics
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Display a List of Fields You Can Import and Export
] overview
To display a list of the fields you can import and export:

1. Open the record or transaction-entry form for the type of record or
transaction you want to import or export.

2. For transaction fields, display an existing batch using the Batch
Number field.

3. From the File menu, click Import or click Export.

4. If a File Import/Export Selection form appears (for example, if you
clicked Import or Export on the Vendors form), select the type of
record to import or export, and then click OK.

5. On the form that appears, click Display Import Fields or Display
Export Fields to display the name, type, and length of each field in the
record that you can import or export.
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Glossary

1099 Form

AR Invoice Type

Account Description
Account Groups

Account Number Segment Overrides
Account Number Segments
Account Number Structures
Account Segment

Account Set

Account Status

Account Types

Accounting Equation
Accounting Method
Accounting Period
Accounts Payable

Accrual

Accrual Carry-Over Date
Accrual Method
Accrual-Basis accounting method
Accrued Expenses
Activating taxes

Activation

Active Order

Actual Fiscal Sets
Adjustment Period
Adjustments

Advance

All Users

Allocated Tips

Allocation Account

Allow Posting to Previous Years
Allow Provisional Posting
Annual Maximum
Annualization

Assets

Assign Ul Profile IDs

Audit Trail

Authentication Method
Automatic Reversal
Backdated document

Bad Debts

Balance Sheet

Base Account

Base Deductions

Base Earnings

Base Hours

Base Taxes

Base Wage Multiplier

Basic Account Information
Basic Project style

Batches

Benefit

Billing Type

Billings And Costs accounting method
Budget Fiscal Sets
Calculation Base
Calculation Methods
Calculator

Carrying Over Vacation, Sick, and Compensatory Time Accruals
Carry-Over

Cash Advance

Cash Benefit

Cash Flow Statement
Cash Method

Category

Category Percentage Complete accounting method
Ceiling

Chart of Accounts

Class Codes

Classified Statements
Clearing Exchange Gain or Loss
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Close to Segment / Account
Closing Account

Closing Period

Closing the Books
Common Stock

Company Database
Company Desktop
Company Profile
Compensatory Time
Completed Project accounting method
Consolidated Batch

Control Account

Control Account for Subledgers
Conversion Rate
Corporation

Cost Accounting

Cost Center Overrides

Cost Center Segments
Cost of Goods Manufactured
Cost of Goods Sold

Cost Plus project

CPRS

Credit

Currencies

Currency Rate Type
Currency Rates

Currency Table

Current Assets

Current Liabilities

Custom (and Local) Taxes
Customization Directory
Customize User Interface
Database

Database ID

Date Matching

Debit

Decimal Places for Quantity
Deduction

Default Closing Account
Default Currency

Default Hours

Default Rate Type

Default Source Code
Defining a Source Journal
Defining Meaningful Account Number Segments
Delimiter Character
Depreciation

Detail and Consolidated Posting Options
Detailed Batch

Details

Direct Labor Costs
Distribution Accounts
Distribution Code
Distribution Set

Dividend

Drilldown
Earning/Deduction
Earning/Deduction Frequencies
Earnings

Edit Imported Entries
Effective Date

Employee History
Employee Level Security
Employee Selection List
EMU

Equity

Euro Conversion Rates
Euro Currency

Euro Option

Exchange Gain or Loss
Exchange Rate

Expense Reimbursement
Expenses

Exporting

Factory Overhead


javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

Federal and State Taxes
Field

Financial Statements
Finder

Fiscal Calendar

Fiscal Periods

Fiscal Sets

Fiscal Year

Fixed Assets

Fixed Price project

FOB Point

Force Listing of Batches
Foreign-currency Bank
Functional Currency
Functional Currency Code
Functional-Currency Equivalent
Future Order

G/L Batch

G/L Options -- Account tab
G/L Options -- Company tab
General Ledger Account
Gross Pay

Gross Profit on Sales
History

Imported Account Data
Imported Batches
Importing

Income

Income Statement
Information in G/L Accounts
Integration Access Pack
Integrity Check

Inventory

Invoice Type

Journal

Journal Entry

Labor Hours Percentage Complete accounting method
LanPak

Last Run Date

Last Year Information
Ledger

Level

Liabilities

Local and Other Custom Taxes
Lock Budget Sets (1-5)
Long-Term Liabilities
Lookup Table

Macro

Maintain Quantities Options
Manual Check

Matching Concept

Menu Bar

Miscellaneous Charge
Multicurrency Accounting
Multicurrency Bank
Multicurrency Fiscal Sets
Multicurrency G/L Accounts
Multicurrency G/L Option
Net Pay

No Users

Normal (Account) Balance
Number of Fiscal Periods
Optional Fields

Original Invoice

Override Segments
Overtime Rate Multiplier
Overtime Schedule

Owner Equity

Partnership

Pay Factors

Payroll Class Codes
Payroll Distribution Accounts
Period Minimum and Period Maximum
Periods Per Year

Picking Slip


javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

Post in Specified/All Currencies
Posting

Posting Statistics

Posting tab in G/L Options
Preferred Stock

Prepaid Expenses

Price List

Printing Scheduled Reports
Printing Source Journal Definitions
Profile ID

Profit

Profit and Loss Statement
Profit Center

Programs (Applications)
Project Percentage Complete accounting method
Project Type

Provisional Fiscal Sets
Provisional Posting

Provisional Posting Journal
Quantities in G/L Accounts
Quantity Fiscal Sets

Quarter With 4 Periods

Quote

Rate Operation

Rate Type

Rates

Realization

Realized Exchange Gain or Loss
Reallocation Account
Recognized Exchange Gain or Loss
Reconcile (Bank)

Record

Record of Employment
Recurring Transaction

Remit-to Location

Repayment Deduction
Reported Tips

Reporting Currency

Restart Record

Retainage Accounting
Retainage Invoice

Retained Earnings

Revaluation

Revaluation Codes

Revenues

Reversed Unrealized Exchange Gain or Loss
Salary and Wages

Salary and Wages Payable Account
Sales

Sales Table

Sample Account Segments
Schedule Code

Schedule Reports

Schedule Transactions

Script

Security Group

Segment Codes Validation
Selection List

Service Years

Services

Session Date

Settlement Rate

Settling Transactions
Shareholders

Shareholders' Equity

Shift Differential Rate

Shift Differential Schedule
Ship-Via Code

Sick Time

Sole Trader

Source Codes

Source Currency

Source Document

Source Journal Profiles

Source Journals and Consolidated Transactions
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Specific User

Spread

Standard Project style
Standing Order

Statement of Retained Earnings
Status

Stock

Subsidiary Ledger

Surtax Multiplier

Suspense Account

System Database

Tax Authorities

Tax Classes

Tax Groups

Tax Tables

Template (employee setup)
Time And Materials projects
Timecards

Tip Disbursement

Total Cost Percentage Complete accounting method
Transaction Rate Type

Trial Balance

Type

Ul Profile ID

Ul Profile Maintenance
Unrealized Exchange Gain or Loss
User Authorization

User Record

Vacation Time

Wage Bracket Table

Wage Garnishment

Web Desktop

Withdrawal

Workers' Compensation Code
Worksheet

Years of Fiscal Sets

Years of Transaction Detail
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New Features in Version 5.6

New features added to Account Payable 5.6 include report changes, new
check sorting options, improved prepayment functionality, and a new
T5018 (CPRS) Electronic Filing form.



Report Changes

Sage Accpac version 5.6 includes global enhancements to all reports that
allow you to save parameters easily and export reports into Microsoft
Excel.

The Aged Cash Requirements and Aged Payables reports now have
better visibility for adjustments as they can be reported as regular
documents as well as in applied details. These reports can now be sorted
by transaction type and have an easier way to identify miscellaneous
payments. Both the Aged Cash Requirements report and Aged Payables
report include an option to show Aged Retainage on the report.




Check Sorting

Accounts Payable now allows you to sort checks during print runs. Using
the Sort Checks by list on the Transactions tab of the A/P Options form,
you can sort by:

e Vendor Number

e Payee Name

e Payee Country

e Payee Postal Code

e Transaction Entry Number

The selection becomes the default sort order when printing checks.



T5018 (CPRS) Electronic Filing

A new T5018 (CPRS) Electronic Filing form is now available in the
Periodic Processing folder.

If you file more than 50 T5018 slips for a calendar year, the Canada
Revenue Agency (CRA) requires you to file original and amended T5018
information returns over the Internet. You use the new T5018 (CPRS)
Electronic Filing form to create your T5018 information return in the
required XML format. You can then submit the generated file using the
CRA's Internet File Transfer application. If you are filing fewer than 50
slips, you can submit the file to the CRA on electronic media.



Prepayments

You can apply payments to existing Purchase Orders when you prepay a
vendor. The previous functionality required a manual entry of the PO
number if the Purchase Order was posted but not invoiced.



Features Added in Accounts Payable 5.5

Here is a summary of the changes and new features in Accounts Payable
5.5.

[}l we introduce the most sophisticated treatment of currency revaluation on the market.

[}l New accounts accommodate changes to revaluation.

You can process advance credits in Payment Entry in all series of
Sage ERP Accpac.

There is a & new posting date field for transactions.

[}l You can specify source codes for transactions.

[}l You can specify different accounts when entering transactions.

You can apply credit notes to fully paid documents. (Previously, the
document had to be unpaid.) You can also apply a debit note to a fully
applied credit note.

[}l You can specify particular accounts for distribution sets.

We have improved [}l integration with Project and Job Costing.

[}l Keeping history is now automatic in Accounts Payable.

Batch entry counts and batch totals appear on all transaction entry
forms.

A new option lets you set the default tax class to 1 (instead of the
vendor's tax class) for document details.

There are a @ number of enhancements to recurring payables.

YOU can NOW [ list documents in ascending order or descending order in the Vendor ACthlty
form.

When you print voided checks, the printed check includes ***VOID***
above the payee.

The Aged Payables and Aged Cash Requirements reports are
available only in letter format. (Previously, a legal-size report that
contained the same information was also available.)

You can include group subtotals when you use sorting criteria to print
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the Aged Payables, Overdue Payables, Aged Cash Requirements,
Vendor Transactions, and Aged Retainage reports.

e The new Print 1099/1096 Forms icon, available in the A/P Vendor
Reports folder, lets you print 1099 and 1096 forms for reporting
amounts paid to vendors in the U.S. The Print T5018 (CPRS) Forms
icon lets you print CPRS amounts on the T5018 required for
Canadian filing. (Previously, you used the 1099/CPRS Forms icon to
print these forms for both jurisdictions.)

e The 1099/CPRS Amounts form has been renamed 1099/CPRS
Inquiry. Also, you can now print a report with the same information
that is displayed on the Inquiry form.

¢ When you reverse a miscellaneous payment, the associated invoice
Is reversed automatically, too.

¢ You can post batches at the same time others are posting batches,
but you cannot post batches that others are using.

¢ You assign separate security authorization to post batches and to
enter them (as required under Sarbanes-Oxley legislation), if you use
security with your system. (Previously, having authorization to post a
certain type of batch also gave you authorization to view and enter
and edit transactions in that type of batch.)

® [} Accounts Payable now integrates with Sage FAS.

Note: You cannot convert from ACCPAC Plus for DOS to this version of
Sage ERP Accpac .

Upgrading from an Earlier Version?

If you are upgrading from version 5.3, see Changes introduced in
Accounts Payable 5.4
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Changes in Accounts Payable 5.4

Accounts Payable version 5.4 introduced a number of exciting changes
and new features!

Click the name of an Accounts Payable form or the type of change,
below, to see a summary description of the changes.

[}l Account Sets

[ Adjustment Entry

[}l Aged Cash Requirements Report

[}l Aged Payables Report

[l Check Printing

[}l Checking Data Integrity

[t control Payments

[t create Payment Batch

[}l Delete Inactive Records

[ Distribution Sets

[l E-Mail Messages / Letters/Labels

[ G/L Integration

[ Invoice Entry
[ Optional Fields

[ Options

[}l overdue Payables Report

[ Payment Batches
[ Payment Codes

[ Payment Entry

[}l payment Selection Codes

[}l Project and Job Costing

[}l Recurring Payables

[}l Remit-To Locations
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I Terms

[}l Transaction Batches

[}l vendors and Vendor Groups

[t vendor Activity

[}l 1099 Electronic Filing

[}l 1099/CPRS Amounts
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Find Command a or [

The Finder is a tool for looking up records using the key fields of Sage
ERP Accpac records. When you click the Finder button, a form appears
that displays the records you can choose from.

Use the Finder form to:

e Search for a record.

e Select a record for use.

e Set criteria (restrictions) for displaying records.
e Remove criteria for displaying records.

To search for a record

1. Click on the arrow in the Find By field to choose a search topic.
(These will vary; in our example below, the choices relate to currency
because we are using Currency Codes for our search.)

2. From the next field, choose either Starts With or Contains.

3. If you chose Starts With, type the first letter or number in the record
you are searching for. If you chose Contains, type some of the letters,
numbers, or words in the record you are searching for.

When you select the Auto Search option, the Finder will run the
search as you are typing.

If you clear the Auto Search option, you must choose the Find Now
button to start the search.



Go Command s or I

Sage ERP Accpac uses the Go button where you must fill in a number of
fields before the program can select a particular item.

For example, you may have to select a vendor number, document type
and order, and starting document number before Accounts Payable can
display the correct data. When you have made your selections, you click
Go or press F7.



Zoom In/Out Command . or I

This command opens separate Zoom forms that are associated with
particular data entry fields, such as the Remit-to field in the Invoice Entry
and Payment Entry forms.

You can also use the command to open the Vendor Information form you
can reach from the Vendor number field in the Invoice Entry and Payment
Entry forms.

Press F9 to close the Zoom form.



New Button &

Click & to begin creating a new record.



Changing Column Order in Data Entry Forms

You can change the order in which columns appear on many Sage ERP
Accpac forms.

For example, you can change the order of the Payment Entry detalil
columns to match the field order of a document from which you are
entering data.

To move a column

Q. Component [bern Nurmber I Descrption 1. Component's BOR NJ‘nEEr Component's BOM Murnber

Fluorezcent Dezk*Lamp

e Point at the column heading.
e Hold down the left mouse button
e Move the column to its new location
e Release the button.
To restore your original settings

e From the Sage ERP Accpac Desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.

The columns will be in the original order the next time you open the form.

12 Related Topics
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Changing Column Widths in Data Entry Forms

Double clicking on the division between columns resizes the column on
the left to its minimum size based on the data it contains.

[ ® G/ Account | Account Description '+' amount [ Dist__ | in__|
([0 e T | 500 | |

To change the width of columns

ePosition the mouse pointer on the vertical line separating a column
heading from the next heading to the right.

eDrag the column to the right (to make the column wider) or to the left
(to make it narrower).

*\When you reach the width you want, release the mouse button.
To restore your original settings

eFrom the Sage ERP Accpac Desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.

12 Related Topics
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Use this command to print the report for the open form you are using.
For example:
e |f you are in a report form, choose the command to print the report.

e |f you are using Invoice Entry, Payment Entry, or Adjustment Entry,
choose the Print command to open the Batch Listing form which lets
you select the listings to print for unposted batches.

e If you are in the Vendors form, use the command to open the Vendors
(reports) form, then choose whether to print the Vendors, Vendor
Period Statistics, or Vendor Activity Statistics report.

For further information about reports, see Accounts Payable reports.




Printer Setup

Use this command to set up your printer. You can select the default
printer or select another from the list of installed printer names.

For further information about printer options, see the Windows manual.



Customize

Use the Customize command in the File menu of an open form to hide
fields for users assigned to a Ul Profile ID for that form. When these

fields are hidden, data that would normally appear in these fields cannot
be printed.

For more information, see the Ul Profile Maintenance topic in the System
Manager help.



Use the Import choice to transfer data such as vendor account master
information and transaction batches from non-Sage ERP Accpac
programs to Accounts Payable. Transferring this information to Sage
ERP Accpac is called importing.

One common use of the import command is to import setup records or
transaction batches from other Sage ERP Accpac applications and non-
Sage ERP Accpac programs.

For more information, see the System Manager help.

12 Related Topics
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Accounts Payable lets you export data such as batches of transactions to
files that can be read and used by other programs. Transferring this
information from Sage ERP Accpac databases is called exporting.

For more information, see the System Manager help.

12 Related Topics
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Close

Double-click the top left corner of the form or use the File, Close
command to close the current form.

If you are editing a record, Sage ERP Accpac will ask you whether you
want to save your changes or cancel them.

Shortcut keys: Ctrl + F4



Using Help

Welcome to Sage ERP Accpac online Help for Accounts Payable!
For help on using Sage ERP Accpac

*Click Help Topics on the Help menu on the Sage ERP Accpac
desktop, or

ePress F1 in your browser from an open form.
To view the Help contents for a specific module

*Open a form for the module, then click Contents on the module's Help
menu or press F1.

For help about the Sage ERP Accpac desktop

¢Click the What's This command from the Help menu or click the
Context Help button.



Designing Accounts Payable Coding Schemes

Before you can use Accounts Payable, you must add codes to identify
the account sets, distribution codes, vendors, and other records you will
add to your system. You should take the time to design sensible coding
schemes for each type of code you require, before you start assigning
codes to records.

If you already have a system for the most of these codes, you may be
able to continue with the same system. Check the list below to see
whether each code type allows for the number and type of characters you
use in your current system.

Codes used in Accounts Payable

Maximum
Number of
Code Name Characters

Account set code 6 digits and letters
1099/CPRS code 6 digits and letters
Distribution code 6 digits and letters
Distribution set 6 digits and letters

Payment selection

code 6 digits and letters

Recurring Payable

15 characters
code

Remit-to location
6 characters
code

Terms code 6 digits and letters

Vendor group

code 3 digits and letters

Vendor number 12 characters

If you are designing new codes, you should assign codes that make it



easy to identify each record type and that list records in the order you
want them to appear on reports and in Finder windows.

Each code is a unique set of letters, symbols, and digits. For example,
each of the following could be a valid vendor number:

123
123A
AB1234
Al

AO01

To simplify codes, we recommend that you:

¢ Use the same number of characters in all codes of the same record
type.

e Where permitted, define codes of at least three characters to allow for
future expansion.

e Use a numbering system that is significant for your business, such as
a geographical region or division or vertical market.

¢ |f possible, use only numbers (not letters or symbols), for consistency
of sorting.
Sorting order of codes

Accounts Payable sorts codes on screens and reports in a specific order,
which you should take into consideration when designing codes.

The program reads codes from left to right, and uses the following
sequence to put them in order:

[Blank] '"#$% &' ()*+,-./0123456789:;,<=>?@ABC
DEFGHIJKLMNOPQRSTUVWXYZ[\]*"_"abcdefg
hijklmnopqgrstuvwxyz{|}~

The codes listed in the introduction to this discussion would be sorted by
the program into the following order:

123
123A
Al



AO01
AB1234

You should use the same number of characters in all your codes;
otherwise, you get number sequences as shown next.

100
10000
19

2
2000

& Related Topics
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Setting Up Vendor Groups

You use vendor groups to classify your vendor records into groups that
share similar characteristics. You must define your vendor groups before
you can add vendor records.

Vendor groups provide the following features. They let you:
e Set default entries to speed up the task of adding vendor records.

e Select accounts for payment. (The vendor group is one of the
selection criterion.)

e Select vendors on reports. (Vendor transactions, aged payables, aged
cash requirements, letters, and labels can all be printed for a range of
vendor groups.)

You can add as many vendor groups as you need, but you must add at
least one group.
Adding vendor groups

You must define at least one Vendor Group, and you may define multiple
vendor groups.

You use the Vendor Groups form to define the vendor groups you need.

To define a vendor group, you must
e Assign a unique code, up to three characters, to identify the group.

e Select the account set, terms code, and bank code you want to use
as the default selections for the vendor records you will add to the

group.
e Specify the method for distributing transactions to general ledger

accounts. You can distribute invoices by distribution set, distribution
code, or general ledger account.

e Once you select the method, you must specify a default code for the
method. For example, if you select G/L Account, you must specify the
default general ledger account to which you want distributions made.

e Specify the default rate type for vendors in the group (if you have a
multicurrency ledger).



e Choose whether to check for duplicate invoices with the same vendor
and amount or same vendor and date.

e Choose whether to generate separate payments for each invoice, or
pay several invoices with a single check.

o Set default entries for vendor optional fields.

e Select the default tax group for vendors in the vendor group. You must
also enter a tax class for each tax authority in the group, and indicate
whether tax is usually included in the invoice details.

e Specify whether the vendors in this group are subject to 1099/CPRS
reporting. (You can override this choice for individual vendors.)

Vendor group statistics

Accounts Payable keeps statistics for vendor groups, and displays them
in the Vendor Groups form. You can display the statistics by the type of
year and period specified in the Options form for vendor statistics.

For each group, Accounts Payable lists the amount and number of
invoices, payments, discounts taken, discounts lost, credit notes, debit
notes, adjustments, and total paid invoices. Accounts Payable also
calculates and displays the average payment amount, the total days to
pay, and the average days to pay for the group.

You can edit the statistics in a vendor group if you select the Allow Edit
Of (vendor) Statistics option in the Options form.

Accumulating tax amounts

The totals kept for invoices, credit notes, and debit notes can include or
exclude any tax amounts that were posted with the documents,
depending on the choice you enter for the Include Tax In Statistics option
in the Options form.



12 Related Topics
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Setting Up Payment Selection Codes

When you create an automatic payment batch with Accounts Payable,
you must tell the program how you want it to select vendors and invoices
for payment. The way you do this is with a payment selection code.

Payment selection codes are identified by codes of up to six characters
(letters and digits). The rest of the selection record defines the criteria for
selecting — or excluding — vendor invoices for payment.

Payment selection codes define the following elements:
e The bank on which the checks are drawn.

e How you select invoices (by due date, discount date, or due date and
discount date).

e Whether you pay all documents or forced documents only.
e The range of vendor groups.

e The range of vendors.

e The range of account sets.

e The range of check amounts (for example, so you could pay all the
small outstanding amounts first).

e Vendors you want to exclude from the payment selection.
e The bank currency (multicurrency ledgers only.
e The vendor currency (multicurrency ledgers only).

e Exchange rates between the bank currency and functional currency
and between the vendor currency and functional currency (if you have
a multicurrency ledger).
Using payment selection codes

You create payment selection codes using the Payment Selection Codes
form.

You cannot use the Create Payment Batch form to generate checks
unless you have defined at least one payment selection code.

You can change the payment selection criteria after you enter the



payment selection code in the Create Payment Batch form. So, if your
payment selection needs are fairly simple (for example, if you use only
one bank and have a small number of vendors), you may define only one
code and modify it if you are generating a special check run.

& Related Topics
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Accounts Payable Reports

Accounts Payable Reports are divided into the following categories:
[ Setup reports
that list the information entered to define your Accounts Payable system.

e [ vendor Reports that list information about your vendors and vendor
groups.

e [ Transaction reports that provide you with transaction listings and status
information, and reports that you can use to interpret, analyze, and
summarize your data.

If you have a multicurrency ledger, some of these reports can also
include source and functional-currency (home-currency) information.
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Recurring Payables — Overview

If you have vendors who issue standard invoices at regular intervals,
such as rent, standing orders, or services that vary little from period to
period, you can set up records for the payables using the Recurring
Payable Setup form.

You can also attach schedules with reminders to alert specific or all
Sage ERP Accpac users to process the recurring transactions when
they are due.

You use the Create Recurring Payables Batch form to create an
invoice batch automatically when the payables are due. If a recurring
payable record uses a schedule with a reminder attached, you can
also process the payable right from the Reminder List. For more
information about creating schedules and using the Reminder List, see
the System Manager help.

There are two processes involved in creating recurring payables:

e First, you set up a recurring payable record with the information that
Accounts Payable needs to create invoices periodically.

e Later, you use the Create Recurring Payable Batch form or the
Reminder List to create payable invoices.

Specifying when to invoice recurring payables

You can set up a recurring payable to be processed indefinitely, or you
specify a limit for the payable. You also assign a schedule to each
recurring payable, then generate an invoice for it at the frequency
determined by the schedule.

Specifying limits for a recurring payable

To limit the number of times you can process an invoice for a recurring
payable, you enter a start date and, by choosing Specific Date as the
Expiration Type, you can enter an expiration date for the payable. No
iInvoice is created for the payable prior to its start date or after its
expiration date.

You can also specify a maximum amount that can be invoiced for a



payable. No invoices are created that would cause the total amount
invoiced to exceed this maximum for a recurring payable.

Assigning payment terms to recurring payables

You enter a terms code for each recurring payable. The code determines
the due date for recurring payable invoices, as well as the discount
percentage and period. Once you generate an invoice, you can change
this information on that invoice in the Invoice Entry form.

Adding general ledger and tax information

You can distribute each detail of a recurring payable to a different
distribution code or general ledger payable account, and you can specify
whether taxes are to be calculated automatically or not.



Options Field List

For help about the options and fields in the Options form, select from
these keywords:

Company tab

L] Processing tab

) Transactions tab

] Numbering tab
L] Retainage tab
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Options — Numbering Tab

Use the Numbering tab to:

e Choose the prefixes and next numbers to assign when you save
recurring payables, payments, prepayments, and adjustment
transactions, or you can allow Accounts Payable to assign them
automatically.

These numbers include a prefix (up to 6 letters) followed by a
sequence number. The prefix you assign must be unique and cannot
be used for any other type of Accounts Payable document.

You can change these prefixes and next numbers at any time.

e Restrict the length of the number to be assigned to recurring
payables, payments, prepayments, and adjustment transactions. You
can use a maximum length of 22 characters, including prefixes.

This tab also displays the numbers that will be assigned to the next
invoice, payment, adjustment, and revaluation posting sequences, and
the next invoice, payment, and adjustment batches.

For information about a tab on the Options form, click the corresponding
link:

Company @ Processing Transactions Retainage

12 Related Topics
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Displaying Open Documents in Payment Entry

You can control the order in which open documents (such as invoices
that are not yet paid, or credit notes that have not been applied) appear
in selection lists when you are applying payments in the Payment Entry

form. This option lets you display the documents in the order that is
easiest for you to use.

Accounts Payable displays open documents by document number unless
you choose another order. To change the order at any time, use the

Default Order Of Open Documents option on the Transactions tab in the
Options form.

You can choose to display open documents for each vendor account by:

] Document number

PO number @
Due date @

Order number @
Document date ©
Current Balance @
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G/L Integration Fields

Integration tab
[}l consolidate G/L Batches
[}l Create G/L Transactions By

[}l create GI/L Transactions (During Posting/On Request Using Create G/L Batch Icon)
[}l G/L Source Codes

[l G/L Transactions Generated Through

Transactions tab
[l G/L Detail Comment

[}l G/L Detail Description

[l G/L Detail Reference

[}l G/L Entry Description

[] Transaction Type

[}l GIL Integration Detail
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Account Sets Field List

Account Set Code
Currency Code (multicurrency ledgers)
Description

General Ledger Account Numbers
Inactive

Last Maintained
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Distribution Sets Field List

Description (distribution code)
Description (distribution set)
Distribution Code

Distribution Method
Distribution Percent
Distribution Set Code

G/L Account

Inactive

Last Maintained
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E-malil Messages Field List

L] pescription
[ E-mail Subject
[ Inactive

[t Last Maintained
[} Message (unlabeled text box)

] Message ID
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Substitute Variables for Use in E-mail Messages

If you use variables (field names) from your company database in the
subject line and in the body of e-mail messages that you set up for use
with letters to vendors, the program will substitute (or merge) vendor- or
company-specific information in the e-mail messages.

Variables for messages that you send with e-mail letters

$VENDOR_ID
$VENDOR_NAME
$VENDOR_CONTACT
$COMPANY_PHONE
$COMPANY_FAX
$COMPANY_CONTACT
$COMPANY_NAME



Optional Fields Form Field List

L) Auto Insert

[}l Default Value and Description
[}l Optional Field and Description
[}l Optional Fields For

[ Required
[t value Set
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Optional Field Settings

You can - and should - restrict the flow of information that is passed to
General Ledger when you post transactions that use optional fields.

The Optional Fields setup form lets you specify groups of accounts for
which values for an optional field can be passed to General Ledger. (The
optional fields used in a transaction must also match the transaction
details optional fields used for an account in order to be passed to
General Ledger.)

When defining an optional field for use with transactions, click the
Settings button (or double-click the line on the grid). A separate form
opens, listing the groups of accounts that are affected when you post
transactions of the type for which you are defining the optional field.

Select from the list all the account groups for which you want to pass
values to General Ledger when you post transactions that include the
optional field.

Note: While all account groups are initially selected for new optional
fields, you need to consider carefully the purpose of the optional field you
are defining. You should send values to General Ledger only for optional
fields that require financial analysis, and only to accounts where they are
required. For example, you might want to send optional fields that contain
vendor numbers or sales territories only to revenue accounts.

You do not need to send optional field information for analysis that is
performed only in Accounts Payable. If you routinely send all the optional
fields you use in Accounts Payable transactions, your General Ledger
may become unwieldy, and you may also considerably slow down
processing.

If you use Sage ERP Accpac and Job Costing, you can also specify
whether optional field information for job-related transactions will be
passed to Project and Job Costing, if the optional fields match those used
for billings in that program.



Payment Codes Field List

For help about the options and fields in the Payment Codes form, select
from the keywords listed below:

Description
Inactive

Last Maintained
Payment Code
Payment Type
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Payment Selection Codes Field List

For help about the options and fields in the Payment Selection Codes
form, select from the keywords listed below:

Selection Code and Description

Select tab

Apply Method

Bank Currency

Inactive

Last Maintained

Pay from Bank

Rate Type

Select Vendors with this Bank Code Only
Vendor Currency

Criteria tab

Accounts Sets Range

Pay All Selected Documents
Pay Only Forced Documents
Payment Code Range
Select Documents by
Vendor Amounts Range
Vendor Group Range
Vendor Number Range
Vendor Optional Fields

Exclusion tab
Vendor Number and Name

Optional Fields tab
Optional Field and Description
Value and Description
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Payment Selection Codes — Select Tab
Use this tab to specify:

e Whether the payment selection code is active.
e The bank account from which to draw the checks.

e The bank currency (check currency) and the vendor currency
(multicurrency ledgers only) and exchange rate information.

This tab also shows the date when the payment selection code was last
edited and saved.

Click the links below for help on using the corresponding tabs:

Criteria | Exclusion | Optional Fields

12 Related Topics
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Payment Selection Codes — Criteria Tab

Use this tab to:

e Choose the method for selecting documents for payment (by due
date, discount date, or both due date and discount date).

e Select all documents meeting the criteria or forced documents only.

e Set ranges of vendor groups, vendors, account sets, and vendor
amounts.

Click the links below for help on using the corresponding tabs:

Select | Exclusion | Optional Fields

12 Related Topics
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Payment Selection Codes — Exclusion Tab
Use this tab to:

e List all vendors that you want excluded from the payment batch.
To exclude vendors

e In a new line of the list, enter the number of the vendor you want
excluded or select it from the Finder.

Press the Insert key to start a new line.
To remove vendors from the list

e Highlight the line you want to remove, and press the Delete key.
Click the links below for help on using the corresponding tabs:

Select | Criteria | Optional Fields

12 Related Topics
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Payment Selection Codes — Optional Fields

Tab

This tab appears if you use Transaction Analysis and Optional Field
Creator, a separately licensed program available from Sage ERP Accpac.

The tab lets you

e Specify optional fields and values to be assigned as defaults when
you create a payment batch.

When you enter a new payment selection code, the tab initially displays
payment optional fields that are marked for automatic insertion, along
with their default values.

You can add or delete optional fields, and change the default values.
Note that you can add only optional fields that are defined for payments
in the Optional Fields setup form.

If you delete an automatically inserted optional field for a payment
selection code, when you create batches using the code, the program will
reinsert the optional field using the default value from the optional field
setup record.

Click the links below for help on using the corresponding tabs:

Select | Criteria | Exclusion




1099/CPRS Codes Field List

1099/CPRS Code
Description
[nactive

Last Maintained
Minimum to Report
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Terms Field List

For help about the options and fields in the Terms form, select from
these keywords:

Calculate Base for Discount With Tax Included/Excluded
Description

Due Date Table

Due Date Type

Discount Date Table

Discount Percent

Discount Type

Inactive

Last Maintained

Multiple Payment Schedule

Number of Days / Day of Month (discount)

Number of Days / Day of Month (due)

Payment Number

Percent Due

Range — Starting and Ending Date, Add Months, Day of Month
Terms Code
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Distribution Codes Field List

Description
Discountable

Distribution Code

General Ledger Account Numbers
Inactive

Last Maintained
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Vendors Field List

[l Address tab

LI contact tab

L] Processing tab

L] Invoicing tab

Optional Fields tab

[ statistics tab

L] Activity tab

] comments tab
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Vendor Groups Field List

For help about the options and fields in the Vendor Groups form, select
from the keywords listed below:

D] Group Information tab

) Invoicing tab
Optional Fields tab

[ statistics tab
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Remit-To Locations Field List

For help about the options and fields in the Remit-To Locations form,
select from the keywords listed below:

Remit-To Location
Remit-To Name
Vendor Number

Address tab
Address

Check Language
City

Country

E-mail

Fax

[nactive

Last Maintained
Primary Remit-To
State/Prov.

Telephone
Zip/Postal Code

Contact tab
Contact
Fax

Telephone
E-mail

Optional Fields tab
Optional Fields
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Look up 1099 or CPRS Vendor Amounts

[l Before you start

To display 1099 or CPRS amounts stored in your Accounts Payable
system:

1. Open Accounts Payable > A/P Vendors > 1099/CPRS Inquiry.

2. In the Year field, type the year in which you paid the amounts you
want to view.

3. Use the From Vendor/To fields to specify a range of vendor numbers.
You can type the vendor numbers, or use the Finder to select them.

You can also accept the blank entry in the From Vendor field and the
ZZZ7s in the To field to include amounts for all vendors.

4. Use the From Code/To fields to specify the range of codes for the
amounts you want to view, or accept the blank entry in the From Code
field and the ZZZs in the To field to display amounts for all
1099/CPRS codes.

5. Click the Go button (s») to display all the amounts that meet the
criteria you specified.

The program displays amounts for each month of the year, as well as
the last payment date in each month, the number of payments and
total amount paid.

To print a report of the information you see on the screen:
e Click the Print button.
To delete an amount:

e Select the line for the amount, then click the Delete key on your
keyboard.

To change an amount:

e Double-click the Amount field, then type the correct 1099 or CPRS
amount.

To add a 1099 or CPRS amount for a vendor:
1. Click the first blank line on the grid, or press the Insert key on your
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keyboard to create a new line, then enter information as follows:

a. Double-click the Vendor Number field for the selected line, or, with
the insertion point in the Vendor Number field, click the Vendor
Number column heading, then use the Finder to select the Vendor.

b. Press the Tab key to move to the Code field or click the Code field,
then use the Finder to select the code for the 1099/CPRS amount
you want to add for the vendor.

c. Enter month in which you made the payment, the date of the last
payment for that month, the number of payments, and total
amount paid.



Recurring Payables Setup Field List

For help about the options and fields in the Recurring Payables form,
select from these keywords:

Recurring Payable Code and Description
Vendor Information form
Vendor Number

[ Invoice tab
[t Detail tab

(The Detail Accounts/Taxes form (F9 on a detail distribution line) contains
additional, tax-related, fields for a selected detail.)

) Optional Fields tab
[}l Tax | Totals tab

[ statistics tab
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Recurring Payables Setup -- Invoice Tab

This tab lets you specify the following information for the recurring
payable:

e The starting date..
e The expiration type, and, depending on the type you specify:
o The expiration date, if there is one.

o A maximum amount that you will pay for the recurring payable, if
there is a maximum.

o A maximum number of invoices.

Assign a schedule to set the frequency of payable invoices.

Select a remit-to location for the payable, if needed.

Assign payment terms and tax information for the payable.

Enter a description and the purchase order number, if any.

Schedule code

Enter the code for the schedule that you want to attach to this record, or
select it using the Finder.

If you want to set up a new schedule or modify an existing one, choose
the Schedule button. You can use up to 15 characters to create the new
code. (Note that you must have a security authorization to maintain
schedules in Common Services to be able to add or modify an existing
schedule.)

For more information about setting up schedules for recurring
transactions, refer to the System Manager help.

Starting and expiration dates

Accounts Payable lets you specify the date on which the recurring
payable comes into effect and, if you choose Specific Date as the
Expiration type, the date that it expires. If you choose No Expiration Date
as the Expiration Type, you can create invoices for the recurring payable
indefinitely.



The Create Recurring Payable Batch form will not create invoices for

payables unless the creation date is between the start date and the
expiration date.

Maximum amount

If an invoice would cause the amount invoiced to date to exceed the
maximum, Accounts Payable does not create the invoice.

Click one of the links below for help on using the corresponding tab:

Detail | Optional Fields | Tax/Totals @ Statistics

& Related Topics
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Recurring Payables Setup — Detail Tab

The Detail distribution tab on the Recurring Payable setup form lets you:

e Enter the details of the recurring payable.

e Open a separate Detail Accounts/Taxes form to enter distribution and
tax information for the detail.

e Lets you view estimated tax amounts for each payable detail (if you
selected Calculate or Distribute as the tax entry method for the Tax
Amount and Tax Base fields on the Tax/Totals tab).

To open the detail Accounts/Taxes form, highlight the detail line, and then
click the Acct/Tax button.

You assign a distribution code or general ledger payable account, and
enter a description and amount for each detail line in the recurring
payable record.

Click one of the links below for help on using the corresponding tab:

Invoice | Optional Fields & Tax/Totals | Statistics

12 Related Topics
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Recurring Payables — Optional Fields Tab

This tab appears if you use Sage ERP Accpac Transaction Analysis and
Optional Field Creator and you have defined invoice optional fields.
Recurring payables use the same optional fields you set up for invoices.

e Use the Optional Fields tab on the Recurring Payables form to
o Assign optional fields to a document.

The program displays the optional fields that you set up for
automatic insertion on invoices, but you can change them or
add other optional fields defined for Accounts Payable invoices.

Accounts Payable displays default values for the invoice
optional fields, as follows:

¢ |f you assigned exactly the same optional fields to the vendor and
remit-to location records as you defined for invoices, the program
displays the optional field values from the remit-to location on the
Optional Fields tab.

e If the optional fields in the remit-to location record and the vendor
record are different from each other, the optional field values from
the vendor record appear as defaults for the invoice.

o If an optional field is defined for invoices, but is not assigned either
to the vendor or the remit-to location, the program displays the
value specified for the optional field in the Optional Fields record.

o Change the value that appears for an optional field. If the optional
field is validated, you must specify a value that is defined for the
optional field in Common Services. If the optional field is not
validated, you can select a value from Common Services or you
can enter another value that is consistent with the type of optional
field.

For more information about another tab on the recurring payable Setup
form, click the corresponding link, below:

Invoice | Detail | Tax/Totals | Statistics




18 Related Topics
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Recurring Payables Setup € Tax/Totals Tab

Tax/Totals tab displays for the recurring payable:

e The tax group and tax authorities. The tax group assigned in the
vendor record appears as the default for the recurring payable, but
you can change it, if necessary.

e The vendor tax class. The vendor tax class is also assigned in the
vendor record. However, for many tax authorities, the tax class varies
depending on the purpose of the goods or services being purchased.
You can change the tax class, if necessary.

e Estimated tax amounts, if tax is calculated for the recurring payable.
You can specify how tax is to be calculated for the recurring payable
using the Tax Amount and Tax Base fields.

Unless you select Calculate as the tax entry method, you must specify
the total amount of tax for each tax authority on the Tax/Totals tab,
then allocate to each detail the total tax amounts that you enter
manually.

If you select Distribute as the tax entry method, you can enter the tax
totals on the Tax/Totals, and let the program allocate taxes to the
details when you save the record.

Note that the sum of the taxes for each detail must match the total
you specify on the Tax/Totals tab.

e \Whether tax is included in the total for this document.

You can change the Tax Included option only if the option Allow Tax in
Price option is selected for the tax authority in Tax Services.

Click one of the links below for help on using the corresponding tab:

Invoice @ Detail = Optional Fields | Statistics

Click the links below for additional help on using the buttons on the
Recurring Payables Setup form:

Save| Delete| Acct./Tax... Close
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Recurring Payables Setup — Statistics Tab

The Statistics tab lets you:

¢ View the number and amount of posted and unposted invoices
created for the recurring payable. You can edit these fields to include
historical amounts.

¢ View the year-to-date number and amount of invoices created for the
recurring payable. Accounts Payable updates these amounts when
you post the invoices, and you cannot change them.

¢ View information about the last invoice posted for the recurring
payable, including the date, amount, invoice and entry numbers, as
well as the batch number and posting sequence of the batch that
contained the last invoice.

Click the links below for more information on other tabs on the Recurring
Payables form:

Invoice | Detail | Optional Fields | Tax/Totals




Remit-To Locations — Address Tab

Use this tab to:

e Change the check language, address, contact name, telephone
number, and fax number for remit-to locations.

e Select primary remit-to locations for vendors.

e Assign Inactive status to remit-to locations you want to suspend
temporarily or delete at year end.

Click the link below for help on using the Optional Field tab:

Contact | Optional Fields

12 Related Topics
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Remit-To Locations — Contact Tab

Use this tab to enter the name, telephone number, fax number, and e-
mail address for a contact person at the remit-to location.

For information about another tab on the Remit-To Locations form, click
the corresponding link, below:

Address | Optional Fields

7 Related Topics
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Remit-To Locations — Optional Fields Tab

Optional fields are available only if you installed Sage ERP Accpac
Transaction Analysis and Optional Field Creator (a separately licensed
package).

You use the Optional Fields tab of the Remit-To Locations form to assign
optional fields for particular remit-to locations.

If you set any optional fields for automatic insertion in remit-to location
records, they appear on the tab, along with their default values.

If you set up the same optional fields for remit-to locations as for vendors
and vendor groups, the program uses the values from the vendor record
as defaults for the optional fields in the remit-to location record.

You can accept or change the optional field values. If an optional field
requires validation, you can select only a value that is assigned to the
optional field in Common Services or, if the optional field allows it, you
can leave the default value field blank.

If you use exactly the same optional fields for invoices, vendors, and
remit-to locations, when you specify a remit-to location in the Invoice
Entry form, the program uses the optional field values from the remit-to
location for the invoice, debit note, or credit note.

Click the link below for help on using another tab:

Address Contact




7 Related Topics
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Vendor Activity Field List

For help about the options and fields in the Vendor Activity form, select

from the keywords listed below. Most of the fields in this form display
information which you cannot edit.

Activity tab

Amounts In [ ] Currency
Credit Limit

Vendor Number
Inactive

Last Invoice Amount
Last Invoice Date

Last Payment Amount
Last Payment Date
Prepayment Amount
Prepayment Count
Open Invoice Count
On Hold

Outstanding Balance
Qutstanding Retainage

Aging tab

Age As Of

Age By

Aging period information
Cutoff Date

Include Prepayments

Include Transactions On Hold

Transactions tab

Amounts in [ ] Currency

Currency

Columns in the Transaction Detail List
Doc. (Document) Type

Include Fully Paid Transactions
Include Pending Amounts

Order By
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Original Retainage Amt.
Payment Status

Pending Adjustment Total
Pending Balance
Pending Discount Total
Pending Payment Total
Retainage Amount
Retainage Due Date
Starting Value

Payments tab

Bank

Batch Number
Check Number (in list)
Check Status (in list)
Currency

Entry Number

Order By

Payment Amount
Payment Date
Remit To

Starting Value
Status

Vendor Number
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Vendor Activity — Activity Tab

To display account information

1. Type the vendor number or select it from the Finder in the Vendor No.
Field.

2. If you use multicurrency accounting, select the currency in which to
display figures. You can choose Vendor or Functional.

Click the links below for help on using the corresponding tabs:

Aging | Transactions | Payments

12 Related Topics
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Vendor Activity — Aging Tab

Use this tab to:

e Display the vendor's outstanding transaction balances aged into the
periods you specify.

e Specify the date as of which you want to age transaction balances
(such as by today's date).

e Specify a cutoff date, so you can include or exclude transactions that
are more recent than the "As of" date.

Click the links below for help on using the corresponding tabs:

Activity | Transactions | Payments

Accounts Payable sorts outstanding transactions and balances into five
periods, a current (not due) period and four aging periods.

You specify the length of each aging period for the Accounts Payable
system in the Options form, but you assign any aging periods you want
on this tab.

You can choose whether to age transactions by their due dates or their
document dates for each type of report.

e Due date — current transactions are those with due dates that are
later than the Age As Of date. The first period starts at 1 day past the
due date.

e Document date — the first period includes transactions with
document dates that are earlier than the Age As Of date. Current
transactions are those with the same or a later date than the Age As
Of date.

See the notes below on credit notes, debit notes and prepayments. Also
note that the cutoff date lets you decide whether to include transactions
entered after the Age As Of date.

Aging credit notes, debit notes, and prepayments
When your vendor accounts include credit notes, debit notes, and



prepayments that do not apply to specific invoice numbers or other
documents, you can specify whether to report the amounts in the aging
periods that contain their document dates, or you can group them all in
the current (not due) period.

You choose these options on the Processing tab of the Options form. You
can change your choices for the options at any time.

The options have no effect on credit notes, debit notes, and prepayments
that are applied to specific document numbers. Applied amounts are
always included in the same aging periods as the documents to which

they apply.

& Related Topics
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Vendor Activity — Transactions Tab
Use this tab to:

e View summary and detailed information about the transactions
(invoices, debit notes, credit notes, and payments) currently posted to
vendor accounts. You can choose the types of documents you want to
see, the order of appearance, and the starting document number.

e View completed (fully paid) documents that you have not yet cleared
from Accounts Payable. You choose whether to include or exclude
fully paid transactions.

¢ View information about pending transactions, including pending
document balances.

In multicurrency ledgers, you can also view the amounts in the functional
currency or the vendor's currency.

For information on using a different tab on the Vendor Activity form, click
one the links below:

Activity | Aging | Payments

To inquire on vendor transactions:

1. Choose Vendor Activity from the Vendors folder.
2. Select the vendor using the Vendor No. field.

3. Click the Transactions tab.
4

. Select the type of document you want to view, and the starting
document number to include in the display.

5. In the Order By flEld, SpeCify [ the order in which to list transactions. CliCK the button
() beside the Order By field if you want to change the list order from
ascending to descending, or from descending to ascending order.

6. Select the currency in which to display the payments. You can select
Functional Currency or Vendor Currency.

7. If you want to include fully paid transactions and/or pending amounts
in the display, select the options to include them.


javascript:void(0);

8. Click the Go (»») button or press F7 to display documents using your
selections.

Accounts Payable displays & one line of information fOr each document on the
tab.

Click the links below for more information on viewing transaction details:

Open | Document | Details...
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7 Related Topics
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Vendor Activity — Payments tab

For each payment you made to a selected vendor, the Payments tab of
the Vendor Activity form displays the:

Bank code.
Check number and check date.

Check amount in the functional currency or vendor currency (if you
have a multicurrency ledger).

Check status (outstanding, cleared, or reversed).
Payment batch number and entry number.
Payee (name on the check).

Click the links below for information on viewing transaction details:

Open | Document

For help on using a different tab on the Vendor Activity form, click one of
the following links:

Activity | Aging | Transactions

To inquire on payments

1.

2
3.
4

Choose Vendor Activity from the Vendors folder.

. Select the vendor from the Vendor Number field.

Click the Payments tab.

. Select the status and the starting check number of the checks you

want to view. You can choose Outstanding, Cleared, Reversed, or All
for the status.

In the Order By field, specify whether to list payments by check
number or document date. Click the button () beside the Order By
field to change the display from ascending to descending order, or
from descending to ascending order.

Select the currency in which to display the payments. You can select
Functional Currency, Vendor Currency, or Bank Currency.



7. Click the Go button (s») or press F7 to display the vendor checks.

& Related Topics
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Vendor Groups — Group Tab

Use this tab to:

¢ Assign the account set, terms code, and bank code to use for new
vendors you add to the group.

¢ |In multicurrency ledgers, specify the default rate type to assign for
vendors who do not use the functional currency.

Click the links below for help on using the corresponding tabs:

Invoicing | Optional Fields | Statistics

12 Related Topics
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Vendor Groups — Invoicing Tab

Use this tab to:

e Specify the default distribution method to assign to vendor records
you add to the group.

e Select the default tax group and tax classes to which your company
belongs when invoiced by vendors in this group.

e Select options to specify how to identify duplicate invoices for this
vendor group and whether to print separate check for each invoice or
pay several invoices with a single check to a vendor.

e Specify whether vendors in the group are normally subject to
1099/CPRS reporting and enter the 1099/CPRS code for the group.

You can change your choices for these options at any time.
Click the links below for help on using the corresponding tabs:

Group | Optional Fields | Statistics

For information about fields in the Vendor Groups form, select the Field
List button beside the title of this help topic.

12 Related Topics



javascript:mc191.Click()

Vendor Groups — Optional Fields Tab

Optional fields are available only if you installed Sage ERP Accpac
Transaction Analysis and Optional Field Creator (a separately licensed
package).

Optional fields that you set up for automatic insertion in vendor group and
vendor records automatically appear, along with their default values,
when you add a new vendor group record.

You can accept the optional fields that appear or you can delete them;
you can also assign different optional fields that you have set up for
vendors and vendor groups.

You can accept or change any default values that appear. However, if an
optional field requires validation, you can select only a value that is
assigned to the optional field in Common Services. (If the optional field
allows blanks, you can leave the default value field blank.)

The values you assign to the vendor group will appear on new vendor
records you add to the group, if you assign the same optional fields to the
vendor records.

Click the links below for help on using the corresponding tabs:

Group | Invoicing | Statistics
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Field List

Vendor Groups — Statistics Tab

Use this tab to:

¢ Lists the number and amount of all transactions processed for the
vendor group in the year and period you select.

e Lists the total days to pay figure and displays the average days to pay
figure for the group and period.

e Lets you change statistical information if you have selected the Allow
Edit Of (vendor) Statistics option on the Processing tab of the Options
form.

Click the links below for help on using the corresponding tabs:

Group | Invoicing | Optional Fields
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Editing Vendor Groups

If you plan to edit vendor group statistics, you must first select the Allow
Edit Of Statistics option in the Options form.



Restrictions on changing records

You can change most of the information in a vendor group record at any
time, with the exception of the vendor group code. If you need to change
a code:

eAdd a vendor group with the code you want to use.
eTransfer all vendor records to the new group.

eTransfer all group statistics to the new group (by editing the statistics
in the new group).

eDelete the group that has the code you no longer want.

You cannot change the account set for a group to a set which uses a
different currency (in a multicurrency ledger).

Use macros

If you need to make the same change to a number of vendor groups, use
Sage ERP Accpac's macro facility, as described in the System Manager
Help.

Optional fields

If you use Sage ERP Accpac Transaction Analysis and Optional Field
Creator (available separately), you can use the Optional Fields setup
form to define vendor optional fields, marking for automatic insertion the
ones you want to use as defaults when you add new vendor group
records.

You can edit or delete the automatically inserted optional fields, and you
can add different vendor optional fields for specific vendor groups. If an
optional field uses validation, however, you can select only entries that
are defined for the optional field in Common Services.

To edit a vendor group record

1.Type the code for the vendor group you want to edit, or select it from
the Finder.

2.Make the changes you need in the record.
3.When finished, choose Save to record your changes.



Effects of changes

Most changes you make to a vendor group affect only the vendor records
you add to the group after making the changes.

The only change you can make to a vendor group that will affect existing
vendor records is assigning Inactive status to the group.

If you assign Inactive status to the group, you cannot:
*Add new vendors to the group.

eChange any of the vendor records assigned to the group (except to
change their vendor group).



Deleting Vendor Groups

You can delete a vendor group to which vendors are assigned, but you

must first reassign the vendors to other groups or delete the vendor
records.



Moving vendors between groups
You can move vendors from one group to another, but if you do, you will:
eUpdate the existing vendor record with the new group defaults.

eInvalidate statistical comparisons between fiscal periods or between
vendor groups (unless you update the vendor group statistics).

To delete a vendor group

1.Type the code for the vendor group you want to delete, or choose it
from the Finder.

2.Choose the Delete key.

3.If you see a message asking you to confirm that you want to delete
the record, choose Yes.



Vendors Form — Address Tab

Use this tab to change the vendor's group, short name, site address,
telephone number, fax number, start date and company e-mail address.

Click the links below for help on using the corresponding tabs:

Contact | Processing ' Invoicing Optional Fields
Statistics | Activity Comments

Changing vendor information on the address information
tab

You cannot change the vendor number, but you can change all other
information on the Address Information tab with these restrictions:

Group code. You can change the vendor's group code at any time, but
you should be aware that the default information for the new group (such
as the account set, terms code, bank code, tax information, and other
options) replace existing information in the vendor record.

If you change a vendor's group after posting transactions, you will also
create incorrect statistics in the old and new groups . You can edit the
statistics to correct the information, but it can be a complicated task.

If you use multicurrency accounting, you can change the vendor's group
to a group that uses an account set with a different currency, but you
must select an account set with the currency you originally assigned for
the vendor before you can save the change.

Inactive status. You can select Inactive status for a vendor record only if
the account has a zero balance and no outstanding transactions.

Additional vendor addresses. If you need to keep more than one
address for a vendor, use the Remit-To Locations form to add any
additional addresses you require.

For information on changing information on other pages in the Vendors
form, choose the appropriate tab (above).
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Vendors — Contact Tab

Use this tab to:

e Enter the name of a contact person for the vendor, and an e-mail
address and telephone and fax numbers for the contact.

Click here for tips on using Accounts Payable forms.
Click the links below for help on the corresponding tabs:

Address | Processing | Invoicing Optional Fields
Statistics | Activity Comments
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Vendors — Processing Tab

Use this tab to:

e Select the vendors account set which, in multicurrency ledgers,
identifies the vendor's currency.

e Select the terms code to enter with invoices from the vendor.

e Select the bank code from which you usually issue checks to the
vendor.

e Specify whether to generate separate checks for each invoice, or
create a single check to cover all outstanding invoices, when you
create payments automatically for the vendor.

e Enter the credit limit the vendor allows your company.

e Select the rate type to use for converting transactions for the vendor
to the functional currency (in multicurrency ledgers).

Click here for tips on using Accounts Payable forms.
Click the links below for help on using the corresponding tabs:

Address | Contact @ Invoicing Optional Fields
Statistics | Activity | Comments
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Vendors — Invoicing Tab

Use this tab to:

Specify the default method by which you distribute the vendor's
invoices to general ledger accounts.

Select options to specify how to identify duplicate invoices you enter
from the vendor and whether you print a separate check for each
invoice from the vendor, or pay several invoices with a single check.

Select the tax group and tax classes to which your company belongs
when invoiced by this vendor.

Enter your company's tax registration or tax exemption number, if any,
for each tax class.

Specify whether the vendor is subject to 1099, CPRS, or no tax
reporting and enter the 1099 or CPRS tax number, type, and code for
vendors that use 1099 or CPRS reporting.

You can change your choices for these options at any time.

Click here for tips on using Accounts Payable forms.

Click the links below for help on using the corresponding tabs:

Address | Contact Processing @ Optional Fields

Statistics | Activity | Comments
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Vendors — Optional Fields Tab

Optional fields are available only if you installed Sage ERP Accpac
Transaction Analysis and Optional Field Creator (a separately licensed
package).

The tab displays optional fields that you set up for automatic insertion in
vendor group and vendor records, along with their default values, when
you add a new vendor record.

You can accept the default optional fields or you can delete them; you
can also assign different optional fields that you have set up for vendors
and vendor groups.

If you assign the same optional fields to the vendor as you assigned to
the vendor group, the values from the vendor group record appear as
defaults. Otherwise, the default values from the optional field record
appeatr.

You can accept or change any default values that appear. However, if an
optional field requires validation, you can select only a value that is
assigned to the optional field in Common Services. (If the optional field
allows blanks, you can leave the default value field blank.)

Click the links below for help on using the corresponding tabs:

Address @ Contact | Processing | Invoicing
Statistics | Activity | Comments
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Vendors — Statistics Tab

Use this tab to:

¢ List the number and amount of all transactions processed for the
vendor in the year and period selected.

e List the total days to pay figure and displays the average days to pay
figure for the account and period.

e Change statistical information if you selected the Allow Edit Of
(vendor) Statistics option on the Processing tab of the Options form.

Click here for tips on using Accounts Payable forms.
Click the links below for help on using the corresponding tabs:

Address Contact | Processing | Invoicing
Optional Fields | Activity = Comments
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Vendors — Activity Tab

Use this tab to:

e View current-year and previous-year account activity for the selected
vendor.

(Account activity includes the current balance of your account with the
vendor and the current number of open documents, the number and
amount of outstanding prepayments, and the amount and date of the
highest and lowest balances and largest invoices for the current and
previous years, as well as the amount and date of the last posted
invoice, payment, credit note, debit note, adjustment, and discount
posted for the vendor.)

e Edit activity statistics when first setting up vendor accounts.
Click here for tips on using Accounts Payable forms.

Click the links below for help on using the corresponding tabs:

Address Contact | Processing ' Invoicing
Optional Fields | Statistics | Comments
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Vendors — Comments Tab

You can use this tab to:

e Add any number of comments to the vendor record, along with follow-
up and expiration dates for each comment.

e Make changes to existing comments.
Click here for tips on using Accounts Payable forms.

Click the links below for help on using the corresponding tabs:

Address Contact | Processing ' Invoicing
Optional Fields | Statistics | Activity

Vendor comments

You can enter comments in the vendor records in the Vendors form. Each
comment can be up to 2,500 characters long. For example, you might
enter a comment about a vendor complaint that is being investigated, or
about a missing payment.

You can enter a comment directly on the comment grid on the Comment
tab, or you can double-click in the Comment column to open a separate
form that lets you see the entire comment you are typing, without having
to scroll.

Clearing comments

To make sure that comments are kept current, you assign a number of
days for which you will retain each one, then, when you enter a comment,
Accounts Payable adds this number of days to the comment date, and
calculates an expiration date.

When you use the Vendor Comments option in the Clear History form,
comments that have been kept past the expiration date are deleted,
saving you from having to delete each comment individually from the
vendor records.

To specify the default number of days to keep the comments, use the
Number of Days to Keep Comments option on the Processing tab of the



Options form.

Printing comments

You can print comments on the Vendors report. When you choose
comments, the program lets you specify the range of follow-up dates for
which you want the comments printed.
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Editing Vendor Records

Use the Vendors form to edit vendor records in Accounts Payable.

eYou can change most of the information in a vendor record at any
time, with these restrictions:

eYou cannot save changes to a vendor record if the vendor's group is
inactive.

eYOu cannot assign a vendor to a vendor group that has an Inactive
status.

eYOUu cannot post transactions to any vendor records that are inactive.

eYou cannot directly change a vendor number. However, if you
accidentally add an incorrect vendor number, you can create a new
record with the correct number, then delete the incorrect record.

You can also create a new record and delete the old one if the vendor
record has a zero balance, and you have deleted paid transactions.

However, you must still edit the vendor statistics in the new record if
you want to keep statistical data, and you must transfer the
appropriate vendor group statistics if the new vendor number is
assigned to a different group.

eIn multicurrency ledgers, you can change the vendor group, account
set, and tax group assigned to a vendor, but only to another vendor
group, account set, or tax group that uses the same currency.

Changing the vendor group or account set

We do not recommend that you change the vendor group or account set
assigned to a vendor record to which you have posted transactions.

If you do change the vendor group, you should be aware that the default
choices for the new vendor group will replace existing choices in the
vendor record, although you can edit the vendor record to change the
new selections.

You may also need to correct statistics for the affected vendor groups.
You can edit statistics only if you have selected the Allow Edit Of
Statistics option in the Options form.



If you are changing the vendor's account set, check the vendor's account
balances.

If the vendor account has outstanding amounts, you will need to transfer
the control account balances to the new control accounts in the General
Ledger after updating the vendor record with the new account set code;

otherwise, you will have old balances that are never reconciled.

If you move vendors from one payables control account to another, check
the unpaid balance of the vendor account. You will have to transfer that
balance from the original control account to the new account.

Changing optional fields

If you use Sage ERP Accpac Transaction Analysis and Optional Field
Creator (available separately), you can use the Optional Fields setup
form to define vendor optional fields, marking for automatic insertion the
ones you want to use as defaults when you add new vendor records.

You can edit or delete the automatically inserted optional fields, and you
can add different vendor optional fields for specific vendors. If an optional
field uses validation, however, you can select only entries that are
defined for the optional field in Common Services.

Using macros

If you need to make the same change to a number of vendor records,
use Sage ERP Accpac's macro facility, as described in the System
Manager Help. For example, you can use a macro to change the default
entries in optional fields.

Effects of changes

eYou can move vendors from one group to another, but if you do, you
will invalidate statistical comparisons between fiscal periods or
between vendor groups (unless you update the vendor group
statistics).

eYou cannot make a vendor inactive if there is a balance owing. Once
you make a record inactive, you cannot add any invoices, payments,
or adjustments.

eYou can enter invoices and payments for a vendor who is on hold, but



the program will warn you of the vendor status.



Deleting Vendor Records

Use the Vendors form to delete vendor records in Accounts Payable.
Before deleting vendor records
If you plan to delete a vendor record, you must first:

ePost all outstanding transactions for the vendor.

ePost transactions to reduce the vendor's account balance to zero.

eUse the 1099/CPRS's icon to print 1099/CPRS forms for the vendor, if
the vendor is subject to 1099/CPRS reporting. You can then use the
Clear History form to clear 1099/CPRS information for the vendor.

eUse the Clear History and Clear Statistics forms to clear all
transaction details for the vendor.

e\Wait until payments posted to the account have cleared the bank and
have been reconciled to the bank statement.

You can delete a vendor record if the account has a zero balance, no
outstanding transactions, and all payments posted to the account have
cleared the bank account and been reconciled for at least 45 days.

Before trying to delete a vendor record, you may prefer to assign the
Inactive status to the record, to ensure that no further transactions are
posted to it. You can then wait to delete the account until the end of the
fiscal or calendar year, depending on the method you use to accumulate
vendor statistics. This step will keep the year's statistics in balance for
the vendor's group.

To delete an active vendor record

Use this method to delete a vendor record to which you have been
posting transactions. The method keeps the vendor statistics in balance
with the statistics in the vendor's group.

1.Type the number for the vendor record you want to delete or choose it
from the Finder.

2. Select the Inactive option.
3.Choose Save to save your changes.



4.At the end of your fiscal year or calendar year (depending on the type
of year specified for vendor statistics in the Options form), use Delete
Inactive Records in the Periodic Processing folder to delete the
vendor record.

To delete an unused vendor record

Use this method to delete a vendor record if you added it by accident or if
you have not yet posted any transactions to the account. You can delete
an unused vendor record without affecting statistics for the vendor group
to which you assigned the vendor.

1.Type the number for the vendor record you want to delete or choose it
from the Finder.

2.Choose the Delete key.

3.If you see a message asking you to confirm that you want to delete
the record, choose Yes.



Assigning and Using Batch Numbers and Entry

Numbers

To keep a clear and accurate audit trail, Accounts Payable automatically
assigns a number to each batch and to each entry (transaction) you add
to a batch, starting with 1. You must use the assigned batch and entry
numbers.

A separate numbering sequence is used for each type of batch (invoice,
payment, and adjustment).

The batch and entry numbers are a permanent part of each transaction
record, and they appear with the transactions on Accounts Payable
reports, such as posting journals and the Vendor Transactions report.

You can use batch and entry numbers to trace the progress of
transactions through the Accounts Payable system and, if you use the
numbers as the descriptions or references for G/L transactions, into your
general ledger (unless you consolidate the transactions during posting in
Accounts Payable).



Creating Accounts Payable Batches

You use the Invoice Entry form, the Payment Entry form, and the
Adjustment Entry form to create batches and enter transactions directly
into them.

In addition, Accounts Payable automatically creates batches for you
when you:

e Use the Create Payment Batch form to create a batch of payment
transactions for currently due invoices.

e Post transactions that contain errors. Accounts Payable posts error-
free transactions only, and creates a new batch that contains all the
transactions it could not post.

e Use the Create G/L Batch form or post Accounts Payable batches.
Depending on whether you defer general ledger batch creation or not,
Accounts Payable creates batches of general ledger transactions
arising from the invoices, payments, and adjustments you post to
vendor accounts.

e Import Accounts Payable batches from Sage ERP Accpac
applications at another location or from non-Sage ERP Accpac
products.

Multicurrency ledgers

If you have a multicurrency ledger, you must create a new payment batch
for each currency you want to process. All transactions in the same
payment batch must be in the same currency. You can enter a mix of
currencies in invoice and adjustment batches.



Editing and Deleting Batches and Transactions

You can edit transactions or delete open batches according to your
selection of the following options:

¢ Allow Edit Of System Generated Batches.

e Allow Edit Of Imported Batches.

e Allow Edit of External Batches.

System generated batches are payment batches created by the Create
Payment Batch form.

Editing batches

You can always change most batch header information, regardless of the
restrictions you may place on batch editing. For example, you can always
change dates and descriptions of all open batches, whether you created
them in Accounts Payable or imported them from another ledger.

You can add a new vendor or a new remit-to location during invoice entry
or when editing an invoice.

You cannot change the bank code in payment batches once you add the
first transaction.
Editing transactions

The status of a batch must be Open or Printed to edit the transactions.
(Printed means that the batch listing has been printed). If the batch has a
Ready To Post status, you must turn off the Ready To Post selection
before you can edit transactions.

If you allow editing of batches, you can always delete unposted
transactions. You can also change any transactions in an open batch
except payment transactions for which you have printed checks.

If you have printed the check for a transaction, you cannot edit it. You can
delete the transaction to void the check.

Deleting entries and batches

When you delete a batch or an entry in a batch, you cannot reuse its



number. Deleted batches and entries are reported on the batch listing
and posting journal for the batch. Deleted batches are also reported on
the Batch Status report.

If you delete a payment transaction for which you printed a check, you
will void the check.

Editing imported batches

If you need to correct an imported batch, you should delete the batch
from Accounts Payable and make the corrections to it in the program
where you created the batch. This procedure ensures that the batch you
post in Accounts Payable contains exactly the same information as the
batch in the source program.

To prevent editing of imported batches in Accounts Payable, make sure
that you do not select the Allow Edit Of Imported Batches option in the
Options form.



Listing Batches

Once you have entered all transactions in a batch, you should print the
batch listing and compare it to your source documents to be sure all
transactions were entered correctly. If you find mistakes, edit the batch to
correct them, then reprint the batch listing and check it before you post
the batch.

Using the Force Listing Of Batches option

To make sure listings are printed for each batch before you post it, select
the Force Listing Of Batches option in the Options form. The option also
prevents you from posting batches you edited but did not relist.

To print a listing for a batch you are working on, use the File Print
command in the batch-entry form. To print listings for a range of batches,
use the Batch Listings icon in the Transaction Reports folder. File the
reports as part of your audit trail to batches.
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Printing Posted Transactions — Posting Journals

and G/L Transactions Report

Each time you post batches, Accounts Payable creates a journal of the
entries from the batches you posted together. These posting journals are
an essential part of your audit trail, because they provide a record of all
posted details and of the related general ledger distributions.

You should keep your audit trail of posted transactions up to date by
printing and filing each posting journal as it is created.

You should also print the G/L Transactions report as part of your period-
end procedures. You are required to print these reports only once, before
you close the year. (You cannot use the Year End form until you have
printed all outstanding posting journals and created the general ledger
transaction batch.)

If you carefully maintain and identify source documents, and print and file
all batch listings, posting journals, and other audit trail reports, you will be
able to trace any transaction from source to general ledger entry.



Tracking Batches

To check on current batches, print their batch listings or the Batch Status
report (for the type of batches you want to review). To display batch
information on your screen, print the reports using Preview as the printing
destination or look up the batches in the Invoice Batch List, Payment
Batch List, and Adjustment Batch List forms.

Batch statuses

Batches are categorized by their statuses — Open, Deleted, Ready To
Post, Printed, Post In Progress, Posted, Check Creation In Progress
(payment batches) — and types — Entered, Imported, Generated (error
batches), or System (system generated payment batches).

Clearing batch status information

You can remove information about posted and deleted batches from the
Batch Status report if you select the option to clear Deleted And Posted
Batches in the Clear History form.
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Assigning Multiple Payments to Invoices

You can enter invoices that will be paid by a series of payments, using a
terms code that includes a multiple payment schedule (such as to make
six payments over a specified period to pay a single invoice). This feature
makes it easy to track the payments for each invoice.

Based on the information entered for the terms code, Accounts Payable
creates a payment schedule that divides the invoice total into the
specified number of payments, each with its own due date, payment
amount, and discount period.

Payment information is displayed on the Payment Schedule tab of the
Invoice Entry form. You can change it after you have distributed the
invoice amounts.

If you want, you can print payment schedules on batch listings by
selecting the Show Schedules option from the Batch Listing form.

You reference payments by payment number when you apply checks to
multiple payment invoices.



Calculating Discounts

If your vendors offer discounts for early invoice payment, you should
define a terms code for each of the methods used to calculate discount
amounts and discount periods.

Accounts Payable uses the terms code you specify with an invoice to
calculate the discount period and amount for the document. If the terms
code defines a multiple payment schedule, Accounts Payable sets up a
payment schedule tab that includes separate discount information for
each payment.

You can also specify whether the invoice discount applies to a particular
detail, or not. To indicate that a detail is not subject to the invoice
discount, you simply clear the Discountable option for the detail on the
Detail Items/Taxes form, or select No for the option on the detail-entry
grid.

You can change the discount date, discount base, amount, and discount
rate at any time until you post the invoice. Note that you must enter a
discount date before you can enter an amount or a rate.

The discount date determines whether a discount is available when you
enter a payment in the Payment Entry form. If a discount is available,
Accounts Payable displays the available discount amount and the invoice
total net of the discount when you apply payments to the invoice.

Discounts do not apply to credit notes and debit notes.



Calculating Tax — Overview

Accounts Payable provides you with three methods for entering tax
amounts and tax bases on invoices, credit notes, and debit notes.

On the Invoice Entry form, the Taxes tab provides fields that let you
specify how taxes are calculated for the current document. In the Tax
Amount and the Tax Base field, you can select:

e Enter — then manually enter total tax amounts and/or tax bases on
the Taxes tab, and enter tax amounts for each detail in the
Accounts/Taxes form using the information from the invoice.

If you want, you can distribute amounts automatically to the invoice
details using the Distribute Taxes button. You can edit the detail taxes,
later, in the Detail Accounts/Taxes form.

Clicking the Calculate Taxes button overrides all manually entered
taxes (the total amounts on the Taxes tab as well as the detail taxes).

e Distribute — then manually enter the total tax amounts and/or tax
bases on the Invoice Entry form's Taxes tab, using the information
from the invoice, then distribute amounts automatically to the invoice
details using the Distribute Taxes button.

You cannot edit taxes on the Detail Accounts/Taxes form if you
choose this method.

e Calculate — then have the program calculate taxes and distribute
them when you add the invoice or distribute the invoice amount.

If you choose Calculate for the tax amount and Distribute or Enter for the
tax base, the program uses the tax base to calculate tax amounts
automatically.

You specify whether the distribution amounts are net of taxes or include
taxes (on the Taxes tab of the Invoice Entry form).

If you assign to the invoice a tax group that uses a different currency that
the vendor, a Tax Reporting field appears, letting you specify an entry
method for amounts to .

Accounts Payable automatically uses the default tax entry method that



you chose on the Transactions tab of the Options form. You can change
the method on individual invoices.

The main reasons for having the program calculate tax are:
e To check the tax amount that appears on the invoice.
e To track a tax which is hidden in the invoice total.

Tax on retainage

You can report taxes on retainage amounts when you post an original
invoice or when specified by a tax authority. Accounts Payable respects
the option specified for each tax authority.

This feature meets the reporting requirements for GST and VAT, for which
tax is reported separately on the amount payable on the original invoice,
and then on the amount of the retainage when the retainage is due.

Tax Reporting Currency

You can specify a tax reporting currency, and automatically calculate
taxes in source currency, functional currency, and the tax reporting
currency. (This feature is required in some jurisdictions, such as
Singapore.)

Tax Services stores tax information and tracks taxes

Account Payable gets all its tax rates and tax account information from
Tax Services, which is part of Sage ERP Accpac's Common Services.

When Accounts Payable distributes tax amounts, it:

e Checks the Taxes tab to see which taxes apply to the vendor and the
tax entry method.

If Calculate is not selected, the program uses the tax amounts
entered on the Taxes tab.

If Calculate is selected, it checks the Tax Included settings, then
calculates the total tax amount for the distributions listed on the
Document tab.

¢ Allocates entered or calculated taxes in the same proportion as you
distributed the rest of the invoice amount.



e Removes any proportion of the tax which is recoverable from the tax
distribution amount and assigns it to the tax recoverable account.

You define tax authorities and specify whether taxes are recoverable
using the forms in the Tax Services folder. See the Tax Services
online Help (open a Tax Services form and press F1.

e Removes any tax which is separately expensed from the tax
distribution amount and assigns it to the tax expense account.

You specify whether taxes are separately expensed using Tax
Services.

Note that Tax Services performs the tax calculations when you choose
the Distribute Taxes button on the Taxes tab.

Also note that whether you let the program calculate taxes or you enter
them manually, Accounts Payable sends all the appropriate tax
information to Tax Services for tax reporting purposes.

Tax groups and tax authorities

The tax group you select determines which tax authorities appear on the
Taxes tab and the tax class of each tax authority.

The only way to change the list of tax authorities is by changing the tax
group.

Tax classes

The tax class usually determines whether goods are taxable. You can
change the tax classes for different tax authorities on the Vendor Taxes
tab.

If you select Calculate as the tax entry method, you can also change the
tax classes for particular distribution lines by pressing F9 when the line is
highlighted.

If you select Calculate as the tax entry method, the only way to change
the tax authorities or amounts calculated for an invoice, credit note, or
debit note is by:

e Changing the tax group
Or



e Changing the tax classes

If you select Enter as the tax entry method, you can enter all tax amounts
directly. You can also use the Distribute Taxes button to distribute taxes
to the invoice details.

If you select Distribute as the tax entry method, you use the Distribute
Taxes button to allocate to invoice details total tax amounts you enter
manually.

Whatever method you choose, you can always override manually entered
amounts by choosing the Calculate Taxes button.

Multicurrency ledgers

If you use multicurrency accounting, you can change only to another tax
group that also uses the vendor's currency.
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Changing the Tax Class for Individual Distributions

for Tax Calculation

You can change the tax class (tax status) for single invoice distributions
by highlighting the invoice distribution line, pressing F9, and selecting a
different tax class.

Note that you must select the different tax class before you distribute
taxes.

If you know the tax amounts for each distribution, you can also enter the
taxes manually for each line by selecting Enter as the tax entry method
on the Taxes tab.

Return to Processing invoices, credit notes, and debit notes.

12 Related Topics
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Creating General Ledger Transactions

When you post invoice batches, Accounts Payable creates transactions
for the inventory or expense accounts to which the invoices are
distributed and creates balancing transactions for the general ledger
payables control accounts.

If you want to automatically create general ledger transaction batches
each time you post Accounts Payable transactions, choose the option to
Create G/L Transactions During Posting (in the Options form).

To create general ledger batches only when you want to, select Create
G/L Transactions On Request Using Create G/L Batch Icon.

If you use the Create G/L Batch form, you must create the transactions
before using the Year End form to do year-end processing.

Reporting G/L Transactions

The G/L Transactions report and the summary at the end of each
Accounts Payable posting journal lists the general ledger accounts that
will be debited and credited with payables transactions when you post the
batch of general ledger entries in General Ledger.

In the Options form, you choose the type of reference and description
that is included with each General Ledger transaction.

Note: You must print the G/L Transactions report before clearing posting
journals (using the Clear History form), as this option deletes data for the
G/L Transactions report.

GIL accounts

Accounts Payable uses the following general ledger accounts: Payables
Control, Purchase Discounts, Prepayments, and the accounts you assign
to distribution codes or enter with transactions.

If you use multicurrency accounting, Accounts Payable also uses
General Ledger's unrealized and realized exchange gain and loss
accounts.

If you do not use Sage ERP Accpac General Ledger



If you do not use Sage ERP Accpac General Ledger — or if your Sage
ERP Accpac General Ledger system is at another location — Accounts
Payable creates its general ledger transactions in a file called
APGLTRAN.CSV, which can be imported by a remote site Sage ERP
Accpac General Ledger, or transferred to another general ledger that you

use.
The file is in a Comma Separated Values format.

Note that General Ledger transactions will be placed in the same CSV
file, and that each time Accounts Payable creates transactions it will ask
you whether to add to the file, or replace it.



Distributing Invoices, Credit Notes, and Debit

Notes

For most invoices you need to distribute two amounts:
e The amount of the invoice net of taxes.
e The tax amount.

You distribute both of these amounts after you enter the document total
on the Document tab and tax information on the Taxes tab of the Invoice
Entry form.

Including tax in the distribution amount

If you selected Tax Included (tax is hidden in the total on your vendor
invoice) and Calculate in the Tax Amount field on the Taxes tab, you
distribute the invoice total (the details plus the included tax).

If all your taxes are listed separately, you distribute the amount of the
invoice net of tax, then calculate tax on the invoice.

If you select Distribute or Enter as the tax entry method, you always enter
the tax amounts on the Taxes tab, then distribute the net-of-tax amount
(the rest of the invoice) on the Document tab.

Instructions for distributing invoice and tax amounts

For full instructions for distributing invoice and tax amounts in the Invoice
Entry form, choose the appropriate keyword below for your type of tax
calculation and distribution:

Manually enter and distribute tax amounts
Use Calculate and Tax Included
Use Calculate when tax not included

Multicurrency ledgers

Note that you distribute all invoice and tax amounts in the vendor's
currency. Accounts Payable calculates the functional-currency equivalent
to the invoice amount using exchange rates maintained in the Currency
forms in Common Services.



You can change the exchange rate, rate type, and rate date for an
invoice, using the Rate Information tab in the Invoice Entry form, but you
cannot change the vendor currency.



Distributing Self-Assessed Taxes

A self-assessed tax is one that you must pay, even though it is not
collected by the vendor. These taxes commonly arise when you order
goods from another state or province, but are still subject to local sales
taxes.

Accounts Payable does not have a self-assessing tax type, but you can
use the program to calculate self-assessing taxes and distribute them to
expense and tax payable accounts. The trick is to create two tax
authorities, one for the tax expense, and one for the tax payable.

To create and use a self-assessing tax
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Entering Document Header Information

Invoices, credit notes, and debit notes contain two types of information:
e Header information

e Detall information

Header information

Certain information, such as the vendor number, document number, and
document type, is the same for all details in a single invoice, credit note,
or debit note. This is the header information for the document and you
enter it on the first tab of the Invoice Entry form.

Header information for all three types of documents includes:

e Entry Number. A sequence number that is assigned by Accounts
Payable to indicate the order in which a document was added to a
batch. Entry numbers let you select documents for editing and identify
documents on Accounts Payable reports.

e Vendor Number. Identifies the vendor, sets the default tax group and
payment terms (for invoices), and specifies the currency of the
document in multicurrency systems.

¢ Remit To Address. Optional field. Specifies the address to which the
payment is sent.

e 1099/CPRS Code and Amount.
e Document Type. Invoice, Credit Note, Debit Note, or Interest Charge.

e Apply To. Invoice to which this document applies, if you are entering
a credit note, debit note, or interest charge.

e Document Number. Assigned by the vendor. You can use each
document number only once.

e Document Date. Sets the date from which the document is aged on
reports. You can choose whether to age credit notes and debit notes
by document date or treat them as current transactions. Invoices are
always aged by due date.

e Fiscal Year and Period. From the fiscal calendar defined for the



company in Common Services. Identifies the period to which the
document will be posted.

Document Description. Appears on the Invoice Batch Listing and
the Invoice Posting Journal.

Tax Group. Specifies the tax authorities and tax classes assigned
with goods you buy from the vendor. Used to calculate tax amounts
for the document.

Purchase Order Number. Optional field. You can sort documents by
purchase order number in Finders and for payment application, and
you can use the number as the reference or description in G/L
transaction batches.

Sales Order Number. You can sort documents by sales order
number in Finders and for payment application, and you can use the
number as the reference or description in G/L transaction batches.

Terms Code. This field appears for invoices only. If the terms code is
for a multiple payment schedule, Accounts Payable adds an

additional Schedule tab to the form. Otherwise, the code sets the
information in the Due Date, Discount Date, Discount %, and Discount
Amount fields.

Changing document header information

You can change most of the header information after you save an
invoice. You can change:

Document date.

Description.

Payment terms and discount information.
Purchase order number.

Sales order number.

Remit-to location.

Tax group.

You cannot change:



o Vendor number

o Document type
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Entering Multicurrency Invoices, Credit Notes, and

Debit Notes

This topic summarizes the steps you take to add invoices, credit notes,
and debit notes in currencies other than the functional (home) currency.

You enter multicurrency transactions in the same way as functional-
currency transactions. The only extra consideration arises if you need to
change exchange rates or assign a different tax group to the transaction.

The currency for an invoice, credit note, or debit note is displayed along
with the current exchange rate when you enter a vendor number.

To change exchange-rate information, use the Rate Information tab (it
appears only with multicurrency transactions). You can change the rate
type, rate date, and exchange rate for the document.

You can change the tax group for a document only to another tax group
that also uses the vendor's currency.

When you post multicurrency transactions, Accounts Payable converts
the amounts to the functional currency, using the exchange rate
information entered with the transaction.

12 Related Topics
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Entering Optional Fields on Invoices

You can use optional fields with Invoice Entry if:

¢ You use Transaction Analysis and Optional Field Creator and you
have set up system-wide optional fields.

e You set up optional fields for invoices and invoice details using the
Optional Fields setup form in the A/P Setup folder.

When you start a new invoice, Accounts Payable uses the optional fields
that are marked for automatic insertion on invoices and invoice details.
You can view or change optional fields, as follows:

e You use the Optional Fields tab on the Invoice Entry form to view or &

assign optional fields to specific invoices.

e You open a separate Optional Fields form associated with the
Optional Fields check box on the Invoice Entry detail grid and on the
Detail Accounts/Taxes form [ to view or assign optional fields for individual details.

If you use the same optional fields for invoices as for vendors, the
optional field values from vendor records appear as the default values on
invoices. Otherwise, the value form the Optional Field record is used.

You can change the value that appears for an optional field, as follows:

e |f the optional field is validated, you must specify a value that you
have defined for the optional field in Common Services. You can leave
the value blank only if the optional field allows blanks.

e If the optional field is not validated, you can either select an value that
you defined for the optional field in Common Services, or you can
enter any value that is consistent with the type of optional field and
that does not exceed the length specified for the field.

Optional Fields for Job-Related Details

On a job-related invoice, if the detail optional fields are identical to the
optional fields used by the contract project, in Project and Job Costing,
Accounts Payable uses the optional field values from the contract project
as default values for the details.

If an optional field used with an invoice detail does not exist for the
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contract project, the default value defined in the optional field record
appears.
Optional Fields for Retainage Document Details

On retainage documents, the optional fields and values specified on the
original documents are used as defaults for the related retainage
iInvoices, retainage credit notes, and retainage debit notes, whether you
enter the retainage documents manually or create them using Create
Retainage Batch.

Updating General Ledger

Accounts Payable transfers optional field information to General Ledger
when you create transactions for General Ledger if:

¢ You specified in the optional field setup record that optional field
information will be passed to the General Ledger account.

e You defined the same optional fields for invoices and invoice details
as you defined for transaction details in the General Ledger account
record.

The General Ledger accounts can include:
e Payables Control
e Recoverable Tax
e Expense Tax
e Purchase Discount
e Prepayment
¢ Retainage
e Realized Exchange Gain
e Realized Exchange Loss

¢ Rounding

Updating Project and Job Costing

If the invoice is job-related and the optional fields match the optional
fields defined for Project and Job Costing billings, the optional field



information is passed to Project and Job Costing.
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Updating Vendor Statistics

When you post invoice batches, the following vendor statistics are
updated:

Vendors. Adds the amount and number of new invoices, credit notes and
debit notes to the totals for the period statistics in the vendor's account.
Also enters the amount and document date of the last invoice, credit
note, or debit note that was posted for the vendor in the vendor's activity
statistics.

Vendor Groups. Adds the total amount of invoices, credit notes and
debit notes posted to vendors in the group and the number of invoices,
credit notes and debit notes to the group statistics. Use the Vendor
Groups form to view this information.



Payment Entry — Overview

This topic contains an overview of the Payment Entry form. It describes
the information you enter for each payment, and discusses how to print
checks and advices.

You use the Payment Entry form to:
e Create new batches of payments.

e Enter payment information for checks you have already issued or for
checks you want to print using Accounts Payable.

e Apply existing documents (such as prepayments) to invoices.
e Apply payments and partial payments to job-related invoices.
e Edit system-generated payment batches.
e Print checks.
e Enter adjustments to invoices you are paying in the Payment Entry
form, instead of using the Adjustment Entry form.
Types of payment entries

In most cases, a payment transaction is the information that Accounts
Payable needs to print one check for a vendor and update the vendor
account with the check information.

The Payment Entry form lets you enter four types of transactions:

Payment. Records a check to pay outstanding transactions. You can
print the check from Payment Entry or enter the number of a previously
written check.

The program displays the vendor's outstanding transactions (invoices,
credit notes, debit notes, adjustments, and prepayments), and you select
the transactions you want to partially or fully pay.

Prepayment. Records a check written as a prepayment. You can print
the check from Payment Entry or enter the number of a previously written
check.

Prepayments pay for a purchase before you have been invoiced for it.



When you receive the invoice, you enter it using the Invoice Entry form,
then post it. The prepayment will then be applied against the invoice.

Apply Document. Lets you apply one posted document against another
(such as a prepayment against an invoice).

Miscellaneous Payment. Lets you issue a check to a person or
company for which you have not set up a vendor record. You enter the
distribution details of the purchase on the second tab of the Payment
Entry form in the same way as you enter an invoice. The distributions
debit the general ledger accounts you specify and credit the bank
account.

For each type of transaction (except Apply Document) you can print
checks immediately after entry or you can print them when you post the
payment batch.

Restrictions on batch entries

The main restrictions on the entries in a single payment batch are these:

All checks in the batch must use the same bank account. (You specify
the bank when you create the payment batch.)

All checks in the batch must be in the same currency and use the same
rate of exchange between the bank currency and the functional (home)
currency (if they are different).

As with the bank, you specify the batch currency and rate when you
create the batch. (You can change the bank rate later, but not the check
currency.)

Note that the currency you specify for a payment batch is the check
currency — not the currency of the vendors paid in the batch. Accounts
Payable lets you pay vendors in any currency you choose.

For example, you can have a functional currency of Canadian dollars, but
create a payment batch using US dollars to pay vendors in Mexico
(whose source currency is the peso).

Information entered with payments
For each batch, you enter:



Batch Number (supplied by the program).

Batch Date.

Batch Description (optional).

Bank Code.

Currency (of the payment batch in multicurrency ledgers).

Rate Date (date for establishing the rate of exchange between the
payment currency and the functional currency if you have a
multicurrency ledger).

Rate Type (such as spot rate, average rate, or weekly rate).
Bank Rate (set by the rate date and type, or overridden by the user).

You enter the following general payment information on the Payment
Entry form:

Entry number (select only if editing; otherwise, Accounts Payable
supplies the number).

Transaction Type (Payment, Prepayment, Apply Document, or
Miscellaneous Payment).

Description.
Vendor (will not appear for miscellaneous payments).

Remit To (a primary remit-to location code will appear by default if the
vendor has one; enter the payee name for miscellaneous payments).

Check Date (or Apply Date if applying a document).
Fiscal Year and Period (to which transaction posted).
Print Check (select if you want program to print it).

Check Number (if a payment or prepayment, you must enter a
number if not printing the check from Accounts Payable).

Check Language (unless you are applying a document).
Apply Method (for job-related payments).

Optional Fields (if you use Transaction Analysis and Optional Field
Creator).



You also enter the following detail information:
e Document(s) to which transaction is applied.

o If a payment, you select documents using one of two selection
modes (Select mode or Direct mode).

o If a prepayment, you specify a document number, purchase order
number, or sales order number.

o If applying a document, select the document being applied and the
document to which it applies.

e Distribution accounts (miscellaneous payment only).
e Check amount.
o If a payment, the total applied to documents.
o If a prepayment, a single amount.
o If a miscellaneous payment, the total of all distributions.

e Activation date for prepayments (usually the date you expect the
invoice).

A prepayment is not considered to be a credit to the vendor's account
until the activation date. So, if you generate payments using Create
Payment Batch before the activation date, the prepayment will not
offset vendor invoices or debit notes.

Exchange rates

You enter rate information for the payment on the Exchange Rates tab of
the form if either the bank or the vendor currency differs from the
functional currency.

There are two sets of rates:

e Bank rate — the rate of exchange between the check currency and
the functional currency.

¢ Vendor rate — the rate of exchange between the vendor's source
currency and the functional currency.

You can also override the check amount if the bank currency differs from
the vendor's. (This will, in turn, change the exchange rate.)
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Create Payment Batch Form — Overview

This topic contains an overview of the Create Payment Batch form.

The Create Payment Batch form lets you automatically create batches of
payment entries to pay all or a selection of your due accounts.

Only one bank per batch

You must create a separate payment batch for each bank account on
which you want to write checks.

Once you create a batch of payments, you can edit them the same way
you edit batches created with the Payment Entry form. (You must first
select the option Allow Edit Of System Generated Batches from the
Options form.)

Before you create a payment batch

e Post all outstanding batches.

e Post invoice batches to update vendor accounts with any new
charges, credit notes, and debit notes.

e Post adjustment batches to ensure that vendor records are correct.

e Post payment batches. Accounts Payable will scan all open batches
for pending payments, but problems can arise when you work on
several payment batches simultaneously.

For example, the payments listed on the Pre-Check Register will not
match the generated payment batch if you continue to enter payments
manually.

e Choose Generate Separate Payments For Each Invoice in the vendor
records of any vendors who require separate invoice payment.

e Use the Control Payments form to set maximum amounts or to hold
payments on individual invoices.

e Edit the Payment Selection Criteria to exclude individual vendors from
the check run.

e Place vendor records on hold if you want to block payments.



Print the Pre-Check Register

Print the Pre-Check Register and review it before you generate the
payment batch.

The Pre-Check Register lists the details and totals of checks that the
program will produce, using the criteria you specify in the Create
Payment Batch form. After reviewing the Pre-Check Register, you may
decide not to pay certain transactions, or you may want to force payment
on certain transactions, or pay only a portion of a transaction.

If you use the Control Payments form to add payment restrictions, reprint
the Pre-Check Register to check their effects.

Create the batch

When you are satisfied with the transactions listed for payment on the
Pre-Check Register, you can use the Create Payment Batch form to
create the payment batch.

Print batch listings

List the payment batch after you create it and before you print checks.
You can edit payments and delete transactions before you print checks.
Once you print checks, you cannot edit the transactions, but you can
delete them.

Print checks

Print the checks and payment advices together or separately using the
Print/Post button in the Payment Batch List form. Once you indicate that
the printed checks are acceptable, the checks are posted to the vendor
accounts.

If the checks are not acceptable, you can reprint them as often as
necessary. They will not be posted until you indicate that they are
acceptable.

Print Check Register

Normally, you print the Check Register immediately after you have
printed and posted checks and advices.



The Check Register provides a list of all valid checks issued by the check
printing program.

You will likely do check runs on a regular basis (semi-monthly, for
example, or as often as necessary to maintain a consistent cash flow).

Selecting invoices for payment

You select invoices for payment in the Create Payment Batch form by
specifying:
e The bank for the payment batch and the vendor. In multicurrency

ledgers, you also specify the bank currency for the payment batch
and the currency for the vendor.

e The type of document date you want to use for selecting documents
for payment. You must choose one of the following:

Due Date. Select this option if you want the program to select
transactions only on the basis of due dates and not consider discount
dates. (The program ignores discount dates when selecting
transactions, but still takes the discounts that are available when
paying the transactions.)

You must also enter the date on or before which the invoice must be
due in order to be paid.

Discount Date. Select this option if you want the program to select
transactions only on the basis of discount dates and not consider due
dates. (The program ignores due dates when selecting transactions.)

You must also enter a range of dates during which the discount must
be paid in order for the invoice to qualify.

Due Date and Discount Date. Select this option when you want to
pay all transactions that are due on or before a certain date, or that
may not be due, but which have a discount available on or before the
same date. (The program looks at both due dates and discount dates
when selecting transactions.)

You must enter an “on or before” due date and a range of discount
dates.

e Whether to pay all selected documents or forced documents only.



All Selected. Includes all selected transactions.

Only Forced. Includes only the selected transactions that have a
Forced status.

e Vendor ranges. You can select vendors by choosing ranges for each
of the following:

o Vendor groups.

o Vendor numbers.

o Account sets.

o Check amounts (lets you place a ceiling on check amounts)
e Vendors you want to exclude from the check run.

Selection criteria are defined, then used again and again

Remember, that you define these selection criteria in the Payment
Selection Codes form, then use them when you create the payment
batch.

On Hold transactions

Transactions that are being withheld (either because the associated
vendors are on hold or because the transactions have been placed on
hold in the Control Payments form), and prepayments with activation
dates later than the check date, do not appear on the Pre-Check Register
unless you force them (assign them a Forced status) in the Control
Payments form.

Note that the Pre-Check Register will list transactions assigned a Forced
status only if the amounts of the checks that would include the Forced
payments are within the minimum and maximum check amounts
specified for the check run.

The Pre-Check Register can also include all payables that were
bypassed in the check run. Bypassed transactions include transactions
placed on hold in the Control Payments form, transactions being withheld
from payment because the vendors have been placed on hold in the
Vendors form, and Forced transactions for amounts outside the specified
range of check amounts.



Create Recurring Payable Batch Field List

For help about the options and fields in the Create Recurring Payable
Batch form, select from the keywords listed below:

From/To
Method
Run Date
Select By
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Method

Accounts Payable lets you choose whether to create a new batch or add
the invoices to an existing batch. (To select an existing open batch, click
the Finder beside the Add to an Existing Batch field.)

¢ |f you select Default, the program adds the invoices to an open
invoice batch that has the same run date. If no batch has the same
run date, it creates a new batch.

e |f you select Create A New Batch, the program creates a new batch of
recurring payable transactions.

e If you select Add To An Existing Batch, the program displays an
additional field with a Finder that lets you select the batch you want to
contain the new transactions.



Aged Retainage Report — Features

The Aged Retainage report groups outstanding retainage amounts by
due date into a current period and four aging periods.

You can print the report in detailed form, listing all outstanding retainage
amounts for each vendor, or in summary form, printing one line for each
vendor number, including the outstanding retainage amounts in each
aging period.

If you select Vendor Group or Account Set as the primary sort order,
subtotals (for a single currency company), or subtotals by currency (for a
multicurrency company) appear on both the summary and the detalil
report.

For instructions on printing the report, see Aged Retainage Report —
Printing.
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Refresh

Click the Refresh button to update the information in the displayed batch
list, if it has changed since you opened the form. For example, if you
have chosen not to show posted/deleted batches and another user has
posted or deleted a batch, the batch will disappear from the list when you
click Refresh.



Adjustment Entry Field List

Batch description

Batch number and batch header information
Batch date

No. of Entries (display only)

Total Amount (display only)

] Document tab
] Job-Related Details
) Retainage tab

) Optional Fields tab

[}l Rates tab
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Adjustment Entry — Document Tab

The Document tab lets you:

e Specify the vendor number.

e Specify the document number and the payment number for the
document you want to adjust.

e Open a H rinder that lets you select a particular detail for adjustment.

e Use the detail grid to add details that did not exist on the original
document, or to enter debit or credit amounts to modify existing
details.

For more detailed information about another tab on the Adjustment Entry
form, click the corresponding link:

Retainage | Optional Fields | Rates
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Adjustment Entry — Retainage Tab

The Retainage tab appears if you use retainage accounting in your
Accounts Payable system.

Use the tab to enter retainage terms and (if you use multicurrency) the
retainage exchange rate.

Also, if you are adding or adjusting retainage for a document created with
a version of Accounts Payable earlier than version 5.4, you use the tab to
enter the amount by which to add or adjust retainage in the retainage

debit field (for an invoice or a debit note) or the retainage credit field (for
a credit note).

Note: If the selected document is job-related, or if you created the
document using Accounts Payable version 5.4, or later, you add or adjust
retainage for particular document details on the detail-entry grid.

For detailed information about another tab on the Adjustment Entry form,
click the corresponding link, below:

Document @ Optional Fields @ Rates




Adjustment Entry — Optional Fields Tab

The Optional Fields tab appears on the Adjustment Entry form only if you
use Sage ERP Accpac Transaction Analysis and Optional Field Creator.

If you marked any adjustment optional fields for automatic insertion, they
appear on the tab, along with their default values, when you add a new
adjustment entry.

You can add any other optional fields that are defined for adjustments,
and you can delete any that are assigned automatically, except Required
fields.

Default values for the optional fields appear, as follows:

e |f an optional field assigned to the current adjustment was also used
on the document you are adjusting, the program displays the values
from the original document.

e |f an optional field assigned to the current adjustment was not used on
the original document, but it is assigned to the vendor record,
Accounts Payable displays the default value from the vendor record.

e |f an optional field assigned to the current adjustment was neither
used on the original document nor assigned to the vendor, the
program uses the default value from the optional field record.

You can change the default values, as follows:

¢ |f the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional field
allows blanks, you can leave the value field blank.

¢ |f the optional field is not validated, you can select a predefined value,
or you can enter any value that is consistent with the type of field
(amount, text, yes or no, and so on), providing your entry does not
exceed the length permitted for the field.

For detailed information about another tab on the Adjustment Entry form,
click the corresponding link, below:

Document | Retainage @ Rates




Adjustment Entry — Rates tab

This tab appears only in multicurrency Accounts Payable systems when

you enter an adjustment for a vendor that does not use your functional
currency.

You use the tab to enter the rate type, rate date, and exchange rate for
the adjustment.

You can also use the tab to check the exchange rate that was used on
the document you are adjusting.

For detailed information about another tab on the Adjustment Entry form,
click the corresponding link, below:

Document @ Retainage | Optional Fields




Batch Number and Batch Header Information

Use the Batch Number field to
e Create a new adjustment batch or open an existing batch
¢ View descriptive information for a batch

To create a new batch
e Click the New ( 1) button beside the Batch Number field.
e Enter a description and a date for the batch.

To view descriptive information for the batch

e Click the Zoom () button beside the Batch Number field. The
adjustment Batch Information form opens, displaying additional
information for the batch.

To select an existing batch, do one of the following
e Type its number in the Batch Number field.
e Select it from the Finder beside the field.

e Click the navigation buttons beside the Batch Number field to move
quickly through the list of batches.
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Adjustment Entry — Batch Information Form

This form appears when you click the Zoom (.) button for the Batch
Number field on the Adjustment Entry form.

You use the Batch Information form to view or specify:
e The batch date and a description for the batch.

This batch information form also lets you view information about the
selected adjustment batch that is not contained on the Adjustment Entry
form, such as the date the batch was last edited, the batch type and

status, the source application, and the number of entries in the batch and
their total amount.

For detailed information about each field on the Batch Information form,
click the Field List button, above.



Control Payments Field List

For help about the options and fields in the Control Payments form,
select from the keywords listed below:

Single Document fields
Activation Date (prepayments)

Balance (display only)

Currency (display only)
Discount Amount

Discount Date

Discount Percent

Document date (display only)
Document Number
Document Status

Document Total (display only)
Document Type (display only)
Due Date

Payment Limit

Payment Number

Terms Code and Description (display only)
Vendor Number

Range Of Documents fields
Clear Payment Limit
Document Number range
Document Status
Document Type
Vendor Group range
Vendor Number range
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Control Payments — Single Document

The Single Document tab of the Control Payments form lets you:

¢ View or change the due date, discount date and percent, prepayment
activation date (if applicable), discount amount, and document status
of individual transactions.

e Set a payment limit for a particular invoice.

To control payments for a range of documents, see Control Payments —
range of documents.

For an overview of the Control Payments form, see Control Payments.

For complete instructions on using the Control Payments form, see Steps
for applying payment controls.

Forced documents

Invoices and debit notes that are assigned a Forced status will be paid in
the next check run, unless:

e The payment amount of the check is outside the minimum and
maximum amounts specified for the check run.

e The vendor bank does not match the batch bank, and you selected
the vendor record option to Select Vendors With This Bank Code
Only.

e The vendor currency does not match the vendor currency for the
batch.

e There is a pending payment in an open batch for the same document.

Documents on hold

Documents assigned an On Hold status will not be paid in a system
check run until the On Hold status is removed.

Note that when you post invoice batches, Accounts Payable will not apply
any matching prepayments if either the prepayment or the invoice has an
On Hold status. In addition, it will not apply credit notes or debit notes if
either the credit (or debit) note or the specified Apply-To document is on



hold. When you post payment batches, prepayments will not be applied
to matching invoices if the invoice has an On Hold status.

To apply a prepayment, debit note, or credit note to a document you have
put on hold, you must first remove the On Hold status using the Control
Payments form, or you can use an Apply Document transaction in
Payment Entry to apply the document manually.

Payment limit

You can use the Payment Limit field set a maximum amount that can be
paid for a selected document when you generate payments using the
Create Payment Batch form.

You can enter a greater payment if you pay the document using the
Payment Entry form..
Date and discount changes are permanent

Changes to the due date, discount date, discount percent, and discount
amount are permanent changes to the document. You would make them
after renegotiating terms or if the original document was incorrect.

& Related Topics
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Control Payments — Range Of Documents

The Range Of Documents tab of the Control Payments form lets you:

e Change the status of groups of selected transactions.
e Clear payment limits set for invoices in the range of documents.

To control payments for a specific document, see Control Payments —
single document.

For an overview of the Control Payments form, see Control Payments.

For complete instructions on using the Control Payments form, see Steps
for applying payment controls.

12 Related Topics
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Create Payment Batch Field List

For help about the options and fields in the Create Payment Batch
form, select from the keywords listed below:

Selection Code

Select tab

Apply Method

Bank Currency

Batch Date

Include Bypassed Payables on Register
Pay from Bank

Payment Date

Select Vendors with this Bank Code Only
Vendor Currency

Criteria tab

Accounts Set Range

Discount Available From ... To...
Due On or Before

Pay All Selected Documents

Pay Only Forced Documents
Payment Code Range

Vendor Amounts Range

Vendor Group Range

Vendor Number Range

Exclusion tab
Vendor Number and Name

Rates tab

Currency (display only)
Exchange Rate

Rate Date (display only)
Rate Type

Optional Fields tab
Optional Field and Description
Value and Description
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Create Payment Batch — Select Tab

Use Select tab to specify the following bank and currency selection
criteria:

e The batch date and the date that will appear on checks.
e The bank account from which the checks will be drawn.

e The bank currency (check currency) and the vendor currency
(multicurrency ledgers only).

e Whether the Pre-Check Register will list payables which were
bypassed due to the selection criteria.

The tab also provides the date of the last Pre-Check Register, the date
that the last manually entered check was printed, and the date that the
last system check was printed, and shows whether there are unposted
payment batches.

To display the Selection Code field

To display the Selection Code field, and change the selection code, use
the Clear button. Once you choose the Selection Code, Accounts
Payable removes the field from the form to protect your settings.

For complete instructions on creating a payment batch, see Steps for
creating a payment batch.

For complete instructions on using the Control Payments form, see Steps
for applying payment controls.

Click one of the links below for help on using the corresponding tab:

Criteria | Exclusion | Rates | Optional Fields

Click the names of the buttons below for additional help:

Reqister Generate Clear Close

Bypassed Payables

This option prints payments which are due but are excluded from the
batch because they have payment controls, or are on the exclusion list.
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You can see which invoices are not being paid as a result of an old hold
— or a too generalized hold on a range of vendors.

Check Language

The language for printing the check amount in text is taken from the
vendor record or primary remit-to record for each vendor. If you need to
specify a different language for individual checks, you will have to edit the
payment entries after you create the batch.

Note that the check language applies only to the textual amount printed
on each check. All other text on the check or advice comes from the
check report form, which you can edit using the Report Designer in
Common Services.

& Related Topics
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Create Payment Batch — Criteria Tab

Use this tab to select the vendor and date, as follows:

e Choose the method for selecting documents for payment (by due date
or discount date).

e Set the selection due date and/or range of dates for available
discounts.

e Select all documents meeting the criteria or forced documents only.

e Set ranges of vendors, vendor groups, account sets, and payment
amounts.

Click one of the links below for help on using the corresponding tab:

Select | Exclusion = Rates | Optional Fields

Click the names of the buttons below for additional help:

Reqister Generate Clear Close

12 Related Topics
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Create Payment Batch — Exclusion Tab
Use this tab to:

e List all vendors that you want excluded from the payment batch.
To exclude vendors

e In a new line of the list, enter the number of the vendor you want
excluded or select it from the Finder.

Press the Insert key to start a new line.
To remove vendors from the list
e Highlight the line you want to remove, and press the Delete key.
Click one of the links below for help on using the corresponding tab:

Select | Criteria | Rates | Optional Fields

Click the names of the buttons below for additional help:

Reqister Generate Clear Close

12 Related Topics
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Create Payment Batch — Rates Tab
The tab lets you:

e Change the exchange rates for the payment batch.
Click one of the links below for help on using the corresponding tab:

Select | Criteria | Exclusion | Optional Fields

Click the names of the buttons below for additional help:

Reqister Generate Clear Close

Exchange rates are maintained in Common Services

The default bank rate for the check currency and the vendor currency
comes from Common Services, and is based on the rate type and the
session date.

If the batch is in the functional currency

Note that the rates are for converting the bank currency and/or the
vendor currency to your functional currency. If either of these currencies
is the functional currency, the exchange rate for that currency will be
1.0000000.

The rates you specify on the Rates tab apply to the whole batch. If you
need to change the rate for a few transactions, you can edit them in the
Payment Entry form.
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Create Payment Batch — Optional Fields

Tab

This tab appears if you use Sage ERP Accpac Transaction Analysis and
Optional Field Creator. It lets you specify optional fields for a payment
batch.

The program automatically inserts the payment optional fields and default
values assigned to the payment selection code you specify for the
payment batch.

You can add or delete payment optional fields, and you can accept or
change the values that appear as defaults.

If you delete optional fields that are automatically inserted by the
program, when you create the batch, the program will reinsert the
optional field, but will use the default value from the Optional Field setup
record.

When you create the batch, the program includes with each payment:

e Use all payment optional fields that are marked for automatic
insertion.

e Any additional payment optional fields that you specified for the
payment batch.

The program assigns values to the optional fields, as follows:

e For optional fields assigned to the batch on the Create Payment
Batch form, the program uses the value from the Optional Fields tab.

e For automatically inserted payment optional fields that do not appear
on the payment selection code or the Optional Fields tab:

o If the payment optional field matches an optional field in the
vendor record, the program uses the value from the vendor record
— unless you also specified a remit-to location.

o |If the payment optional field matches an optional field in the remit-
to location record specified on an invoice, the program uses the
value for the remit-to location.

o If the values for an optional field in the vendor record and the



remit-to location record are different, the value from the remit-to
location is used.

o If the vendor does not use the payment optional field, the program
uses the value specified in the optional field setup record.

Click one of the links below for help on using the corresponding tab:

Select @ Criteria = Exclusion | Rates

7 Related Topics
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Printing a Check Register

The Create Payment Batch form provides a Pre-Check Register to let
you preview the payment transactions that will be created by the current
payment criteria when you generate a payment batch.

You should always print a Pre-Check Register, so you do not get
unexpected results when you generate the batch.

To print the Pre-Check Register
1. Open the Create Payment Batch form

2. Select the code you want to use to create the payment batch. Use the
Clear button to erase previous selection criteria that you do not want
to use.

3. Modify the criteria, if necessary.

4. Make sure your printer is turned on and ready, then choose the
Register button to print the Pre-Check Register.

Note that you can leave the Create Payment Batch form at any time, and
the program will retain all the criteria you have specified. This ensures
that the generated checks will match the Pre-Check Register.



Generating a Payment Batch

To generate the payment batch

1.
2.

Open the Create Payment Batch form

Select the code you want to use to create the payment batch. Use the
Clear button to erase previous selection criteria that you do not want
to use.

Modify the criteria, if necessary.

4. Make sure your printer is turned on and ready, then choose the

Register button to print the Pre-Check Register.

You should always print a Pre-Check Register, so you do not get
unexpected results when you generate the batch.

Review the register and make whatever changes are necessary for
your check run. You can use the Control Payments form or refine the
selection criteria.

Note that you can leave the Create Payment Batch form at any time,
and the program will retain all the criteria you have specified. This
ensures that the generated checks will match the Pre-Check Register.

When you are ready to create the payment batch, choose the
Generate button.

You can edit the batch using the Payment Entry form. (You must select
the option Allow Edit Of System Generated Batches in the Options form.)



Print a Check from Payment Entry

[}l Before printing a check

Note: Once you print a check, you cannot edit it. If you delete a check
before it is posted, Accounts Payable will void the check in Bank
Services.

To print a check:

1.

Open the Payment Entry form, select or enter the check you want to
print. (You cannot print the check until you add the transaction. The
check can be a payment, prepayment, or miscellaneous payment.)

Select the Print Check option, if it is not selected.

3. Click the [ print check button t0 Open the Print Checks form.

Note these points:

o The check stock is set in Bank Services, but you can change it
here, if necessary.

o An Advice file name appears only if you are printing separate
payment advices.

o The check status is "Not Printed."

When a check (and advice, if printed) is printed successfully, the
status changes to "Printed." If the check is printed, but you have not
yet printed the advice, the status is "Advice Not Printed."

If you are not ready to print this check, click the Close button.
When a message appears warning you that "Not all checks have
been printed,"” click Yes to leave the Print Checks form, cancel the
check run, and void the printed checks. (None were printed.)

Click the Align button to print an alignment check. (The alignment
check prints Xs in place of numbers and letters on a check form, so
you can see that the check forms are inserted properly in the printer.)

Align always prints to your printer, no matter what print destination
you selected for Sage ERP Accpac. Make sure your printer is ready
before you choose Align.

Click the Print button to print the current check. When the check has
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been printed, a message appears asking whether the check was
successfully printed.

If the check was printed and is correct, click Yes.

If you are not printing a payment advice, Accounts Payable posts the
check information to Bank Services and closes the Print Checks form,
returning you to the Payment Entry form.

Once the check information has been posted to Bank Services, you
cannot edit the payment entry or reprint the check. If necessary, you
can delete the payment entry (until you post it), which voids the check
in Bank Services.

If you need to reprint the check, click No. Then reset the status of
the check to Not Printed. You can change the status in one of two
ways:

o Double-click or press the Spacebar in the Check Status column.
If you printed Advices, then said No to the message that asked

whether the advices were printed successfully, you will cycle
through all three possible statuses by double-clicking.

o Click the Select Reprint Range button.

The Select Reprint Range form appears, letting you specify a
range of checks.

e Click OK to select the default range — which is for the one
check you printed.

o After resetting the status to Not Printed, click the Print button
again. (Unless you are printing Checks then Advices, the
button will change to Reprint.)

6. If you are also printing payment advices after printing checks (the
choice of Checks Then Advices), a message appears when the check
is successfully printed asking you to insert the advice stock in the
printer and click the OK button.

As with checks, the program lets you confirm that you inserted the
payment advice forms in the printer.

7. Once the advice has been printed, you confirm that it was printed



properly — as you did with the check.
If the advice was printed and is correct, click Yes.

o Accounts Payable posts the check information to Bank Services,
and closes the Print Checks form, returning you to the Payment
Entry form.

You cannot edit the payment entry or reprint the check once the
information is posted to Bank Services. If necessary, you can
delete the payment entry, which voids the check in Bank Services.

If you need to reprint the advice, click No. Then reset the status of
the check to "Advice Not Printed."” You can change the status in one
of two ways:

o Double-click in the Check Status column. You can reset the status
to Not Printed (to reprint the check) or to Advice Not Printed (to
reprint the advice only).

o Choose the Select Reprint Range button to reset the status to
Advice Not Printed.

8. If the check was not printed properly, but you cannot reprint it at this
time:

a. Click No when asked whether the check was printed successfully.
b. Reset the check status to Not Printed.

c. Click the Close button. A message appears stating that not all
checks have been printed, and asking whether you want to cancel
the check run.

d. Click Yes to cancel the print run and void the current check
number. (The number will otherwise be assigned a Void status
when you reprint the check.)

If you do not cancel the check run, Accounts Payable sets the batch
status to Check Printing In Progress, and you cannot edit the batch
until you reset the status to Open.

[t] After printing a check

[}l Related information
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Creating a New Invoice Batch

To create an invoice batch
1. Choose Invoice Batch List from the A/P Transactions folder.

2. When the form opens, click the New button to open the Invoice Entry
form, then enter a batch date and a description.

You can also create batches directly in the Invoice Entry form by clicking
the New button next to the Batch Number field.

For more information on creating batches, see Invoice Entry.




To open an existing batch

Use the Finder or the navigation buttons beside the Batch Number field
to list existing batches, then choose the batch you want from the list.



Posting an Invoice Batch

You can use the Post button in the Invoice Batch List form to post one

invoice batch at a time. To post a batch, you select (highlight) it in the list,
then click Post.

If the Ready To Post option is not selected for the batch, a message

appears to let you select the option for the batch from within the Invoice
Batch List form.

For more information on posting see Posting batches.
To post ranges of batches, use the Post Batches form.




Invoice Entry Field List

For help about the options and fields in the Invoice Entry form, select
from the keywords listed below:

Batch number and description
Batch date

No. of Entries (display only)
Total Amount (display only)

Batch Information Form

] Document tab
[l Detail distribution section
[}l Job-related fields

[] Detail Accounts/Taxes form (select a detail line, then click Account/Tax)

[l Taxes tab

[ Terms tab
[ retainage tab (@Vailable if Retainage Accounting option is used)

[ Optional Fields tab

[ rates tab (Multicurrency ledgers only)

[ Totals tab
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Invoice Entry € Document Tab

This tab lets you:

e Enter header information for the document.

¢ Indicate that the transaction is related to a project you maintain in
Sage ERP Accpac and Job Costing, and enter job-related information
for each document detail.

e Enter account distribution information for the document.
e Edit or delete existing distributions.

e Add a new vendor or a new remit-to location during invoice entry or
when editing an existing invoice.

¢ Indicate that the transaction is an intercompany transaction by
selecting the originating company for the transaction (the originator),
the destination company, and the route number of the transaction.
(See the Intercompany Transactions online Help for more information
about intercompany transactions.)

For full instructions on adding an invoice, credit note, debit note, or
interest, see Enter an invoice, credit note, or debit note.

For information on a different Invoice Entry tab, click the corresponding
link:

Taxes Retainage | Terms
Optional Fields | Rates Totals

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment Close
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Invoice Entry — Taxes Tab
Use this tab to:

e Change the tax class and tax included settings for the specified tax
group.

e If you want to enter taxes manually, edit the tax base and tax amount
fields.

To change the tax authorities listed on this tab, you must select a different
tax group on the Document tab.

To change the tax rates, you must use the Tax forms in Common
Services.

For an overview of the invoicing process, see Processing invoices, credit
notes, and debit notes.

For full instructions on adding an invoice, credit note, debit note, or
interest, see Enter an invoice, credit note, or debit note.

For information on a different Invoice Entry tab, click the corresponding
link:

Document Retainage | Terms
Optional Fields @ Rates Totals

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment | Calculate Taxes
Distribute Taxes | Derive Rate  Close

12 Related Topics
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Invoice Entry -- Retainage Tab

When you select the Retainage option on the Document tab, a Retainage
tab appears that lets you specify how to process retainage for this
invoice, debit note, or credit note.

The program displays the retainage percentage, retainage rate, and the
retainage terms from the vendor record. (If the invoice was created using
Accounts Payable 5.3, the retention period also appears on this tab.)
Unless the document is job-related, you can change these retainage
factors for a particular document.

If the document is job-related, you can change only the retainage rate
and retainage terms on this tab. You enter job-related retainage amounts,
retention periods, and retainage due dates with each job detail.

Accounts Payable calculates and displays the retainage amount and
retainage due date for the selected document. You can change these
fields, whether or not the document is job-related.

For detailed information about another tab on the Invoice Entry form, click
the corresponding link, below:

Document Taxes | Terms
Optional Fields | Rates @ Totals

For more information about processing retainage, see Using Retainage
Accounting.

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment Close
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Invoice Entry € Terms Tab

Use this tab to:

e Specify the terms for the invoice, if they are different from those
specified in the vendor record.

e Edit multiple payment schedules that are calculated for invoices.

e Qverride the discount base or discount amount calculated for an
invoice.

A payment schedule is created only if the invoice terms code uses the
Multiple Payment Schedule option.

For information on a different Invoice Entry tab, click the corresponding
link:

Document Taxes | Retainage
Optional Fields | Rates @ Totals

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment Close

Multiple payment schedule

Accounts Payable adds a Payment Schedule to the Terms tab if you
assign a terms code that uses a multiple payment schedule (for a number
of payments over a period of time € such as six monthly payments).

The payment schedule divides the invoice total into the number of
payments specified by the terms code. Each payment has its own due
date, payment amount, and discount period, which is displayed on the
Terms tab of the Invoice Entry form. If you want, you can change any
dates on the schedule, as well as decrease the number of payments (by
making later payments blank).

You can use multiple payment schedules with Intercompany
Transactions.

You can print payment schedules on batch listings if you select the Show
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Schedules option when printing listings of invoice batches from the Batch
Listing form.

& Related Topics
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Invoice Entry -- Optional Fields Tab

The Optional Fields tab appears only if you use Sage ERP Accpac
Transaction Analysis and Optional Field Creator (available separately),
and you have defined optional fields for Accounts Payable invoices.

Use the Optional Fields tab on the Invoice Entry form to:

® [} Check the optional fields used on a document.

e Assign different optional fields to a document.

e Check or Change the [ value used for an invoice optional field.

You use the Optional Fields setup form to define and assign optional
fields for invoice headers and for invoice details. You can also mark for
automatic insertion any optional fields you want to use as defaults when
you add new invoices, debit notes, and credit notes.

e Automatically inserted invoice optional fields appear on the Invoice
Entry Optional Fields tab when you add new documents. You can edit
or delete the optional fields that appear on the tab, and you can add
different invoice optional fields for specific invoices.

e Automatically inserted invoice details optional fields are associated
with each detail line. The Optional Fields indicator field on the detail
grid and on the Detail Accounts/Taxes form shows whether optional
fields are used with a particular detail. To add, edit, or delete invoice
detail optional fields, select the detail, then click the Optional Fields
zoom (a) button to open a separate Optional Fields form that lets you
change the optional field information for the detail.

Note that if an optional field uses validation, you can select only entries
that are defined for the optional field in Common Services.

For more information about entering invoice detail optional fields on
invoices, see Entering Optional Fields on Invoices.

For information on a different Invoice Entry tab, click the corresponding
link:

Document @ Taxes | Retainage
Terms Rates | Totals
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Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment Close

18 Related Topics
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Invoice Entry € Rates Tab

Use this tab to:

e Change the rate type, rate date, and exchange rate for converting the
document amount from the vendor's currency to the functional
currency.

This tab appears only if you use multicurrency accounting, and you are
entering a document for a vendor who does not use the functional
currency.

Note: Exchange rates between currencies participating in the European
Economic and Monetary Union (EMU) cannot be changed. If your
company does not use the euro (or other EMU currency) as its functional
currency, and you are paying an EMU vendor, you can change the rate of
exchange between your functional currency and the euro. However, you
cannot change the rate between the euro and a vendor participating in
the EMU.

For information on a different Invoice Entry tab, click the corresponding
link:

Document | Taxes Retainage
Terms Optional Fields @ Totals

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment Close
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Invoice Entry € Totals Tab

Use the Totals tab to see the amount of recoverable tax, separately
expensed tax, and allocated tax, and to see why an invoice has an
undistributed amount.

The Totals tab displays the total tax amount on the invoice for each taxing
authority, as well as current totals for the document in two summaries: an
invoice summary and a tax summary.

For information about a different Invoice Entry tab, click the
corresponding link:

Document | Taxes Retainage
Terms Optional Fields @ Rates

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Prepayment Close

Recoverable and separately expensed taxes

Using Tax Services, you can specify that taxes are recoverable or are
expensed separately. For example, the GST in Canada and VAT in many
other countries are recoverable taxes and will not be distributed with
invoice totals.

When you choose the Dist. Taxes button, Accounts Payable:

e Removes (deducts) any recoverable portion of the tax from the tax
distribution amount and assigns it to the tax recoverable account.

e Removes (deducts) any portion of the tax which is expensed
separately and assigns it to the tax expense account.
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Invoice Entry — Prepayment

Use this Prepay button to open the Payment Entry form and enter a
prepayment for an invoice at the same time as you enter the invoice. You
can enter only one prepayment per invoice.

Once you have added the prepayment, you can print the check for it, if
you want. Click the Print Check button after adding the prepayment to
open the Print Checks form.

Click the Add button to add a prepayment to the selected payment batch.
Click the Close button to close the Prepayment form.



Payment Entry Field List

For help about the options and fields in the Payment Entry form, select
from the keywords listed below:

Bank

Batch Date

Batch Number and description
Currency

No. of Entries (display only)
Total Amount (display only)

L] Entry fields

[}l Document selection and application detail fields

Project and Job Costing Apply Details form

[}l Prepayment detail fields

[}l Miscellaneous Payments detail fields

D] Adjustment Entry fields

] Document History fields

[}l Rate Override fields
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Project and Job Costing Apply Details Form

When you pay an amount that is less than the current balance for a job-
related invoice, you need to specify the amount you are paying for each
detail, so that Accounts Payable can update the correct contracts,
projects, and categories in Sage ERP Accpac and Job Costing.

The Payment Entry form lets you use one of two apply methods to
allocate partial payments to job-related details. The Payment Entry form
also lets you open the Project and Job Costing Apply Details form that
you use if you need to:

e Choose a different apply method for a particular invoice.
e Select particular details for payment.

e Manually enter the amounts to pay for each invoice detail.

To apply partial payments to job-related invoices



Miscellaneous Adjustment Entry

The main purpose for this form is to let you account for small differences
between the amount you are paying to a vendor and the amount that
your records show you owe.

In order to use this form, you must select the Allow Adjustments In
Payment Batch option in the Options form.

You can adjust a document only if you have applied a payment to it (by
entering a Payment transaction).

To add an adjustment

If you have not added the payment yet, follow these steps to add the
payment and enter the adjustment

1. Choose the Print Check option.
2. Apply the transaction.

3. Save the transaction.
4

. Highlight the invoice you want to adjust, click the Adjust button, enter
the adjustment details, and save the adjustment.

5. Edit the payment once again to turn off the Print Check option and
enter the number of the check you issued.

If you have already added the payment, follow these steps to enter
an adjustment

1. Zero the check number and select the Print Check option. You can
then adjust the invoice to which the payment is applied, then save the
payment.

2. Edit the payment again after saving the changes, this time turning off
the Print Check option and entering the check number.
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Document History Form

This form lists all transactions that have been applied to the document
you select from the list of documents on the Payment Entry form (when
applying payments or previously posted documents).

To view the history of an invoice or debit note while applying a
payment, prepayment, or credit note

1. Highlight the document in the list at the bottom of the Payment Entry
form.

2. Click the History button.

The History form provides the following information about each
document that was previously applied to the selected invoice, credit
note, or debit note:

o Transaction type

o Check/document number

o Transaction date

o Payment adjustment amount
o Transaction description

3. If not all columns or rows are visible, click the arrows in the lower
corners of the form, or press the Tab key.

You cannot change any of the information in this form.
4. Click Close to return to the Payment Entry form.

You can also review document history on the Activity tab of the Vendor
Activity form.

You can view check information on the Payments tab of the Vendor
Activity form.




Payment Entry € Applying Payments

You use the Payment Entry detail grid to apply payments to specific
outstanding documents.

Once you have applied the payment, you can save the transactions and
print the check, if you want.

For an overview of payment entry, see Processing payments.

For full instructions on adding payments, see Steps for entering and
applying payments.

To apply the payment
1. Select the mode € Select or Direct.
If using Select Mode:

o Select:
e The document type (All, Invoice, Credit Note, Debit Note).

e The order (Document Number, Purchase Order Number, Due
Date, Order Number, Document Date, Balance Due).

e An optional starting number, balance, or date.

o Click Go to display the vendor's open documents of the selected
type.

2. Double-click in the Apply column to select Yes for each document to
which you want to apply the payment. To partially pay a document,
type the amount to apply in the Applied Amount column.

You cannot apply more than the total amount of the payment.

You can post the transaction without fully applying the prepayment or
credit note, leaving some to be applied at a later date.

3. If an early-payment discount applies to the invoice, enter the amount
in the Discount Taken column. Note that you can enter a discount
taken that exceeds the discount specified on the original invoice.

4. When finished, click Save.

To cancel the application, click Close or select another entry number,



then click No at the message that appears asking whether you want
to save your changes.

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Adjust Jobs
History | Print Check Void Check Close

To see the history of an invoice (all documents applied previously)

1. Highlight the invoice in the list at the bottom of the screen, then enter
Yes in the Apply column for the line.

2. Click the History button.

The History form provides the following information on each document
applied to the selected invoice:

o Transaction type
Check/document number

o

Transaction date

(¢]

o

Applied amount

(¢]

Transaction description

(¢]

Payer vendor number and name

3. Click Close to return to the Payment Entry form.

& Related Topics
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Payment Entry € Applying Prepayments and

Credit Notes

Use the Payment Entry detail grid to:

e Apply new payments to outstanding transactions.

e Apply previously posted prepayments and credit notes.
e Change unposted payment applications.

e Enter adjustments to invoices, credit notes, or debit notes (if you use
the Allow Adjustments In Payment Batch option).

e View the history of applications to a document.

To apply the prepayment or credit note

1. Enter the Document number of the prepayment or credit note you
want to apply, or choose it from the Finder.

Accounts Payable will display the amount that you can apply in the
Unapplied Amount field.

2. If you use optional fields and you want to view or edit any payment
optional fields automatically assigned to this transaction, click the
Zoom button («) beside the Optional Fields indicator.

A separate Optional Fields form appears, letting you edit or delete the
optional fields assigned to this transaction. You an also assign
different payment optional fields.

3. Select the mode € Select or Direct.
If using Select Mode,
o Select:
o The document type (All, Invoice, Credit Note, Debit Note).

o The order (Document Number, Purchase Order Number, Due
Date, Order Number, Document Date, Balance Due).

o An optional starting number, balance, or date.

o Choose Go to display the vendor's open documents of the
selected type.



Double click in the Apply column to select Yes for each document to
which you want to apply the payment. To partially pay a document,
type the amount to apply in the Applied Amount column.

You cannot apply more than the total amount of the payment. You can
post the transaction without fully applying the prepayment or credit
note, leaving some to be applied at a later date.

When finished, choose Save to apply the prepayment or credit note.

To cancel the application, choose Close or select another entry
number, then choose No at the message that appears asking whether
you want to save your changes.

For an overview of payment entry, see Processing payments.

For full instructions on adding payments, see Steps for entering and
applying payments.

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Adjust Jobs

History | Print Check Void Check Close

To see the history of an invoice (all documents applied previously)

1.

Highlight the invoice in the list at the bottom of the screen, then enter
Yes in the Apply column for the line.

Click the History button.

The History form provides the following information on each document
applied to the selected invoice:

o Transaction type
o Check/document number
Transaction date

(@)

o

Applied amount

(¢]

Transaction description

(¢]

Payer vendor number and name
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3. Click Close to return to the Payment Detail form.

7 Related Topics
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Payment Entry Details — Miscellaneous

Payments

The Payment Entry form lets you distribute a miscellaneous payment to
general ledger accounts.

Once you have distributed the payment, you can save the transaction
and print the check.

To distribute a miscellaneous payment
1. For each account to which you want to distribute this payment:
o Enter the distribution code or the general ledger account number.

o Enter the amount. Note that you may enter a negative amount on
a detail line. However, the document total must not be a negative
amount.

o Optionally enter a reference and description.

2. In multicurrency systems, choose the Rates tab if you need to assign
a different exchange rate for the miscellaneous payment.

3. When finished, click Add.
To add a distribution line
e Highlight a distribution line and press the Insert key.
To delete a distribution line
e Highlight the line you want to delete and press the Delete key.

Click the link below for help on using the Rate Override form:

Rates
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Payment Entry € Prepayments

Use the Payment Entry form to:
e Specify the amount of the prepayment.

e Specify the number of the document to which you want the
prepayment applied. You can identify the unposted document by its
invoice number, PO number, or sales order number.

To add a prepayment
Click the link below for help on using the Rate Override form:

Rates

Click the links below for additional help on using the corresponding
buttons:

Add/Save Delete Adjust Jobs
History | Print Check|Void Check| Close

You can post the invoice or the prepayment first

Accounts Payable matches up prepayments when you post payment
batches and when you post invoice batches. If the prepayment correctly
references the invoice number, PO number, or sales order number of an
invoice, it will be applied to the invoice no matter which document is
posted first.

12 Related Topics
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Payment Batch Information Form

The payment Batch Information form lets you specify:

e The batch date and a description for the batch.
e The bank.

e |n a multicurrency ledger, a currency, rate type, rate date, and
exchange rate to be used for the payments you add to the batch.

The Batch Information form also lets you view information about the
selected batch that is not contained on the main Payment Entry form,
such as the date the batch was last edited, the batch type and status, the
number of entries in the batch and their total amount, and whether the
batch listing and the checks have been printed.

For detailed information about each field on the Batch Information form,
click the Field List button, above.



Clear History Field List

For help about the options and files in the Clear History form, select from
these field names:

1099/CPRS Amounts
Deleted and Posted Batches
From/To

Fully Paid Documents
Posting Errors

Printed Posting Journals
Vendor Comments
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Clear Statistics

Vendor Statistics
Vendor Group Statistics




Create G/L Batch Field List

Create G/L Transactions from
Through Posting Sequence
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Create Retainage Batch Field List

] Document Type

) Number of Days In Advance To Generate Retainage Documents
L) Run Date

[ select By

[ From / To
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Delete Inactive Records Field List

For help about the options and fields in the Terms form, select from the
keywords listed below:

Delete These Records
From/To Inactive Dates
From/To Records
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Revaluation Field List

For help about the options and fields in the Revaluation form, select from
the keywords listed below:

Currency

Earliest Backdated Activity Date
Optional Fields

Provisional Revaluation

Rate

Rate Date

Rate Type

Revaluation Date
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Revaluation History Form

The Revaluation History form appears when you click the History button
on the Revaluation form.

It lets you:

e View historical revaluations for a selected currency. The Revaluation
History form lists all revaluations, even if no adjusting entries were
generated.

e Print the Revaluation posting journal. (Highlight a line on the grid, then
click the Print Posting Journal button.)

e Select a historical revaluation for display on the Revaluation form, if
you need to redo the revaluation to correct an error (for example, if
the original revaluation used wrong exchange rate) or to include a
backdated document. (Highlight a line on the grid, then click the
Select button.)

Click the links below for information about the buttons that appear on this
form.

Print Posting
Journal
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Revaluing Multicurrency Transactions

When exchange rates fluctuate, you may need to revalue outstanding
documents denominated in other currencies to reflect their present value
in your own (functional) currency at a particular time, for example, at
financial statement dates. When you revalue a transaction, Accounts
Payable recalculates its functional equivalent value at a new exchange
rate.

Some accounting standard-setting bodies require that you take gains or
losses due to fluctuating exchange rates into income (recognized) in the
period in which they occur.

In Sage ERP Accpac, exchange gains and losses are treated as
permanent or temporary, depending on the exchange Gain/Loss
Accounting Method specified for your Sage ERP Accpac system (in the
company profile).

¢ |f you use the Recognized Gain or Loss accounting method,
revaluation transactions are considered permanent. In this accounting
treatment, they are recognized immediately when you post them, and
they are not reversed in the next period.

¢ If you use the Realized and Unrealized Gain/Loss accounting method,
revaluation transactions are considered temporary, or unrealized,
gains and losses. Therefore, they are posted to General Ledger as
reversing transactions, meaning that General Ledger simultaneously
posts reversing transactions to the first day of the next fiscal period
following the revalued period. In this way, revaluation has no
permanent effect on the general ledger.

Under this method, realized exchange gains or losses are calculated
only when you post payments to pay invoices and debit notes, or
when you post credit notes to pay down invoices.

Note:Rounding differences may occur during revaluation. These
exchange differences are automatically posted to the exchange rounding
account when payments are posted.

You do not post revaluation batches in Accounts Payable. If you do not
have Sage ERP Accpac General Ledger in your company database,



Accounts Payable creates an export batch for your general ledger. If you
import a revaluation batch into another general ledger, make sure that the
revaluation transactions are reversed in the next fiscal period.

To revalue multicurrency documents




Revaluing Periods that Contain Backdated Documents

Sage ERP Accpac lets you post a multicurrency document that predates
the last revaluation for the document currency, and it lets you apply the
backdated document. An exchange gain or loss can arise.

The accounting method you use to record exchange gains and losses in
your Sage ERP Accpac system determines how the revaluation process
handles backdated documents.

¢ If you use the Realized and Unrealized Gain/Loss accounting
method, you can revalue the backdated document by running the
Revaluation program again for the period to which you posted the
document (process a backdated revaluation). For this accounting
method, if you rerun revaluation for a period that contains a
backdated document, you must also rerun all subsequent
revaluations.

¢ If you use the Recognized Gain/Loss accounting method, you can
let the program automatically correct any exchange gains or losses
for backdated documents and the documents to which they are
applied.

To automatically correct these exchange gains or losses, enter or
accept a date in the Earliest Backdated Activity Date field on the
Revaluation form.

You can also choose to ignore the backdated document, for example,
if it is not material or if you posted it to a period that does not coincide
with the end of a reporting period. If you do not want the program to
revalue backdated documents and activity when you perform a
backdated revaluation, leave the Earliest Backdated Activity Date field
blank on the Revaluation form.

The program adjusts exchange gains and losses for backdated
documents and documents affected by backdated activity as of the
balance sheet dates:

o If the current revaluation date is on or after the last revaluation
date and there is a backdated document (or a document affected
by backdated activity), the program revalues the document and



creates adjustments as of the current revaluation date. (The
Earliest Backdated Activity Date field does not appear.)

If the current revaluation date predates the last revaluation date
and you are revaluing a backdated document or a document
affected by backdated activity, Revaluation:

o Creates entries to recognize exchange gains or losses for
backdated documents as of each revaluation date from the
earliest backdated activity date to the last revaluation date.

o Ignores any backdated documents with posting dates before
the Earliest Backdated Activity Date.

If the revaluation occurs between the document date and
settlement date, and the revaluation rate is different from the
current rate for the settlement document, Revaluation creates
adjustments to:

o Update the document’s functional balance (including discount
and retainage balances) for the revalued period.

o Correct any exchange gains and losses recognized at the time
of settlement for the period from the revaluation date to the
settlement date.



Revaluing Documents with a Multiple Payment Schedule

If you use the Recognized Gain/Loss accounting method, when you
revalue a document that uses a multiple payment schedule, Revaluation
revalues each portion of the invoice that is due and applies the sum of
the net gains (or losses) to the document.



Revaluing Outstanding Retainage

If you use multicurrency, when you run Revaluation, the program also
revalues amounts outstanding in the retainage control account.

For revalued outstanding retainage, the program creates general ledger
entries to adjust the retainage control account rather than the payables
control account.

If your Sage ERP Accpac system uses the Realized and Unrealized
Gain/Loss the accounting method to revalue multicurrency documents,
the program also creates reversing entries for the next period. (You set
the revaluation accounting method in the Company Profile, in Common
Services.)

The Revaluation Posting Journal includes a separate section for
retainage, following the current revaluation of documents for each
vendor.

If you include job-related details on the posting journal, a retainage
section appears on the Summary page after the current job details.



Unrealized Gains and Losses

If your Sage ERP Accpac system uses the Realized and Unrealized
Gain/Loss method to revalue multicurrency amounts, Accounts Payable
calculates unrealized exchange gains or losses as follows:

Source , Revaluation
amount Rate

Less: Functional amount
Unrealized gain (loss)

The revaluation transaction is reported on the Vendor Transactions report
for the vendor as type GL.

When you post the revaluation batch in General Ledger, the program also
posts a reversing entry to the first day of the next fiscal period:

When you print the Vendor Transactions report for the period in which
you post the reversing revaluation transaction, both transactions appear
for the vendor. Their net effect on the account balance is zero.



Year End Field List

For help about the options and fields in the Year End form, select from
the keywords listed below:

Clear Activity Statistics

Clear Invoices Paid And Days To Pay Counter
Clear Recurring Payable Amount Invoiced To Date
Reset All Batch Numbers



javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

1099 Electronic Filing Field List

[l From/To Vendor No
| Output File
) Payment Year

Transmitter information
| Company

[t contact

[}l control Code (TCQ)

[t current Filing Method

[ E-mail

| Foreign Entity

[}l Name Line 1 and Line 2

[l Phone

[t street/City/State/Prov./Zip/Postal Code/Country
| Tax Number

L Test File

Payer information
L Final Filing

| Foreign Entity

[l Media Number

[t] Name Control

] Name Line 1

| (Name) Line 2

[}l office Branch (optional)

[l Phone

[} street / City / State (Prov.) / Zip (Postal Code) / Country
| Tax Number

[t Transfer Agent



javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

T5018 Electronic Filing Field List

| Payment Year

| Output File

| Report Type

[l From/To Vendor No.
] From/To CPRS Code

Transmitter information

[}l Name Line 1 and Line 2

[}l Address Line 1 and Line 2

[t City/State/Prov./Zip/Postal Code/Country Code
[}l Transmitter Number

[}l Submission Reference ID

[t contact

[l Phone

[ E-mail

) Language

Payer information

[}l Account Number

[}l Name Line 1 and Line 2

[t City/State/Prov./Zip/Postal Code/Country Code
[}l contact/Phone
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Account Sets Report — Features

This report lists the account sets defined for your Accounts Payable
system. Print the report when you add, change, or delete account sets.

For instructions on printing the report, see Account Sets Report —
Printing.

Information printed on the report
For each account set, the report lists:

e The account numbers for your general ledger Payables Control,
Purchase Discounts, and Prepayment accounts.

e The range of account sets printed.
If you use multicurrency accounting, the report also lists:

e The currency code that identifies the currency used by the vendors
assigned to this account set.

e The unrealized and realized exchange gain and loss general ledger
accounts (if the account set is in a currency other than the functional
currency). Unrealized gains and losses occur when you perform a
revaluation of your Accounts Payable data. Realized gains and losses
occur when you post transactions such as payments (and the
payment is at a different rate of exchange than the invoice).

e The exchange rounding account to which to post differences that arise
during currency conversion.

18 Related Topics
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Distribution Codes Report — Features

The Distribution Codes report lists the descriptions and numbers of the

general ledger accounts used in the distribution codes in your Accounts
Payable system.

For instructions on printing the report, see Distribution Codes Report —
Printing.

Information printed on the report

e The description and general ledger account number assigned to each
distribution code.

e The date the record was last edited.

e For inactive distribution codes, the date on which a code was made
inactive.

12 Related Topics
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Distribution Sets Report — Features

The Distribution Sets report lists the distribution methods and distribution
codes specified for the distribution sets you use to allocate purchase
amounts in your Accounts Payable system.

For instructions on printing the report, see Distribution Sets Report —
Printing.

Information printed on the report

e The number and description of the general ledger account assigned
to the distribution code.

e The Distribution Percentage column contains information only when
the distribution method is Fixed Percentage.

7 Related Topics
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E-mail Messages — Features

The E-mail Messages report lists the messages you created to send to
vendors with e-mailed letters.

For instructions on printing the report, see E-mail Messages Report —
Printing.

Information printed on the report

e Each message is printed along with its message ID, description, and
subject line.



G/L Integration Report — Features

The GJ/L Integration report lists the options and other information entered
on the G/L Integration form that determine how your Accounts Payable
system interacts with General Ledger.

For instructions about printing the report, see G/L Integration Report —
Printing.

Information printed on the report
e The options selected on the G/L Integration form.

e The posting sequences through which you have created general
ledger transactions.

e The segments and separators to be used for the reference,
description, and comment fields for each type of transaction created

for general ledger (specified on the Transactions tab of the G/L
Integration form).

12 Related Topics



javascript:mc153.Click()

Optional Fields Report — Features

You print the Optional Fields report whenever you need a listing of all the
optional fields set up for Accounts Payable.

For each type of optional field, the report shows the optional field codes,
descriptions, default values, and whether an optional field is set for
automatic insertion in new records.

If you need instructions on printing the report, see Optional Fields Report
— Printing.

12 Related Topics
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Options Report— Features

The Options report lists the options selected and other information
entered in the Options form to specify how your Accounts Payable
system operates.

Information printed on the report
e The options in the Options form and your selection for each.
e The prefix and next number to assign to prepayments.

e The numbers that will be assigned to the next invoice, payment, and
adjustment batch you create and the next posting sequence for each
batch type.

e The posting sequences through which you have created general
ledger transactions.

For instructions about printing the report, see Options Report — Printing.

18 Related Topics
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Payment Codes Report — Features

The Payment Codes report lists the codes, descriptions, and methods of
payment used in your Accounts Payable system.

For instructions on printing the report, see Payment Codes Report —
Printing.

Information printed on the report
For each payment code, the report lists:

e The name of the payment code that appears in the payment code
fields in Accounts Payable (such as CASH, CHECK, WIRE, or the
name of a credit card).

e The description.
e The payment type (such as Cash, Check, Credit Card, or Other).
e The date the payment code record was last edited.

e For inactive payment codes, the date on which Inactive status was
selected.



Payment Selection Codes Report — Features

The Payment Selection Codes report lists the bank and currency codes,
selection criteria, and exclusion criteria defined for the payment selection
codes used to create payment batches in your Accounts Payable system.

For instructions on printing this report, see Payment Selection Codes
Report — Printing.

Information printed on the report
e The bank code associated with each payment selection code

e The selection criteria assigned to the code, including the method of
selecting documents and the ranges of vendor groups, vendor
numbers, account sets, and amounts from which to select.

e The list of vendors, if any, who are excluded from the accounts that
can be selected by the payment selection code.

7 Related Topics
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Terms Codes Report — Features

The Terms Codes report lists the information entered to define each
terms code, including multiple payment schedules and due date and
discount date tables, when used.

For instructions about printing the report, see Terms Codes Report —
Printing.

Information printed on the report

The range of terms codes you chose to print on the report.

The terms code and description, and date the terms record was last
edited.

The method used to determine the due dates for invoices assigned to
the terms code. You can calculate due dates using a number of days
from the invoice date, the end of the next month, a day of the next
month, a number of days from a day of the next month, or a due date
table.

Discount information including the method used to determine the
discount period, whether to include tax in the base for discount
calculations, and the discount percentage.

If the terms code uses a table to calculate due dates or discount
dates, the report lists the information in the table.

For multiple payment schedules, the report shows the percentage
due, the method of calculating the due date, and discount information
for each payment. This information appears only if you select the
Include Multiple Payment Schedules option.

18 Related Topics
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1099/CPRS Codes Report — Features

The 1099/CPRS Codes report lists the code and description for each
1099/CPRS code entered in your Accounts Payable system.

For instructions about printing the report, see 1099/CPRS Codes Report
— Printing.

Information printed on the report
e The range of 1099/CPRS codes you chose to print.

e The 1099/CPRS code and description, and date the terms record was
last edited.

If you add non-standard codes

e Only standard 1099-MISC codes are printed on the stock 1099/CPRS
Amounts report.

e |f you add any non-standard 1099/CPRS codes, you must modify the
1099/CPRS Amounts report form to print the non-standard codes.

12 Related Topics
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Aged Cash Requirements Report — Features

The Aged Cash Requirements report highlights the cash amounts that
will be required to meet obligations as they become due, including the
amount needed to pay invoices that are overdue, current, and due in
each of four future periods you define. Use the report for cash flow
analysis and projections.

For instructions on printing the report, see Aged Cash Requirements
Report — Printing.

Information printed on the report

e The Due Date/Applied Number/Applied Type column lists the due
date for documents at the left, and the document number and type of
applied details at the right.

e The Current column contains documents that are not yet due. Credit
notes, debit notes, and prepayments appear in this column if you
select "As Current" for the Age Credit Notes And Debit Notes and Age
Prepayments options in the Options form.

e The vendor contact and phone number, and your company's credit
limit with the vendor are listed if you select the Contact/ Phone/Credit
option.

e Subtotals (for a single currency company), or subtotals by currency
(for a multicurrency company), if you select Vendor Group or Account
Set as the primary sort order. Subtotals appear on both the summary
and the detail report.

e Extra space appears between each vendor record if you select the
Space For Comments option.

e Miscellaneous payments will appear as "MC" in the Document Type or
Applied Type.

e Reports set to age by Due Date have an option to display Aged
Retainage for each vendor. This option is not available if the Report
Type is set to age by Document Date.

The summary version of the report includes one line for each vendor



number, listing the overdue and current balance in the vendor's account,
and the balance that will come due in each of four periods.

& Related Topics
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Aged Payables Report — Features

The Aged Payables report groups outstanding transactions into a current
period and four aging periods by document date or due date. Use the
report to analyze your payables.

For instructions on printing the report, see Aged Payables Report —
Printing.

Information printed on the report

e The Due Date/Applied Number/Applied Type column lists the due
date for documents at the left, and the document number and type of
applied details at the right.

e The Current column contains documents that are not yet due. Credit
notes, debit notes, and prepayments appear in this column if you
select "As Current" for the Age Credit Notes And Debit Notes and Age
Prepayments options in the Options form. (You can choose whether to
include prepayments when printing the report.)

e The vendor contact and phone number, and your company's credit
limit with the vendor are listed if you select the Contact/ Phone/Credit
option.

e Subtotals (for a single currency company), or subtotals by currency
(for a multicurrency company), if you select Vendor Group or Account
Set as the primary sort order. Subtotals appear on both the summary
and the detail report.

e Extra space appears between each vendor record if you select the
Space For Comments option.

e Miscellaneous payments will appear as "MC" in the Document Type or
Applied Type.

e Reports set to age by Due Date have an option to display Aged
Retainage for each vendor. This option is not available if the Report
Type is set to age by Document Date.

The summary version of the report includes one line for each vendor
number, listing the current balance in the vendor's account and the



balance in each of four periods.

& Related Topics
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Batch Listing — Features

A batch listing is the printed record of the transactions in a batch.

You can print batch listings for invoice, payment, and adjustment batches
that have been entered, imported, generated, or posted. The invoice
batch listing includes debit notes and credit notes, as well as interest
invoices.

For instructions on printing the report, see Batch Listing — Printing.

To enforce a strict audit trail, turn on the Force Listing Of All Batches
option in the Options form. This option prevents you from posting batches
that are unlisted.

Information printed on the report
The following information is printed on the report:

e The batch entry number assigned to each transaction in the Invoice,
Payment, or Adjustment Entry form. This number is a permanent part
of the information stored for an entry, and appears on the posting
journals and on the unconsolidated G/L Transactions report. Use this
number to select an unposted transaction for editing, and to trace the
history of posted transactions.

L] Type (Ty) column lists the [ transaction type for the entry,

e Payment terms and due date for invoices. (Note that this information
appears only on invoice batch listings.)

The following codes may appear:

A"T", indicating that the payment terms have been edited, as noted
on the final tab of the report.

For multicurrency ledgers, an "R" appears if the exchange rate has
been edited. Note that the "R" and "T" codes appear only on invoice
batch listings.

An "E" appears on payment batch listings if an entry has been edited.
e Optional field

e Payment schedules are listed if you selected the Show Schedules
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option (for invoice batch listings only).
Summary pages

The invoice batch listing includes a summary page that lists batch
totals for the invoices, credit notes, debit notes, and interest charges
entered, and a total for the batch.

The payment batch listing summary page lists totals for adjustments
entered in the batch, discounts taken, and payments (amounts), and a
total for the batch.

The adjustment batch listing summary page lists the total debits and
credits for the batch.

The final page lists the descriptions of symbols that appear on the
report (for invoice and payment batch listings only), and the number of
entries and batches printed.

The payment batch listing final page also lists the general ledger
account debits and credits for adjustments entered in the batch.

7 Related Topics



javascript:mc145.Click()

Batch Status Report — Features

The Batch Status report describes all unposted invoice, payment, or
adjustment batches, and posted or deleted batches for which the
information has not yet been cleared from Accounts Payable. The report
is a valuable management tool for tracking batches, particularly when
several operators are entering batches on a multi-user system.

Print the report as part of the transaction-entry cycle, to discover batches
for which you need to print or reprint listings before posting, and batches
that contain errors.

The report includes a summary that lists the number of entries, number of
batches, and total amount for each type of batch and each batch status.

For instructions on printing the report, see Batch Status Report —
Printing.

7 Related Topics
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Check Register — Features

The Check Register report lists details of checks that are produced and
posted to vendor accounts during a check run. The Register can also list
the general ledger distributions that result. Checks that are used for
alignment or leading, as well as checks that are voided before posting,
are not included on this report because they do not result in the creation
of general ledger distributions or changes to vendor account balances.
These checks are listed on the Check Status report in Bank Services.

For instructions on printing the report, see Check Register — Printing.

Information printed on the report

The report lists the checks issued to vendors, in vendor number order.
Miscellaneous payments are listed first. Information includes:

e Sequence numbers that count the number of checks that will be
printed for the batch. (These numbers are not posting sequence
numbers or check numbers.)

e The type of payment (PI for prepayments; PY for payments).

e The number of the document paid by the check, followed by the
payment schedule number. The payment schedule number is always
1 unless the document has a multiple payment schedule.

e Discounts taken or adjustments made at the time the payment was
entered. You can make adjustments during payment entry only if you
select the Allow Adjustments In Payment Batch option in the Options
form.

e Any miscellaneous payments. Miscellaneous payments, which are not
assigned to vendor records, are listed under "MISC," with the name
(or other information) you entered in the Remit-To field in the Payment
Entry form.

e Entries that were edited after they were added are marked with an
asterisk.



7 Related Topics
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G/L Transactions Report — Features

The G/L Transactions report is a list of the general ledger transactions
created from all posted Accounts Payable batches, and from posted
revaluations (in multicurrency ledgers). You can print detailed or
summary versions of the report.

The level of detail for transactions on the detailed report depends on your
choices on the Integration tab of the G/L Integration form. For example, if
you choose Consolidate By Account And Fiscal Period, the report shows
a total for each general ledger account and fiscal period. If you choose
Do Not Consolidate, the report shows full details for each transaction.

The summary report lists one total for each account number.

For instructions on printing the report, see G/L Transactions Report —
Printing.

Information printed on the report
eThe detailed report includes:

e The batch and entry number. The entry number is assigned when
the transaction is added to a batch, and is a permanent part of the
record of the transaction.

® The [} source code assigned during posting to identify the transaction type.

e The Reference and Description information you selected in the GL
Integration form.

e Total by sorting option.

eThe summary version of the report includes a single line for each
account number, with the total debits and credits posted to the
account.

eTotal debits and credits for the report.
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Posting Errors Report — Features

The Posting Errors report lists incorrect entries that were placed into error
batches during posting and explains why the entries could not be posted.

For instructions on printing the report, see Posting Errors Report —
Printing.

Information printed on the report

e The incorrect entries, listed in order by the posting sequence numbers
assigned to their original batches, then by their original batch and
entry numbers.

e An explanation of the error in each entry.

7 Related Topics
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Posting Journals — Features

Posting journals list all the transactions in a group of batches that were
posted together, as well as the general ledger transactions that were
created from the batches.

The journals provide audit trail reports of all uncleared posted details.
For instructions on printing the report, see Posting Journals — Printing.

Information printed on the report

e The original batch and entry number for each transaction. Use these
numbers to trace transactions back to their batch listings. You can
also use the numbers to identify the transactions on the G/L
Transactions report, if you choose not to consolidate general ledger
batches (using the Consolidate G/L Batch option in the Options form).

e Tax information appears only on the Invoice Posting Journal, to show
the total tax for each tax authority on each invoice, credit note, or
debit note.

e Optional information that you can choose to include on the report &.

e The Payment Posting Journal includes an Adjustment and a Discount
column, to list any adjustments made to documents in the Payment
Entry forms, and discounts taken when payments were applied to
documents. (You can make adjustments during payment entry only if
you select the Allow Adjustments In Payment Batch option in the
Options form.)

e The Adjustment Posting Journal includes a Debit and a Credit
column, to list the general ledger account number or distribution code
(representing general ledger account numbers) to which each debit or
credit was posted.

e A summary page.

The Invoice Posting Journal includes a summary tab that lists
separate totals for invoices, debit notes, credit notes, and interest
invoices.

The Payment Posting Journal summary tab lists totals for
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adjustments, discounts taken, and payments.

The Adjustment Posting Journal summary tab lists the totals of debits
and credits.

e The General Ledger Summary lists the total amounts of the
transactions that were created for each general ledger account used
in the posted batches. These transactions are placed in the general
ledger batches Accounts Payable creates in Sage Accpac General
Ledger, if you use it, or in the batches that are produced for you to
transfer to another general ledger system.

If you use multicurrency accounting, the posting journals also include the
following additional information:

e The currency, exchange rate, and rate date for each transaction.

The Payment Posting Journal shows exchange rates for vendors and
banks that do not use the functional currency.

e The total for the transaction (and the total tax, for invoice posting
journals) in the functional currency as well as the source currency.

e A Summary tab which lists totals for each source currency used in the
report, as well as the equivalent totals in the functional currency.

e The amounts on the General Ledger Summary tab are shown in their
source currencies, with the corresponding equivalent amounts in the
functional currency.

& Related Topics
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Vendor Transactions Report — Features

The Vendor Transactions report lists transactions that were posted to
vendor accounts during the period you specify when you print the report.
You can order the transactions by document date, by"document number,
or by fiscal year and period.

For instructions on printing the report, see Vendor Transactions Report —
Printing.

Information printed on the report

[}l The transaction type.

Order number and 1099/CPRS information. If you do not enter a
1099/CPRS tax number in the record for a vendor who is subject to
1099/CPRS reporting, the total for the vendor is marked with an
asterisk to indicate that the tax identification number is missing.

L The applied type.

The number of days that the transaction is overdue on the date you
print the report. This information shows your payment habits with
each vendor and highlights seriously overdue transactions that may
require immediate payment.

Vendor contact, phone, and credit limit (if you select the Contact /
Phone / Credit option for the report).

Totals by vendor of outstanding invoices, credit notes, debit notes,
interest charges, and prepayments (if you select the Include Applied
Details option).

Miscellaneous payments will appear as "MC" in the Document Type or
Applied Type.

Space between each vendor record (if you select the Space For
Comments option).
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1099/1096 Forms — Features

The 1099 Amounts report lists the 1099-MISC amount for each vendor in
your Accounts Payable system.

The 1096 Amounts report prints the summary for the 1099-MISC forms.

For instructions about printing the forms, see 1099/1096 Forms —
Printing.

Information printed on the report

e Your company name, address, and tax number (TIN/SSN)..

e The vendor name, address, and tax number (TIN/SSN)..

e The 1099 payments you made to the vendor in the calendar year.

e Only standard 1099-MISC codes are printed on the stock 1099/CPRS
Amounts report.

12 Related Topics
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5018 (CPRS) Forms — Features

The CPRS/T5018 Amounts report lists the CPRS amount for each
vendor entered in your Accounts Payable system.

For instructions about printing the forms, see 5018 (CPRS) Forms —
Printing.

Information printed on the report
e Your company name, address, and business number.
e The vendor name, address, and business number.

e The CPRS payments you made to the vendor in the calendar year.

12 Related Topics
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Letters and Labels — Features

Letters and labels contain the information you specify for them in the
report format you choose to print. You can print letters and labels for the
individual vendors in your Accounts Payable system.

If you use optional fields as selection criteria when printing the report, you
can specify the ranges of values from which to select records for printing.
The report then includes only vendors that use the specified optional
fields, whose values fall within the specified range.

If you select Vendor as the delivery method when printing letters,
Accounts Payable prints the letters according to the & gelivery method specified in the
individual vendor records. YOU Can then specify the code for the message you want
to send with e-mailed letters.

For instructions on printing letters and labels, see Letters and Labels —
Printing.

Information printed on the report

Letters and labels can include the following types of information:

e Your company's name, address, telephone numbers, and contact
person.

e The vendor's name and address, from the vendor account or at the
remit-to location.

You can use Crystal Reports (available separately) to adapt the report
format that comes with Accounts Payable to suit your own needs.

12 Related Topics
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Recurring Payables Report — Features

The Recurring Payables Report lists your recurring payable records by
recurring payable code. You print the Recurring Payables report
whenever you need a listing of the recurring payables you have set up.

For instructions on printing the report, see Recurring Payable Report —
Printing.



Information for each recurring payable record printed on
the report

e Details from the Document tab, including: the vendor, schedule code,
start date, expiration type, expiration date or maximum amount or
number of invoices, the next invoice date, the date the recurring
payable became inactive (if the record is inactive), the date the record
was last changed (maintained), the maximum amount, the vendor’s
currency and the rate type, remit-to location, description of the
recurring payable, the vendor’s tax group, the method of tax
calculation, as well as the purchase order and (sales) order number.

It also shows the distribution code, description, general ledger
account and description, the amount of each detail, as well as tax
amounts (if entered manually), and the invoice total.

e |f you choose the Show Schedules option, the report also shows the
schedule code, the date the schedule was last processed, the
recurring period, and the frequency.

e Optional field information, if you choose to include it.

& Related Topics
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Remit-To Locations Report — Features

The Remit-To Locations report lists the remit-to locations (alternate
addresses) used by your vendors.

For instructions on printing the report, see Remit-To Locations Report —
Printing.

Information printed on the report

e Address Information (if selected for the report). Includes vendor

name, address, telephone and fax numbers, check language, and
contact.

e Optional fields assigned to the location, if you use them and you
choose to include them on the report.

The report also identifies primary remit-to locations.

7 Related Topics
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Vendor Group List — Features

The Vendor Group List reports the information entered in each vendor
group used in your Accounts Payable system. The report can also
include a list of the vendors who are assigned to each group.

For instructions on printing the report, see Vendor Group List — Printing.

Information printed on the report

¢ |f you select the Profile option, the report lists:

o

o

e}

o

The group's account set and bank code.

The code or account number specified for the Distribute By option
(distribution code, distribution set, or G/L account),

The tax group and related tax authorities and tax classes.

Selections for the Duplicate Invoice Checking and Generate
Separate Payment For Each Invoice options

The optional fields used in the Vendor Groups form, if any.
The group's currency code (multicurrency ledgers).

¢ |f you select Group Members, the report includes the vendor number,
name, telephone number, and contact person for each of the member
vendors, for quick reference.

7 Related Topics
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Period Statistics Reports — Features

Each report lists the total amount of amount of invoices, payments,
discounts taken, discounts lost, credit and debit notes, and adjustments
you have recorded for a given vendor during the period covered by the
report, as well as the total number of invoices paid during that period.
The information on this report is also available on the Vendor Statistics

tab of the Vendors form and the Group Statistics tab of the Vendor
Groups form.

The reports list statistics for the type of year and period specified in the
Options form.

For instructions on printing the report, see Period Statistics Reports —
Printing.

Information printed on the report

e The totals for each type of transaction in the years and periods
selected for the report.

¢ |f selected for the report, the number of each type of transaction
(document) posted in the selected years and periods.

e Totals for all periods by vendor or vendor group, depending on the
type of report you printed.

7 Related Topics
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Vendors Report — Features

The Vendors report lists the information entered for the vendor records in
your Accounts Payable system.

For instructions on printing the report, see Vendors report — Printing.

When to print
Print the report when you add, change, or delete vendor records.

Information printed on the report

e Vendor's address (appears if you select the Address option). Includes
short name, telephone and fax numbers, and contact.

e Profile information (appears if you select the Profile option). Includes:

o The vendor's group, account set, terms code, bank code, credit
limit, check language, and start date.

o The primary remit-to location, if any.

o The code or account number specified for the Distribute By option
(distribution code, distribution set, or G/L account).

o The tax group and related tax authorities, classes, and registration
numbers.

o Selections for the Duplicate Invoice Checking and Generate
Separate Payment For Each Invoice options.

o The vendor's currency code (multicurrency ledgers).

e Comments and dates entered in the vendor record (appears only if
you select the Comments option and entered comments in the record
with follow-up dates within the specified range).

e Any optional fields used in the vendor records, if you choose to
include them.



7 Related Topics
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Vendor Activity Statistics Reports — Features

The Vendor Activity Statistics report lists information about the purchases
and payment history for the current year to date and previous fiscal year
for the vendor records in your Accounts Payable system. Most of the
information on this report is also available on the Vendor Activity tab of
the Vendors form.

For instructions on printing the report, see Vendor Activity Statistics
Report — Printing.

Information printed on the report

e Outstanding balance, number of invoices in the system, number of

paid invoices, the total days to pay invoices, and the average number
of days to pay.

e Last posting date.

e The date and amount of the last invoice, credit note, debit note,
payment, discount, and adjustment posted to the account.

e The amount and date of the largest invoice and balance in the
account in the current year and previous year.

In multicurrency ledgers, you can print report amounts in the functional
currency or the vendor's currency.

7 Related Topics
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Invoice Entry — Prepayments Field List

Activation Date

Bank

Bank Currency (multicurrency ledgers)
Batch Number

Date (check)

Check Amount (display only)

Check Language

Check Number (display only)
Prepayment Amount

Prepayment Doc. Number (display only)
Print Check

Remit-To

Transaction Type (display only)
Vendor No. (display only)

Year/Period

Prepayment Batch Information form
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Before Creating Batches

Before creating new batches of invoices, you must
e Define the following Accounts Payable information:

o Account sets

o Distribution codes

o Distribution sets (if you plan to use them)

o Terms codes

o Vendor groups

o Vendors

o Remit-to locations (if your vendors have different payment
addresses)

e Use the Invoicing tab in the Options form to:
o Select 1099/CPRS reporting.

o Allow you to edit imported batches using the Invoice Entry form.

o Define any optional fields you want to add to the Invoice Entry
form.

e Define the following information in Tax Services and Bank Services:
o Tax authorities, tax groups, tax classes, and tax rates.
o Bank codes.

Before adding transactions to an invoice batch

e Make sure you have complete information for each document you
want to enter, including the vendor number, document number, date,
purchase order number, if any, and sales order number, if any.

If you are entering credit notes or debit notes, find out the invoice
number to which they apply, if any.

¢ In multicurrency ledgers:

o Update currency information and exchange rates in the Currency
forms in Common Services.



o Find out the rate type, rate date, and exchange rate to use for
each invoice, credit note, debit note, and interest charge.



Invoice Entry — Batch Information Form

The Batch Information form opens when you click the Zoom (.) button
beside the Batch Number field.

It displays information for the selected invoice batch, such as:
e The batch date and a description for the batch.

e The source application, showing whether the batch was added
directly through the Accounts Payable or was generated by another
program (such as Purchase Orders).

e Whether the batch listing has been printed.
e The date the batch was lasted edited.

For information about each field on the Batch Information form, click the
Field List button, above.



Entering Payments and Invoices at the Same Time

The Payment Entry form lets you enter invoices at the same time as you
enter payments for existing vendors as well as for & gne-time vendars. (IN SOMe
other programs, this is called a "cash invoice.")

To enter an invoice when you add a payment, you must select Misc.
Payment as the transaction type. Accounts Payable then displays a
detail-entry grid where you can enter general ledger account distributions
for the payment, as you would to add an invoice using the Invoice Entry
form. (If you prefer to view all the information for a detail, without
scrolling, click the Accounts/Taxes button to enter the details using the
Detail Accounts/Taxes form.)

Payment Entry also lets you enter job-related details for miscellaneous
payments. To display the necessary job-related fields, select the Job
Related option on the Payment Entry form before you enter any details.

If you are entering a miscellaneous payment for an existing vendor, you
must also enter the invoice number. When you add the entry, Accounts
Payable creates an invoice document that uses this number.

Accounts Payable calculates tax and updates tax services for
miscellaneous payments, as it does for invoices you enter using Invoice
Entry. The program displays tax information from the vendor record as
defaults for the document.

e To change the tax group or other tax information for the document,
you use the Document Taxes form. (You can use a tax group that is
from the one specified in the vendor record.) Click the Document
Taxes button, to display the Document Taxes form.

e To change tax information for the invoice details, you use the separate
Detail Accounts/Taxes form to enter the details and detail tax
information. Click the Accounts Taxes form to display the Detalil
Accounts/Taxes form.

When you post the miscellaneous payment, Accounts Payable creates
an invoice transaction as well as a payment transaction. The entries are
combined on the same posting journal.
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Limitations

Note that invoices created for a miscellaneous payment do not include:
¢ Retainage.

e Optional Fields.

e Terms. (The invoice is paid immediately.)

& Related Topics
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Force Listing of Batches

If you use the Force Listing Of Batches option, you must print batch
listings for each batch you want to post. You must also print a new listing
for each batch you edit.



Invoicing Interest

An interest charge is entered in the Invoice Entry form just like a credit
note or debit note, except that the program does not let you enter or
distribute taxes.



Tax Group

Tax groups specify the authorities that tax the goods you purchase from
vendors and assign your tax class for each authority. (Tax classes
determine the specific classification for a tax — such as which rate is
applied or whether you are tax-exempt.)

You assign a tax group to each vendor record with other tax information
such as tax numbers and whether tax is usually included in invoice
amounts. This information appears by default when you enter an invoice
from the vendor.

If you need to change tax rates or amounts for a document, you can
assign a different tax group or you can change the tax class or tax
included settings. (On the Invoice Entry form, you change these settings
on the Taxes tab. On the Recurring Payables form, you change the
settings on the Tax/Totals tab.)

You can also change tax settings for individual invoice distribution lines (if
you are calculating tax) by highlighting the distribution line and pressing
the F9 key.

To change the tax rates, use the Tax Services forms in Common
Services.

In multicurrency ledgers, you can change only to another tax group that
uses the same currency as the vendor.



Manually Enter and Distribute Tax Amounts

Follow these instructions if you do not use Calculate as the tax entry
method. These instructions describe how to enter and distribute tax
directly in the invoice.

1. On the Document tab of the Invoice Entry form, enter the total amount
of the invoice in the Document Total field. (Make sure you fill in all
other information on the tab.)

2. Distribute the document amount net of taxes using a distribution set or
by entering individual distribution codes or general ledger account
numbers manually.

3. Click the Taxes tab.

4. Select Enter or Distribute as the tax entry method in the Tax Amount
(and/or the Tax Base) field, depending on whether you want to be
able to edit the detail tax distribution. You can edit detail taxes only if
you use Enter as the tax entry method.

5. Enter the amount of each tax (and the tax bases, if you chose Enter
or Distribute in the Tax Base field) from the vendor's invoice.

6. Check the tax classes. If they are incorrect, use the Finder to select
the correct classes.

7. Click the Distribute Taxes button to allocate tax amounts
proportionally to each distribution.

You can edit the amount of each tax allocation if necessary.

12 Related Topics
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Tax Included — with Calculate as the Tax Entry

Method

To have Accounts Payable calculate and distribute taxes that are
included in the invoice amounts, follow these steps.

1. Enter the total amount of the invoice in the Document Total field on
the document tab of the Invoice Entry form. (Make sure you fill in all
other information on the tab.)

2. Distribute the total document amount. If some taxes are not included
in the invoice total, distribute the document amount net of these taxes
(deduct the tax amount from the document total).

The tax calculation will calculate the portion of each distribution that is
tax.

If you need to change the tax settings of a single distribution, do it
before you calculate tax:

o Highlight the distribution line.

o Press the F9 key to display a form similar to the one shown in step
5 above.

o Change the Tax Class or the Tax Included setting.
o Click OK.

3. Click the Taxes tab.

4. Select Calculate in the Tax Amount field.

5. Check the tax classes. If they are incorrect, use the Finder to select
the correct classes.

6. Select "Yes" in the Tax Included column for each tax hidden in the
invoice total (by clicking your mouse or pressing the Spacebar in the
column). Note that you can only change the Tax Included setting if the
Tax Authority allows the tax included option.

The Vendor Tax Class and Tax Included settings on this tab are the
default settings for all distribution lines on the Distribution Information
tab.



You can change the setting for an individual line by selecting the line,
then pressing F9. Make any changes you need in the popup form that
appears.

7. Click the Distribute Taxes button.

Note: You can edit tax allocations by selecting Enter as the tax entry
method on the Taxes tab, then changing the Allocated Tax amount on
each distribution line.

& Related Topics
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Tax Not Included — with Calculate as the Tax

Entry Method

To have Accounts Payable calculate and distribute taxes that are not
included in the invoice amounts, follow these steps.

1. Enter the total amount of the invoice in the Document Total field on
the Document tab of the Invoice Entry form. (Make sure you fill in all
other information on the tab.)

2. Distribute the amount of the document net of taxes. (Using a
distribution set or entering distribution lines manually.)

3. Click the Taxes tab.

4. Select Calculate as the tax entry method for both the Tax Amount field
and the Tax Base field.

5. Check the tax classes. If they are incorrect, use the Finder to select
the correct classes.

6. Select "No" in the Tax Included column for each tax hidden in the
invoice total. Note that you can change the Tax Included column only
if the settings are permitted by the Tax Authority.

7. Click the Distribute Taxes button.

Note: You can change the Allocated Tax amount on each distribution
line on the document tab only if you select Enter as the tax entry method
on the Taxes tab.

12 Related Topics
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Processing Advance Credits for the Return of

Goods

Accounts Payable lets you record an advance credit for goods that you
have returned to a vendor, but the vendor has not yet received and has
not yet issued a credit.

When you pay the invoice, you reduce your payment by the agreed
amount , at the same time recording the advance credit for the returned
goods.

The advance credit offsets the full amount of the invoice. However —
because the vendor has not received either a payment or the goods — it
preserves the outstanding balance for the unpaid portion of the invoice.

When the vendor issues the real credit note, you enter it in Invoice Entry,
offsetting the advance credit in the vendor account.

Click here for step-by-step instructions on entering an advance credit.




Posting Recurring Payable Batches

When you post a recurring payable batch, Accounts Payable creates a
posting journal for the transactions and updates the following records:

Updating vendor statistics

e Vendors. Adds the amount and number of new recurring payables to
the totals for the period in the vendor’s account. Also enters the
amount and document date of the last recurring payable that was
posted for the vendor.

e Vendor Groups. Adds the total amount of the recurring payables
invoiced to vendors in the group and the number of recurring-payable
invoices created for the group to the group statistics. Use the Vendor
Groups form to view this information.

Creating general ledger transactions

When you post recurring payable batches, Accounts Payable creates
transactions for the payable accounts specified for each detail line on a
recurring payable invoice, and for the affected accounts in the vendor’s
account set. Posting also creates balancing transactions for the
corresponding payable control accounts. Print the posting journal for the
recurring payable batch or the G/L Transactions report to view this
information.

7 Related Topics
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Transaction Type
You can enter four types of transactions:

Payment. Records a check to pay outstanding transactions. You can
print the check from Payment Entry or enter the number of a previously
written check.

Prepayment. Records a check written as a prepayment. You can print
the check from Payment Entry or enter the number of a previously written
check.

Prepayments pay for a purchase before you are invoiced for it. When you
enter and post the invoice, Accounts Payable automatically applies the
prepayment.

Apply Document. Lets you apply a posted prepayment or credit note
against an invoice, debit note, or interest charge.

Miscellaneous Payment. Lets you issue a check to a person or
company for which you have not set up a vendor record. You enter the
distribution details of the purchase in the same way as you enter them for
an invoice.



Optional Fields (Payments)

The Optional Fields check box on the Payment Entry form indicates
whether optional fields are assigned to the currently selected payment. If
you marked any payment optional fields for automatic insertion, the field
will be selected when you add a new payment entry.

If you use exactly the same optional fields in vendor records and on
payments, the program assigns the optional field values used in the
vendor record to the payment.

You can accept or delete the optional fields that appear as defaults, and
you can add other optional fields that you have set up for payment
documents. You can also change the optional field values used in the
entry.

To check or to change the optional fields and values for a payment:

1. On the Payment Entry form, click the zoom button (« ) beside the
Optional Fields check box.

An Optional Fields form appears, displaying any optional fields that
are marked for automatic insertion on new payments.

2. Use this Optional Fields form to add or delete optional fields for the
payment document. You can add any optional fields that are defined
for invoice details.

You can also change the default values that appear, as follows:

o If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional
field allows blanks, you can leave the value field blank.

o If the optional field is not validated, you can select a predefined
value, or you can enter any value that is consistent with the type of
field (amount, text, yes or no, and so on), providing your entry
does not exceed the length permitted for the field.



Apply To

Enter the invoice number, PO number, or sales order number for the
invoice you are prepaying (depending on your choice for Document
Type). Accounts Payable will use this number to identify the invoice to
which you are applying this prepayment.



Posting Date

The posting date is used to record the date the documentwas applied to
another transaction and when it is actuallyposted to General Ledger. It
does not affect the determination of the discount or the days to pay
statistics.

Accounts Payable also uses this date to select the default fiscal year and
period to which the transaction is posted. (You cannot change to another
year or period.)

The default posting date that appears depends on your selection for the
Default Posting Date option on the A/P Options form.

Note:If you consolidate G/L transactions, the posting date for
consolidated entries is the last date of the fiscal period.

See also
Payment Date




Control Payments Form — Overview

This topic contains an overview of the payment controls and of the
Control Payments form.

When you use Create Payment Batch to create a batch of checks, you
control which checks are generated in three ways:

e By using payment selection criteria that you have already defined with
payment selection codes.

The payment selection codes provide default settings for the Create
Payment Batch form. These settings cover such things as the
payment bank and bank currency, the range of vendors, and a vendor
exclusion list.

e By imposing payment controls (either holding or forcing payment) for
individual vendors and invoices.

e By placing a vendor on hold. You cannot enter any payments for a
vendor who is on hold.

Payment selection codes

When you create a payment batch, the payment selection code provides
default criteria for creating the payment batch. You can override these
criteria when you create the batch.

Payment selection codes specify how Accounts Payable should select
vendor invoices for payment.

You can create as many payment selection codes as you want, using the
Payment Selection Codes form, then choose the one you need for a
check run. For example, you might have separate selection codes for
processing US, Canadian, and Mexican payments.

Setting a vendor on hold

At the vendor level, you can set the vendor status in a vendor record to
On Hold — meaning that no transactions for that vendor are paid.

Note that this restriction only applies to the Create Payment Batch
process (and you cannot Force a payment for an On Hold vendor using



the Control Payments form). However, you can make payments to an On
Hold vendor manually, using the Payment Entry form.
Placing invoices on hold with the Control Payments form

If you place invoices on hold in the Control Payments form, the restriction
applies only to the Create Payment Batch process. It does not prevent
you from entering checks in the Payment Entry form.

The Control Payments form lets you:

e Control payments for a specific vendor, document, and payment (for
multiple payment schedules).

Once you select the vendor and document, you can:
o Change the due date
o Change the discount date
o Change the discount percent
o Change the discount amount
o Change the activation date for a prepayment
o Cancel a previous control status
o Place documents on hold
o Force payment of the document

Invoice on hold. Putting a transaction on hold means it will not be
paid until you remove the hold.

Forcing payment. Forcing a transaction for payment means that it
will definitely be paid on the next check run, provided that the vendor
is within the selection criteria and the check amount is within the
minimum and maximum check amount range specified for the run.

We recommend that you set holds and force payments to control non-
payment and payment of individual transactions, rather than trying to
achieve the same effect by changing due dates or discount dates.

Prepayment activation. Bringing forward or delaying the activation
date of a prepayment affects payments, because Create Payment
Batch does not take prepayments into account unless they are



activated.

e Place or lift general payment restrictions on a single vendor or range
of vendors and documents.

You can choose the document type (invoice, credit note, debit note, or
prepayment) and:

o Cancel a previous control status
o Force payment of documents
o Place documents on hold

Normally, you use the Control Payments form after printing the Pre-
Check Register and reviewing the current payables to select the
transactions you want to pay.

& Related Topics
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Apply Method

The Apply Method field lets you specify a default method for allocating
partial payments to details on job-related invoices that use different
contracts, projects, and categories.

You can select one of the following methods:

o [f Top Down

® [} prorate By Amount
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A/P Integrity Checker

This form opens when you select Accounts Payable on the Data Integrity
form (in Administrative Services), then click Application Options. This
form lets you limit the scope of integrity checks to fit the time available.

The A/P Integrity Checker lets you specify:
e The type of data to check.
e Arange of vendor records for which to check data.
e Whether minor errors will be fixed while the check is proceeding.
e Whether to check for or delete orphan records.



Checks € Printing

You can print checks for the payments you enter in Accounts Payable on
check forms that include an advice slip listing the details of the payment,
or you can print the checks and advices separately on different forms, or
you can print checks or advices only.

Sage ERP Accpac Accounts Payable comes with four sample formats for
checks, with attached advice slips. You can use the sample formats or
change them to suit your company's requirements (for example, to adapt
the formats if you use separate pre-printed check and advice forms).

For information on the contents of checks, see Checks € Features.

Printing checks

You can print checks in one of three ways from the Accounts Payable
program:

e Open the Payment Entry form, add a payment or open an existing
one, and choose the Print Check button to print the check for the
payment.

Or

e Open the Invoice Entry form, add a prepayment with an invoice,
select the Print Check option in the Invoice Entry - Prepayment form,
then choose the Print Check button to print the check for the
prepayment.

Or

e Open the Payment Batch List form, select a payment batch, and
choose the Print/Post button to print checks for all the payments in a
batch.

The Print/Post button also posts the payment batch to vendor
accounts after printing the checks.

You can print checks while other users are printing checks, as long as the
check runs are all for different payment batches.

Using the Print Checks Button in the Payment Entry form



To print a check from the Payment Entry or Invoice Entry form

1.

In the Payment Entry form, enter all details of the payment, making
sure to select the Print Check option. In the Invoice Entry form, enter
the invoice, then choose the Prepay button, enter the information for
the prepayment, then select the Print Check option.

Click Save (or Add) to save the payment.

3. Click Print Check to display the Print Checks form.
4. Ensure that the check form selected in the Print Checks form is the

one you want to use, and make sure the check forms are positioned
properly in the printer. You can print an alignment check to test the
positioning.

5. Click Print.
6. Review the check once it is printed. Accounts Payable will ask

whether checks were printed correctly.
o If the check was printed correctly, click Yes.

o If the check was not printed correctly, click No, then reset the print
status by clicking the print status column or by clicking the Select
Reprint Range button and specifying the number of the check you
just printed.

o |If you are also printing a payment advice, Accounts Payable will
ask you whether the advice forms are in the printer.

Click Yes to print the advice form, then, if correct, click Yes
again when asked whether the advice was printed correctly.

When you accept the check and the payment advice, if you
printed one, Accounts Payable will post the check information
to Bank Services, and close the Print Checks form.

Note that the check information is immediately posted to Bank Services,
but the payment information is not posted to vendor accounts until you
post the payment batch, using the Print/Post button in the Payment Batch
List form.

Note also that you cannot reprint the check once the check information
has been posted to Bank Services. However, if you delete the payment



from the payment batch after you print the check, Accounts Payable
changes the status of the check to Void in Bank Services.

You can delete payments (void checks) until you post the batch. Deleted
checks do not appear on the Accounts Payable Check Register.
Using the Print/Post button from the Payment Batch List

The most common way to print checks is with the Print/Post button in the
Payment Batch List form.

To print checks and post the payment information to vendor
accounts, you:

1. Open the Payment Batch List form.
2. Select the batch for which you want to print checks.

3. Click the Print/Post button. Accounts Payable performs the following
tasks:

o Makes sure that the batch has been listed if you selected the
option Force Listing Of Batches (in the Options form).

If you use the option and the batch has not been listed, you
must list it before you can print and post the checks.

o Makes sure that the batch you selected is Ready To Post, and, if it
Is not, asks whether you want to set it to Ready To Post and
continue with posting.

o Posts the batch immediately if all checks in the batch have been
printed (or if the payment batch does not contain checks).

o If there are checks to be printed, Accounts Payable displays the
Print Checks form.

4. Review the settings in the Print Checks form before you proceed, and
review the list of checks the program is ready to print.

You can change the following items if they are incorrect:
o Check stock.
o Next check number.
o Number of leading checks.



Although nothing will be printed on the leading checks, Bank
Services needs the information to assign check numbers for
the blank forms, to keep the audit trail correct.

o Report file used to print the check and/or advice forms.

You cannot proceed with printing and posting checks without a
valid check report file.

5. Click the Print button when you are ready to proceed.

If you are printing checks then advices (instead of checks only or
combined check and advice forms), the program will tell you to insert
the check stock in the printer before proceeding.

When printing is finished, Accounts Payable asks whether the checks
were printed correctly.

6. Review the checks, then click Yes or No.

If you choose No, click the Select Reprint Range button and specify a
range of checks for reprinting, then choose the Reprint button.

If you choose Yes, Accounts Payable returns you to the Payment
Batch List form, and posts the payments.

If you are printing advices after the checks, the program will start to
print advices as soon as you choose Yes to confirm the check
printing.

The program asks you to confirm that advices were printed correctly
before it returns you to the Payment Batch List and posts the
payments to vendor accounts.

After you click Yes to accept the check run (or the advice run if
printing advices), Accounts Payable displays the Payment Batch List
form once again, and proceeds immediately to posting the payment
batch to vendor accounts.

Once the check data has been posted, you cannot reprint the checks or
advices.

Printing alignment checks

To print a test copy of a check to verify that your check forms are aligned



correctly in your printer, choose the Align button. You can repeat this step
as often as needed when the printing destination is Printer.

& Related Topics
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Allow Edit Of External Batches

This option lets you revise information in batches generated for Accounts
Payable in other Sage ERP Accpac programs. Do not use the option if
you want to ensure that the external batches are posted without changes
in Accounts Payable.

You can change your choice for this option at any time, using it to
increase your auditing and supervisory control of external batches and
reducing the possibility of errors from accidental editing.



Allow Edit of Statistics

Accounts Payable automatically accumulates statistics from the
transactions you post to vendor accounts, and displays them in the
Vendors and Vendor Groups forms.

Use the Allow Edit Of Statistics option to enter or revise the period
statistics that are kept for both forms, as well as the current-year and
previous-year activity statistics that are kept in the Vendors form.

You may want to turn on the editing option while you are setting up your
Accounts Payable system, particularly if you are creating the system part
way through an accounting year. You can then enter more complete
payables records by adding the statistics from your previous system.

Once your system is operating, you can turn off the option because the
program automatically updates the statistics when you post invoice,
adjustment, and payment transactions.

You may decide to use the option to edit vendor group statistics if you
change a vendor's group, or to edit a particular statistic because unusual
circumstances have exaggerated the amount.

For example, if a single invoice remained unpaid for a long period on an
otherwise satisfactory account, you could adjust the total number of days
to pay or the total number of paid invoices to correct the average so that
it more accurately reflects your company's paying habits for the vendor.

Keeping statistics in balance in vendor groups

If you edit a vendor's statistics, you should make the same changes to
the statistics for the vendor group to which the vendor belongs. Print the
Vendor Group Period Statistics and Vendor Period Statistics reports for
the records you change, to verify that the totals still balance.



Base Retainage On

Select whether retainage will be calculated on the document total before
tax or after tax is included.



Default Retainage Exchange Rate

If you use multicurrency, specify whether to use the current exchange
rate or the exchange rate used for the original document as the default
for retainage documents.



Default Retainage Percentage (optional)

Enter the percentage of the document total to withhold on invoices, credit
notes, and debit notes. This percentage will appear as the default when
you add new vendors, but you can change the retainage (or holdback)
percentage for particular vendors in the vendor record.



Default Retention Period (optional)

Enter the number of days from the original document date that you can
withhold the retained amount from vendors. The program determines the
default retainage due date by adding the retention period to the original
document date.

The default retention period is used for new vendor records, but you can
specify different ones for individual vendors. You can also change the
retention period on invoices.



Retainage Document Numbering (optional)

Accounts Payable uses a separate numbering system to identify
retainage documents that you generate using the Create Retainage
Batch form.

The retainage document numbering grid lets you specify the next
number, length, and prefix to assign to retainage invoices, credit notes,
and debit notes, or you can accept the default that appears on the grid.



Last Invoiced (display only)

The Retainage tab displays the date that you ran Create Retainage Batch
from the Reminder List.



Number of Days in Advance to Create Retainage
Documents

Enter the number of days before the retainage due date that you can
generate retainage documents using the Create Retainage Batch form.

For example, if you enter 5, you can generate the retainage invoice five
days before the retainage is due.



Schedule To Use For Automatic Creation Of Retainage
Documents (optional)

Enter or use the Finder to select the code for the schedule you want to
use to process retainage from the Reminder List.

If the schedule does not yet exist in Common Services, you can click the
zoom button (« ) beside the field, then create the schedule using the
Schedules form that opens. You can also click the zoom button after
entering a schedule code to view information about the schedule.



General Ledger Account Numbers

Enter the general ledger account numbers for:

o [f Payables Control

® [ purchases Discount

o [f Prepayment

o [f Retainage

In a multicurrency system, if the account set uses a different currency
than the functional currency, you must also specify the currency code
and the following accounts:

® [} Unrealized Exchange Gain and Unrealized Exchange Loss

o [f Exchange Gain
o [f Exchange Loss

® [} Exchange Rounding
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Delivery Method

This field lets you specify how to send purchase orders and returns to the
vendor. You can select Mail &, E-mail, or Contact's E-mail.

If you choose Vendor as the Delivery Method when printing purchase
orders or returns, the program uses the delivery method you specified in
the vendor record.
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Payment Code

On the Vendor Group record, use this field to enter the payment code you
want to use as the default for new vendors you add to the vendor group.

On the Vendor record, you can change the default payment code for an
individual vendor. The payment code used on the vendor record appears
as the default payment code when you process a new payment for the
vendor.



Retainage % (vendor)

You can specify on the vendor record the default percentage to use for
calculating retainage on original documents. You can always change the
retainage percentage when you enter an invoice, debit note, or credit
note for the vendor.

When you add a new vendor record, the retainage percentage you
specified on the A/P Options form appears as the default, but you can
change it for a particular vendor.



Retainage Terms (vendor)

You can specify on the vendor record a default terms code to use for
original documents. You can always change the retainage terms when
you enter an invoice, debit note, or credit note for the vendor.

When you add a new vendor record, the retainage terms code you
specified on the A/P Options form appears as the default, but you can
change it for a particular vendor.



Retention Period (vendor)

You can specify on the vendor record the default retention period to use
on original documents. You can always change the retention period when
you enter an invoice, debit note, or credit note for the vendor.

When you add a new vendor record, the retention period you specified on
the A/P Options form appears as the default, but you can change it for a
particular vendor.



Tax Reporting

This option appears in vendor records only if you selected the Use
1099/CPRS Reporting option in the Options form.

On the Invoicing tab of the Vendors form, select 1099, CPRS, or None,
depending on the type of tax forms you are required to submit for each
vendor, if any.

When you select 1099 or CPRS, you then also enter the vendor's 1099
or CPRS tax number and type, as well as the 1099 or CPRS code that
matches the type of goods or services you purchase from the vendor.



Optional Fields and Values (vendor and vendor groups)

Optional fields are available if you installed Sage ERP Accpac
Transaction Analysis and Optional Fields Creator.

Optional fields that you set up for automatic insertion in vendor group and
vendor records automatically appear, along with their default values, on
the Optional Fields tab of the:

e Vendor Groups form when you add a vendor group.

You can accept the optional fields that appear or you can delete them,
and you can accept or change any default values that appear.

e Vendors form when you add a new vendor.

If the optional fields match those used by the vendor group, values
from the vendor group record appear as defaults. Otherwise, the
default values from the optional field record are used.

You can accept or change the default values that appear for optional
fields in vendor group and vendor records, or you can delete them, and
you can accept or change any default values that appear. You can also
add different optional fields that you have set up for use with the
respective form.

If an optional field requires validation, you can select only a value that is
assigned to the optional field in Common Services. (If the optional field
allows blanks, you can leave the default value field blank.)

If the optional field does not use validation, you can select a value from
Common Services, leave the field blank, or enter any value that is
consistent with the type of field (yes/no, text, number, date, amount, and
so on) and does not exceed the number of characters specified for the
optional field.

The optional field data you enter in a vendor record appears on new
invoices you enter for the vendor if you use exactly the same optional
fields for vendors as for invoices.



YTD Average Days to Pay

Accounts Payable keeps track of the average number of days it takes
you to pay each invoice for vendors in a vendor group.

The program displays the average for the year in the YTD Average Days
To Pay field on the Statistics tab on the Vendor Groups form. You cannot
change the figure.



State/Province

This field contains the name of the state or province for the remit-to
address. You can type up to 30 characters in the field, including spaces.



Fax (remit-to contact)
Use this field for the fax number for the contact person at this remit-to
location.

The field contains area code parentheses and hyphens if you selected
the Format Phone Number option for the company in the Company
Profile form of Common Services.



Telephone (remit-to contact)

Use this field for the telephone number of the contact at this remit-to
location.

The field contains area code parentheses and hyphens if you selected
the Format Phone Number option for the company in the Company
Profile form in Common Services.



E-mail (remit-to contact)

Enter an e-mail for the contact person at this remit-to location.



Recurring Payables Setup — Vendor Information

Form

This form displays the address, contact, and telephone numbers entered
in the vendor record. Use the form to check this information to ensure
that you are entering the payable for the correct vendor.

If the vendor wants you to remit your payment to another address, use
the Remit-To field to select an address from the Finder or use the Zoom

button beside the field to open the Remit-To Information form and enter
the address to use.



Recurring Payables Setup — Remit-To Information

Form

This form (which you open from the Recurring Payable Setup form)
displays address, contact, telephone for the vendor.

You can check this form to ensure that the remit-to address is correct or
you can enter another address or other information to apply for the
recurring payable.

To display the Remit-To Information form, click the zoom button beside
the Remit-To field or press the F9 key on your keyboard while the
insertion point is in the Remit-to field.

If you want to change information that appears for the remit-to location in
this form, use the Remit-To Locations form.



Optional Fields (Invoice and Recurring Payable Details)

This field indicates whether optional fields are assigned to the document
detail. If any invoice details optional fields are set for automatic insertion,
the field will be selected when you add a new detail to an invoice, credit
note, debit note, or recurring payable.

If you use exactly the same optional fields in vendor records and on
invoices, the program assigns the optional field values used in the vendor
record to transaction details that you add in the Invoice Entry and
Recurring Payables forms.

You can accept or delete the optional fields that appear as defaults, and
you can add other optional fields that you have set up for invoice detalils.
You can also change the optional field values used in document details.

To check or to change the optional fields and values that are used
for a detail

1. Select the detail, then click the Optional Fields zoom button (4). You
can also select the detail on the grid, then press Shift+F9.

An Optional Fields form appears, displaying any invoice details
optional fields that are marked for automatic insertion.

2. Use this Optional Fields form to add or delete optional fields for the
detail. You can add any optional fields that are defined for invoice
details.

You can also change the default values that appear, as follows:

o |f the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional
field allows blanks, you can leave the value field blank.

o |f the optional field is not validated, you can select a predefined
value, or you can enter any value that is consistent with the type of
field (amount, text, yes or no, and so on), providing your entry
does not exceed the length permitted for the field.

Optional Fields for Job-Related Details

If the invoice details optional fields used on an invoice detail are identical



to those assigned to the contract project, Accounts Payable uses the
optional field values from the contract project as default values for the
detalils.

If you assign to a job-related detail an optional field that is not assigned to
the contract project, the program displays the default value for the invoice
details optional field. You can also change the values, as you can for any
invoice, credit note, or debit note.



Recurring Payables Setup — Detalll

Accounts/Taxes Form

The Detail Accounts/Taxes form lets you:

e Check or change the General Ledger account to which you are
distributing the currently selected detail. If you change the account,
the program updates the G/L Account field on the detail line.

e Enter a comment with the detail.

e Check or change the tax class for each tax authority, and indicate
whether tax is included or excluded in the detail you are entering.

e Specify the tax amount for each tax authority and detall, if you enter
taxes manually.

If you enter taxes manually, make sure that the sum of the taxes for all
the distribution lines matches the total you specify on the Tax/Totals
tab for each tax authority.

To open the Detail Accounts/Taxes form

1. On the Detalil tab, select a distribution line.

2. Click the Accounts/Taxes button or press F9 .
Click the Close button to return to the Detail tab.



Value and Description
Default values appear for invoice optional fields, as follows:

¢ |f you assigned the same optional fields to the vendor and remit-to
location records as you defined for invoices, the optional field values
for the remit-to location appear on the Optional Fields tab.

e If the optional fields in the remit-to location record and the vendor
record are different from each other, the optional field values from the
vendor record appear as defaults for the invoice.

e If an optional field is defined for invoices, but is not assigned either to
the vendor or the remit-to location, the program displays the value
specified for the optional field in the Optional Fields record.

You can change the value that appears for an optional field, but if the
optional field is validated, you must specify a value that is defined for the
optional field in Common Services. If the optional field is not validated,
you can select a value from Common Services or you can enter another
value that is consistent with the type of optional field.

The description for the value appears automatically. You cannot change
it.



Tax Base (tax entry method)

This is the amount (before included taxes) used as the base for
calculating tax for each tax authority.

If you select Calculate, you cannot change the tax base.

If you select Enter or Distribute as the tax entry method for the Tax Base,
you can enter the amount on which tax is based for the document. If you
select Calculate as the entry method for the tax amount, and select
Distribute or Enter for the tax base, the program uses the tax base you
enter to calculate the tax amounts automatically.



Include Transactions On Hold

Select this option if you want to include in the statistics transactions that
are on hold.



Payment Information

This popup form lets you lets view all the documents and payments to
which a check was applied, and see the amount of each application, the
date, the number of the reference document (if applied to a prepayment),
the type of check (prepayment or payment), and whether the check was
reversed.

To view summary details for a payment listed on the Payments tab of the
Vendor Activity form, select the payment, then click the Open button to
display details such as:

e Document and payment number to which the check was applied, or
prepayment number if a prepayment.

Check amount and currency (if you have a multicurrency ledger).

Transaction type and description.

Applied date.

Reference Document number (if applied to a prepayment).

Before you start, print and post any outstanding checks and payment
batches.



Document Button (Vendor Activity Payments)

You can select any payment listed on the Payments tab of the Vendor
Activity form, then click Document to view the original entry in the

Payment Entry form.



Adjust Line Number

Use the Finder on this field to select the document detail you want to
adjust.



Job Related (display only)

This display-only field indicates whether the selected document is for a
contract that you administer using Sage ERP Accpac and Job Costing.

Adjustment Entry displays a different set of fields when you select job-
related invoices, credit notes, and debit notes, letting you enter the
contract, project, category, and resource, as required for the adjustment.

If you click the Jobs button that becomes available when you select a job-
related document, you can select particular details for adjustment.



Posting Date

The posting date is used to record the date the adjustment transaction is
actually posted to General Ledger.

Accounts Payable also uses this date to select the fiscal year and period
to which the transaction is posted. (You cannot edit the year or period.)

The default posting date that appears depend on your choice for the
Default Posting Date option on the A/P Options form, but you can change
it.

Note: If you consolidate G/L transactions, the posting date for
consolidated entries is the last date of the fiscal period.

See also
Adjustment date




Retainage Debit/Credit

Accounts Payable lets you add or edit the retainage debit or retainage
credit field, even if the original document did not include retainage. (Note
that these fields do not appear for retainage invoices, debit notes, and
credit notes.)

Enter the debit or credit as a positive number. If you enter a retainage
debit or retainage credit amount using a negative number, the program
will move the amount to the retainage credit or retainage debit field.

Note

e |f the document you are adjusting included retainage, the only
retainage fields you can edit for a document detail are the original
retainage debit or retainage credit.Note that you add or edit retainage
on the detail-entry grid. You do not enter a retainage debit or credit for
the document as a whole.

e You can adjust the retainage amount and add or change document
details on the same adjustment document. (The program then creates
two journal entries: one for the retainage adjustment, and the other for
the detail adjustment.)

e retainage



Retainage Exchange Rate

If you use multicurrency, specify whether to use the current exchange
rate or the exchange rate used on the original document when you
process the retainage document.

The Retainage Exchange Rate field does not appear if the original
document included retainage. In this case, Adjustment Entry uses the
retainage exchange rate setting from the original document.



Currency (display only)
Accounts Payable displays the vendor currency in this field.



Exchange Rate

This field displays the current exchange rate for the specified currency,
rate type, and rate date. If necessary, you can type a different rate or
select a rate from the Finder. (Accounts Payable selects the rate to
display from the Currency forms in Common Services.)



Rate Date

Accounts Payable uses the exchange rate specified for this date in
Common Services to convert amounts from the vendor currency to your
functional currency.

Accounts Payable displays the batch date as the default rate date, but

you can enter a different date. If you enter a new date, Accounts
Payable displays the exchange rate associated with that date.



Rate Type

A code for the kind of rate you want to use when converting multicurrency
amounts to functional currency. Examples of rate types might be "spot
rate," "average rate," and "contract rate."

You must type a valid rate type or select one from the Finder. (You define
rate types using the Currency Rate Types form in Common Services.)



Adjustment Entry — Batch Information Fields

This form displays the following information for adjustment batches:

[}l Batch Date
[}l Batch Number and description

[l Batch Printed

[}l Batch Status

L] Batch Type

[ Last Edited

[ No. of Entries

[t source Application
[}l Total Amount
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Batch Number and description

Accounts Payable automatically assigns a number to each new batch,
and to each entry you add to a batch, starting with 1.

The batch number is a permanent part of the information stored for each
invoice, debit note or credit note, and it appears with the transaction on
Accounts Payable reports, such as posting journals and the G/L
Transactions report, if you use the option to use the numbers as the
description or reference for general ledger transactions.

You can use batch and entry numbers to trace transactions through the
Accounts Payable system and, if you use the numbers as the
descriptions or references for G/L transactions, into your general ledger
(unless you consolidate the transactions during posting in Accounts
Payable).

To create a new batch
e Click the New ( 1) button beside the Batch Number field.
You must use the assigned batch number.
e Enter a description and a date for the batch.

To select an existing batch, do one of the following
e Type its number in the Batch Number field.
e Select it using the Finder ( @) beside the field.

e Click the navigation buttons (1« « * »t) beside the Batch Number
field to move quickly through the list of batches to display the one
you need.

To view descriptive information for a batch

e Click the Zoom (.) button beside the Batch Number field. The Batch
Information form opens, displaying additional information for the
batch.



Remit-To Information

The remit-to location is the name and address to which you are going to
send payments.

To display remit-to information during invoice entry, click the Zoom button
beside the Remit-To field on the Document tab of the form or, with the
cursor in the field, press F9. The Remit-To popup form displays the remit-
to name, address, and telephone number. You can check this form to
ensure that the remit-to address is correct or you can enter another
address.

If you have a remit-to location set as the primary remit-to location, the
information for the primary remit-to will appear automatically when you
enter the vendor number.

If you need to change information for the remit-to location record, use the
Remit-To Locations form.



Vendor Information

Vendor information is displayed in a form you can pop up from the
Vendor Number field in the Invoice Entry form. This form lists address
and telephone information from the vendor's record. Use the form to
check that the address is correct for the document you are entering.

If the vendor wants payments sent to a different location, select a remit-to
location in the Remit To field. If you have a remit-to location set as the
primary remit-to location, the information for the primary remit-to will
appear automatically when you enter the vendor number.

To display vendor information, enter the vendor number, then click the
Zoom button beside the Vendor Number field or, with the cursor in the
field, press F9.



Discountable

You use this option to specify whether a selected detail is subject to the
invoice discount. For example, if you do not give discounts on freight
charges, you can exempt a freight detail from the invoice discount.

To indicate that a detail is not discountable, you simply clear the
Discountable option for the detail on the Detail Accounts/Taxes form, or
select No for the option on the detail-entry grid.



Retainage Tax Amount (Detail)

This field shows the tax on retainage calculated for a selected detail on
an original invoice, credit note, or debit note.



Retainage Amount

To calculate the retainage amount, the program multiples the document
amount (or the document total, if you include taxes in retainage) by the
retainage percentage. You can enter a new retainage amount, if
necessary. When you enter an amount to replace a calculated amount,
the program recalculates the retainage percentage.

The retainage amount is subtracted from the document amount (or the
document total) to calculate the amount due.



Retainage % (percentage)

The program uses the retainage percentage to calculate the retainage
amount.

You can enter a different retainage percentage in the Retainage
Percentage (%) field. When you enter a new percentage, the program
recalculates the retainage amount.



Retainage Rate

You use this field to specify the method the program will use to determine
the exchange rate for the retainage document when you eventually
process it. You can choose one of the following:

e Use Original Document Exchange Rate — to use the same rate as
the document you are processing.

e Use Current Exchange Rate — to use the rate in effect when you
process the retainage document to clear the outstanding retainage.



Retainage Terms

You can use different terms for retainage documents (used to invoice for
outstanding retainage) than you used for the original document from
which the retainage was taken.

The program displays the code specified for retainage terms in the
vendor record, but you can change the retainage terms for a document, if
you want.



Calculate Taxes button

This button appears on the Taxes tab on the Invoice Entry form, and it
appears on the Document Taxes form associated with miscellaneous
payments you enter using Payment Entry.

Click the Calculate Taxes button to recalculate the tax amount after you
change the vendor tax class for the invoice.



Distribute Taxes button

his button appears on the Taxes tab of the Invoice Entry form and on the
Document Taxes form associated with miscellaneous payments you enter
using the Payment Entry form.

Click the Distribute Taxes button to prorate the tax you enter manually to
the invoice details. Note that you cannot prorate a tax amount to an
authority that uses an exempt tax class.



Derive Rate Button

The Derive Rate button appears on the Taxes tab on the Invoice Entry
form and on the Document Taxes form associated with Payment Entry
(for miscellaneous payments), if you are entering tax reporting amounts
manually or distributing tax reporting amounts to invoice details.

After entering the taxes and tax reporting amounts for the tax authorities,
click the Derive Rate button to let the program compute the exchange
rate implicit in converting manually entered taxes from the vendor
currency to the tax reporting currency.



Job Related

Select this option if you are adding a prepayment or a miscellaneous
payment for a contract you administer using Sage ERP Accpac Project
and Job Costing.

If you are entering a miscellaneous payment, the program replaces the
columns in the payment application grid with job-related fields that let you
identify a specific contract, project, category, and resource from Project
and Job Costing for which you are making this payment.

If you are entering a prepayment, click the Jobs button to open a
separate Project and Job Costing Application Details form that lets you
identify the contract, project, category, and resource.



Select Mode

This field lets you identify how to select invoices to which to apply this
payment.

e Click the Select Mode option if you want to list vendor documents for
selection in the application grid at the bottom of the form — in the
order you want. Select mode provides more information about the
vendor's documents, adding information from any unposted payments
that you have already applied.

e Do not use Select Mode if you know the number of document to which
you are applying the invoice, or if you have a lot of vendor documents.
This method is faster than Select mode because it is faster to look up
documents in the Finder than to scroll through all the items in the
document list.



Vendor Amount

The field shows the amount you have applied using the grid on the
Payment Entry form, unless you are entering a prepayment.

In multicurrency ledgers, the payment amount is converted from the
vendor currency to the bank currency using the exchange rate
information contained on the Rate Override form. To change the
exchange information for a selected payment, open the Rate Override
form by clicking the Rates button at the bottom of the Payment Entry
form.

If you are entering a prepayment, you use this field to type the amount
you are prepaying. If you have a multicurrency ledger, enter the amount
in the vendor currency — not in the bank currency. The amount is
converted to the bank currency for the check amount, using the rates
shown on the Rate Override form.



Year/Period

Accounts Payable displays the fiscal year and period to which the
document will be posted.

Accounts Payable automatically displays the fiscal year and period that
contains the date you enter in the Posting Date field. You cannot change
this field except by changing the posting date.



Document Number (payment application)

The Document Number column in the payment application grid shows the
numbers of outstanding documents that you can pay at this time, or to
which you can apply a prepayment or a credit note.



Job Related (display only)

This display-only field appears in the application details grid of the
Payment Entry form if you use Sage ERP Accpac Project and Job
Costing.

The field indicates whether a document is job-related or not. (The
program sets the entry in this field; you cannot change it.)

When you apply a payment to a job-related document, the Jobs button
becomes available, letting you open the Project and Job Costing Apply
Details form where you can change the apply method or the allocations
for particular document details.



Payment Entry — Document Taxes Form

The Document Taxes form appears when you click the Document Taxes
button on the Payment Entry form when entering a miscellaneous
payment.

The Document Taxes form lets you:
¢ Assign the tax group for the document.

e Check the tax authorities, vendor tax class, tax base, and tax amount
for the document.

e Change the tax class for the document.

¢ Recalculate the tax amount when you change the tax class for the
document.

e Recalculate the tax reporting amounts when you change the tax
group for the document.

Click the links below for information about the buttons that appear on the
form.

Calculate Distribute Derive
Taxes Taxes Rate
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Payment Entry — Detail Accounts/Taxes

Form

The Detail Accounts/Taxes form appears for miscellaneous payments
when you click the Accounts/Taxes button on the Payment Entry form.

It displays all the fields that appear on the Payment Entry form's detail-
entry grid, but on a single form, so you do not have to scroll to see all the
fields. It also displays tax information for a distribution detail.

The Detail Accounts/Taxes form lets you:

e Add distribution details to the miscellaneous payment (or "cash
invoice") you are entering.

e Check or change the accounts to which you are distributing a selected
detail.

e Change tax classes and (if the tax authority allows it) the Tax Included
In Price field for a particular detail.

e On documents for which you are entering taxes manually, enter the
tax base and the tax amount for the detail.

For information on the fields that appear on this form, click the Field List
button, above.

Note that you must use the Document Taxes form to view or edit taxes for
the document.

Click the links below for information about the buttons that appear on the
form.

Add New Delete Close




Project and Job Costing Apply Details Field List

This form appears when you select a posted job-related document on the
Payment Entry form, then click the Jobs button.

Applied Amount

Applied Amount (display only)

Apply Line Number

Apply Method

Category

Contract

Cost Class (display only)

Discount Taken

Discount Taken (display only)

Document number and description (display only)
Net Balance and currency (display only)
Project

Resource

Unapplied Amount (display only)
Unapplied Discount Amount (display only)
Vendor Number and Name (display only)
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Payment Entry — Rate Override Form

When you click the Rates button on the Payment Entry form, the Rate
Override form appears to let you:

e Change the exchange rate for the current payment — for example, to
one which was previously agreed on for the invoice.

For an overview of payment entry, see Processing payments.
For full instructions on adding payments, see Steps for entering and
applying payments.

Exchange rates are maintained in Common Services

The default bank rate for each transaction is set in the batch header.
(Click the zoom button beside the Currency field to view exchange rate
information for the batch). When you create the batch, the default rate for
the batch comes from Common Services, and is based on the rate type
and the session date.

The vendor exchange rate for payments, prepayments, or miscellaneous
payments also comes from Common Services, and is based on the rate
type and session date.

"Apply Document" exchange rates

If you are applying a document, you cannot change any rates, because
the document you are applying has already been entered and posted
with a rate.

If the batch is in the functional currency

The Check Amount you enter in the Payment Detail form is in the
functional currency.

The Applied Amount or Prepayment Amount shown on the Payment
Detail page is in the vendor currency.

Note that the rates are for converting the bank currency or the vendor
currency to your functional currency. If either of these currencies is the
functional currency, the rate for that currency will be 1.0000000.



If you use the Exchange Rates form to change the Exchange Rate, you
will change the amount in the Check Amount field — which shows the
amount in the vendor currency in this form.

Note: Exchange rates between currencies participating in the European
Economic and Monetary Union (EMU) cannot be changed. If you
company does not use the euro (or other EMU currency) as its functional
currency, and you are paying an EMU vendor, you can change the rate of
exchange between your functional currency and the euro. However, you
cannot change the rate between the euro and a vendor participating in
the EMU.



Payment Entry — Batch Information Fields

[}] Bank and description
[} Batch Date

[} Batch Number and description
[}l Batch Printed

[}l Batch Status

[] Batch Type

[t currency Information
[ Last Edited

[}l No. Checks Printed
] No. Of Entries

L) Source Application
[ Total Amount
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Clear Vendor Statistics

To clear Vendor Statistics

1. Select the option for the type of statistics you want to clear (Vendor
Statistics, Vendor Group Statistics) in the Clear Statistics form. You
can select one or both types at a time.

2. Enter the ranges of vendor numbers and vendor group codes from
which you want to clear period statistics.

3. Inthe Clear Vendor/Group Statistics Through field, specify the year
and period up to which to clear statistics from the ranges of records
you selected.

The Clear Statistics form clears statistics up to the specified year and end
of the period you specify, including uncleared statistics from any earlier
years and periods.

If you do not want to clear all types of statistics for the same periods, use
the Clear Statistics form as many times as necessary to clear statistics
separately for different ranges of vendors and vendor groups.



Vendor Group Statistics

To clear statistics from vendor group records

1. Select the option for the type of statistics you want to clear (Vendor
Statistics, Vendor Group Statistics) in the Clear Statistics form. You
can select one or both types at a time.

2. Enter the ranges of vendor numbers and vendor group codes from
which you want to clear period statistics.

3. Inthe Clear Vendor/Group Statistics Through field, specify the year
and period up to which to clear statistics from the ranges of records
you selected.

The Clear Statistics form clears statistics up to the specified year and end
of the period you specify, including uncleared statistics from any earlier
years and periods.

If you do not want to clear all types of statistics for the same periods, use
the Clear Statistics form as many times as necessary to clear statistics
separately for different ranges of vendors and vendor groups.



Optional Fields (Revaluation)

The Optional Fields column on the detail grid indicates whether any
optional fields are assigned to the revaluation.

The program sets the value in this column for each line that you fill in on
the grid. If you set up revaluation optional fields for automatic insertion,
when you first add a detail line, the program sets the field to Yes.

To change optional fields and values for a particular line, or to
delete optional fields

1. Either double-click in the Optional Fields column for the line or select
the line, then click the Optional Fields column heading.

A separate Optional Fields form opens, showing any revaluation
optional fields set up for automatic insertion, along with their default
values.

2. You can edit the values for existing optional fields, or add or delete
optional fields for the detail. Note that you can add only optional fields
that are set up for use in Revaluation.



Invoice Entry — Prepayment Batch

Information Form

This form appears when you click the Prepayments button on the Invoice
Entry form, then click the Zoom button for the Batch Number field.

You use the Prepayments Batch Information form to view or specify:
e The batch date and a description for the batch.
e The bank.

e |In a multicurrency ledger, the currency, rate type, rate date, and
exchange rate to be used for the individual payments you add to the
batch.

This batch information form also lets you view information about the
selected payment batch that is not contained on the Prepayment forms,
such as the date the batch was last edited, the batch type and status, the
number of entries in the batch and their total amount, and whether the
batch listing and checks have been printed.

For detailed information about each field on the Batch Information form,
click the Field List button, above.



Invoice Entry — Batch Information Field List

[}l Batch Date
[}l Batch Number and description

[}l Batch Printed

[}l Batch Status

[] Batch Type

[ Last Edited

[ No. of Entries

[ source Application
[}l Total Amount
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Payment Date

Accounts Payable uses this date to:
e Assign the payment to aging periods on reports.
e Calculate any payment discount.
e Report the number of days to pay.

If you are recording a check that you have already issued, enter the date
from the check.

If you are printing a check from Accounts Payable, this is the date that
will appear on the check when you print it.

If you are entering an Apply Document transaction, the Payment Date
field is not active. This field automatically defaults to the date of the
document being applied.

This date appears as the Document Date in the Vendor Activity form and
on reports that include payments and apply document transactions.

See also
Posting date




A/P Integrity Checker Fields

[ Check

[} check For Orphan Records

[ Delete Orphan Records

L Fix

) open And Ready To Post Batches

[] posting Journals

[] setup Tables

[}l vendor Documents (From Vendor/To Vendor)
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Checks — Features

Sage ERP Accpac Accounts Payable comes with several & sample formats for
checks With attached advice slips. You can use the sample formats or
change them to suit your company's requirements (for example, to adapt
the formats if you use separate pre-printed check and advice forms)
using Crystal Reports.

For instructions on printing checks, see Checks — Printing.

Information printed on the report

The sample combined check and advice slip that comes with Accounts
Payable contains the following:

¢ Information about the transaction(s) being paid by the check.

e The check number on the preprinted form. You specify the first check
number to use when you print the check, so that Accounts Payable
assigns check numbers to the payments that match the check
numbers on your forms.

e The numeric check amount. It is preceded by asterisks (and the
textual check amount is followed by asterisks) to prevent alteration.

e The name of the payee. It is positioned on the sample check to be
visible in form envelopes. You can change the position of this and any
other information printed on the check forms.

12 Related Topics
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Recurring Payables Setup — Detall

Accounts/Taxes Field List

[t] Amount (of distribution detail)
L] Comment

[} Discountable

[ Distribution Code

] pescription

[}l Detail Tax Class

L] G/L Account

[ Tax Amount

L] Tax Authority

Ll Tax Base

[ Tax Included

[] Total Tax (display only)
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Payment Information Field List

For help about the options and fields in the Payment Inquiry check details
form, select from the keywords listed below:

Displayed information

Currency Column (in the list)
Document Number
Functional Amount

Payment Amount

Payment Number
Transaction Description
Transaction Type

Vendor Amount
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Adjustment Date

The adjustment date identifies the default fiscal year and period to
display for the transaction, and is used to determine the aging period into
which the adjustment is placed on statements and reports. It is also used
as the default posting date for adjustment documents.

You can also print posting journals by adjustment date.

This date appears as the Document Date in the Vendor Activity form and
on reports that include adjustment transactions.

See also
Posting date




Payment Entry € Document Taxes Fields

[ Tax Amount

] Tax Authority

L) Tax Base

L] Tax Class

L] Tax Group

[] Tax Reporting

[ Tax Reporting Amount
[}l Tax Reporting Currency
[} Tax Reporting Exchange Rate
[}l Tax Reporting Rate Type
[}l Tax Reporting Rate Date
[] Tax Reporting Total

L Total Tax
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Payment Entry — Detail Accounts/Taxes Fields

[l Account

[l Amount

L] pescription

[}l Detail Tax Class

[ pist. (Distribution) Code and description

Reference
[ Tax Amount
L] Tax Authority
L] Tax Base

[} Tax Included
L] Total Tax
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Save/Add

Use this button to save the displayed record, account, batch, or
transaction. If you have just entered a new record, the Add button
appears instead of Save.



Use this button to delete the displayed entry.

You can delete an entry at any time before you post the batch, and you
can reuse the entry number. If you do not reuse the entry number, it is
listed as deleted on the batch listing, to ensure a complete audit trail.



Close

Click the Close button to close the current form.

If you are editing a record, the program asks you whether you want to
save your changes or cancel them.



Applied Amount (job-related invoice details)

If you want to change an amount that the program has calculated for a
detail, enter the amount that you want to pay.



Applied Amount (display, job-related invoice)

This is the amount applied to the selected invoice or credit note on the
Payment Entry form.



Category

The program displays the category used for the invoice detail, but you
can select a different category for a selected detalil, if necessary.



Contract

The program displays the contract number used for the invoice detail, but
you can select a different contract number for a selected detail, if

necessary.



Project (job detail)

The program displays the project used for the invoice detail, but you can
select a different project for a selected detall, if necessary.



Resource (job detail)

The program displays the resource used in the invoice detail, but you can
select a different resource for a selected detail, if necessary.



Invoice Entry € Prepayment Batch Information

Field List

This form displays the following information for payment batches:

[}] Bank and description
[}l Batch Date

[} Batch Number and description
[}l Batch Printed

[}l Batch Status

[] Batch Type

[}l Checks Printed

[ Last Edited

[ No. of Entries

[ source Application
[ Total Amount

[l pefault Currency Information
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Reference

You can use this field to enter additional information you want to include
with a transaction (for example, an EFT transaction number).

This field appears for payments, prepayments, miscellaneous payments,
and apply document transactions.
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